## SINUMERIK 840D sl, SINAMICS S120
### IBN CNC: NCK, PLC, drive

Commissioning Manual

### Preface

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Safety information</td>
<td>2</td>
</tr>
<tr>
<td>Requirements for commissioning</td>
<td>3</td>
</tr>
<tr>
<td>Example configuration</td>
<td>4</td>
</tr>
<tr>
<td>Power on and boot up</td>
<td>5</td>
</tr>
<tr>
<td>Connect PG/PC with the PLC</td>
<td>6</td>
</tr>
<tr>
<td>PLC commissioning</td>
<td>7</td>
</tr>
<tr>
<td>Commissioning integrated drives (NCU)</td>
<td>8</td>
</tr>
<tr>
<td>Commissioning communication NCK&lt;-&gt;Drive</td>
<td>9</td>
</tr>
<tr>
<td>NCK start-up</td>
<td>10</td>
</tr>
<tr>
<td>Optimize the drive</td>
<td>11</td>
</tr>
<tr>
<td>Drive optimization using SINUMERIK Operate</td>
<td>12</td>
</tr>
<tr>
<td>Commissioning external drives</td>
<td>13</td>
</tr>
<tr>
<td>Data backup and standard commissioning</td>
<td>14</td>
</tr>
<tr>
<td>File functions</td>
<td>15</td>
</tr>
<tr>
<td>Tips for commissioning SINAMICS drives</td>
<td>16</td>
</tr>
<tr>
<td>Licensing</td>
<td>17</td>
</tr>
<tr>
<td>Cycle protection</td>
<td>18</td>
</tr>
<tr>
<td>New installation/upgrading</td>
<td>19</td>
</tr>
<tr>
<td>General tips</td>
<td>20</td>
</tr>
<tr>
<td>Fundamentals</td>
<td>21</td>
</tr>
<tr>
<td>Appendix</td>
<td>A</td>
</tr>
</tbody>
</table>

### Valid for

Control
SINUMERIK 840D sl/840DE sl
Drive
SINAMICS S120

Software       Version
CNC software for 840D sl/840DE sl  2.7

02/2011
6FC5397-2AP40-0BA0
Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

**DANGER**

indicates that death or severe personal injury will result if proper precautions are not taken.

**WARNING**

indicates that death or severe personal injury may result if proper precautions are not taken.

**CAUTION**

with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

**CAUTION**

without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

**NOTICE**

indicates that an unintended result or situation can occur if the corresponding information is not taken into account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation for the specific task, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

**WARNING**

Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be adhered to. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
Preface

SINUMERIK documentation

The SINUMERIK documentation is organized in the following categories:

- General documentation
- User documentation
- Manufacturer/service documentation

Additional information

You can find information on the following topics at www.siemens.com/motioncontrol/docu:

- Ordering documentation/overview of documentation
- Additional links to download documents
- Using documentation online (find and search in manuals/information)

Please send any questions about the technical documentation (e.g. suggestions for improvement, corrections) to the following address:

docu.motioncontrol@siemens.com

My Documentation Manager (MDM)

Under the following link you will find information to individually compile OEM-specific machine documentation based on the Siemens content:

www.siemens.com/mdm

Training

For information about the range of training courses, refer under:

- www.siemens.com/sitrain
  SITRAIN - Siemens training for products, systems and solutions in automation technology
- www.siemens.com/sinutrain
  SinuTrain - training software for SINUMERIK

FAQs

SINUMERIK

You can find information on SINUMERIK under the following link:

www.siemens.com/sinumerik

Target group

This document is designed for machine tool manufacturers. The document provides detailed information for commissioning engineers that they require to commission the SINUMERIK Operate software.

Standard scope

This documentation describes the functionality of the standard scope. Extensions or changes made by the machine manufacturer are documented by the machine manufacturer.

Other functions not described in this documentation might be executable in the control. However, no claim can be made regarding the availability of these functions when the equipment is first supplied or in the event of servicing.

Furthermore, for the sake of clarity, this documentation does not contain all detailed information about all types of the product and cannot cover every conceivable case of installation, operation or maintenance.

Technical Support

You will find telephone numbers for other countries for technical support in the Internet under http://www.siemens.com/automation/service&support

EC Declaration of Conformity

The EC Declaration of Conformity for the EMC Directive can be found on the Internet at:

http://support.automation.siemens.com

Here, enter the number 15257461 as the search term or contact your local Siemens office.
# Table of contents

Preface ...................................................................................................................................................... 3

1 Introduction ........................................................................................................................................ 13
  1.1 Commissioning manuals for SINUMERIK 840D sl ......................................................................13
  1.2 Principle representation of SINUMERIK 840D sl components for commissioning ..........15
  1.3 Initial commissioning procedure ..............................................................................................19

2 Safety information ............................................................................................................................. 21
  2.1 Danger notices ..........................................................................................................................21
  2.2 ESD notices .............................................................................................................................23

3 Requirements for commissioning .................................................................................................... 25
  3.1 General prerequisites ................................................................................................................25
  3.2 Hardware and software preconditions .....................................................................................27
  3.3 Communication interfaces and terminal assignment ...............................................................29
    3.3.1 Communication interfaces ...................................................................................................29
    3.3.2 Terminal assignment of the digital inputs/outputs ..............................................................31
      3.3.2.1 NCU 7x0.2 and NCU 7x0.3 ..........................................................................................31
      3.3.2.2 NX 1x.1 and NX 1x.3 ..............................................................................................34
    3.3.3 Support for terminal assignment at the HMI ....................................................................35
  3.4 Start-up tool on PG/PC .............................................................................................................36

4 Example configuration ......................................................................................................................... 37

5 Power on and boot up .......................................................................................................................... 39
  5.1 Operating and display elements for run-up ..............................................................................39
  5.2 NCK and PLC general reset ..................................................................................................43
  5.3 Boot completed .........................................................................................................................45

6 Connect PG/PC with the PLC ............................................................................................................ 47
  6.1 Start SIMATIC Manager ..........................................................................................................47
  6.2 Setting up the communication ...............................................................................................48

7 PLC commissioning ............................................................................................................................. 49
  7.1 Creating a SIMATIC S7 project ..............................................................................................49
    7.1.1 Creating a project ..............................................................................................................50
    7.1.2 Inserting a SIMATIC station 300 ....................................................................................50
    7.1.3 Insert NCU 7x0 in HW config .........................................................................................52
    7.1.4 Configuring the properties of the network interfaces ....................................................54
    7.1.5 Insert NX in HW Config .................................................................................................58
    7.1.6 End hardware configuration and load to the PLC .........................................................61
  7.2 Creating a PLC program .........................................................................................................62
Table of contents

8 Commissioning integrated drives (NCU) ......................................................................................... 69
  8.1 Guided commissioning of SINAMICS drives .................................................................................... 70
  8.1.1 Triggering a reset (warm restart) for NCK and drive system ....................................................... 70
  8.1.2 Automatic device configuration .................................................................................................. 73
  8.1.3 Parameterization of infeed ......................................................................................................... 76
  8.1.4 Parameterization of the drives .................................................................................................. 82
  8.1.4.1 Commissioning of listed motor and encoder via SMC ............................................................... 83
  8.1.4.2 Commissioning of third-party motor and additional second encoder via SMC ......................... 90
  8.1.5 First commissioning of SINAMICS drive ended ......................................................................... 98
  8.2 Manual commissioning of SINAMICS drives ................................................................................... 98
  8.2.1 Introduction to commissioning of SINAMICS drives ................................................................. 99
  8.2.2 Activate the factory settings .................................................................................................... 100
  8.2.3 Updating the component firmware ............................................................................................ 103
  8.2.4 Automatic device configuration ............................................................................................... 106
  8.2.5 Commissioning using a drive wizard ......................................................................................... 111
9 Commissioning communication NCK<->Drive ............................................................................. 113
  9.1 Configuration input/output address and telegram ........................................................................... 115
  9.2 Configuration setpoint/actual value ............................................................................................... 116
  9.3 Commissioning communication NCK<->Drive completed .......................................................... 119
10 NCK start-up .................................................................................................................................. 121
  10.1 Overview Commissioning NCK .................................................................................................... 121
  10.2 System data .................................................................................................................................. 121
  10.2.1 Resolutions .............................................................................................................................. 121
  10.2.2 Normalization of phys. units of machine data and setting data ............................................... 124
  10.2.3 Modifying scaling machine data ............................................................................................. 128
  10.2.4 Loading default machine data ............................................................................................... 129
  10.2.5 Switching over the measuring system ...................................................................................... 130
  10.2.6 Traversing ranges .................................................................................................................... 132
  10.2.7 Positioning accuracy of the control system .............................................................................. 132
  10.2.8 Cycle times ............................................................................................................................. 133
  10.2.9 NCK utilization ....................................................................................................................... 137
  10.2.10 Velocities .............................................................................................................................. 139
  10.3 Memory configuration .................................................................................................................. 141
  10.4 Parameter sets of axis/spindle ..................................................................................................... 143
  10.5 Parameterize axis data ................................................................................................................ 145
  10.5.1 Incremental measuring system settings .................................................................................... 145
  10.5.2 Parameterization of absolute measuring systems .................................................................... 149
  10.5.3 DSC (Dynamic Servo Control) ............................................................................................... 151
  10.5.4 Rotary axes ............................................................................................................................. 153
# Table of contents

10.5.5 Positioning axes ................................................................. 155
10.5.6 Indexed axes/*Hirth* axes ...................................................... 156
10.5.7 Position controller ............................................................... 158
10.5.8 Speed setpoint matching .................................................... 163
10.5.9 Drift compensation .............................................................. 165
10.5.10 Velocity matching (axis) .................................................... 166
10.5.11 Axis monitoring ................................................................. 169
10.5.12 Axis homing ...................................................................... 178
10.5.12.1 Incremental measuring system ......................................... 179
10.5.12.2 Distance-coded reference marks ....................................... 182
10.5.12.3 Absolute encoders ......................................................... 185
10.5.12.4 Interface signals and machine data .................................... 188
10.6 Parameterization of spindle data ............................................ 190
10.6.1 Setpoint/actual value channels of spindle ............................ 190
10.6.2 Gear stages ................................................................. 191
10.6.3 Spindle measuring systems ............................................... 192
10.6.4 Speeds and setpoint adjustment for spindle ...................... 194
10.6.5 Position spindle ............................................................... 197
10.6.6 Synchronizing spindle ......................................................... 199
10.6.7 Spindle monitoring ............................................................ 201
10.6.8 Spindle data ................................................................. 204
10.7 Application example .............................................................. 208
10.7.1 Advanced Surface (AS) .......................................................... 208
10.7.2 Preconditions, G code ........................................................ 208
10.7.3 Preconditions, machine data ............................................ 211

11 Optimize the drive ..................................................................... 215
11.1 Measuring functions ............................................................... 217
11.2 Frequency response measurements ..................................... 220
11.2.1 Current control loop measurement .................................... 220
11.2.2 Speed control loop measurement ....................................... 222
11.2.3 Position control loop measurement ................................. 225
11.3 Circularity test measurement ................................................ 231
11.4 Trace ................................................................................. 234
11.4.1 Trace overview .............................................................. 234
11.4.2 Servo trace ................................................................. 235
11.4.3 Drive trace ................................................................. 236
11.5 Further optimization options ................................................ 241

12 Drive optimization using SINUMERIK Operate ............................. 243
12.1 Automatic servo optimization .............................................. 243
12.2 Overview of navigation ........................................................ 244
12.3 Setting options ................................................................. 246
12.4 General operating sequences for automatic servo optimization . 248
12.5 Setting the user-specific strategy ......................................... 255
12.6 Additional optimization stages - commissioning interpolation axes . 256
Table of contents

13 Commissioning external drives .............................................................................................................. 257
  13.1 Introduction (PLC drive <-> NC drive) ......................................................................................... 257
  13.2 Commissioning PLC drives ......................................................................................................... 262
     13.2.1 Example configuration ........................................................................................................... 262
     13.2.2 Principle procedure when commissioning .............................................................................. 264
     13.2.3 PLC commissioning ............................................................................................................... 264
     13.2.4 Generate PLC user program ................................................................................................ 273
     13.2.5 Commissioning external drives ............................................................................................ 276
     13.2.6 Commissioning communication NCK<->Drive .................................................................. 278
  13.3 Configuring safety functions for external drives ........................................................................... 280
     13.3.1 Configuration with SIMATIC Manager under HW Config ...................................................... 280
     13.3.2 Embedding in safe programmable logic (SPL) based on the example of an SPL of
         SINUMERIK 840D sl ....................................................................................................................... 283
     13.3.3 Configuration of test cases with SinuCom NC SI-ATW that must go through an
         acceptance procedure ..................................................................................................................... 284
  13.4 Drive diagnostics ............................................................................................................................. 335

14 Data backup and standard commissioning ............................................................................................ 289
  14.1 Data backup ................................................................................................................................... 290
  14.2 User data backup/Series commissioning ...................................................................................... 291
  14.3 Preassignments when saving PLC data ....................................................................................... 292
  14.4 Series commissioning .................................................................................................................... 294

15 File functions ....................................................................................................................................... 297
  15.1 Introduction ................................................................................................................................... 297
  15.2 File functions for SINAMICS parameters .................................................................................... 298
     15.2.1 Overview ................................................................................................................................. 298
     15.2.2 Data backup of SINAMICS parameters ................................................................................. 298
     15.2.3 Loading/copying the SINAMICS parameter file ................................................................. 300
     15.2.4 Editing the SINAMICS parameter file .................................................................................... 302
  15.3 Copying data from one HMI to another ....................................................................................... 303
     15.3.1 Overview ................................................................................................................................. 303
     15.3.2 Copying machine data ............................................................................................................ 304
     15.3.3 Copying SINAMICS parameters ............................................................................................ 305

16 Tips for commissioning SINAMICS drives ......................................................................................... 309
  16.1 Changing topology (modular machine) ........................................................................................ 310
     16.1.1 Adding components ................................................................................................................. 311
     16.1.2 "Topology" > "Change..." menu ............................................................................................... 319
     16.1.2.1 Changing entry into topology ............................................................................................. 319
     16.1.2.2 Deleting drive objects ........................................................................................................... 321
     16.1.2.3 Deleting components ........................................................................................................... 322
     16.1.2.4 Enabling/disabling drive object .......................................................................................... 324
     16.1.2.5 Changing drive object/component names/numbers ............................................................ 326
     16.1.3 Replacing SINAMICS S120 components ............................................................................. 327
     16.1.4 Display options ......................................................................................................................... 330
     16.1.5 Sorting the topology display .................................................................................................... 332
     16.1.6 Check topology ........................................................................................................................ 334
  16.2 Drive diagnostics ............................................................................................................................... 335
| 16.3 | Diagnostics for pending alarms | 337 |
| 16.4 | Drive (SERVO) parameter RESET, individual | 338 |
| 16.5 | Firmware version display of drive components | 339 |
| 16.6 | Checking/setting power supply data settings | 341 |
| 16.7 | Identification/Optimization "ALM > Infeed/Configuration" | 342 |
| 16.8 | Configuring motor data sets | 343 |

**17 Licensing** ........................................................................................................................................ 351
- 17.1 Import licensing terms ................. ......................................................................................... 351
- 17.2 Overview ....................................................................................................................................... 352
- 17.3 Web License Manager ................................................................................................................. 353
- 17.4 Automation License Manager ....................................................................................................... 353
- 17.5 License database ............................................................................................................................ 353
- 17.6 CF Card and hardware serial numbers .......................................................................................... 355
- 17.7 SINUMERIK License Key ............................................................................................................... 356
- 17.8 Assigning via Web License Manager ............................................................................................ 356
- 17.8.1 You can execute an assignment via direct access as follows .................................................. 356
- 17.8.2 You can execute an assignment via customer login as follows ............................................... 358
- 17.9 Assigning via Automation License Manager .................................................................................. 360
- 17.9.1 Function Overview ..................................................................................................................... 360
- 17.9.2 Installing the Automation License Manager .................................................................................. 361
- 17.9.3 Enabling/disabling SINUMERIK plug-ins .................................................................................. 362
- 17.9.4 Assigning parameters to the TCP/IP communication with a control system ................................ 363
- 17.9.5 How to refresh the navigation view: "Manage" ........................................................................... 366
- 17.9.6 Displaying the license information of a piece of hardware ....................................................... 367
- 17.9.7 Creating a control image (offline) ............................................................................................... 368
- 17.9.8 Performing a license requirement alignment for a piece of hardware ..................................... 370
- 17.9.9 Transferring license information for a control image (offline) to a control system (online) ...... 372
- 17.10 Internet links .................................................................................................................................. 373

**18 Cycle protection** ................................................................................................................................... 375
- 18.1 Overview, cycle protection ............................................................................................................... 375
- 18.2 Sequence ........................................................................................................................................ 376
- 18.2.1 Overview, cycle protection sequence ......................................................................................... 376
- 18.2.2 Preprocessing .............................................................................................................................. 376
- 18.2.3 File extensions for encrypted cycles ............................................................................................ 377
- 18.2.4 Handling encrypted cycles in the control ................................................................................. 377
- 18.2.5 Subprogram calls without extension ......................................................................................... 378
- 18.2.6 Subprogram calls with extensions ............................................................................................. 378
- 18.2.7 NC language commands with absolute path data ...................................................................... 379
- 18.2.8 Actual block display .................................................................................................................... 379
- 18.2.9 Basic block display ....................................................................................................................... 379
- 18.2.10 Version display ........................................................................................................................... 379
- 18.2.11 Simulation .................................................................................................................................... 379
# Table of contents

18.3 General conditions .................................................................................................................. 380
18.4 Notes ........................................................................................................................................ 381

19 New installation/upgrading........................................................................................................ 383
  19.1 Classic................................................................................................................................... 383
  19.1.1 Introduction ....................................................................................................................... 383
  19.1.2 Installing “NCU Service System” on a USB-FlashDrive ..................................................... 384
  19.1.2.1 Installing “NCU Service System” on the USB-FlashDrive via DOS-Shell ..................... 384
  19.1.2.2 Installing “NCU Service System” on a USB-FlashDrive via RCS-Commander .......... 385
  19.1.3 New installation ................................................................................................................ 385
  19.1.3.1 Automatic installation of the CNC software using USB-FlashDrive ......................... 386
  19.1.3.2 Installation of the CNC software using USB-FlashDrive ............................................ 387
  19.1.3.3 Installation of the CNC software using WinSCP on PC/PG ......................................... 390
  19.1.3.4 Installation of the CNC software using VNC Viewer on PC/PG ................................. 391
  19.1.4 Upgrading ....................................................................................................................... 392
  19.1.4.1 Backup/Restore .............................................................................................................. 393
  19.1.4.2 Automatic upgrade of the CNC software using USB-FlashDrive ............................ 396
  19.1.4.3 Upgrading the CNC software using USB-FlashDrive .............................................. 397
  19.1.4.4 Upgrading the CNC software using WinSCP on PC/PG ........................................... 400
  19.1.4.5 Upgrading the CNC software using VNC Viewer on PC/PG .................................... 401
  19.2 With SinuCom Installer (SCI) ............................................................................................ 402
    19.2.1 Software preconditions and fundamentals on the content of this chapter “New installation/upgrade with SinuCom Installer” .................................................. 402
    19.2.2 Automatic new installation with SinuCom Installer (SCI) ............................................ 403
    19.2.3 Automatic upgrade with SinuCom Installer (SCI) ......................................................... 408

20 General tips .................................................................................................................................. 413
  20.1 Configuration of the properties of the network interface for PROFIBUS ................................ 413
  20.2 Separate NCK and PLC general reset ................................................................................. 416
    20.2.1 NCK general reset ........................................................................................................... 416
    20.2.2 PLC general reset ........................................................................................................... 416
  20.3 Configuring the communication between the PLC and the drive ..................................... 419
  20.4 Integrating PG/PC into the network (NetPro) .................................................................... 421
    20.4.1 Integrating PG/PC into NetPro ................................................................................. 422
    20.4.2 PG/PC interface configuration ................................................................................. 424
  20.5 Overview - Assignment of SINAMICS and NCK machine data for communication via PROFIBUS ........................................................................................................... 430
    20.5.1 Load GSD file (contains machine control panel) ......................................................... 436
    20.5.2 Configuration of the properties of the network interface for PROFIBUS .................. 436
    20.5.3 Adding a machine control panel and handwheel in HW Config. ............................... 439
    20.5.4 Modifying PROFIBUS machine control panel in OB100 .......................................... 442

21 Fundamentals ................................................................................................................................ 443
  21.1 Basic information on SINAMICS S120 ............................................................................... 443
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>21.1.1</td>
<td>Rules for wiring the DRIVE-CLiQ interface</td>
<td>443</td>
</tr>
<tr>
<td>21.1.2</td>
<td>Drive Objects (DO's) and Drive components</td>
<td>445</td>
</tr>
<tr>
<td>21.1.3</td>
<td>BICO interconnection</td>
<td>447</td>
</tr>
<tr>
<td>21.2</td>
<td>Transfer telegrams</td>
<td>448</td>
</tr>
<tr>
<td>21.2.1</td>
<td>Structure of the telegram with the process data for SINUMERIK 840D sl.</td>
<td>451</td>
</tr>
<tr>
<td>21.2.2</td>
<td>Process data for receiving and sending</td>
<td>452</td>
</tr>
<tr>
<td>21.3</td>
<td>Control- and status-word bits for NCK&lt;-&gt;drive communication</td>
<td>454</td>
</tr>
<tr>
<td>21.3.1</td>
<td>NCK to drive</td>
<td>454</td>
</tr>
<tr>
<td>21.3.2</td>
<td>Drive to NCK</td>
<td>457</td>
</tr>
<tr>
<td>21.4</td>
<td>PLC program</td>
<td>460</td>
</tr>
<tr>
<td>21.4.1</td>
<td>Fundamentals of creating a PLC user program</td>
<td>463</td>
</tr>
<tr>
<td>21.5</td>
<td>Machine and setting data</td>
<td>464</td>
</tr>
<tr>
<td>21.5.1</td>
<td>Machine data fundamentals</td>
<td>465</td>
</tr>
<tr>
<td>21.5.2</td>
<td>Handling the machine data</td>
<td>467</td>
</tr>
<tr>
<td>21.6</td>
<td>Protection levels</td>
<td>468</td>
</tr>
<tr>
<td>21.6.1</td>
<td>Protection level fundamentals</td>
<td>470</td>
</tr>
<tr>
<td>21.7</td>
<td>Axis data</td>
<td>471</td>
</tr>
<tr>
<td>21.7.1</td>
<td>Axis configuration</td>
<td>473</td>
</tr>
<tr>
<td>21.7.2</td>
<td>Axis assignment</td>
<td>476</td>
</tr>
<tr>
<td>21.7.3</td>
<td>Axis names</td>
<td>478</td>
</tr>
<tr>
<td>21.7.4</td>
<td>Setpoint/actual value channels</td>
<td>479</td>
</tr>
<tr>
<td>21.8</td>
<td>Spindle data</td>
<td>482</td>
</tr>
<tr>
<td>21.8.1</td>
<td>Spindle modes</td>
<td>483</td>
</tr>
<tr>
<td>21.8.2</td>
<td>Initial spindle state</td>
<td>483</td>
</tr>
<tr>
<td>21.8.3</td>
<td>General functionality</td>
<td>484</td>
</tr>
</tbody>
</table>

A Appendix .......................................................................................................................... 489
A.1 Abbreviations .................................................................................................................. 489
A.2 Overview .......................................................................................................................... 492

Glossary ..................................................................................................................................... 493

Index ......................................................................................................................................... 499
Introduction

1.1 Commissioning manuals for SINUMERIK 840D sl

Introduction

The commissioning manuals for SINUMERIK 840D sl are divided into:

- IBN CNC: NCK, PLC, drive
- Base software and HMI-Advanced
- Base software and operating software
- CNC: ShopMill
- CNC: ShopTurn

Basic steps for commissioning SINUMERIK 840D sl

Commissioning a SINUMERIK 840D sl is performed in 2 basic steps:

1. Step 1 (described in "IBN CNC: NCK, PLC, Drive")
   - PLC commissioning
   - Drive commissioning
   - NCK commissioning

2. Step 2 (described in "Base software and HMI-Advanced", "Base software and operating software", "CNC: ShopMill", "CNC: ShopTurn")
   - Commissioning functions in NCK/PLC

References

Commissioning overview

The following figure is a schematic representation of the commissioning steps that are described in the first step (1) and in step (2):

![Commissioning overview diagram]

Figure 1-1  Commissioning overview
1.2 Principle representation of SINUMERIK 840D sl components for commissioning

Introduction

In principle, an NCU 7x0 contains the following components:

- HMI
- NCK
- PLC
- Drive
- CP

The HMI contained in the NCU is designated as internal HMI or as HMI-Embedded/ShopMill/ShopTurn/SINUMERIK Operate.

In addition, a PCU 50.3 can be connected to each NCU, on which the HMI-Advanced then runs (additional optional ShopMill/ShopTurn, SINUMERIK Operate). This HMI is then designated as external HMI.

For commissioning, the HMI Advanced Software is required or the commissioning tool derived from it.

A PG/PC with SIMATIC STEP7 Version 5.5 is required to commission the PLC.

A network switch is required to connect several communication partners to plug X120.

Commissioning components for internal HMI's

Commissioning of an internal HMI requires a PG/PC. This PG/PC is connected via Ethernet to socket X120.

The internal HMI displays its user interface via TCU (Thin Client Unit), which is connected via the Ethernet machine control panel (e.g. MCP 310) to socket X120.

Commissioning components for external HMI's

External HMIs are connected to socket X120.

A PC/PG is required for commissioning of the PLC of the external HMI. This PG/PC is connected via Ethernet to socket X127.

Note

To use the external HMI (PCU 50.3) without TCU, the internal HMI must be switched off.
Commissioning NCU 7x0 with internal HMI

The following figure illustrates an example of a hardware and software arrangement for the commissioning of an NCU 7x0 with internal HMI.

Figure 1-2 Principle representation SINUMERIK 840D sl
Commissioning NCU 7x0 with external HMI

The following figure illustrates an example of a hardware and software arrangement for the commissioning of an NCU 7x0 with PCU 50.3 with external HMI.

Figure 1-3  Principle representation of SINUMERIK 840D sl with PCU 50.3
Schematic representation of the NCU 7x0

The following figure is a schematic representation of the NCU 7x0:

![Schematic representation of NCU 7x0](image-url)
1.3 Initial commissioning procedure

Introduction

The mechanical and electrical installation of the system must be completed.
The following is important when starting commissioning:
• The control with its components boots error-free.
• The EMC guidelines were carefully maintained when configuring the system.

Commissioning options depending on the CNC software on the CompactFlash Card

When commissioning the system for the first time, the following dependencies to the CNC software on the CompactFlash Card are considered:
• CompactFlash Card with the current CNC software.
• CompactFlash Card without CNC software.
• CompactFlash Card with older CNC software.

Commissioning steps

The commissioning steps depending on the CNC software on the CompactFlash Card are listed in the following table. The order is recommended but not mandatory:

<table>
<thead>
<tr>
<th>Commissioning steps</th>
<th>With current CNC software (First commissioning)</th>
<th>Without CNC software (Reinstallation and first commissioning)</th>
<th>With older CNC software (upgrade)</th>
<th>See chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install the CNC software on the CompactFlash Card using one of the following media:</td>
<td></td>
<td>1.</td>
<td>Automatic installation of the CNC software using USB-FlashDrive (Page 386)</td>
<td></td>
</tr>
<tr>
<td>• Bootable USB-FlashDrive</td>
<td></td>
<td></td>
<td>Installation of the CNC software using WinSCP on PC/PKG (Page 390)</td>
<td></td>
</tr>
<tr>
<td>• WinSCP on PC/PKG</td>
<td></td>
<td></td>
<td>Installation of the CNC software using VNC Viewer on PC/PKG (Page 391)</td>
<td></td>
</tr>
<tr>
<td>• VNC viewer on PC/PKG</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note: A USB-FlashDrive with installed &quot;NCU Service System&quot; is called a bootable USB-FlashDrive.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Archive the NCK, PLC, HMI and drive data</td>
<td></td>
<td>1.</td>
<td></td>
<td>Data backup (Page 290)</td>
</tr>
</tbody>
</table>
## Commissioning steps

<table>
<thead>
<tr>
<th>Commissioning steps</th>
<th>With current CNC software (First commissioning)</th>
<th>Without CNC software (Reinstallation and first commissioning)</th>
<th>With older CNC software (upgrade)</th>
<th>See chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrade the CNC software using one of the following media:</td>
<td></td>
<td></td>
<td>2. Automatic upgrade of the CNC software using USB-FlashDrive (Page 396)</td>
<td></td>
</tr>
<tr>
<td>- Bootable USB-FlashDrive</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- WinSCP on PC/PG</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- VNC viewer on PC/PG</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load archived NCK, PLC, HMI and drive data</td>
<td>1.</td>
<td>2.</td>
<td>3. NCK and PLC general reset (Page 43)</td>
<td></td>
</tr>
<tr>
<td>Boot the SINUMERIK 840D sl with NCK/PLC general reset</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Making a communication connection to the PLC</td>
<td>2.</td>
<td>3.</td>
<td>Setting up the communication (Page 48)</td>
<td></td>
</tr>
<tr>
<td>PLC commissioning</td>
<td></td>
<td>3.</td>
<td>4. Creating a SIMATIC S7 project (Page 49)</td>
<td></td>
</tr>
<tr>
<td>Commission the SINAMICS drive system</td>
<td>4.</td>
<td>5.</td>
<td>Commissioning integrated drives (NCU) (Page 59)</td>
<td></td>
</tr>
<tr>
<td>Commissioning communication NCK&lt;-&gt;Drive</td>
<td>5.</td>
<td>6.</td>
<td>Commissioning communication NCK&lt;-&gt;Drive (Page 113)</td>
<td></td>
</tr>
<tr>
<td>NCK commissioning</td>
<td>6.</td>
<td>7.</td>
<td>Overview Commissioning NCK (Page 121)</td>
<td></td>
</tr>
<tr>
<td>- Assigning NCK machine data for communication</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Scaling machine data</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Parameterizing axis data</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Parameterizing spindle data</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Parameterizing the measuring systems</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drive Optimization</td>
<td>7.</td>
<td>8.</td>
<td>Optimize the drive. (Page 215)</td>
<td></td>
</tr>
</tbody>
</table>

**See also**

New installation/upgrading (Page 383)
Safety information

2.1 Danger notices

The following notices are intended firstly for your personal safety and secondly to prevent damage occurring to the product described or any connected devices and machines. Non-observance of the warnings can result in severe personal injury or property damage.

<table>
<thead>
<tr>
<th>DANGER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only appropriately qualified personnel may commission/start-up SINUMERIK equipment. The personnel must take into account the information provided in the technical customer documentation for the product, and be familiar with and observe the specified danger and warning notices. When electrical equipment and motors are operated, the electrical circuits automatically conduct a dangerous voltage. When the system is operating, dangerous axis movements may occur throughout the entire work area. A potential fire hazard exists due to the energy being transferred in the equipment and the work materials used. All work on the electrical system must be performed after the system has been switched off and disconnected from the power supply.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DANGER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proper transportation, expert storage, installation and mounting, as well as careful operation and maintenance are essential for this SINUMERIK device to operate correctly and reliably. The details in the catalogs and proposals also apply to the design of special equipment versions. In addition to the danger and warning information provided in the technical customer documentation, the applicable national, local, and system-specific regulations and requirements must be taken into account. Only protective extra-low voltages (PELVs) that comply with EN 61800-5-1 can be connected to all connections and terminals between 0 and 48 V. Should it be necessary to test or take measurements on live equipment, then the specifications and procedural instructions defined in Accident Prevention Regulation BGV A2 must be adhered to, in particular § 8 &quot;Permissible deviations when working on live components&quot;. Suitable electric tools should be used.</td>
</tr>
</tbody>
</table>
Safety information

2.1 Danger notices

⚠️ WARNING

Power cables and signal lines should be installed in such a way that inductive and capacitive interference does not in any way impair the automation and safety functions.

⚠️ WARNING

Repairs to devices that have been supplied by our company may only be carried out by Siemens customer service or by repair centers authorized by Siemens. When replacing parts or components, only use those parts that are included in the spare parts list.

Before opening the device, always disconnect the power supply.

Emergency stop/off devices which comply with EN 60204 / IEC 60204 (VDE 0113-1) must remain effective in all automation equipment operating modes. The act of releasing the emergency stop/off device must not cause an uncontrolled or undefined hot restart.

Additional external measures must be taken, or devices must be created that enforce a safe operational state even when there is a fault (e.g. using independent limit value switches, mechanical locks, etc.) at any location in the automation equipment where faults might cause major material damage or even physical injury, in other words, where faults could be dangerous.
## 2.2 ESD notices

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>The modules contain electrostatically sensitive devices. Discharge yourself of electrostatic energy before touching the components. The easiest way to do this is to touch a conductive, grounded object immediately beforehand (for example, bare metal parts of control cabinet or the protective ground contact of a socket outlet).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Handling ESD-modules:</td>
</tr>
<tr>
<td>- When handling electrostatically sensitive devices, make sure that operator, workplace and packing material are properly grounded.</td>
</tr>
<tr>
<td>- Generally, electronic modules must not be touched unless work has to be carried out on them. When handling PCBs make absolutely sure that you do not touch component pins or printed conductors.</td>
</tr>
<tr>
<td>- Touch components only if:</td>
</tr>
<tr>
<td>- You are permanently grounded via an ESD armband</td>
</tr>
<tr>
<td>- You are wearing ESD shoes or ESD shoe-grounding-strips, if ESD flooring is available</td>
</tr>
<tr>
<td>- Modules may only be placed on electrically conductive surfaces (table with ESD top, conductive ESD foam plastic, ESD packaging bags, ESD transport containers).</td>
</tr>
<tr>
<td>- Keep modules away from visual display units, monitors or TV sets (minimum distance from screen 10 cm).</td>
</tr>
<tr>
<td>- Do not bring ESD-sensitive modules into contact with chargeable and highly-insulating materials, such as plastic, insulating table tops or clothing made of synthetic materials.</td>
</tr>
<tr>
<td>- Measurements on modules are allowed only if:</td>
</tr>
<tr>
<td>- The measuring instrument is properly earthed (e.g., protective conductor) or</td>
</tr>
<tr>
<td>- Before measuring with a floating measuring instrument, the probe is briefly discharged (e.g., touch the bare metal parts of the control housing).</td>
</tr>
</tbody>
</table>
3 Requirements for commissioning

3.1 General prerequisites

General

All components are dimensioned for defined mechanical, climatic and electrical environmental conditions. No limit value may be exceeded, neither during operation, nor during transportation.

Limit values

In particular, the following must be observed:

- Power supply conditions
- Pollution burden
- Function-impairing gases
- Ambient environmental conditions
- Storage/transport
- Shock stressing
- Vibration stressing
- Ambient temperature

Prerequisites for components involved

The complete system is connected mechanically and electrically, and has been verified in the following points:

- When handling the components, all ESD measures are observed.
- All screws are tightened with their prescribed torque.
- All connectors are plugged correctly and locked/screwed.
- All components are grounded and connected to shields.
- The load capacity of the central power supply is taken into account.
Requirements for commissioning

3.1 General prerequisites

Literature

- All information about the structure of SINAMICS S120 drive components are contained in: SINAMICS S120 Equipment Manual
- You can find all the instructions on how to connect the Ethernet interface here: Equipment Manual NCU
- To initialize an Ethernet, see also: HMI commissioning; TCU commissioning
3.2 Hardware and software preconditions

Preconditions

For the commissioning of SINUMERIK 840D sl, the following points are required:

- Hardware prerequisites
  - CompactFlash Card with CNC software for internal HMI, NCK, PLC and drive inserted in NCU
  - Dual ventilator fan/battery module (MLFB 6FC5348-0AA02-0AA0) to NCU (see following figure)

![Dual fan/battery module](image)

Figure 3-1 Dual fan/battery module

- Connection to NCU
  - Network switch or hub to socket X120
  - Ethernet connection of PG/PC to socket X120 or socket X127 when commissioning the HMI PLC external
  - Ethernet machine control panel to socket X120
  - Ethernet connection from TCU for internal HMI internal to Ethernet machine control panel or
  - Ethernet connection from PCU 50.3 for HMI external to Ethernet machine control panel

Note

Please dispose of used batteries in the specially provided collection points on site. This will ensure they are reused in the correct manner or treated as special waste.
3.2 Hardware and software preconditions

- Software prerequisites
  - SIMATIC STEP 7 Version 5.5 to PG/PC (SIMATIC Manager)
  - STEP7 package for NCU7x0 on PG/PC (Toolbox)
  - GSD file (Toolbox)
  - CompactFlash Card with CNC software for internal HMI, NCK, PLC and drive
  - External HMI on PCU 50.3 or commissioning tool on PG/PC for the commissioning of internal HMI

Note
The order numbers of the SINAMICS drives, motors and encoders should be at hand. These are used for parameterization.
3.3 Communication interfaces and terminal assignment

3.3.1 Communication interfaces

Introduction

The following diagrams show the interfaces on the NCU that can be used for communication with the components involved in the commissioning phase. They are:

- X120 Ethernet interface for TCU and/or PCU (a network switch or hub enables expansion)
- X130 Ethernet interface for factory network
- for PG/PC
  - currently X120 Ethernet interface, internal for HMI
  - X127 Ethernet interface, external for HMI (PLC commissioning)
- X126 PROFIBUS interface for machine control panel, for example

![Diagram of interfaces on the NCU 7x0.2 for commissioning]

Figure 3-2 Interfaces on the NCU 7x0.2 for commissioning
Requirements for commissioning

3.3 Communication interfaces and terminal assignment

Figure 3-3 Interfaces on the NCU 7x0.3 for commissioning

Network configuration characteristics

For the individual, participating components that are connected with the NCU, the following properties are available for the network configuration.

Table 3-1 Network configuration

<table>
<thead>
<tr>
<th>Component</th>
<th>socket</th>
<th>Which network?</th>
<th>IP address</th>
<th>Subnet ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCU/PCU 50.3 and currently PC/PG for commissioning of internal HMI</td>
<td>X120</td>
<td>Ethernet</td>
<td>192.168.214.1</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>Factory network</td>
<td>X130</td>
<td>Ethernet</td>
<td>Asssigned by DHCP server, for example 10.10.255.200</td>
<td></td>
</tr>
<tr>
<td>PG/PC for commissioning of PLC external HMI</td>
<td>X127</td>
<td>Ethernet</td>
<td>192.168.215.1 or DHCP Server</td>
<td>255.255.255.248</td>
</tr>
</tbody>
</table>
3.3.2 Terminal assignment of the digital inputs/outputs

3.3.2.1 NCU 7x0.2 and NCU 7x0.3

Terminal assignment according to the device configuration

With the SINAMICS device configuration (Page 73) the following terminals are preassigned:

- NCU 7x0.2
  - X122
  - X132
- NCU 7x0.3
  - X122
  - X132
  - X142

Note

The terminal assignments of the NCU 7x0.2 and NCU 7x0.3 are different.

When changing over from NCU 7x0.2 to NCU 7x0.3, the terminal wiring must be adapted.

See also SINUMERIK 840D sl NCU manual

For terminal blocks X122, X132 and X142 of the NCUs, the table lists the terminal assignments.

In the column "pre-assigned", the signals for which the HMI sets the associated SINAMICS parameters when configuring a SINAMICS device are marked with "x".

<table>
<thead>
<tr>
<th>NCU 7x0.2 Terminal</th>
<th>NCU 7x0.3 Terminal</th>
<th>Function</th>
<th>Signal</th>
<th>Pre-assigned</th>
</tr>
</thead>
<tbody>
<tr>
<td>X122.1</td>
<td>X122.1</td>
<td>DI 0</td>
<td>Input ON/OFF1 infeed (if one infeed with a DRIVE-CLiQ connection is operated at the NCU)</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Input infeed operation – &quot;infeed ready signal&quot; (if no infeed with DRIVE-CLiQ connection is operated at the NCU)</td>
<td>x</td>
</tr>
<tr>
<td>X122.2</td>
<td>X122.2</td>
<td>DI 1</td>
<td>Input 2. Operating condition OFF3 drives &quot;OFF3 – rapid stop&quot; Function: Braking with a configurable OFF3 ramp (p1135,1136,1137); thereafter, pulse suppression and starting lockout. The drive stops controlled. The braking response can be set separately for each servo.</td>
<td>x</td>
</tr>
</tbody>
</table>
### Requirements for commissioning

#### 3.3 Communication interfaces and terminal assignment

<table>
<thead>
<tr>
<th>NCU 7x0.2 Terminal</th>
<th>NCU 7x0.3 Terminal</th>
<th>Function</th>
<th>Signal</th>
<th>Pre-assigned</th>
</tr>
</thead>
<tbody>
<tr>
<td>X122.3</td>
<td>X122.3</td>
<td>DI 2</td>
<td>Selection safe standstill group 1 SH/SBC - Group 1 SINAMICS Safety Integrated (SH = p9601 release)</td>
<td>-</td>
</tr>
<tr>
<td>X122.4</td>
<td>X122.4</td>
<td>DI 3</td>
<td>Selection safe standstill group 2 SH/SBC - Group 2 SINAMICS Safety Integrated (SH = p9601 release)</td>
<td>-</td>
</tr>
<tr>
<td>-</td>
<td>X122.5</td>
<td>DI16</td>
<td>Freely available</td>
<td>-</td>
</tr>
<tr>
<td>-</td>
<td>X122.6</td>
<td>DI17</td>
<td>Freely available</td>
<td>-</td>
</tr>
<tr>
<td>X122.7</td>
<td>-</td>
<td>Ground for terminals 1...4</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>X122.8</td>
<td>Ground for terminals 5...12</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>X122.9</td>
<td>-</td>
<td>Ground for terminals 7, 8, 10, 11</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>X122.10</td>
<td>Ground for terminals 9, 10, 12, 13</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>X122.11</td>
<td>X122.12</td>
<td>DI/DO 8</td>
<td>Status safe standstill group 1 SH/SBC - Group 1 SINAMICS Safety Integrated</td>
<td>-</td>
</tr>
<tr>
<td>X122.13</td>
<td>X122.14</td>
<td>Input, external zero mark Bero 1 – &quot;equivalent zero mark&quot;</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>X122.15</td>
<td>X122.16</td>
<td>DI/DO 9</td>
<td>Status safe standstill group 2 SH/SBC - Group 2 SINAMICS Safety Integrated</td>
<td>-</td>
</tr>
<tr>
<td>-</td>
<td>X122.17</td>
<td>Ground for terminals 5...12</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>X122.18</td>
<td>Ground for terminals 7, 8, 10, 11</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>X122.19</td>
<td>X122.20</td>
<td>DI20</td>
<td>Freely available</td>
<td>-</td>
</tr>
<tr>
<td>X122.21</td>
<td>X122.22</td>
<td>DI21</td>
<td>Freely available</td>
<td>-</td>
</tr>
<tr>
<td>Terminal strip X132</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>X132.1</td>
<td>-</td>
<td>DI 4</td>
<td>Input $A_IN[1]$</td>
<td>x</td>
</tr>
<tr>
<td>-</td>
<td>X132.1</td>
<td>Freely available</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>X132.2</td>
<td>-</td>
<td>DI 5</td>
<td>Input $A_IN[2]$</td>
<td>x</td>
</tr>
<tr>
<td>-</td>
<td>X132.2</td>
<td>Freely available</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>X132.3</td>
<td>-</td>
<td>DI 6</td>
<td>Input $A_IN[3]$</td>
<td>x</td>
</tr>
<tr>
<td>-</td>
<td>X132.3</td>
<td>Freely available</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>X132.4</td>
<td>-</td>
<td>DI 7</td>
<td>Input $A_IN[4]$</td>
<td>x</td>
</tr>
<tr>
<td>X132.5</td>
<td>-</td>
<td>Freely available</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>X132.5</td>
<td>Freely available</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>X132.6</td>
<td>-</td>
<td>DI20</td>
<td>Freely available</td>
<td>-</td>
</tr>
<tr>
<td>X132.7</td>
<td>-</td>
<td>Freely available</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>X132.8</td>
<td>-</td>
<td>Freely available</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>X132.8</td>
<td>Ground for terminals 1...4</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>X132.9</td>
<td>Ground for terminals 5...12</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>X132.10</td>
<td>Ground for terminals 7, 8, 10, 11</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>X132.11</td>
<td>Ground for terminals 9, 10, 12, 13</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>X132.12</td>
<td>-</td>
<td>Ground for terminals 7, 8, 10, 11</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>X132.13</td>
<td>Ground for terminals 9, 10, 12, 13</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>X132.14</td>
<td>-</td>
<td>Ground for terminals 7, 8, 10, 11</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>X132.15</td>
<td>Ground for terminals 9, 10, 12, 13</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>X132.16</td>
<td>-</td>
<td>Ground for terminals 7, 8, 10, 11</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>X132.17</td>
<td>Ground for terminals 9, 10, 12, 13</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>
### Requirements for commissioning

#### 3.3 Communication interfaces and terminal assignment

<table>
<thead>
<tr>
<th>NCU 7x0.2 Terminal</th>
<th>NCU 7x0.3 Terminal</th>
<th>Function</th>
<th>Signal</th>
<th>Pre-assigned</th>
</tr>
</thead>
<tbody>
<tr>
<td>X132.7</td>
<td>-</td>
<td>Di/Do 12</td>
<td>Output $A_OUT[4]$</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>X132.9</td>
<td></td>
<td>Output: Infeed operation (if one infeed is operated with a DRIVE-CLiQ connection at the NCU)</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Input 2. Operating condition OFF2 drives</td>
<td>-</td>
</tr>
<tr>
<td>X132.8</td>
<td>-</td>
<td>Di/Do 13</td>
<td>Output $A_OUT[3]$</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>X132.10</td>
<td></td>
<td>Output: Status, infeed ready to start (if one infeed is operated at the NCU with a DRIVE-CLiQ connection)</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Input 2. Operating condition OFF2 drives</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Input, external zero mark 2</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Input probe 2 - central measurement</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Input probe 2 - distributed measurement</td>
<td>-</td>
</tr>
<tr>
<td>X132.9</td>
<td>-</td>
<td></td>
<td>Ground for terminals 7, 8, 10, 11</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>X132.11</td>
<td></td>
<td>Ground for terminals 9, 10, 12, 13</td>
<td></td>
</tr>
<tr>
<td></td>
<td>X132.12</td>
<td></td>
<td>Input 2. Operating condition OFF2 drives</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Input, external zero mark 3</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Input probe 2 - central measurement</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Input probe 2 - distributed measurement</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Infeed, control line contactor</td>
<td>-</td>
</tr>
<tr>
<td>X132.11</td>
<td>-</td>
<td>Di/Do 15</td>
<td>Output $A_OUT[1]$</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td>X132.13</td>
<td></td>
<td>Input 2. Operating condition OFF2 drives</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Input, external zero mark 4</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Input probe 2 - central measurement</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Input probe 2 - distributed measurement</td>
<td>-</td>
</tr>
<tr>
<td>X132.12</td>
<td>-</td>
<td></td>
<td>Ground for terminals 7, 8, 10, 11</td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>X132.14</td>
<td></td>
<td>Ground for terminals 9, 10, 12, 13</td>
<td></td>
</tr>
</tbody>
</table>

**Terminal strip X142**

<table>
<thead>
<tr>
<th>Terminal Strip</th>
<th>Function</th>
<th>Signal</th>
<th>Pre-assigned</th>
</tr>
</thead>
<tbody>
<tr>
<td>X142.3</td>
<td>IN/OUT 0</td>
<td>Input $A_IN[1]$</td>
<td>Fixed</td>
</tr>
<tr>
<td>X142.4</td>
<td>IN/OUT 1</td>
<td>Input $A_IN[2]$</td>
<td>Fixed</td>
</tr>
<tr>
<td>X142.5</td>
<td></td>
<td>Ground for terminals X142.3, 4, 6, 7, 9, 10, 12, 13</td>
<td></td>
</tr>
<tr>
<td>X142.6</td>
<td>IN/OUT 2</td>
<td>Input $A_IN[3]$</td>
<td>Fixed</td>
</tr>
<tr>
<td>X142.7</td>
<td>IN/OUT 3</td>
<td>Input $A_IN[4]$</td>
<td>Fixed</td>
</tr>
<tr>
<td>X142.8</td>
<td></td>
<td>Ground for terminals X142.3, 4, 6, 7, 9, 10, 12, 13</td>
<td></td>
</tr>
<tr>
<td>X142.9</td>
<td>IN/OUT 4</td>
<td>Output $A_OUT[1]$</td>
<td>Fixed</td>
</tr>
<tr>
<td>X142.10</td>
<td>IN/OUT 5</td>
<td>Output $A_OUT[2]$</td>
<td>Fixed</td>
</tr>
<tr>
<td>X142.11</td>
<td></td>
<td>Ground for terminals X142.3, 4, 6, 7, 9, 10, 12, 13</td>
<td></td>
</tr>
<tr>
<td>X142.12</td>
<td>IN/OUT 6</td>
<td>Output $A_OUT[3]$</td>
<td>Fixed</td>
</tr>
<tr>
<td>X142.13</td>
<td>IN/OUT 7</td>
<td>Output $A_OUT[4]$</td>
<td>Fixed</td>
</tr>
<tr>
<td>X142.14</td>
<td></td>
<td>Ground for terminals X142.3, 4, 6, 7, 9, 10, 12, 13</td>
<td></td>
</tr>
</tbody>
</table>
### 3.3.2.2 NX 1x.1 and NX 1x.3

**Terminal assignment according to the device configuration**

With the SINAMICS device configuration (Page 73), the following terminals are preassigned:

- **NX1x.1**
  - X122
- **NX 1x.3**
  - X122

For the X122 terminal strip of the the NXes, the table lists the assignments of the terminals.

In the column "pre-assigned", the signals for which the HMI sets the associated SINAMICS parameters when configuring a SINAMICS device are marked with "x".

<table>
<thead>
<tr>
<th>NX 1x.1 Terminal</th>
<th>NX 1x.3 Terminal</th>
<th>Function</th>
<th>Signal</th>
<th>Pre-assigned</th>
</tr>
</thead>
<tbody>
<tr>
<td>X122.1</td>
<td>X122.1</td>
<td>DI 0</td>
<td>Input ON/OFF1 infeed (if one infeed with a DRIVE-CLiQ connection is operated at the NX)</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Input infeed operation - &quot;infeed ready signal&quot; (if no infeed with DRIVE-CLiQ connection is operated at the NX)</td>
<td>x</td>
</tr>
<tr>
<td>X122.2</td>
<td>X122.2</td>
<td>DI 1</td>
<td>Input 2. Operating condition OFF3 drives</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Freely available (from SINAMICS 2.5 and higher)</td>
<td>x</td>
</tr>
<tr>
<td>X122.3</td>
<td>X122.3</td>
<td>DI 2</td>
<td>Selection safe standstill group 1 SH/SBC - Group 1 SINAMICS Safety Integrated (SH = p9601 release)</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Selection safe standstill group 2 SH/SBC - Group 2 SINAMICS Safety Integrated (SH = p9601 release)</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>X122.5</td>
<td></td>
<td>Ground for terminals 1...4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>X122.6</td>
<td></td>
<td>Ground for terminals 1...4?</td>
<td></td>
</tr>
<tr>
<td>X122.6</td>
<td></td>
<td></td>
<td>Ground for terminals 7, 8, 10, 11</td>
<td></td>
</tr>
<tr>
<td></td>
<td>X122.8</td>
<td></td>
<td>Ground for terminals 9, 10, 12, 13</td>
<td></td>
</tr>
<tr>
<td>X122.7</td>
<td>X122.9</td>
<td>DI/DO 8</td>
<td>Status safe standstill group 1 SH/SBC - Group 1 SINAMICS Safety Integrated</td>
<td>-</td>
</tr>
<tr>
<td>X122.8</td>
<td>X122.10</td>
<td>DI/DO 9</td>
<td>Status safe standstill group 2 SH/SBC - Group 2 SINAMICS Safety Integrated</td>
<td>-</td>
</tr>
<tr>
<td>X122.9</td>
<td></td>
<td></td>
<td>Ground for terminals 7, 8, 10, 11</td>
<td></td>
</tr>
<tr>
<td></td>
<td>X122.11</td>
<td></td>
<td>Ground for terminals 9, 10, 12, 13</td>
<td></td>
</tr>
<tr>
<td>X122.10</td>
<td>X122.12</td>
<td>DI/DO 10</td>
<td>Input, external zero mark Bero 1 – &quot;equivalent zero mark&quot;</td>
<td>-</td>
</tr>
</tbody>
</table>
3.3 Communication interfaces and terminal assignment

### 3.3.3 Support for terminal assignment at the HMI

Support for terminal assignment at the HMI

In the following menu you can perform terminal assignment for the drive units (NCU, NX) of the associated SINAMICS drive group.

- "Commissioning" > "Drive system" > "Drive units" > "Inputs/outputs" menu

![Figure 3-4 "Inputs/outputs" menu for terminal assignment](image)
3.4 Start-up tool on PG/PC

Precondition

If a SINUMERIK 840D sl (internal HMI), consisting of TCU, NCU 7x0 and SINAMICS S120 drive components is commissioned, you require the commissioning software "Start-up tool" on the PG/PC.

To commission a system with PG/PC using the start-up tool, the following preconditions apply:

- The start-up tool has been installed on the PG/PC and has been started.
- There is an Ethernet connection to NCU (currently X120).
- Since the standard Ethernet IP address is pre-assigned in the commissioning tool for X120 (192.168.214.1), there are no additional requirements.
- If another Ethernet interface is used, e.g. connected to socket X127, then this must be adapted accordingly in the start-up tool under "Commissioning" > "HMI" > "NCU connection" > "Standard address" (for example, 192.168.215.1 for socket X127).
Example configuration

Overview

The commissioning described in this manual orientates itself on an example configuration of the SINAMICS drive line-up.

The following figure roughly shows the components.
• An NCU 720 with:
  – A Single Motor Module for a motor with SMI (Sensor Module Integrated)
  – A Double Motor Module for two motors each with an SMC 20 (Sensor Module Cabinet)

• An NX 15 with:
  – A Single Motor Module for a motor with two SMC 20 for the encoder

• An infeed (Active Line Module)

Figure 4-1 Example configuration

References
For further available DRIVE-CLiQ components of the SINAMICS drive line-up, see Catalog NC 61, Edition 2007/2008, SINUMERIK & SINAMICS;
Order No.: E86060-K4461-A101-A2
Power on and boot up

5.1 Operating and display elements for run-up

Introduction

The diagram below shows the operating and display elements of the NCU, which are important for switch-on and boot of the SINUMERIK 840D sl:

- Various fault and status LEDs
- Status display (seven-segment display)
- RESET button
- NCK commissioning switch
- PLC mode selector switch
- CompactFlash slot
Power on and boot up

5.1 Operating and display elements for run-up

Figure 5-1 Operating and display elements for commissioning at the NCU 7x0.2 and NCU 7x0.3

Note
When you turn the start-up switch or operating mode switch, then the status display indicates the selected number/letters!
**LED display**

The following LED displays indicate the states at the NCU 7x0.2 and NCU 7x0.3:

Table 5-1  Fault and status display

<table>
<thead>
<tr>
<th>LED NCU 7x0.2</th>
<th>LED NCU 7x0.3</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>RDY (red)</td>
<td>RDY (red)</td>
<td>Watchdog (no NCK Ready)</td>
</tr>
<tr>
<td>RDY (yellow)</td>
<td>RDY (orange)</td>
<td>Write/read access to the CompactFlash Card</td>
</tr>
<tr>
<td>RDY (flashing red/orange (0.5 Hz))</td>
<td></td>
<td>Error when accessing the CompactFlash Card</td>
</tr>
<tr>
<td>RDY (flashing orange (0.5 Hz))</td>
<td></td>
<td>Updating the firmware of the connected DRIVE-CLiQ components</td>
</tr>
<tr>
<td>RDY (flashing orange (2 Hz))</td>
<td></td>
<td>Component firmware update has been completed. Wait for POWER ON for the components involved.</td>
</tr>
<tr>
<td>RDY (flashing green/orange or red/orange (1 Hz))</td>
<td></td>
<td>LED-based recognition of connected DRIVE-CLiQ component is activated: (p0124[0] = 1).</td>
</tr>
<tr>
<td>RDY (green)</td>
<td>RDY (green)</td>
<td>NCK has powered up and is in cyclic operation</td>
</tr>
<tr>
<td>RUN (green)</td>
<td>RUN (green)</td>
<td>PLC ready to operate</td>
</tr>
<tr>
<td>RUN (flashing green/orange or red/orange (1 Hz))</td>
<td></td>
<td>LED-based recognition of connected DRIVE-CLiQ component is activated: (p0124[0] = 1).</td>
</tr>
<tr>
<td>STOP (yellow)</td>
<td>STOP (orange)</td>
<td>PLC is in the stop state</td>
</tr>
<tr>
<td>SU/PF (yellow)</td>
<td>SU/PF (yellow)</td>
<td>PLC FORCE activated</td>
</tr>
<tr>
<td>SF (red)</td>
<td>SF (red)</td>
<td>General PLC error, see diagnostics buffer</td>
</tr>
<tr>
<td>DP1 (red)</td>
<td>DP (red)</td>
<td>Error on PROFIBUS (X126)</td>
</tr>
<tr>
<td>DP2 (red)</td>
<td>DP/MPI (red)</td>
<td>Error on PROFIBUS (X136)</td>
</tr>
<tr>
<td>PN (red)</td>
<td></td>
<td>PROFINET IO group error (X150)</td>
</tr>
</tbody>
</table>
| SY/MT (green) | | • Synchronization status (SY) of the on-board PROFINET IO interface (X150)  
• Maintenance status (MT) of the NCU (presently without function) |
| OPT (red) | | Error on option module |
| OPT (off) | | The PROFINET system is running error-free; data exchange to all configured IO devices runs. |
Power on and boot up

5.1 Operating and display elements for run-up

<table>
<thead>
<tr>
<th>LED NCU 7x0.2</th>
<th>LED NCU 7x0.3</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPT (red)</td>
<td>Bus fault (no physical connection)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Incorrect data transmission rate</td>
<td></td>
</tr>
<tr>
<td>OPT (red flashing (2 Hz))</td>
<td>Failure of a connected I/O device</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Incorrect or no configuration</td>
<td></td>
</tr>
<tr>
<td>All yellow</td>
<td>Power up not possible (CompactFlash Card not inserted or empty)</td>
<td></td>
</tr>
</tbody>
</table>

**NCK commissioning switch**

The following switch settings are assigned:

- 0 -> NCK in the operating mode
- 1 -> NCK in the initial clear mode (standard MD)
- 7 -> NCK is not started during run-up
- 8 -> Display IP address for the factory network at X130
  - Turn the NCK start-up switch to "8"
  - Trigger RESET.
  - The individual values of the IP address are displayed as individual digits with points to separate the individual values. The last digit does not have a point. The IP address is displayed again after a short delay. In this state, no NCK operation is possible.

**PLC mode selector switch**

The following switch settings are assigned:

- 0 -> NC in operating mode
- 1 -> NC in operating mode, protected
- 2 -> NC in operating mode
- 3 -> PLC general reset
5.2 NCK and PLC general reset

When commissioning the NCU for the first time, in order to achieve a defined initial state of the whole system, a general NCK and PLC reset must be performed. To do this, carry-out the following actions:

1. Turn the commissioning switch on the front of the NCU to the following positions (see Chapter "Operating and display elements for run-up (Page 39"):
   - NCK commissioning switch: Switch position "1"
   - PLC commissioning switch: Switch position "3"

2. Initiate a power on reset by switching-off the control and switching-on again – or by pressing the Reset button on the front of the NCU. The NCU is terminated and with the request for a general reset is restarted.
   Effect:
   - LED "STOP" flashes
   - LED "SF" is lit

3. Turn the PLC mode selector switch to position "2" and back again to position "3".
   Effect:
   - LED "STOP" first flashes with about 2Hz and then changes to a steady light
   - "RUN" LED is lit

4. After the LED "STOP" again has a steady light condition, turn the PLC mode selector back to position "0".
   Effect:
   - LED "STOP" goes dark

5. Turn the NCK mode selector switch back to the "0" position.

The NCU has now been generally reset and is in the following state:

- **NCK**
  - The user data have been deleted
  - The system data are initialized
  - The standard machine data are loaded

- **PLC**
  - The user data have been deleted (data and program blocks).
  - The system data blocks (SDB) have been deleted.
  - The buffered data have been written back to the RAM area.
  - The time of day and the operating hours counter have not been reset.
  - The diagnostics buffer and the MPI parameters are reset.
  - General reset puts the PLC in a defined initial state by deleting and initializing all system and user data.
**Power on and boot up**

### 5.2 NCK and PLC general reset

**Completion**

Then initiate a power on reset again by switching-off the control and switching-on again - or by pressing the Reset button on the front of the NCU.

After an error-free boot, the number "6" and a flashing point are output on the status display (7-segment display) on the front of the NCU. The "RUN" LED lights up. NCK and PLC are in cyclic operation.

**Note**

**PLC general reset**

If a general PLC reset is performed using a power on reset, then the user data must again be transferred to the PLC, e.g. via a programming device (PG).

If position "3" is selected for less than three seconds, no general reset is requested. Furthermore, the "STOP" LED remains unlit if the sequence "2" → "3" → "2" is not completed within 3 seconds after requesting a general reset.

**Note**

In the following cases, a general PLC reset must always be performed:

- Initial commissioning
- Module replacement
- Battery failure
- General reset request via the PLC
- Upgrading the PLC

**Note**

Since no PLC start is executed after PLC general reset, the following alarms are displayed:

- Alarm: "120201 Communication failed"
- Alarm: "380040 PROFIBUS DP: Configuring error 3, parameter"
- Alarm: "2001 PLC not booted"

These alarms have no influence on the next steps.

**See also**

- NCK general reset (Page 416)
- PLC general reset (Page 416)
5.3 Boot completed

Introduction

After an error-free boot of the NCU, it displays the following:

- Number "6" and a flashing point
- LED RUN illuminates GREEN continuously

Run-up has been completed.

In the following step, commissioning of the PLC is done with the SIMATIC Manager.
Power on and boot up

5.3 Boot completed
6.1 Start SIMATIC Manager

Introduction

SIMATIC Manager is a GUI for online/offline editing of S7 objects (projects, user programs, blocks, hardware stations and tools).

The SIMATIC Manager lets you
- manage projects and libraries,
- call STEP 7 tools,
- access the PLC online.

Start SIMATIC Manager

After installation, the SIMATIC Manager icon appears on the Windows desktop, and in the Start menu a "SIMATIC Manager" program item appears under "SiMATIC".

1. Run SIMATIC Manager by double-clicking the icon, or from the Start menu (same as with all other Windows applications).

User interface

A corresponding editing tool is started up when you open the relevant objects. The program editor starts by double-clicking on a program block. The block can be processed.

Online help

The online help for the active window is always called by pressing F1.
6.2 Setting up the communication

Introduction

To load the configuration into the PLC, the communications connection (Ethernet) from PG/PC to the PLC required for the loading must be secured.

Operating sequence for establishing a communications connection to the PLC

The communications connection to the PLC may be set from PG/PC via SIMATIC Manager with the following operating sequence:

1. Select menu command: "Extras" > "Set PG/PC interface..."
2. Under the "Access Mode" tab, look for the interface used in the "Interface parameterization used" selection field, for instance: "TCP/IP -> Realtek RTL8139/810x F..."
3. Confirm the parameterization with "OK".

Note

Parameterization of the PG/PC interface can be performed or changed from the SIMATIC Manager at any time.
7.1 Creating a SIMATIC S7 project

Introduction

It is necessary to create an S7 project for the basic commissioning of the PLC, the Ethernet and PROFIBUS communication as well as the input/output data areas of the NCK. To do this, perform the following steps:

- Create a project
- Insert a SIMATIC station 300
- Insert NCU 7x0 in HW Config
- Configure the properties of the network interfaces
- Insert machine control panel and hand wheel

Note

The toolbox must have been installed.

What do you need to be aware of?

Loading the PLC via network interface X130 is also possible if the IP address of the Ethernet interface is known.

Loading an archive may always be carried out if the communication HMI-NCK is available.

Note

Loading the PLC (CP840) is essential for the configuration of the data path for saving/restoring the drive data. See Section "Terminating hardware configuration and loading to PLC" (Page 61)

References

The PLC interface signals are described in "List Manual 2".
7.1 Creating a SIMATIC S7 project

7.1.1 Creating a project

Introduction

You have started the SIMATIC Manager.

Operating sequence

1. To create a new project, select the "File" > "New" menu command in the SIMATIC Manager.
2. Enter the following project data in the dialog box:
   – Name (for example: PLC-Erst-IBN 840D sl)
   – Storage location (path)
   – Type
3. Confirm the dialog with "OK".
   SIMATIC Manager is opened. The project window is displayed showing an empty S7 project structure.

7.1.2 Inserting a SIMATIC station 300

Introduction

Before you introduce required hardware to the S7 project, the following steps are needed:

- Insert a SIMATIC station 300 in the project
- Starting HW-Config
Operating sequence

1. Select <right mouse button> "Insert new object" > "SIMATIC 300-Station" menu.

2. Double-click on the symbol <SIMATIC 300 (1)>. 
3. Double-click on the symbol <Hardware>.
   The HW config for introducing required hardware is started.
4. In the menu, select "View" > "Catalog". The catalog with the modules is displayed (see following picture).

![HW-Config](image)

Figure 7-2  HW-Config

### 7.1.3 Insert NCU 7x0 in HW config

#### Introduction

The user interface of "HW Config" mostly displays (see the following figure):

- **Station window:**
  The station window is split. The upper part displays the structure of the station graphically, and the lower part provides a detailed view of the selected module.

- **Hardware catalog**
  In this catalog, the NCU 7X0 that you need for configuring the hardware is also included.

Use the operating sequence described below to insert an NCU 720.1 as an example.
Operating sequence

1. Select "View" > "Catalog".

2. Search for the module in the catalog under "SIMATIC 300" > "SINUMERIK" > "840D sl" > "NCU 720.1" (see following figure).

3. Select NCU 720.1 with the left mouse button, hold the mouse button down and drag to the "Station design" station window.

After you release the mouse button, configure in the dialog box the interface properties of processor CP 840D sl located on NCU 720.1 (see next chapter).

Figure 7-3 NCU 720.1 in the catalog
7.1.4 Configuring the properties of the network interfaces

**Introduction**

In the STEP7 project, configure the following network interfaces you want to use to reach the NCU 7X0:

- PROFIBUS DP, only with machine control panel for PROFIBUS (see PROFIBUS machine control panel on the HMI (Page 436))
- Ethernet
- integrated PROFIBUS

When creating a new project using the catalog, the configuration of the PROFIBUS interface is called automatically.

**PROFIBUS DP operating sequence**

1. You used the left mouse button to select NCU 720.1 and while holding down the mouse button you dragged it to the "Station design" station window.

2. After you release the mouse button, configure the properties of PROFIBUS DP interface for socket X126 (machine control panel) in the dialog box (see figure below).

![Figure 7-4 Properties of PROFIBUS DP](image)
3. This is an Ethernet machine control panel, which does not require configuration. Select "Cancel".

4. Module NCU 720.1 with SINAMICS S120 is inserted into the HW config (see figure below).

**Note**

With the <F4> key and confirmation of the question regarding "Reorganize", you can reorganize the display in the station window.

![Figure 7-5 HW config with NCU 720.1](image)

Next, specify the properties for the Ethernet interface.

**Operating sequence for Ethernet interface**

**Note**

Use socket X127 for commissioning of the PLC for the external HMI. No configuration of the Ethernet interface is required for this. This interface is set with IP address 192.168.215.1 as a default.
For the first commissioning of a HMI with a PG/PC, it is necessary to configure an Ethernet interface. In our example, this involves the interface to socket X120.

1. Double-click on "CP 840D sl" in the basic rack of the NCU 720.1. The dialog "Properties - Ethernet Interface CP 840D sl" is opened (see figure below).

![Figure 7-6 General properties of the CP 840D sl](image)

2. After clicking on the "Properties" button, a new Ethernet interface can be created.

![Figure 7-7 Properties of the Ethernet interface](image)

The interface for socket X120 is used to commission the internal HMI. You will have to change the IP address.

3. For socket X120, enter the IP address "192.168.214.1" and the Subnet screen form "255.255.255.0".
4. Create the Ethernet interface using "New" and then "OK".
5. Click on "OK" twice.
Next, specify the properties for the integrated PROFIBUS.

Operating sequence for integrated PROFIBUS
The integrated PROFIBUS for communication with the SINAMICS S120 requires a common Subnet ID. This Subnet ID has to be introduced to the external HMI in the MMC.ini.

1. In the station window, click on the bus of the integrated PROFIBUS "PROFIBUS Integrated: DP Master System" and use the right mouse button to select the menu item "Object properties".
2. Click on "Properties" on the "General" tab.
Enter the ID "0046-0010" in field "S7 Sub-network ID".

Telegram lengths and I/O addresses
The telegram lengths and input/output addresses for communication between the PLC and the drive (can be viewed via the object properties of the integrated SINAMICS) are pre-assigned by default and do not require any configuration.

As the next step insert a NX component.

See also
Configuring the communication between the PLC and the drive (Page 419)
7.1 Creating a SIMATIC S7 project

7.1.5 Insert NX in HW Config

Introduction

A NX component is contained in the example configuration, for the axis to control the spindle. This component must also be inserted in the HW Config when creating the SIMATIC-S7 project.

Operating sequence

1. Look for the NX module (NX10, NX15) in the hardware catalog under "PROFIBUS DP" > "SINAMICS" > "SINUMERIK NX...".

2. Click with the left mouse button to select the "SINUMERIK NX..." module and drag it to the "PROFIBUS Integrated DP master system" bus in the "Station design" station window.

3. The "DP Slave Properties" dialog box opens.

![Figure 7-9 DP Slave Properties for NX15](image)

Enter the address for the integrated PROFIBUS in this dialog.

The default value for the first NX15 is "15".

Note

The NX must be wired to the NCU via the DRIVE-CLiQ. A fixed DRIVE-CLiQ socket is provided for the relevant address.
The following table contains the wiring:

<table>
<thead>
<tr>
<th>Integrated PROFIBUS address</th>
<th>DRIVE-CLiQ Socket NCU720</th>
<th>DRIVE-CLiQ Socket NCU710</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>X100</td>
<td>X100</td>
</tr>
<tr>
<td>11</td>
<td>X101</td>
<td>X101</td>
</tr>
<tr>
<td>12</td>
<td>X102</td>
<td>X102</td>
</tr>
<tr>
<td>13</td>
<td>X103</td>
<td>X103</td>
</tr>
<tr>
<td>14</td>
<td>X104</td>
<td>-</td>
</tr>
<tr>
<td>15</td>
<td>X105</td>
<td>-</td>
</tr>
</tbody>
</table>

1. Enter the address and press "OK".

2. Confirm the wiring notification with "OK".
3. After releasing the mouse button, the NX module is added (see figure below).

![NX in HW Config](image)

**Figure 7-11 NX in HW Config**

**Note**

When deleting and re-inserting NX modules in the hardware config., new slot addresses are issued during addressing. In order to create a clear and transparent configuration that is always the same, we would recommend that addresses are allocated as shown in the following table:

<table>
<thead>
<tr>
<th>Integrated PROFIBUS address</th>
<th>DRIVE-CLiQ socket, e.g.: NCU720</th>
<th>Start address of first control slot</th>
<th>Start address of last control slot</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>X105</td>
<td>4340</td>
<td>4540</td>
</tr>
<tr>
<td>14</td>
<td>X104</td>
<td>4580</td>
<td>4780</td>
</tr>
<tr>
<td>13</td>
<td>X103</td>
<td>4820</td>
<td>5020</td>
</tr>
<tr>
<td>12</td>
<td>X102</td>
<td>5060</td>
<td>5260</td>
</tr>
<tr>
<td>11</td>
<td>X101</td>
<td>5300</td>
<td>5500</td>
</tr>
<tr>
<td>10</td>
<td>X100</td>
<td>5540</td>
<td>5740</td>
</tr>
</tbody>
</table>
7.1.6 End hardware configuration and load to the PLC

End hardware configuration and load to the PLC

To end the overall configuration and generate the system data for the PLC, the project must be saved and compiled.

1. Select the menu "Station" > "Save and compile".
2. Click on the button "Load in module", to load the configuration to the PLC.

The "Select target module" dialog mask automatically displays both configured communication partners (see figure below).

![Select Target Module](image)

3. Confirm with OK to load into these two modules.
4. Confirm the dialog boxes displayed subsequently with "OK" or "No" for the query "…Should the module be started now (restart)?".

**Note**

You can test the communication interface at "Target system > Diagnosis > Operating mode".

5. Close the "HW config" window.

The next step is to create the PLC program.
7.2 Creating a PLC program

Introduction
The operating sequence for the creation of a PLC program describe how to create a basic program.
The SIMATIC STEP7 documentation describes how to modify and extend an application program.

7.2.1 Insert PLC basic program

Introduction
You have performed hardware configuration, have saved and compiled the project ad have created the system data for the PLC.
You have installed the toolbox software, which also contains the libraries for the PLC basic program of an NCU 7x0.
You are on the main screen of the SIMATIC Manager.

Operating sequence to open library and copy sources, symbols and blocks
1. Select the "File" > "Open" menu and then click on the "Libraries" tab (see figure below).

![Opening the library](image)

Figure 7-13 Opening the library

2. Select the library of the basic PLC program, e.g. "bp7x0_44" and confirm the dialog with "OK".
You have inserted the library and selected the PLC program under "PLC-Erst-IBN 840D sl" > "SINUMERIK" > "PLC 317 2DP" > "S7 Program" (see figure below).

3. Copy the sources, modules and symbols to the PLC program

**Overwriting OB 1**

Inserting blocks overwrites the existing organization block OB1. Confirm the query as to whether you want to overwrite the block with "Yes".

You have now created the PLC basic program.

In the next section you will modify some of the data for the machine control panel in OB100.
7.2 Creating a PLC program

7.2.2 Modifying Ethernet machine control panel in OB100

Introduction

The PLC basic program automatically transfers the machine control panel signals (MCP signals) and the addresses of the MCP in the HW config if the configuration is set up as laid out below.

Operating sequence

- Under "Blocks", double-click on "OB100" to open it.

  In OB100, the parameters below have to be preset:

  MCPNum := 1
  MCP1IN := P#E 0.0
  MCP1OUT := P#E 0.0
  MCP1StatSend := P#E 8.0
  MCP1StatRec := P#E 12.0

  MCPBusAddress := 192
  MCPBusType = B#16#55

  You have completed the configuration of the PLC basic program.

  In the next step, you will load the project to the PLC.
7.3 Loading the project to the PLC

Introduction

For loading the configured PLC project, the following prerequisites must be fulfilled:

Precondition

- An Ethernet network connection exists between STEP7 and the PLC.
- The configuration to be loaded corresponds to the actual station configuration.
- NCU 7x0 is active
  - NCK is in cyclic mode
  - PLC in RUN or STOP mode

Supplementary condition

The following supplementary conditions regarding the system data blocks must be observed when the configuration is loaded:

- HW Config
  When loading the configuration via HW Config, only the system modules and their associated system data blocks selected in HW Config are loaded into the module. However, global data defined in SDB 210 is not loaded from the HW Config, for example. You have loaded the HW config to the module in the previous chapter "End hardware configuration and load to the PLC".

- SIMATIC Manager
  When loading the configuration via the SIMATIC manager all the system data blocks are loaded into the module.

Note

When the PLC program is loaded in the "RUN" mode, each block loaded becomes active immediately. This can result in inconsistencies when executing the active PLC program. It is therefore advised to place the PLC in the "STOP" mode before loading the configuration, if this has not already been done.
Operating sequence for loading system blocks into the module

1. To load the configuration of the system blocks change to the SIMATIC Manager.

2. In the SIMATIC Manager in the PLC directory, select the directory "Blocks" > right mouse button> "Target system" > "Load" (see figure below), or the "Load" symbol.

   ![Figure 7-15 Loading system blocks](image)

3. If there is no connection to the destination system, you must confirm in sequence the following dialog requests with:
   - "OK" for "Check the required sequence of blocks for correct functioning"
   - "Yes" for "Do you want to load system data?"
   - "Yes" for "Must system data be deleted on the module and replaced by off-line system data?"
   - "No" for "The module is in STOP mode. Do you want to start the module (cold restart)?"

You have loaded the PLC program to the PLC; the PLC is in "STOP" mode.

**Note**
If the PLC is stopped via the SIMATIC Manager, then it also has to be started via the SIMATIC Manager. Starting via the PLC mode selector is also possible.
7.4 Configuring an Ethernet machine control panel

Note
If you have an Ethernet machine control panel with Ethernet hand wheel, a "7" for "Ethernet" must be entered for the hand wheel in the general machine data MD11350[0] $MN_HANDWHEEL_SEGMENT.

7.5 First commissioning of the PLC completed

NOTICE
A reset (warm restart) of the NCK is required for the PLC-NCK synchronization.
See Chapter Triggering a reset (warm restart) for NCK and drive system. (Page 70)

The PLC and NCK are in the following state after a reset (warm restart):

- LED RUN illuminates GREEN continuously.
- Status display shows a "6" with a flashing point.
  ⇒ PLC and NCK are in cyclic operation.

You have completed the first commissioning of the PLC.
Continue with the steps for "Guided commissioning" of SINAMICS drives.
You start with Reset (warm restart) for the NCK and drive system.
7.5 First commissioning of the PLC completed
Commissioning integrated drives (NCU)

The closed-loop drive control for SINAMICS S120 is integrated in the NCU.

You have the following options when commissioning SINAMICS drives:

- Guided commissioning
  For "Guided commissioning", you are guided through the configuration / parameterization of the units, infeed(s) and drives (SERVOs).

  **Note**
  We recommended that "Guided commissioning" is used when commissioning a drive system for the first time.

  Additional commissioning steps are possible using "Manual commissioning".

- Manual commissioning
  For "Manual commissioning", you can select the steps of "Guided commissioning" in any sequence.

  You perform additional optional functions, which are not part of "Guided commissioning" (e.g. PROFIBUS connection).

  **Note**
  "Manually commissioning" is recommended for experienced commissioning engineers.
8.1 Guided commissioning of SINAMICS drives

8.1.1 Triggering a reset (warm restart) for NCK and drive system

Introduction

The HMI has booted. You are in the "Machine" operating area.

In the previous step before loading the project to the PLC (Page 65), this was brought into the stop state. The NCK interprets this STOP state, with corresponding alarm response, as failure of the PLC.
Alarm response

- Press the <MENU SELECT> key and select the menu "Diagnostics > Alarms" menu.

The system may display the following alarms on the HMI (see figure below):

![Figure 8-2 Diagnostics operating area](image)

A "reset" (warm restart) is required for the PLC-NCK synchronization.

**Operating sequence for initiating an NCK reset**

1. Press the <MENU SELECT> key and select the "Commissioning" menu.

![Figure 8-3 Setting the commissioning operating area without password](image)

2. Press "Password...".

3. Press "Set password".
4. Enter the manufacturer's password "SUNRISE".
5. Press "OK".

![Commissioning operating area password set](image)

6. Press the "Reset..." softkey.
7. Answer the question "Do you want to trigger a reset (warm restart) for the NCK and the entire drive system (all drive units)?" with the "Yes" softkey.

   The PLC goes to RUN mode.

   Guided commissioning of the SINAMICS drives is then started.

   Continue with the steps described in the following chapter.

See also

Drive diagnostics (Page 335)
8.1.2 Automatic device configuration

Operating sequence

You have set the password for manufacturer and initiated a reset (warm restart). During the warm restart, the HMI displays the following dialog box for several seconds.

Alarm "120 402:...First commissioning of SINAMICS required!" is displayed in the area for alarms.

![HMI screenshot showing commissioning process]

Note

When commissioning for the first time, wait until the complete drive system has powered-up!
1. After the complete drive system has powered-up, the HMI displays the following dialog box to automatically configure the devices:

![Screen capture showing automatic device configuration]

Figure 8-6 Query, automatic device configuration

2. Press "OK".

   Note:

   If you "Cancel", then you can manually perform the commissioning (see Chapter Manual commissioning of SINAMICS drives (Page 98)).

3. The individual steps for automatic device configuration are displayed one after the other in the following dialog box:

![Screen capture showing automatic device configuration steps]

Figure 8-7 Note, SINAMICS is commissioning the device
4. The following dialog box is displayed after the device has been configured:

![Image of NCK Power On Reset (warm restart)](image)

**Figure 8-8** NCK Power On Reset (warm restart)

5. Press "Yes".

The following notes are displayed during the NCK power on reset:
- "Wait for communication with NC"
- "Wait for communication to the drive"
- "Wait until communication is restored"

After the automatic device configuration, the HMI checks which infeeds and drives (SERVOs) still have to be parameterized/commissioned.

Commissioning guides you using the following dialog box to the individual drive objects that have still not been commissioned.

![Image of NCK power on reset completed](image)

**Figure 8-9** NCK power on reset completed

Continue with the steps to parameterize the infeed in the following chapter.

Press "Infeeds".
8.1.3 Parameterization of infeed

Introduction

You have pressed "Infeeds".

You are in the "Commissioning" > "Drive system" > "Infeeds" menu.

![Menu "Infeed" > "Configuration"

Figure 8-10  Menu "Infeed" > "Configuration"

Operating sequence

The system detects that the infeed has not been commissioned and that a commissioning is required (see above figure).

The commissioning is performed with the "Change" vertical softkey.
1. Press the vertical softkey "Change".

2. If required, assign a drive object name or accept the default settings.

3. Follow the drive wizard with the horizontal softkey "Next >".
4. The default values in the following dialogs are standard values and can be taken over with "Next >".

![Menu "Infeeds > "Configuration" with recognized ALM (Next 1)](image1)

![Menu "Infeed > "Configuration - additional data" (Next 2)](image2)
Figure 8-14 Menu "Infeed" > "Configuration - terminal wiring" (Next 3)

Figure 8-15 Menu "Infeed" > "Configuration - summary" (Next 4)

5. This completes the configuration for the infeed. You can check the configuration in the summary.
6. Press the "Finish >" softkey.

7. Press "Yes".

The data is saved as non-volatile data.
8. After commissioning the infeed, the HMI checks which drives (SERVOs) still have to be commissioned.

If the HMI finds a drive, then the following dialog box is displayed:

![Figure 8-17 Drive still not commissioned](image)

9. Press the "OK" softkey to continue with the steps to commission the drives (see Chapter Parameterization of the drives (Page 82)).

**Note**

The following block diagram of the infeed is displayed if
- "Cancel" was pressed
- When exclusively using motors with SMI, drives no longer have to be commissioned

![Figure 8-18 Menu "Infeed" > "Configuration" > "Finish"](image)
**8.1 Guided commissioning of SINAMICS drives**

---

**Note**

In this case, "Guided commissioning" ends here.

Using "Manual commissioning (Page 98)" you can now perform additional commissioning steps.

---

**See also**

Checking/setting power supply data settings (Page 341)

---

**8.1.4 Parameterization of the drives**

**Introduction**

The following components are parameterize/configured with the drive wizard:

- Motor
- Encoder
- Interface signals

**Parameterizing/configuring**

Guided commissioning navigates you through the commissioning of SINAMICS drives with motors without SMI (Sensor Module Integrated).

For motors without SMI, when parameterizing/configuring, a distinction is made between the following motor types:

- Catalog motors (standard motors, listed with associated motor data) (Page 83)
- Third-party motors (Page 90)

---

**Note**

Motors with SMI (DRIVE-CLiQ) are automatically configured by the drive unit during the device configuration with a drive data set (DDS), but only with the motor measuring system; i.e. motors with SMI only have to be configured with the drive wizard when more than one drive/motor data set (DDS/MDS) or a second (direct) measuring system is required.
8.1.4.1 Commissioning of listed motor and encoder via SMC

Introduction

In our example a power section is to be configured with a listed motor and encoder. You are in the "Commissioning" > "Drive system" > "Drives" menu:

![Figure 8-19 "Drives" > "Configuration" menu]

Operating sequence

1. The system detects that a drive object has not been commissioned and that a new commissioning is required (see above figure).
   
   The new commissioning is performed with the "Change" vertical softkey.

2. Press the vertical softkey "Change".

![Figure 8-20 Menu "Drives" > "Configuration - motor module" (Change)
3. The drive wizard identifies the power section (Motor module). You can assign a new drive object name or accept the default setting.

4. Follow the drive wizard with the horizontal softkey "Next >".

5. The following dialog boxes are displayed in succession for the configuration:

![Figure 8-21 Menu "Drives" > "Configuration - motor" (Next 1)](image1)

6. In this dialog box, select the "Select standard motor from list" button.

7. Select the motor with the "Cursor up / Cursor down" keys.

8. Press "Next >".

![Figure 8-22 Menu "Drives" > "Configuration - motor holding brake" (Next 2)](image2)

9. You can select brake control in the "Configuration - motor holding brake" dialog.

If a connected brake is detected during the unit configuration, the system will automatically activate the brake control and will by default display "Brake control according to procedural control" here.
10. Press "Next >".

![Diagram of Drive Configuration - Encoder](image)

Figure 8-23  Menu "Drives" > "Configuration - encoder" (Next 3)
11. Press "Next >".

An identification of the selected encoders is triggered (Encoder 1).

The drive unit can identify encoders with EnDat protocol. These encoders are selected in the encoder list in the follow-up dialog boxes ("Configuration - Encoder 1" menu).

The entry "No encoder" is selected in the encoder list for encoders that the drive unit cannot identify.

The encoder connected via SMC20 must be configured.
12. Select the motor encoder from the list: Select the encoder with the "Cursor up / Cursor down" keys.

**Note**

You can specify the following data using the "Details..." function:
- Inversion of the actual speed value
- Inversion of the actual position value
- External zero mark

Alternatively, the encoder system can be parameterized manually using the "Enter data" softkey.

13. Press "Enter data".

Configure the encoder in the following fields:
- Encoder type
- Incremental tracks
- Zero marks
- Synchronization

14. Press "OK".
15. Press "Next >".

![Image of menu configuration control type/setpoints]

16. Set the number of required drive data sets (DDS). The default setting is a drive data set.

17. You can change the settings for the control mode and the PROFIBUS telegram type.

The control mode and the PROFIBUS telegram are generally correctly pre-assigned by the drive wizards.

18. Press "Next >".

![Image of menu configuration BiCo interconnection]

19. You can select the 2nd operating condition input 2nd OFF2 (Page 31) (external input for pulse cancellation)
20. Press "Next >".

21. The configuration of the drive (SERVO) with listed motor is completed. You can check the configuration in the summary.

22. Press the "Finish >" softkey.

23. Confirm the query with "Yes".

24. The next section describes how you can configure a drive (SERVO) with a third-party motor and a second encoder.
8.1.4.2 Commissioning of third-party motor and additional second encoder via SMC

Introduction

In our example a power section is to be configured with third-party motor and encoder. You are in the "Commissioning" > "Drive system" > "Drives" menu:

1. The system detects that the drive object has not been commissioned and that a new commissioning is required (see above figure).

The new commissioning is performed with the "Change" vertical softkey.

2. Press the vertical softkey "Change".

3. The drive wizard identifies the power section (Motor module). You can assign a new drive object name or accept the default setting.
4. Follow the drive wizard with the horizontal softkey "Next >".

5. The following dialog boxes are displayed in succession for the configuration:

![Figure 8-33 Menu "Drives" > "Configuration - motor with externally supplied motor" (Next 1)]

6. Select "Enter motor data" and the motor type.

7. Press "Next >".

![Figure 8-34 Menu "Drives" > "Configuration - motor holding brake" (Next 2)]

8. You can select brake control in the "Configuration - motor holding brake" dialog.

   If a connected brake is detected during the unit configuration, the system will automatically activate the brake control and will by default display "Brake control according to procedural control" here.
9. Press "Next >".

10. Use the "Cursor Up/Cursor Down" keys to select the parameters that need to be changed from the list of motor data.

11. Enter the motor data.

12. Press "Next >". If you have activated "Replacement circuit diagram data" and you select "Next >", the following dialog will appear:

13. You can enter additional motor data.
14. Press "Next >".

If more than one encoder has been selected (see following figure), then the parameterization is run through for each individual encoder in succession with "Next >".

![Menu "Drives" > "Configuration - encoder" (Next 5)](image)

**Figure 8-37** Menu "Drives" > "Configuration - encoder" (Next 5)
15. Press "Next >".

An identification of the selected encoders is triggered (Encoder 1/2).

The drive unit can identify encoders with EnDat protocol. These encoders are selected in the encoder list in the follow-up dialog boxes ("Configuration - Encoder" menu).

Figure 8-38 Menu "Drives > Configuration" "Encoder 1" (Next 6)

The encoder has been identified.

**Note**

You can specify the following data using the "Details..." function:

- Inversion of the actual speed value
- Inversion of the actual position value
- External zero mark

Alternatively, the encoder system can be parameterized manually using the "Enter data" softkey.
16. Press "Next >".

The second encoder has been identified.

**Note**

If EnDat encoders are detected, no further encoder parameterization need be performed. Parameterizations for the pole position ID/synchronization can be found at "Enter data".

17. Press "Next >".

18. Set the number of required drive data sets (DDS). The default setting is a drive data set.

19. You can change the settings for the control mode and the PROFIBUS telegram type.

The control mode and the PROFIBUS telegram are generally correctly pre-assigned by the drive wizards.
20. Press "Next >".

21. You can select the 2nd operating condition input 2nd OFF2 (Page 31) (external input for pulse cancellation)

22. Press "Next >".

23. The configuration of the drive (SERVO) with third-party motor is completed. You can check the configuration in the summary.
24. Press the "Finish >" softkey.

![Figure 8-43 Menu "Drives > Configuration" ...save permanently..." (Finish)](image)

25. Confirm the query with "Yes".

![Figure 8-44 Menu "Drives > Configuration"](image)

**Note**

If the system identifies other drives, which have still not been commissioned, then you will still be guided to commission these.

Otherwise, this completes the first commissioning.
8.1.5 First commissioning of SINAMICS drive ended

First commissioning of SINAMICS drive completed

You have completed the first commissioning of the SINAMICS drives. The unit configuration and parameterization has been completed successfully:

- All upper LEDs of the drives (SERVOs) are GREEN.
- The lower LEDs of the drives (SERVOs) are always YELLOW.

Continue with the steps for commissioning the NCK (see chapter Commissioning communication NCK<->Drive (Page 113)).

8.2 Manual commissioning of SINAMICS drives

Note

"Manually commissioning" is recommended for experienced commissioning engineers.
8.2.1 Introduction to commissioning of SINAMICS drives

1. Press the <MENU SELECT> > "Commissioning".

   Figure 8-45 "Commissioning" menu

2. Press the "Drive system" softkey.

   Figure 8-46 Drive system has already been commissioned

Among others, you can manually perform the following functions to commission SINAMICS drives:

- Restoring factory settings (Page 100)
- Updating the component firmware (Page 103)
- Configuring/parameterizing the infeed and drives (SERVOs) (Page 111)
- Check and configure the PROFIBUS connection (Page 106)
8.2.2 Activate the factory settings

Introduction

If a commissioning has already been performed, then the drive system can be reset to the factory settings with the "Factory settings..." function.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before restoring the factory settings, ensure that the EP terminal (Enable Pulses) of the infeed (booksize: X21, chassis: X41) is de-energized.</td>
</tr>
</tbody>
</table>
Procedure for activating factory settings

1. You are in the "Commissioning" > "Drive system" menu.

2. Press the "Factory settings..." softkey.

Figure 8-47 "Commissioning > Drive system" menu

Figure 8-48 Question
3. Press "Drive system" to restore the factory settings for all drive units used in the system (the NCU and NX modules).

![Switch factory settings off/on](image)

Figure 8-49 Switch factory settings off/on

4. Switch the control (NCU and NX) off (de-energized drive system) and then on again.

Wait until communication has been established again with the NC.

![Query, automatic device configuration](image)

Figure 8-50 Query, automatic device configuration

A message appears that a first commissioning is required (Alarm 120402).

In the dialog box "...Should a device configuration be performed for all drive devices?" you have the following options:

- If you press "OK", then the "Guided commissioning" (Page 70) of the SINAMICS drives starts.
- If you press "Cancel", then you can perform the "Manual commissioning".
8.2.3 Updating the component firmware

Loading firmware update for SINAMICS V2.5 and higher

Note
SINAMICS V2.5 and higher
As of SINAMICS V2.5, an automatic firmware update is undertaken when powering up the drive system if required.
Manual updates for the individual components are not needed in such cases.
After powering up and when operating the control, the drive firmware can however always be loaded from the CompactFlash card.
You activate the "Load firmware ..." function from the "Commissioning > Drive system" menu.

Loading firmware update up to SINAMICS V2.4
Prior to initial startup, all SINAMICS components should have the same firmware version. The software required for this forms part of the SINAMICS software and is stored on the CompactFlash card. An update of individual components may become necessary, after component replacement for example, and is required if the drive-specific alarm A01006 "Firmware update required for DRIVE-CLiQ component <No.>" appears.

Note
If a firmware update is run before configuring the device, once this is complete continue with the "First commissioning of drive units (Page 106)" operating sequence.

Precondition
All components of the NCU/NX accessible (connected via DRIVE-CLiQ).

Note
The correct firmware update of the SINAMICS components is ONLY performed, if ALL were inserted in the switched-off state. Subsequently inserting components may ONLY be carried out in the switched-off state.
Operating sequence

1. You are in the "Commissioning" > "Drive system" > "Drive units" > "Configuration" menu.

2. Select the next drive module, the NCU or NX with the vertical softkey "Drive unit+/Drive unit-".

3. Press the vertical softkey "Load firmware ...".

4. The "Load all" softkey loads the firmware from the CompactFlash card to all DRIVE-CLiQ components of the drive unit (NCU or NX).

Note

Depending on the design of the SINAMICS drive group, a complete update of component firmware can take about 30 minutes.

The component, on which a firmware update is performed, is indicated by a flashing LED.

5. Answer the query "Must firmware from the CompactFlash card be loaded to the component?" with "Yes".

6. After the firmware update has been completed, the entire control (NCU, all NX and all DRIVE-CLiQ components (motor modules, encoder interfaces, etc.)) must be switched off (de-energized) and then switched on again so that the firmware update can take effect.

Follow the instructions displayed on the HMI after the firmware update has been completed.

You can now continue with the commissioning of the drive components (infeed, motor modules, encoders).
Loading firmware for the entire drive system

The "Commissioning" > "Drive system" menu contains the option for activating a complete component firmware update for the entire drive system.

**Note**

Depending on the design of the SINAMICS drive group, a complete update of component firmware can take about 30 minutes.

The component, on which a firmware update is performed, is indicated by a flashing LED.

---

**Figure 8-52  Load firmware using the "Commissioning" > "Drive system" menu**
8.2.4 Automatic device configuration

Introduction

The following unit configuration is performed during the first commissioning of the drive units:

- Transfer of the DRIVE-CLiQ topology to the drive unit
  With the transfer of the topology, all components connected on the DRIVE-CLiQ are detected and the drive-internal data traffic is initialized.
- Drive-object assignment for PROFIBUS connection.
  The PROFIBUS connection via the relevant message frames has been specified with the configuration in the HW Config.

Precondition

- The drive unit is in the first commissioning state.

Note the following:

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up to SINAMICS V2.5</td>
</tr>
<tr>
<td>It must be ensured that compatible firmware has been loaded on all components. If necessary, stop the operation and first load the firmware from the CompactFlash card to all components of the drive unit(s).</td>
</tr>
</tbody>
</table>

The operating sequence for loading the firmware is described in chapter "Update of the component firmware".

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>As of SINAMICS V2.5, an automatic firmware update is undertaken when powering up if required.</td>
</tr>
</tbody>
</table>
Operating sequence

1. Press the "Drive units" softkey in the "Commissioning" > "Drive system" menu.

![Figure 8-53 "Commissioning" > "Drive system" > "Drive units" menu](image)

You are reminded once again that the drive unit is in the first commissioning state and that a unit configuration must be performed for the drive system.

In the example for first commissioning it is assumed that compatible firmware has been loaded on all components.

2. Press the "Drive system" vertical softkey.

During the unit configuration there are a succession of messages containing information on the respective configuration of the individual drive components.

Depending on the size of the drive system, this can take several minutes.

Before the configuration is completed, the HMI displays the following query:

![Figure 8-54 Unit configuration, warm restart](image)
3. Press "Yes" to perform an NCK power on restart (warm restart).

The unit configuration for the drive units and drive components of the NCU has been completed.

If necessary check and correct the settings in the "PROFIBUS connection" dialog.

4. Press "OK".

This means that you continue commissioning in the actual dialog box "Drive system" > "Drive units" > "Configuration".

The associated components of the selected drive units are displayed in brackets (generally, the NCU).
5. Press "Drive unit +".

If you have selected the NX, then the components belonging to the NX are displayed.

Figure 8-57 NX unit configuration

If necessary you can correct and/or modify the settings in the "PROFIBUS connection" dialog.
6. Press "PROFIBUS connection" > "Change...".

![Figure 8-58 PROFIBUS NX connection](image)

![Figure 8-59 PROFIBUS NCU connection](image)

Check and, if required, correct the settings.

7. Press <RECALL>.
8.2.5 Commissioning using a drive wizard

Introduction

Drive configuration is done with a drive wizard on the HMI. The following drive components are to be configured:

- Active Line Module (infeed)
- Motor module, motor and encoders (drives)
Operating sequence for drive configuration

The drive configuration can be opened by selecting "Commissioning" > "Drive system" in the menu.

1. Press the corresponding softkey for the drive object to be configured.
   - "Infeeds"
   - "Drives" for drive controls (SERVO)

2. Configuration is performed in the following sequence:
   - You select the component with the vertical softkey "Infeed+/Infeed-" or "Drive+/Drive-"
   - Press the vertical softkey "Change" and follow the drive wizard with the horizontal softkey "Next >".
   - Parameterize the appropriate configuration in the dialog box that appears.

   The individual dialog boxes are listed in Chapter "Parameterization of infeed (Page 76)" and "Parameterization of the drives (Page 82)".

   **Note**
   If required, check the power (line supply) data using the vertical "Power data" softkey function.

See also

Checking/setting power supply data settings (Page 341)
Commissioning communication NCK<-->Drive

Introduction

The first commissioning of the PLC and SINAMICS drives is completed.

What will be configured next?

You will configure the NCK machine data, which communicates with the drive. These are:

- **General machine data**
  General machine data required for communication with the drive via PROFIBUS, which have been preset with default values. These values may be taken over during first commissioning. These are:
  - The message frame type for transfer
  - The logical addresses for the PLC

---

**Note**

**Up to software 1.5/2.5**

For an NX module, the logical address "6516" for the PLC must be entered in the general machine data MD13120[1] CONTROL_UNIT_LOGIC_ADDRESS.

- **Axis-specific machine data**
  The axis component for transfer of the setpoints and actual values for the relevant axis is set in the axis machine data.
Assigning general and axis-specific machine data

The following table illustrates using the example of an SINAMICS S120 module structure (one NCU (CU), one ALM, three motor modules (MM)) the assignment of the NCK machine data for input/output address/telegram/message frame/actual value:

<table>
<thead>
<tr>
<th>SINAMICS S120</th>
<th>STEP7 (HW Config) DP slave properties</th>
<th>NCK machine data General MD</th>
<th>NCK machine data Axis MD(2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component</td>
<td>Message frame type/length(1) I/O address(1)</td>
<td>MD13120[0] Control Unit I/O address(1)</td>
<td>MD13050 [0-5] Axis I/O address(1)</td>
</tr>
<tr>
<td>MM1</td>
<td>116. PZD-11/19 4100</td>
<td>4100</td>
<td>116</td>
</tr>
<tr>
<td>MM2</td>
<td>116. PZD-11/19 4140</td>
<td>4140</td>
<td>116</td>
</tr>
<tr>
<td>MM3</td>
<td>116. PZD-11/19 4180</td>
<td>4180</td>
<td>116</td>
</tr>
<tr>
<td>X (not available)</td>
<td>116. PZD-11/19 4220</td>
<td>4220</td>
<td>116</td>
</tr>
<tr>
<td>X (not available)</td>
<td>116. PZD-11/19 4260</td>
<td>4260</td>
<td>116</td>
</tr>
<tr>
<td>X (not available)</td>
<td>116. PZD-11/19 4300</td>
<td>4300</td>
<td>116</td>
</tr>
<tr>
<td>CU</td>
<td>391. PZD-3/7 6500</td>
<td>6500</td>
<td>6500</td>
</tr>
<tr>
<td>ALM</td>
<td>370. PZD-1/1 6514</td>
<td>6514</td>
<td>6514</td>
</tr>
</tbody>
</table>

1) Default value, do not change

2) The axis-specific machine data for configuring setpoints and actual values are pre-assigned using the "Assign axis" function (see section "Configuration of setpoint and actual value" (Page 116)).
9.1 Configuration input/output address and telegram

Introduction

The following general machine data are pre-assigned with a standard value for the PROFIBUS connection between the axes and drive (also see previous table).

- MD13050 $MN_DRIVE_LOGIC_ADDRESS (axis address)
- MD13060 $MN_DRIVE_TELEGRAM_TYPE (telegram type)
- MD13120 $MN_CONTROL_UNIT_LOGIC_ADDRESS (CU address)

Note

No adjustment is necessary here since these values correspond to those preassigned values in HW Config.

PROFIBUS connection

The connection between the relevant axes and drive via PROFIBUS can be viewed and sorted on the HMI in the "Commissioning" > "Drive system" > "Drive units" > "PROFIBUS connections" menu.

The following diagram shows an example of the connection between the relevant axes and drive for an NCU.

![PROFIBUS NCU connection diagram]

Figure 9-1 PROFIBUS NCU connection
9.2 Configuration setpoint/actual value

Introduction

The axis component for transfer of the setpoints and actual values for the relevant axis is set in the axis machine data. The following axis machine data is to be adjusted for each axis (also see previous table):

- MD30110 $MA_CTRLOUT_MODULE_NR (setpoint channel)
- MD30220 $MA_ENC_MODUL_NR (actual value channel)
- MD30130 $MA_CTRLOUT_TYPE (setpoint type of output)
- MD30240 $MA_ENC_TYPE (actual value sensing)

These axis/machine data can be automatically adapted using the "Assign axis" function or directly using the "Axis MD" function.
Operating sequence in the "Assign axis" menu

1. Select the "Commissioning" > "Drive system" > "Drives" menu.

   1. Select the "Commissioning" > "Drive system" > "Drives" menu.

   - Press the "Assign axis" horizontal softkey

   - Use "Drive +"/"Drive -"/"Direct selection" to select the corresponding servo.

2. Press the "Assign axis" horizontal softkey

   - Press the "Assign axis" horizontal softkey

   - Use "Drive +"/"Drive -"/"Direct selection" to select the corresponding servo.

3. Use "Drive +"/"Drive -"/"Direct selection" to select the corresponding servo.
Commissioning communication NCK<->Drive

9.2 Configuration setpoint/actual value

4. Press "Change".

5. Use the cursor keys to select the selection boxes for the setpoint or actual value.
6. Use the <INPUT> key to open the selection box.
7. Use the cursor keys to select the component.
8. Press "Transfer".

Operating sequence in the "Commissioning" > "Machine data" > "Axis MD" menu

1. Select the "Axis MD" softkey in the "Commissioning > Machine data" in the operating range.
2. Select the corresponding axis using "Axis+".
3. For the setpoint channel, search for MD30110 $MA_CTRLOUT_MODULE_NR.
4. Enter the drive number.
5. For the actual value channel, search for MD30220 $MA_ENC_MODUL_NR.
6. Enter the drive number.
7. For the setpoint type of output, search for MD30130 $MA_CTRLOUT_TYPE.
8. Enter "1".
9. For the actual value sensing, search for MD30240 $MA_ENC_TYPE.
10. Enter "1" for incremental encoder or "4" for absolute value encoder.
11. Select the next axis in each case with Axis+ and continue with Step 3 for the next drive.
9.3 Commissioning communication NCK<->Drive completed

Commissioning communication NCK<->PLC completed

You have commissioned the following in operation:

- PLC
- SINAMICS drives
- Communication NCK-PLC

The basic commissioning is completed. Now you can move the axes.

The next chapter, "Commissioning NCK", describes the parameterization of NCK regarding the connected machine by setting system variables.
9.3 Commissioning communication NCK<->Drive completed
10.1 Overview Commissioning NCK

Introduction
The parameterization of NCK regarding the connected machine occurs by setting system variables. These system variables are called:
- Machine data (MD)
- Setting data (SD).

See also
Machine and setting data (Page 464)
Preconditions, machine data (Page 211)

10.2 System data

10.2.1 Resolutions
The following types of resolution, e.g. resolution of linear and angular positions, velocities, accelerations and jerk, must be differentiated as follows:
- the input resolution, i.e. the input of data from the user interface or using the parts programs.
- the display resolution, i.e. the display of data on the user interface.
- the computational resolution, i.e. the internal representation of the data input through the user interface or the parts program.

Input and display resolution
The input and display resolution is specified via the control panel being used, whereby the display resolution of position values can be changed with MD9004 $MM_DISPLAY_RESOLUTION (display resolution).

MD9011 $MM_DISPLAY_RESOLUTION_INCH (INCH measuring system display resolution) can be used to configure the display resolution for position values with inch setting. This allows you to display up to six decimal places with the inch setting.
For the programming of parts programs, the input resolutions listed in the Programming Guide apply.

**Computational resolution**

The computational resolution defines the maximum number of effective decimal places for all data the physical unit of which is referred to a length or an angle, e.g. position values, velocities, tool offsets, zero offsets, etc.

The desired computational resolution is defined using the machine data

- MD10200 $MN_INT_INCR_PER_MM (computational resolution for linear positions)
- MD10210 $MN_INT_INCR_PER_DEG (computational resolution for angular positions).

The default assignment is:

- 1000 increments/mm
- 1000 increments/degrees

The computational resolution thus also determines the maximum achievable precision for positions and selected offsets. However, it is essential that the measuring system is adapted to this degree of precision.

**Note**

Although the computational resolution is generally independent of the input/display resolution, it should have at least the same resolution.

**Rounding**

The precision of angle and linear positions is limited to the computational resolution by rounding the product of the programmed value with the computational resolution to an integer number.

**Example of rounding:**

Computational resolution: 1000 increments/mm
Programmed path: 97.3786 mm
Effective value = 97.379 mm

**Note**

To keep rounding easily understandable, it is better to use powers of 10 for the computational resolution (100, 1000, 10,000).

**Display resolution**

In MD9004 $MM_DISPLAY_RESOLUTION (display resolution), you can set the number of decimal places after the decimal point for the position values on the operator panel.
Input and display limit values

Limitation of the input values depends on the display features and on the input options on the operator panel. The limit is ten digits plus comma and sign.

**Example of programming in the \(1/10\) μm range:**

All the linear axes of a machine are to be programmed and traversed within the range of values 0.1 to 1000 mm.

In order to position accurately to 0.1 μm, the computational resolution must be set to \(\geq 10^4\) incr./mm.

MD10200 $MN\_INT\_INCR\_PER\_MM = 10000$ [incr./mm]:

Example of related parts program:

N20 G0 X 10000 Y 10000
; Axes move to position X=10000 mm, Y=10000 mm

N25 G0 X 50002 Y 20003
; Axes move to position X=50002 mm, Y=20003 mm

Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Name of identifier</th>
<th>Name / remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>9004</td>
<td>DISPLAY_RESOLUTION</td>
<td>Display resolution</td>
</tr>
<tr>
<td>9011</td>
<td>DISPLAY_RESOLUTION_INCH</td>
<td>Display resolution for INCH system of measurement</td>
</tr>
<tr>
<td>10200</td>
<td>INT_INCR_PER_MM</td>
<td>Computational resolution for linear positions</td>
</tr>
<tr>
<td>10210</td>
<td>INT_INCR_PER_DEG</td>
<td>Computational resolution for angular positions</td>
</tr>
</tbody>
</table>

Literature

Function Manual Basic Functions; Velocities, traversing ranges, accuracy: Input/display resolution, computational resolution
10.2.2 Normalization of phys. units of machine data and setting data

Standard

Machine and setting data having a physical unit are interpreted in the input/output units listed in the table "Scaling physical units of machine and setting data" by default, depending on the scaling system (metric/inch).

The internally used units which the NC uses are independent and fixed.

<table>
<thead>
<tr>
<th>Physical unit</th>
<th>Input/output units for the standard basic system</th>
<th>Internally used unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear position</td>
<td>Metric: 1 mm</td>
<td>Inch: 1 inch</td>
</tr>
<tr>
<td></td>
<td>Metric: 1 degree</td>
<td>Inch: 1 degree</td>
</tr>
<tr>
<td>Linear velocity</td>
<td>Metric: 1 mm/min</td>
<td>Inch: 1 mm/s</td>
</tr>
<tr>
<td>Angular position</td>
<td>Metric: 1 degree</td>
<td>Inch: 1 degree</td>
</tr>
<tr>
<td>Angular velocity</td>
<td>Metric: 1 rpm/min</td>
<td>Inch: 1 rpm</td>
</tr>
<tr>
<td>Linear acceleration</td>
<td>Metric: 1 m/s²</td>
<td>Inch: 1 m²/s</td>
</tr>
<tr>
<td>Angular acceleration</td>
<td>Metric: 1 rev/s²</td>
<td>Inch: 1 rev/s²</td>
</tr>
<tr>
<td>Linear jerk</td>
<td>Metric: 1 m/s³</td>
<td>Inch: 1 m³/s</td>
</tr>
<tr>
<td>Angular jerk</td>
<td>Metric: 1 rev/s³</td>
<td>Inch: 1 rev/s³</td>
</tr>
<tr>
<td>Time</td>
<td>Metric: 1 sec</td>
<td>Inch: 1 sec</td>
</tr>
<tr>
<td>Position controller servo gain</td>
<td>Metric: 1 s⁻¹</td>
<td>Inch: 1 s⁻¹</td>
</tr>
<tr>
<td>Rev. feedrate</td>
<td>Metric: 1 mm/rev</td>
<td>Inch: 1 inch/rev</td>
</tr>
<tr>
<td>Compensation value linear position</td>
<td>Metric: 1 mm</td>
<td>Inch: 1 mm</td>
</tr>
<tr>
<td>Compensation value angular position</td>
<td>Metric: 1 degree</td>
<td>Inch: 1 degree</td>
</tr>
</tbody>
</table>

User-defined

The user can define different input/output units for machine and setting data.

For this purpose,

- MD10220 $MN_SCALING_USER_DEF_MASK (activation of standardizing factors) and
- MD10230 $MN_SCALING_FACTORS_USER_DEF[n] (standardizing factors of the physical quantities)

allow you to set the adaptation between the newly selected input/output units and the internal units.
The following applies:

*Input/output unit selected*=

MD10230 $MN_SCALING_FACTORS_USER_DEF[n] * internal unit

The selected I/O unit, expressed in the internal units 1 mm, 1 degree and 1 s must therefore be entered in MD10230 $MN_SCALING_FACTORS_USER_DEF[n].

<table>
<thead>
<tr>
<th>Physical unit</th>
<th>MD10220 bit number</th>
<th>MD10230 index n</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear position</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Angular position</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Linear velocity</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Angular velocity</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Linear acceleration</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Angular acceleration</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>Linear jerk</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>Angular jerk</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>Time</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>$K_v$ factor</td>
<td>9</td>
<td>9</td>
</tr>
<tr>
<td>Rev. feedrate</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>Compensation value linear position</td>
<td>11</td>
<td>11</td>
</tr>
<tr>
<td>Compensation value angular position</td>
<td>12</td>
<td>12</td>
</tr>
</tbody>
</table>

**Example 1:**

Machine data input/output of the linear velocities is to be in m/min instead of mm/min (initial state). The internal unit is mm/s.

MD10220 $MN_SCALING_USER_DEF_MASK Bit2 = 1 is used to enter the scaling factor for linear velocities as a user-defined value.
The scaling factor is calculated using the following formula:

\[
\text{MD10230 } \$\text{MN_SCALING\_FACTORS\_USER\_DEF}[n] = \frac{\text{Input/output unit selected}}{\text{Internal unit}}
\]

\[
\begin{align*}
\text{MD10230 } \$\text{MN_SCALING\_FACTORS\_USER\_DEF}[n] &= \frac{1 \text{ m/min}}{1 \text{ mm/s}} = \frac{1000 \text{ mm/min}}{60 \text{ s}} = \frac{1000}{60} = 16.667 \\
\rightarrow \text{MD10230 } \$\text{MN_SCALING\_FACTORS\_USER\_DEF}[2] &= 16.667
\end{align*}
\]

Index 2 specifies the "linear velocity" (see above).

**Example 2:**

In addition to the change in example 1, the machine data input/output of linear accelerations is to be performed in ft/s², instead of m/s² (initial state). (the internal unit is mm/s²).

\[
\begin{align*}
\text{MD10220 } \$\text{MN_SCALING\_USER\_DEF\_MASK} &= \text{.H14}; \text{ (bit no. 4 and bit no. 2) from example 1 as hex value} \\
\text{MD10230 } \$\text{MN_SCALING\_FACTORS\_USER\_DEF}[n] &= \frac{1 \text{ ft/s²}}{1 \text{ mm/s²}} = \frac{12 \times 25.4 \text{ mm/s²}}{1 \text{ mm/s²}} = \frac{1000}{60} = 304.8 \\
\rightarrow \text{MD10230 } \$\text{MN_SCALING\_FACTORS\_USER\_DEF}[4] &= 304.8
\end{align*}
\]

Index 4 specifies the "linear acceleration" (see above).
Machine data

Table 10- 4  Normalization of phys. units of machine data and setting data: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Name of identifier</th>
<th>Name / remarks</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>10220</td>
<td>SCALING_USER_DEF_MASK</td>
<td>Activation of scaling factors</td>
<td></td>
</tr>
<tr>
<td>10230</td>
<td>SCALING_FACTORS_USER_DEF[n]</td>
<td>Scaling factors of physical quantities</td>
<td></td>
</tr>
<tr>
<td>10240</td>
<td>SCALING_SYSTEM_IS_METRIC</td>
<td>Basic system metric</td>
<td></td>
</tr>
<tr>
<td>10250</td>
<td>SCALING_VALUE_INCH</td>
<td>Conversion factor for switchover to inch system</td>
<td></td>
</tr>
<tr>
<td>10260</td>
<td>CONVERT_SCALING_SYSTEM</td>
<td>Basic system switchover active</td>
<td></td>
</tr>
<tr>
<td>10270</td>
<td>POS_TAB_SCALING_SYSTEM</td>
<td>System of measurement of position tables T1</td>
<td></td>
</tr>
<tr>
<td>10290</td>
<td>CC_TDA_PARAM_UNIT</td>
<td>Physical units of the tool data for CC</td>
<td></td>
</tr>
<tr>
<td>10292</td>
<td>CC_TOA_PARAM_UNIT</td>
<td>Physical units of the tool edge data for CC</td>
<td></td>
</tr>
</tbody>
</table>
10.2.3 Modifying scaling machine data

The scaling of machine data having physical units is defined by the following machine data:

- MD10220 $MN_SCALING_USER_DEF_MASK (activation of standardizing factors)
- MD10230 $MN_SCALING_FACTORS_USER_DEF (standardizing factors of the physical quantities)
- MD10240 $MN_SCALING_SYSTEM IS_METRIC (basic system metric)
- MD10250 $MN_SCALING_VALUE INCH (conversion factor for switchover to INCH system)
- MD30300 $MA IS ROT AX (rotary axis)

When scaling machine data are modified, all machine data affected by this modification due to their physical unit are converted with the next NCK reset.

**Example:** Redefining an A1 axis from linear to rotary axis.

The control has been started up with default values. Axis A1 is declared as a linear axis.

- MD30300 $MA IS ROT AX[A1] = 0 (no rotary axis)
- MD32000 $MA MAX AX VELO [A1] = 1000 [mm/min] (max. axis velocity).

Axis A1 is now declared as a rotary axis containing the following machine data:

- MD30300 $MA IS ROT AX[A1] = 1 (rotary axis)
- MD32000 $MA MAX AX VELO [A1] = 1000 [mm/min] (max. axis velocity).

With the next NCK reset, the control system recognizes that axis A1 is defined as a rotary axis and standardizes MD32000 $MA MAX AX VELO to [rev./min] with reference to a rotary axis.

- MD30300 $MA IS ROT AX[A1] = 1 (rotary axis)
- MD32000 $MA MAX AX VELO [A1] = 2.778 [rev./min]

**Note**

If a scaling machine data item is altered, then the control outputs alarm “4070 Scaling data changed”.

**Modifying manually**

The following procedure is recommended when modifying scaling machine data manually:

1. Set all scaling machine data
2. Carry out NCK reset
3. Set all dependent machine data after the NC has powered up.
10.2.4 Loading default machine data

The default machine data can be loaded in different ways.

**HMI startup**

HMI startup via the HMI standard user interface: Operating area menu "Diagnostics" > "NC/PLC"

- Button: "Delete NCK Data"
- Button: "NCK RESET"

**NOTICE**

With deleting the NCK data, all user data are lost.

To avoid data loss, a series commissioning file should be created before the NCK data are deleted. The way to create a series machine start-up file is laid out in the Chapter "Creating a series machine start-up file".

**MD11200 $MN_INIT_MD**

Using the entry values listed below in MD11200 $MN_INIT_MD (loading the standard machine data for the "next" NC boot), you can load various data storage areas with default values at the next NC boot.

After setting the machine data, an NCK reset must be carried out:

1. NCK RESET: The machine data is activated.
2. NCK RESET: Depending on the entry value, the corresponding machine data is set to its standard values and the MD11200 $MN_INIT_MD is reset to value "0".

**Input values**

MD11200 $MN_INIT_MD = 1
At the next NC power-up, all machine data (with the exception of the memory configuring data) are overwritten with default values.

MD11200 $MN_INIT_MD = 2
At the next NC boot, all memory-configuring machine data are overwritten with default values.
10.2.5 Switching over the measuring system

The measuring system is switched over for the entire machine using a softkey in the "Machine" HMI-Advanced operating area. The switchover is only accepted if:

- MD10260 $MN_CONVERT_SCALING_SYSTEM=1.
- Bit 0 of MD20110 $MC_RESET_MODE_MASK is set in every channel.
- All channels are in the Reset state.
- Axes are not traversing with JOG, DRF or PLC control.
- Constant grinding wheel peripheral speed (GWPS) is not active.

Actions such as parts program start or mode change are disabled for the duration of the switchover.

If the switchover cannot be performed, this is indicated by a message in the user interface. These measures ensure that a consistent set of data is always used for a running program with reference to the system of measurement.

The actual switchover of the system of measurement is performed internally by writing all the necessary machine data and subsequently activating them with a Reset.

MD10240 $MN_SCALING_SYSTEM_IS_METRIC and the corresponding G70/G71/G700/G710 settings in MD20150 $MC_GCODE_RESET_VALUES are switched over automatically and consistently for all configured channels.

The value of machine data: MD20150 $MC_GCODE_RESET_VALUES[12] varies between G700 and G710.

This process takes place independently of the protection level currently set.

System data

When changing over the measuring system, from the view of the user, all length-related specifications are converted to the new measuring system automatically. This includes:

- Positions
- Feed rates
- Acceleration rates
- Jerk
- Tool offsets
- Programmable, settable and work offsets external and DRF offsets
- Compensation values
- Protection zones
- Machine data
- Jog and hand wheel factors

After switching, all above mentioned data is available in the physical units according to Chapter "Standardizing of physical units of machine and setting data".
Data for which no unique physical units are defined, such as:

- R parameters
- GUDs (Global User Data)
- LUDs (Local User Data)
- PUDs (Program global User Data)
- Analog inputs/outputs
- Data exchange via FC21

are not converted automatically. The user is prompted to take the current valid measuring system MD10240 $MN_SCALING_SYSTEM_IS_METRIC into consideration.

The current system of measurement setting can be read at the PLC interface via the "inch system" signal DB10.DBX107.7. DB10.DBB71 can be used to read out the "system of measurement change counter".

**Machine data**

Table 10- 5  Switching over the unit system: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Name of identifier</th>
<th>Name / remarks</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>General ($MN_ ... )</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10240</td>
<td>SCALING_SYSTEM_IS_METRIC</td>
<td>Basic system metric</td>
<td></td>
</tr>
<tr>
<td>10250</td>
<td>SCALING_VALUE_INCH</td>
<td>Conversion factor for switch-over to inch system</td>
<td></td>
</tr>
<tr>
<td>10260</td>
<td>CONVERT_SCALING_SYSTEM</td>
<td>Basic system switch-over active</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>axis spec. ($MA_ ... )</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>32711</td>
<td>CEC_SCALING_SYSTEM_METRIC</td>
<td>System of measurement of sag compensation</td>
<td>G2</td>
</tr>
</tbody>
</table>

**Literature**

Function Manual; speed, setpoint/actual-value systems, control: Metric/inch measuring system
10.2 System data

10.2.6 Traversing ranges

Computational resolution and traversing ranges

The range of values of the traversing ranges directly depends on the selected computational resolution (see Subsection "Resolutions" (Page 121)).

With the default assignment of the machine data for the computational resolution

- 1000 inc./mm
- 1000 inc./deg.

the following traversing ranges result:

<table>
<thead>
<tr>
<th>Traversing range in the metric system</th>
<th>Traversing range in the inch system</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear axes</td>
<td>± 999,999.999 [mm; deg.]</td>
</tr>
<tr>
<td>Rotary axes</td>
<td>± 999,999.999 [mm; deg.]</td>
</tr>
<tr>
<td>Interpolation parameters I, J, K</td>
<td>± 999,999.999 [mm; deg.]</td>
</tr>
</tbody>
</table>

10.2.7 Positioning accuracy of the control system

Computational resolution and traversing ranges

The positioning accuracy depends on:

- the computational accuracy (internal increments/(mm or degrees))
- the actual-value resolution (encoder increments/(mm or degrees)).

The rougher resolution of both determines the positioning accuracy of the NC.

The input resolution, the position control and interpolation clock do not affect the accuracy.

Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Name of identifier</th>
<th>Name / remarks</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>General ($MN_...$)</td>
<td>INT_INCR_PER_MM</td>
<td>Computational resolution for linear positions</td>
<td>G2</td>
</tr>
<tr>
<td></td>
<td>INT_INCR_PER_DEG</td>
<td>Computational resolution for angular positions</td>
<td>G2</td>
</tr>
<tr>
<td>Axis-specific ($MA_...$)</td>
<td>ENC_RESOL[n]</td>
<td>Encoder pulses per revolution</td>
<td></td>
</tr>
</tbody>
</table>
10.2.8 Cycle times

On the SINUMERIK 840D sl the system clock cycle, the position controller cycle, and the interpolation cycle of the NC are based on the DP cycle time configured in STEP 7 HW config. See Chapter "SIMATIC create S7 project".

System basic cycle

The system clock cycle is set fixed to the ratio of 1:1 with regard to the DP cycle time. The active value is displayed in the machine data MD10050 $MN_SYSCLK_CYCLE_TIME (system cycle). It cannot be changed.

Position controller cycle

The position controller cycle (MD10061 $MN_POSCTRL_CYCLE_TIME) is set to the fixed ratio 1:1 with respect to the system clock cycle. It cannot be changed.

Position control cycle offset

The position control cycle offset $T_M$ is automatically determined in the default setting (MD10062 $MN_POSCTRL_CYCLE_DELAY=0$).

The effective position controller offset is displayed in the MD10063[1].

The following values can be read out via the MD10063 $MN_POSCTRL_CYCLE_DIAGNOSIS:

- MD10063[0]= $T_{OX}$
- MD10063[1]= $T_M$
- MD10063[2]= $T_M + TLag_{max}$

The following conditions must be met for explicit specification of the position controller cycle offset (MD10062 $MN_POSCTRL_CYCLE_DELAY!=0$):
The cyclic communication with the DP slaves (drives) must be completed before the position controller is started.
Condition: \( T_M > T_{DX} \)

The position controller must be completed before the DP cycle/system clock is completed.
Condition: \( T_M + T_{Position\ control\ max} < T_{DP} \)

---

**Figure 10-1** Position control cycle offset compared to PROFIBUS DP cycle

**Key to Fig. above:**

- \( T_{Lag} \): CPU time required by position controller
- \( T_{DP} \): DP cycle time: DP cycle time
- \( T_{DX} \): Data Exchange Time: Total transfer time for all DP slaves
- \( T_M \): Master time: Offset of the start time for NCK position controller
- GC: Global Control: Broadcast message for cyclic convergence of the equidistance between DP master and DP slaves
- R: CPU time
- Dx: Useful data exchange between the DP master and DP slaves
- MSG: Acyclic services (e.g. DP/V1, pass token)
- RES: Reserve: "Active pause" until the isochronous (equidistant) cycle has expired

**Error response**

- Alarm: "380005 PROFIBUS DP: Bus access conflict, type t, counter z"
Cause of errors/error handling

- t = 1
  The position-control cycle offset selected is too small. The cyclic PROFIBUS communication with the drives was not yet completed with the start of the position controller.
  - Remedy: Increase the position-control cycle offset.

- t = 2
  The position-control cycle offset selected is too large. The cyclic PROFIBUS communication with the drives started before the position controller had finished. The position controller requires more CPU time than available within the DP cycle.
  - Remedy: Decrease the position-control cycle offset
  - Remedy: Increase the DP cycle time.
    The DP cycle time is set using STEP7 "HW-Config". See Chapter "SIMATIC create S7 project".

Interpolation cycle

The interpolator cycle may be chosen freely as a whole multiple of the position control cycle.

- MD10070 $MN_IPO_SYSCLK_TIME_RATIO (factor for the interpolation cycle)

Error response

- Alarm: "4240 CPU time overflow on the IPO or position controller level"

Cause of errors/error handling

The DP cycle time/position controller cycle, the interpolation cycle, or the NC CPU time share is set in such a way that not enough CPU time is available for one of the two cyclic levels of the NCK (position controller or interpolator).

Remedial action:
Calculate the maximum values for $T_{pos\ max}$ and $T_{IPO\ max}$ (see above) and adapt the following machine data:

- MD10185 $MN_NCK_PCOS_TIME_RATIO (CPU time share NCK)
- MD10070 $MN_IPO_SYSCLK_TIME_RATIO (factor for the interpolation cycle)
- MD10050 $MN_SYSCLK_CYCLE_TIME (system clock cycle)

Note

You must adjust the system clock cycle by changing the DP cycle time using STEP7 "HW-Config".
NCK start-up

10.2 System data

Literature

Function Manual Special Functions; Cycle times

Machine data

Table 10- 8 Cycle times: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name / remarks</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>10050</td>
<td>SYSCLOCK_CYCLE_TIME</td>
<td>System clock cycle/only display data; is always equal to the equidistant PROFIBUS DP cycle. Note: For SINUMERIK solution line for display only!</td>
<td></td>
</tr>
<tr>
<td>10060</td>
<td>POSCTRL_SYSCLOCK_TIME_RATIO</td>
<td>Factor for the position control cycle/is set fixed to the factor 1.</td>
<td></td>
</tr>
<tr>
<td>10061</td>
<td>POSCTRL_CYCLE_TIME</td>
<td>Position Controller cycle</td>
<td></td>
</tr>
<tr>
<td>10062</td>
<td>POSCTRL_CYCLE_DELAY</td>
<td>Position control cycle offset</td>
<td></td>
</tr>
<tr>
<td>10063</td>
<td>POSCTRL_CYCLE_DIAGNOSIS</td>
<td>[0] = DP cycle time [1] = Position controller cycle offset [2] = Position controller cycle offset + max. computation time needed by the position controller</td>
<td></td>
</tr>
<tr>
<td>10070</td>
<td>IPO_SYSCLOCK_TIME_RATIO</td>
<td>Factor for the interpolator cycle/can be freely selected in integer multiples.</td>
<td></td>
</tr>
<tr>
<td>10185</td>
<td>NCK_PCOS_TIME_RATIO</td>
<td>Computation time ratio NCK</td>
<td></td>
</tr>
</tbody>
</table>

⚠️ CAUTION

If you change the cycle times, check the behavior of the controller in all operating modes before you finish commissioning.

Note

The smaller the cycle times (PROFIBUS DP cycle) chosen, the greater the control quality for the drive and the better the surface quality on the workpiece.
10.2.9 NCK utilization

Introduction

You can view utilization of system resources for the NCK on the HMI under the menu "Diagnostics > Service displays > System resources".

The following machine data is taken into consideration for displayed runtimes (see Chapter Cycle times (Page 133)):

- MD1061 $MD_POSCTRL_CYCLE_TIME = MD10050 $MN_SYSCLOCK_CYCLE_TIME (System basic cycle)
- MD1070 $MD_IPO_SYSCLOCK_TIME_RATIO (factor for the interpolation cycle)
- MD1071 $MD_IPO_CYCLE_TIME (interpolation cycle)

What will be displayed?

In the display of the "System resources" menu, the values have the following meaning:

- Area "Net runtime (purely CPU time)"
  
  Active times (current, minimum and maximum) are displayed in the net values.
  
  The relation to the machine data can be seen from the displayed values.

- Area "Gross runtime (time from start to end)"
  
  The corresponding total utilization of the system (position controller + interpolator) is displayed, based on the net values.
• Line "NCU load by position controller and interpolator":

  Note
  The current, minimum and maximum utilization of the NCK is displayed.
  In order to have sufficient reserves for program processing, maximum utilization in reset condition when pressing the <Reset> key should be in the range of 60-65%.

• Line "Capacity of interpolator buffer":
  The capacity indicator MD28060 $MC_NUM_IPO_Buffer_SIZE is indicated in %.
  This display indicates whether batch preparation for batch processing can commence.
  Jerky processing in continuous-path mode, if for instance a number of short traversing blocks have been programmed in succession, is a typical indicator of the IPO buffer idling.
  Capacity indication is channel-specific.
10.2.10 Velocities

Max. axis velocity or spindle speed

The maximum possible axis velocities and spindle speeds depend on the machine design, drive dynamics and the encoder limit frequency of the individual drives.

Max. progr. tool path velocity

The maximum programmable tool path velocity results from the maximum axis velocities of the axes involved in the path programmed.

Max. tool path velocity

The maximum tool path velocity at which traversing is possible within a parts program block results as follows:

\[
V_{\text{max.}} = \frac{\text{Progr. path length in part program block [mm or degrees]}}{\text{Interpolation cycle [s]}}
\]

Upper limit

To guarantee that parts program blocks are executed continuously (control margin), the NC limits the tool path velocity within a parts program block to 90% of the max. possible tool path velocity as follows:

\[
V_{\text{max.}} \leq \frac{\text{Progr. path length in part program block [mm or degrees]}}{\text{Interpolation cycle [s]}} \times 0.9
\]

For example, in the case of parts programs generated by means of CAD system, which contain extremely short blocks, this limiting of the path velocity can result in a strong reduction of the path velocity over several parts program blocks.

The function "Online compressor" can help to avoid such sudden velocity dips.

Literature

Programming Manual Work Preparation: Compressor COMPON/COMPCURVE
Voltage limit

The minimum tool path or axis velocity at which traversing is possible results from:

\[
V_{\text{min}} \geq \frac{10^{-9}}{\text{comput. resolution}} \cdot \text{IPO cycle [s]}
\]

(for the computational resolution, see Chapter "Resolutions"

If \(V_{\text{min}}\) is not reached, no traversing movement is carried out.

Literature

Function Manual Basic Functions; Velocities, traversing ranges, accuracy: Velocities
10.3 Memory configuration

Introduction

On the SINUMERIK 840D sl, the persistent data are divided into various independent areas:

- SIEMENS
- Vendor
- Users

SRAM

For historical reasons, SRAM is still named as the memory medium at various points in relation to persistent data. For SINUMERIK solution line, this only applies insofar as SRAM is also sometimes used in the context of persistent data management. However, when a SINUMERIK solution line control system is in continuous operation, the data are physically stored in the much more powerful DRAM. Only when the control system is switched off are the data saved to a persistent data storage area. SRAM is also used for specific control systems.

Memory division

The figure below shows how NCK persistent data is divided:

Figure 10-3 Memory division
10.3 Memory configuration

<table>
<thead>
<tr>
<th>Legend</th>
<th>Description</th>
<th>User</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Part programs and OEM cycles can be set via MD 18352 $MN_U_FILE_MEM_SIZE</td>
<td>User</td>
</tr>
<tr>
<td>2</td>
<td>In addition to part programs and OEM cycles, can be set via MD 18353 $MN_M_FILE_MEM_SIZE</td>
<td>User</td>
</tr>
<tr>
<td>3</td>
<td>SIEMENS cycles</td>
<td>Siemens AG</td>
</tr>
<tr>
<td>4</td>
<td>Reserved</td>
<td>Siemens AG</td>
</tr>
<tr>
<td>5</td>
<td>RAM in NCK</td>
<td>User</td>
</tr>
<tr>
<td>6</td>
<td>RAM in NCK, contains the system and user data accessed by the NCK during program execution. Numbers for tools, frames, etc., are set by default.</td>
<td>User</td>
</tr>
<tr>
<td>7</td>
<td>Additional memory (optional)</td>
<td>Available to users as an option and can be used for RAM in NCK or for part programs and cycles.</td>
</tr>
</tbody>
</table>

Memory display

The memory available in the NCK is displayed on the user interface, e.g., HMI Advanced, under: Operating area "Commissioning" > "NC" > "NC memory".

See also

Import licensing terms (Page 351)
10.4 Parameter sets of axis/spindle

Per machine axis, six parameter sets are available. They are used as follows

- on an axis:
  for accommodation of the own dynamic response to another machine axis, e.g. when tapping or thread cutting on the relevant spindle.

- on a spindle:
  for accommodation of the position controller to modified properties of the machine during operation, e.g. when switching the gearbox.

Tapping, thread cutting

The following applies to axes:

- For a machine axis that is not involved in tapping or thread cutting, the 1st set of parameters (index=0) is active in all cases.
  The further parameter sets need not be considered.

- Machine axes involved in tapping or thread cutting: the parameter set is activated in accordance with the current gear stage.
  All parameter sets must be parameterized in accordance with the gear stages of the spindle.

The following applies to spindles:

- With spindles, each gear stage is assigned a parameter set of its own.
  For instance Gearbox step 1 - Parameter set 2 (Index 1). Spindles in axis operation (DB31, ... DBX60.0 = 0) use Parameter set 1 (Index 0).
  The active gearbox step can be read in the PLC via the signals DB31, ... DBX82.0-2 (Gearbox step setpoint). The parameter set is selected from the PLC using the interface signal DB31, ... DBX16.0 - 16.2 (actual gear stage).
  All parameter sets must be parameterized in accordance with the gear stages of the spindle.

For example, in HMI-Advanced, the active parameter set of a machine axis is displayed in the "Diagnosis" control area in the "Service axis" screen.

The active parameter set can be read in the PLC via the signals DB31, ... DBX69.0-2 (Controller parameter set).
10.4 Parameter sets of axis/spindle

<table>
<thead>
<tr>
<th>Parameter set no.</th>
<th>Axis interpolated with spindle (G33)</th>
<th>Spindle mode</th>
<th>Gear stage The spindle</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Standard</td>
<td>as specified by manufacturer input</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Axis interpolated with spindle (G33)</td>
<td>Spindle mode</td>
<td>1.</td>
</tr>
<tr>
<td>2</td>
<td>Axis interpolated with spindle (G33)</td>
<td>Spindle mode</td>
<td>2.</td>
</tr>
<tr>
<td>3</td>
<td>Axis interpolated with spindle (G33)</td>
<td>Spindle mode</td>
<td>3.</td>
</tr>
<tr>
<td>4</td>
<td>Axis interpolated with spindle (G33)</td>
<td>Spindle mode</td>
<td>4.</td>
</tr>
<tr>
<td>5</td>
<td>Axis interpolated with spindle (G33)</td>
<td>Spindle mode</td>
<td>5.</td>
</tr>
</tbody>
</table>

Figure 10.4  Validity of parameter sets for axis and spindle modes

**Remarks on the "Axis" column:** Switch-over applies to G33 as well as for G34, G35, G331 and G332.

**Machine data**

The following machine data of a machine axis depend on the parameter set:

\[ n = \text{parameter set number} \ (0 \ldots 5) \]

Table 10-9 Parameter-set-dependent machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>31050</td>
<td>DRIVE_AX_RATIO_DENOM[n]</td>
<td>Denominator load gearbox</td>
<td></td>
</tr>
<tr>
<td>31060</td>
<td>DRIVE_AX_RATIO_NUMERA[n]</td>
<td>Numerator load gearbox</td>
<td></td>
</tr>
<tr>
<td>32200</td>
<td>POSCTRL_GAIN [n]</td>
<td>( K_v ) factor</td>
<td></td>
</tr>
<tr>
<td>32810</td>
<td>EQUIV_SPEEDCTRL_TIME [n]</td>
<td>Equivalent time constant, of speed control loop for feed forward control</td>
<td></td>
</tr>
<tr>
<td>32910</td>
<td>DYN_MATCH_TIME [n]</td>
<td>Time constant for dynamic matching</td>
<td></td>
</tr>
<tr>
<td>35110</td>
<td>GEAR_STEP_MAX_VELO[n]</td>
<td>Maximum speed for gear change</td>
<td></td>
</tr>
<tr>
<td>35120</td>
<td>GEAR_STEP_MIN_VELO[n]</td>
<td>Minimum speed for gear change</td>
<td></td>
</tr>
<tr>
<td>35130</td>
<td>GEAR_STEP_MAX_VELO_LIMIT[n]</td>
<td>Maximum speed of gear stage</td>
<td></td>
</tr>
<tr>
<td>35140</td>
<td>GEAR_STEP_MIN_VELO_LIMIT[n]</td>
<td>Minimum speed of gear stage</td>
<td></td>
</tr>
<tr>
<td>35200</td>
<td>GEAR_STEP_SPEEDCTRL_ACCEL[n]</td>
<td>Acceleration in speed control mode</td>
<td></td>
</tr>
<tr>
<td>35210</td>
<td>GEAR_STEP_POSCTRL_ACCEL[n]</td>
<td>Acceleration in position control mode</td>
<td></td>
</tr>
<tr>
<td>36200</td>
<td>AX_VELO_LIMIT [n]</td>
<td>Threshold value for velocity monitoring</td>
<td></td>
</tr>
</tbody>
</table>
10.5 Parameterize axis data

Reference

See also

- Axis data (Page 471)
- Axis assignment (Page 476)
- Axis names (Page 478)

10.5.1 Incremental measuring system settings

Rotary measuring system

The diagrams below show the general possibilities of arranging a rotary incremental measuring system with regard to motor and load, as well as the resulting values for the appropriate machine data.

Figures equally apply to rotary axes, modulo axis and spindles.

**Linear axis with encoder on the machine**

![Diagram of linear axis with encoder on the machine]

Figure 10-5 Linear axis with encoder on motor
10.5 Parameterize axis data

Figure 10-6  Linear axis with sensor on load

Figure 10-7  Rotary axis with encoder on motor
Linear axis with encoder on the machine

![Diagram of linear axis with encoder on the machine]

Figure 10-8  Linear axis with encoder on the machine

### Machine data

**Table 10-10**  Incremental measuring systems: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name / remarks</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>30240</td>
<td>ENC_TYPE[n]</td>
<td>Actual value acquisition modes</td>
<td>1=incremental raw signal encoder</td>
</tr>
<tr>
<td>30242</td>
<td>ENC_IS_INDEPENDENT[n]</td>
<td>Encoder is independent</td>
<td></td>
</tr>
<tr>
<td>30300</td>
<td>IS_ROT_AX</td>
<td>Rotary axis</td>
<td>R2</td>
</tr>
<tr>
<td>31000</td>
<td>ENC_IS_LINEAR[n]</td>
<td>Direct measuring system (linear scale)</td>
<td></td>
</tr>
<tr>
<td>31020</td>
<td>ENC_RESOL[n]</td>
<td>Encoder pulses per revolution</td>
<td></td>
</tr>
<tr>
<td>31030</td>
<td>LEADSCREW_PITCH</td>
<td>Leadscrew pitch</td>
<td></td>
</tr>
<tr>
<td>31040</td>
<td>ENC_IS_DIRECT[n]</td>
<td>Encoder is connected directly to the machine</td>
<td></td>
</tr>
<tr>
<td>31050</td>
<td>DRIVE_AX_RATIO_DENOM[n]</td>
<td>Denominator load gearbox</td>
<td></td>
</tr>
<tr>
<td>31060</td>
<td>DRIVE_AX_RATIO_NUMERA[n]</td>
<td>Numerator load gearbox</td>
<td></td>
</tr>
<tr>
<td>31070</td>
<td>DRIVE_ENC_RATIO_DENOM[n]</td>
<td>Denominator of resolver gearbox</td>
<td></td>
</tr>
<tr>
<td>31080</td>
<td>DRIVE_ENC_RATIO_NUMERA[n]</td>
<td>Numerator of resolver gearbox</td>
<td></td>
</tr>
</tbody>
</table>

### Linear measuring system

The diagram below shows the general possibilities of arranging a linear incremental measuring system with regard to motor and load, as well as the resulting values for the respective machine data.
**Linear axis with linear scale**

![Diagram of linear axis with linear scale]

**Machine data**

Table 10-11  Linear measuring systems: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name / remarks</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis-specific ($MA_...$)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30240</td>
<td>ENC_TYPE[n]</td>
<td>Actual value acquisition modes</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1=incremental raw signal encoder</td>
<td></td>
</tr>
<tr>
<td>30242</td>
<td>ENC_IS_INDEPENDENT[n]</td>
<td>Encoder is independent</td>
<td></td>
</tr>
<tr>
<td>30300</td>
<td>IS_ROT_AX</td>
<td>Rotary axis</td>
<td>R2</td>
</tr>
<tr>
<td>31000</td>
<td>ENC_IS_LINEAR[n]</td>
<td>Direct measuring system (linear scale)</td>
<td></td>
</tr>
<tr>
<td>31010</td>
<td>ENC_GRID_POINT_DIST[n]</td>
<td>Distance between reference marks on linear scales</td>
<td></td>
</tr>
<tr>
<td>31030</td>
<td>LEADSCREW_PITCH</td>
<td>Leadscrew pitch</td>
<td></td>
</tr>
<tr>
<td>31040</td>
<td>ENC_IS_DIRECT[n]</td>
<td>Encoder is connected directly to the machine</td>
<td></td>
</tr>
<tr>
<td>31050</td>
<td>DRIVE_AX_RATIO_DENOM[n]</td>
<td>Denominator load gearbox</td>
<td></td>
</tr>
<tr>
<td>31060</td>
<td>DRIVE_AX_RATIO_NUMERA[n]</td>
<td>Numerator load gearbox</td>
<td></td>
</tr>
<tr>
<td>32110</td>
<td>ENC_FEEDBACK_POL[n]</td>
<td>Sign actual value (feedback polarity)</td>
<td></td>
</tr>
</tbody>
</table>

Figure 10-9  Linear axis with linear scale
10.5 Parameterize axis data

10.5.2 Parameterization of absolute measuring systems

Encoder types

The following encoder types are currently supported:

- Single-turn absolute value encoder
- Multi-turn absolute value encoder

with EnDat protocol and incremental sinusoidal encoder signals A and B, e.g. Haidenhain EQN 1325.

**EQN 1325**

The absolute value encoder EQN 1325 from Heidenhain has the following properties:

- EnDat protocol
- PPR count: $2048 = 2^{11}$ (encoder fine resolution)
- Positions/revolution: $8192$ (13 bits)
- Differentiable revolutions: $4096$ (12 bits)
- Encoder signals A/B: $1$Vpp sin/cos

Calibration

Convergence of the measuring system with the machine positions is performed by calibration of the absolute value encoder in absolute measuring systems. For calibration of the absolute value encoder, see Chapter "Axis homing" (Page 178).

**Linear axis with absolute value encoder on motor**

![Diagram](image)

**Figure 10-10 Linear axis with absolute value encoder on motor**
## 10.5 Parameterize axis data

### Rotary axis, modulo axis and spindle with absolute value sensor on motor

![Diagram of Rotary axis, modulo axis and spindle with absolute value sensor on motor](image)

Figure 10-11  Rotary axis, modulo axis and spindle with absolute value sensor on motor

### Machine data

#### Table 10-12  Measuring systems: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name / remarks</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>30240</td>
<td>ENC_TYPE[n]</td>
<td>Actual-value acquisition modes</td>
<td></td>
</tr>
<tr>
<td>30242</td>
<td>ENC_IS_INDEPENDENT[n]</td>
<td>Encoder is independent</td>
<td></td>
</tr>
<tr>
<td>30260</td>
<td>ABS_INC_RATION[n]</td>
<td>Encoder fine resolution (absolute value encoder)</td>
<td>R2</td>
</tr>
<tr>
<td>30300</td>
<td>IS_ROT_AX[n]</td>
<td>Rotary axis</td>
<td>R2</td>
</tr>
<tr>
<td>31000</td>
<td>ENC_IS_LINEAR[n]</td>
<td>Direct measuring system (linear scale)</td>
<td></td>
</tr>
<tr>
<td>31030</td>
<td>LEADSCREW_PITCH[n]</td>
<td>Leadscrew pitch</td>
<td></td>
</tr>
<tr>
<td>31040</td>
<td>ENC_IS_DIRECT[n]</td>
<td>Encoder is connected directly to the machine</td>
<td></td>
</tr>
<tr>
<td>31050</td>
<td>DRIVE_AX_RATIO_DENOM[n]</td>
<td>Denominator load gearbox</td>
<td></td>
</tr>
<tr>
<td>31060</td>
<td>DRIVE_AX_RATIO_NUMERA[n]</td>
<td>Numerator load gearbox</td>
<td></td>
</tr>
<tr>
<td>31070</td>
<td>DRIVE_ENC_RATIO_DENOM[n]</td>
<td>Measuring gearbox denominator</td>
<td></td>
</tr>
<tr>
<td>31080</td>
<td>DRIVE_ENC_RATIO_NUMERA[n]</td>
<td>Measuring gearbox numerator</td>
<td></td>
</tr>
<tr>
<td>34200</td>
<td>ENC_REFP_MODE[n]</td>
<td>Referencing mode</td>
<td>R2</td>
</tr>
<tr>
<td>34210</td>
<td>ENC_REFP_STATE[n]</td>
<td>Status of absolute value encoder</td>
<td></td>
</tr>
<tr>
<td>34220</td>
<td>ENC_ABS_TURNS_MODULO[n]</td>
<td>Absolute value encoder range for rotary encoders</td>
<td>R2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name / remarks</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ENC_REFP_MODE[n]</td>
<td>Referencing mode</td>
<td>R2</td>
</tr>
<tr>
<td></td>
<td>ENC_REFP_STATE[n]</td>
<td>Status of absolute value encoder</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ENC_ABS_TURNS_MODULO[n]</td>
<td>Absolute value encoder range for rotary encoders</td>
<td>R2</td>
</tr>
</tbody>
</table>
10.5.3 DSC (Dynamic Servo Control)

The DSC function eliminates the deadtime that necessarily exists at the speed-setpoint interface normally used between the NCK and drive due to relocation of the position controller into the drive.

This results in the following advantages for an axis operated with DSC:

- Considerably improved fault response/stability of the position control loop
- Improved command behavior (contour precision) if the loop gain ($K_v$ factor) that can be set higher in conjunction with DSC is used.
- A reduction of the cyclic communication load on the PROFIBUS, if the position controller cycle/PROFIBUS cycle is reduced by adjusting the above parameters, even if the control loop performance is the same.

Note

The speed feedforward control can be used in conjunction with DSC.

Requirements

Before you can activate DSC mode, the following preconditions must be fulfilled:

- DSC-capable drive
- A DSC-capable message frame type has been parameterized in the S7 project for the drive.

Switch ON/OFF

The DSC function is switched on via the following axis-specific NCK machine data:

- MD32640 $MA_STIFFNESS_CONTROL_ENABLE (dyn. Stiffness control)

If DSC operation is switched ON or OFF, it might be necessary to adjust the following machine data:

- MD32200 $MA_POSCRTL_GAIN (servo gain factor)
- MD32610 $MA_VELO_FFW_WEIGHT (feedforward control factor)
- MD32810 $MA_EQUIV_SPEEDCTRL_TIME (substitute time const. of the closed speed control loop)

NOTICE

Before you can switch off DSC operation you might have to adapt (reduce) the $K_v$ factor of the axis. Otherwise, instability of the position control loop might result.
Actual value inversion during DSC operation

Note
Actual value inversion during DSC operation (MD32640=1) is undertaken as follows:

- Set the p0410 parameter (encoder inversion actual value) in the drive.
- In the NC in the machine data, set MD32110 $MA_ENC_FEEDBACK_POL = 0 or 1 (no inversion!).

Actual value inversion via MD32110=-1 is not possible during activated DSC operation.
If MD32110=-1 is to be set, the "26017 axis%1 machine data 32110 value not permitted" alarm is output when DSC operation is activated.

Speed setpoint filter
If you use DSC, a speed setpoint filter for rounding the speed setpoint steps is no longer necessary. The speed setpoint filter is then only of any use with differential connection to support the position controller, for example, to suppress resonance.

Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>32640</td>
<td>STIFFNESS_CONTROL_ENABLE</td>
<td>Dyn. stiffness control</td>
<td>DD2</td>
</tr>
<tr>
<td>32200</td>
<td>POSCRTL_GAIN</td>
<td>Kv factor</td>
<td>G2</td>
</tr>
<tr>
<td>32642</td>
<td>STIFFNESS_CONTROL_CONFIG</td>
<td>The dynamic stiffness control is configured. 0-&gt;standard case: DSC in drive operates with indirect measuring system 1-&gt;DSC in the drive operates using direct measuring system</td>
<td>DD2</td>
</tr>
</tbody>
</table>
10.5 Parameterize axis data

10.5.4 Rotary axes

Rotary axes

A machine axis is parameterized as a rotary axis in

- **MD30300** $MA_IS_ROT_AX (rotary axis) = 1

The machine data is a scaling machine data. A change results in a conversion of all machine data of the machine axis with length-related units.

For the recommended procedure with respect to scaling machine data, please refer to Subsection "Modifying Scaling Machine Data".

Modulo display

The display of the rotary axis position modulo 360 degrees is displayed via the following machine data:

- **MD30320** $MA_DISPLAY_IS_MODULO (modulo 360 degrees display for rotary axes)

Endlessly rotating rotary axis/modulo axis

The traversing of the rotary axis modulo 360 degrees is displayed via the following machine data:

- **MD30310** $MA_ROT_IS_MODULO (modulo conversion for rotary axis)

  The limit switches are not monitored during this process. The rotary axis can thus rotate endlessly.

  The limit switch monitoring can be activated by the PLC interface.

Machine data

Table 10-14 Rotary axes: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>general  ($MN_ ...)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10210</td>
<td>INT_INCR_PER_DEG</td>
<td>Computational resolution for angular positions</td>
<td>G2</td>
</tr>
<tr>
<td>Axis-specific ($MA_ ...)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30300</td>
<td>IS_ROT_AX</td>
<td>Axis is rotary axis</td>
<td></td>
</tr>
<tr>
<td>30310</td>
<td>ROT_IS_MODULO</td>
<td>Modulo conversion for rotary axis</td>
<td></td>
</tr>
<tr>
<td>30320</td>
<td>DISPLAY_IS_MODULO</td>
<td>Actual value display modulo</td>
<td></td>
</tr>
<tr>
<td>36100</td>
<td>POS_LIMIT_MINUS</td>
<td>Minus software limit switch</td>
<td>A3</td>
</tr>
<tr>
<td>36110</td>
<td>POS_LIMIT_PLUS</td>
<td>Plus software limit switch</td>
<td>A3</td>
</tr>
</tbody>
</table>
10.5 Parameterize axis data

Setting data

Table 10-15  Rotary axes: Setting data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>General ($SN_ ... )</td>
<td></td>
<td></td>
</tr>
<tr>
<td>41130</td>
<td>JOG_ROT_AX_SET_VEL0</td>
<td>JOG speed for rotary axes</td>
<td>H1</td>
</tr>
<tr>
<td></td>
<td>Axis-specific ($SA_ ... )</td>
<td></td>
<td></td>
</tr>
<tr>
<td>43430</td>
<td>WORKAREA_LIMIT_MINUS</td>
<td>Working area limitation minus</td>
<td>A3</td>
</tr>
<tr>
<td>43420</td>
<td>WORKAREA_LIMIT_PLUS</td>
<td>Working area limitation plus</td>
<td>A3</td>
</tr>
</tbody>
</table>

Literature

Function Manual Expanded Functions; Rotary axes
10.5 Parameterize axis data

10.5.5 Positioning axes

Positioning axes are channel axes traversing parallel to the path axes without interpolating with them.

Positioning axes can be traversed either from the parts program or from the PLC.

Concurrent machine axes

A channel axis is neutrally defined by default with the following machine data. As a result no REORG takes place if the axis/spindle is traversed by the PLC (FC18) or by synchronous actions.

- MD30450 $MA_IS_CONCURRENT_POS_AX (concurr. positioning axis) = 1

Positioning axis feedrate

If a positioning axis is programmed in the part program without specifying an axis-specific feedrate, the feedrate entered in the following machine data is automatically applicable to this axis:

- MD32060 $MA_POS_AX VELO (initial setting for positioning axis velocity)

This feedrate will apply until an axis-specific feedrate is programmed in the parts program for this axis.

Machine data

Table 10-16 Positioning axes: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel-specific ($MC_ ... )</td>
<td>22240 AUXFU_F_SYNC_TYPE</td>
<td>Output timing of F functions</td>
<td>H2</td>
</tr>
<tr>
<td>Axis-specific ($MA_ ... )</td>
<td>30450 IS_CONCURRENT_POS_AX</td>
<td>Concurrent positioning axis</td>
<td></td>
</tr>
<tr>
<td>32060  POS_AX_VELO</td>
<td>Feedrate for positioning axis</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Interface signals

Table 10-17 Positioning axes: Interface signals

<table>
<thead>
<tr>
<th>DB number</th>
<th>Bit, byte</th>
<th>Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis/spindle-specific</td>
<td>31,... 0</td>
<td>Feedrate override, axis-specific</td>
<td></td>
</tr>
<tr>
<td>31,... 2.2</td>
<td>Delete distance-to-go, axis-specific</td>
<td></td>
<td></td>
</tr>
<tr>
<td>31,... 74.5</td>
<td>Positioning axis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>31,... 78-81</td>
<td>F function (feedrate) for positioning axis</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
10.5 Parameterize axis data

10.5.6 Indexed axes/"Hirth" axes

Indexed axes are rotary or linear axes, which can be traversed to indexed positions by index program instructions.

These indexed positions are approached in JOG mode.

In "normal" positioning, every position can be approached.

Note

Traversing to indexing positions using the parts program or manually is only effective if the corresponding machine axis has been successfully referenced.

Hirth axes are indexing axes with Hirth tooth system. These axes are rotary or linear axes, which may only be traversed to defined positions, the indexing positions, within the traversing range (MD30505 $MA_HIRTH_IS_ACTIVE).

The indexing positions are stored in tables.

Indexing axis

The following machine data assigns the machine axis the relevant table of indexing positions and also defines the machine axis as an indexing axis:

- MD30500 $MA_INDEX_AX_ASSIGN_POS_TAB[n] (axis is indexing axis)

Indexing position tables

The indexing positions are stored in one of the 2 tables.

- MD10900 $MN_INDEX_AX_LENGTH_POS_TAB_1 (number of positions of indexing table 1)
- MD10910 $MN_INDEX_AX_POS_TAB_1[n] (indexing position table 1)
- MD10920 $MN_INDEX_AX_LENGTH_POS_TAB_2 (number of positions of indexing table 2)
- MD10930 $MN_INDEX_AX_POS_TAB_2[n] (indexing position table 2)
Machine data

Table 10-18 Indexing axes: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>general</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10260</td>
<td>CONVERT_SCALING_SYSTEM</td>
<td>Basic system switch-over active</td>
<td>G2</td>
</tr>
<tr>
<td>10270</td>
<td>POS_TAB_SCALING_SYSTEM</td>
<td>Measuring system of position tables</td>
<td></td>
</tr>
<tr>
<td>10900</td>
<td>INDEX_AX_LENGTH_POS_TAB_1</td>
<td>Number of indexing positions used in Table 1</td>
<td></td>
</tr>
<tr>
<td>10910</td>
<td>INDEX_AX_POS_TAB_1[n]</td>
<td>Indexing position table 1</td>
<td></td>
</tr>
<tr>
<td>10920</td>
<td>INDEX_AX_LENGTH_POS_TAB_2</td>
<td>Number of indexing positions used in Table 2</td>
<td></td>
</tr>
<tr>
<td>10930</td>
<td>INDEX_AX_POS_TAB_2[n]</td>
<td>Indexing position table 2</td>
<td></td>
</tr>
<tr>
<td>Axis/spindle-specific</td>
<td>   </td>
<td></td>
<td></td>
</tr>
<tr>
<td>30300</td>
<td>IS_ROT_AX</td>
<td>Rotary axis</td>
<td>R2</td>
</tr>
<tr>
<td>30310</td>
<td>ROT_IS_MODULO</td>
<td>Modulo conversion for rotary axis</td>
<td>R2</td>
</tr>
<tr>
<td>30320</td>
<td>DISPLAY_IS_MODULO</td>
<td>Position display is modulo 360 degrees</td>
<td>R2</td>
</tr>
<tr>
<td>30500</td>
<td>INDEX_AX_ASSIGN_POS_TAB</td>
<td>Axis is indexing</td>
<td></td>
</tr>
<tr>
<td>30501</td>
<td>INDEX_AX_NUMERATOR</td>
<td>Numerator for indexing axes with equidistant</td>
<td></td>
</tr>
<tr>
<td>30505</td>
<td>HIRTH_IS_ACTIVE</td>
<td>Axis is an indexing axis with Hirth toothing</td>
<td></td>
</tr>
</tbody>
</table>

Interface signals

Table 10-19 Indexing axes: Interface signals

<table>
<thead>
<tr>
<th>DB number</th>
<th>Bit, byte</th>
<th>Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis/spindle-specific</td>
<td>   </td>
<td>Signals from axis/spindle to PLC</td>
<td></td>
</tr>
<tr>
<td>31,...</td>
<td>60.4, 60.5</td>
<td>Referenced/synchronized 1, referenced/synchronized 2</td>
<td>R1</td>
</tr>
<tr>
<td>31,...</td>
<td>76.6</td>
<td>Indexing axis in position</td>
<td></td>
</tr>
</tbody>
</table>

Literature

Function Manual Expanded Functions; Indexing axes
10.5.7 Position controller

Control loops

The closed-loop control of a machine axis consists of the cascaded closed-loop control circuits of current controller, speed controller and position controller.

![Control loops diagram](image)

Figure 10-12 Control loops

Traversing direction

If the axis does not traverse into the desired direction, the appropriate adaptation is made in the following machine data:

- MD32100 $MA_AX_MOTION_DIR (travel direction)

The value "-1" reverses the direction of motion.

Control direction

If the control direction of the position measuring system is incorrect, it can be adjusted with the following machine data:

- MD32110 $MA_ENC_FEEDBACK_POL (sign of actual value)

Note

When DSC is activated on the incorrect position measuring system, the control direction must also be adjusted in SINAMICS parameter p410.
**Servo gain**

To obtain high contour accuracy, a high loop gain (KV factor) of the position controller is required. However, an excessively high KV factor causes overshoot, instability and impermissibly high machine loads.

The maximum permissible KV factor is dependent on the dynamic response and the use of the feedforward control or DSC, of the drive and the mechanical system of the machine.

---

**Note**

The first commissioning is performed without feedforward control.

A KV factor of "0" leads to the position controller being cut.

**Definition of the KV factor**

The KV factor is defined as the ratio of velocity in m/min and the resulting following error in mm

\[
KV = \frac{\text{Velocity}}{\text{Following error}} \quad \left(\frac{\text{m/min}}{\text{mm}}\right)
\]

This means for a KV factor of 1 that at a velocity of 1m/min, a following error of 1mm results.

The KV factor of the machine axis is entered via the following machine data:

- MD32200 $MA_POSCTRL_GAIN (servo gain factor)

---

**Note**

To adapt the input/output unit of the KV factor selected by default to the internal unit [1/s], the following machine data is assigned pre-assigned:

- MD10220 $MN_SCALING_USER_DEF_MASK = 'H200'; (bit no. 9 as hex value)

When entering the KV factor it is important to note that the gain factor of the whole position control loop is still dependent on other parameters of the controlled system (speed setpoint alignment).

These factors include, among others:

- MD32260 $MA_RATED_VELO
- MD32250 $MA_RATED_OUTVAL
- Automatic interface alignment (SINAMICS parameter "Reference speed" p2000)
For drive optimization see Further optimization options (Page 241)

**NOTICE**

Machine axes that interpolate one with another must have the same dynamic response at the same velocities.

This can be achieved by setting the same KV factor or dynamic response adaptation in the following machine data:
- MD32900 $MA_DYN_MATCH_ENABLE
- MD32910 $MA_DYN_MATCH_TIME

The real KV factor can be checked with the following error in the service display.
- e.g., HMI Advanced: Operating area “Diagnosis” > “Service displays” > “Service axis”

**Checking the loop gain**

If a KV factor is already known for a machine type in question, this can be set and checked. To ensure that the drive does not reach its current limit during acceleration and deceleration, the acceleration is reduced for checking via the following machine data:
- MD32300 $MA_MAX_AX_ACCEL (axis acceleration)

The KV factor must also be checked for high speeds of the rotary axis and spindle (e.g., for spindle positioning, tapping).

The approach behavior at various speeds can be checked by means of the HMI Advanced servo trace software. The speed setpoint is recorded for this purpose.

No overshoots may occur while the drive is approaching the static states; this applies to all speed ranges.

**Overshoot in the position control loop**

The reasons for an overshoot in the control loop can be:
- Acceleration too high (current limit is reached)
- Rise time too long (re-optimization necessary)
- Mechanical backlash
- Mechanical components canted
For safety reasons, set the KV factor for each axis to a little less than the maximum possible value.

- MD32900 $MA_DYN_MATCH_ENABLE[n]
- MD32910 $MA_DYN_MATCH_TIME[n]

For axes interpolating with each other, the same KV-factor should be set. Normally it is the KV-factor of the weakest interpolating axis.

Contour monitoring must be set subsequently (MD36400 $MA_CONTROL_TOL).

**Acceleration**

In the following machine data machine axes are accelerated and decelerated with the values entered.

- MD32300 $MA_MAX_AX_ACCEL (axis acceleration)

This value should allow the axes to be accelerated and positioned fast and accurately, while ensuring that the machine is not loaded unduly.

**Checking the acceleration**

The sign of a properly adjusted acceleration of a machine axis is acceleration and positioning free from overshoot at rapid traverse rate and maximum load (max. external moment of inertia).

After the acceleration has been entered, the axis is traversed rapidly and the actual current values and current setpoint are recorded.

This recording shows whether the drive reaches the current limit. Here, the current limit can be reached for a short time.

The current must be well below the current limit, however, before the rapid traverse velocity or the final position is reached.

Load changes during the machining should not result in the current limit being reached, as they may result in contour errors. For this reason, the acceleration value should be a little bit less than the maximum acceleration value.

Machine axes can have different acceleration values, even if they interpolate with each other.
Jerk

For jerk, the following should be noted:

- For indexing program instructions (SOFT), the maximum jerk must be set in the following machine data:
  - MD32431 $MA_MAX_AX_JERK (maximum jerk)

- For JOG and positioning axes the following machine data should be supplemented:
  - MD32420 $MA_JOG_AND_POS_JERK_ENABLE
  - MD32430 $MA_JOG_AND_POS_MAX_JERK

Machine data

Table 10- 20 Position control: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name/remarks</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>axis spec. ($MA_... )</td>
<td></td>
<td></td>
</tr>
<tr>
<td>32100</td>
<td>AX_MOTION_DIR[n]</td>
<td>Traversing direction</td>
<td></td>
</tr>
<tr>
<td>32110</td>
<td>ENC_FEEDBACK_POL[n]</td>
<td>Actual value sign</td>
<td></td>
</tr>
<tr>
<td>32200</td>
<td>POSCTRL_GAIN [n]</td>
<td>KV factor</td>
<td></td>
</tr>
<tr>
<td>32300</td>
<td>MAX_AX_ACCEL[n]</td>
<td>Axis acceleration</td>
<td></td>
</tr>
<tr>
<td>32420</td>
<td>JOG_AND_POS_JERK_ENABLE</td>
<td>Enabling jerk limitation</td>
<td></td>
</tr>
<tr>
<td>32430</td>
<td>JOG_AND_POS_MAX_JERK</td>
<td>Axial jerk</td>
<td></td>
</tr>
<tr>
<td>32431</td>
<td>MAX_AX_JERK</td>
<td>Maximum axial jerk when traversing along the path</td>
<td></td>
</tr>
<tr>
<td>32900</td>
<td>DYN_MATCH_ENABLE[n]</td>
<td>Dynamic response adaptation</td>
<td></td>
</tr>
<tr>
<td>32910</td>
<td>DYN_MATCH_TIME [n]</td>
<td>Time constant for dynamic matching</td>
<td></td>
</tr>
<tr>
<td>36400</td>
<td>CONTROL_TOL</td>
<td>Contour monitoring</td>
<td></td>
</tr>
</tbody>
</table>

Literature

- Function Manual; speed, setpoint/actual-value systems, control: Closed-loop control
- Function Manual Extended Functions; Compensation, Section "Dynamic feedforward control (following error compensation)"
10.5.8 Speed setpoint matching

In the case of speed setpoint comparison, the NC is informed, which speed setpoint corresponds to which motor speed in the drive, for parameterizing the axial control and monitoring. Speed setpoint matching can be performed automatically or manually.

Automatic adjustment

It is possible to perform automatic speed setpoint adjustment if the drive supports acyclic services on the PROFIBUS-DP (standard for SINAMICS).

Acyclic services on the PROFIBUS-DP are supported if in the following machine data the value "0" is entered:

- MD32250 $MA_RATED_OUTVAL (rated output voltage) [%]

During start-up of the NCK, speed setpoint matching between the NCK and the drive is then performed automatically.

⚠️ WARNING

The SINAMICS parameter "Reference speed" p2000 may not be changed during operation of the control with the drive.

Note

If automatic speed setpoint matching fails for one axis, the following message is output on a traverse request for this axis:

- Message: "Wait, axis enable missing"

This axis and any axes that interpolate with it are not traversed.

Manual comparison

The speed setpoint alignment (interface normalization) is specified in the following machine data:

- MD32250 $MA_RATED_OUTVAL (rated output voltage) [%]
- MD32260 $MA_RATED_VELO (rated motor speed)

If a non-zero value is entered into the following machine data, the NCK assumes that speed setpoint matching will be performed manually.

- MD32250 $MA_RATED_OUTVAL (rated output voltage) [%]

Note

The maximum upper limit for the speed setpoint is set in machine data

- MD36210 $MA_CTRLOUT_LIMIT (maximum speed setpoint) [%]
Calculation of the motor speed

If the motor speed required for speed setpoint matching is not known directly, it can be calculated as follows with reference to the required axis velocity (linear axis) or load speed (rotary axis/spindle):

\[
\text{Motor speed for linear axis} \quad n_{\text{motor}} = \frac{v_{\text{Axis}}}{\frac{\text{MD31060} \times \text{MD31051}}{\text{MD31050}}} \times \frac{\text{MD31030}}{	ext{MD31050}}
\]

- \(v_{\text{Axis}}\) [mm/min]
- \(\text{MD31060} \times \text{MA_DRIVE_RATIO_NUMERA}\) (load gearbox numerator)
- \(\text{MD31050} \times \text{MA_DRIVE_RATIO_NUMERA}\) (load gearbox denominator)
- \(\text{MD31030} \times \text{MA_LEADSCREW_PITCH}\) (leadscrew pitch) [mm/rev]
- \(n_{\text{motor}}\) [rpm]
- \(n_{\text{Load}}\) [rpm]

Checking the trim

Incorrect speed setpoint matching has a negative impact on the real loop gain of the axis. To check speed setpoint matching it is necessary for a defined traverse velocity to compare the actual following error with the desired following error that should be set if speed setpoint matching is correct.

\[
\text{Desired following error} = \frac{\text{Traversing speed}}{\text{MD32200} \times \text{MA_POSCTRL_GAIN}}
\]

- Desired following error [mm]
- Traversing velocity [m/min]
- \(\text{MD32200} \times \text{MA_POSCTRL_GAIN}\) (servo gain factor) [(m/min)/mm]

The actual following error is shown in the axis-specific service data:

HMI:
Operating area "Diagnostics" > "Service displays" > "Service axis/spindle"
Machine data

Table 10- 21  Speed setpoint matching: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name/remarks</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis-spec. ($MA_ ... )</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32250</td>
<td>RATED_OUTVAL</td>
<td>Rated output voltage [%]</td>
<td>G2</td>
</tr>
<tr>
<td>32260</td>
<td>RATED_VELO</td>
<td>Rated motor speed</td>
<td>G2</td>
</tr>
</tbody>
</table>

Literature

Function Manual Basic Functions;
Speeds, setpoint/actual value systems, control, Chapter "Speeds, traversing ranges, accuracy"

10.5.9 Drift compensation

Digital drives

Digital drives are not subject to drift or compensate for it automatically.

Machine data

Table 10- 22  Drift compensation: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name/remarks</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>axis spec. ($MA_ ... )</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| 36720  | DRIFT_VALUE   | Basic drift value, always = 0
Note:
0 recommended for digital drive. | G2        |
10.5 Parameterize axis data

10.5.10 Velocity matching (axis)

Max. axis velocity

The value entered in the following machine data is the limit velocity up to which a machine axis can accelerate (rapid traverse limiting). It depends on the machine and drive dynamics and the limit frequency of actual-value acquisition.

- MD32000 $MA_MAX_AX_VELO[n] (max. axis velocity)

The max. axis velocity is used for traversing in the parts program when rapid traverse (G00) is programmed.

The maximum linear or rotary axis velocity should be entered in the machine data in accordance with MD30300 $MA_IS_ROT_AX[n].

Rapid traverse in JOG mode

The value entered in the following machine data is the velocity at which the machine axis traverses in JOG mode with the rapid traverse override key actuated and with an axial feedrate override of 100%.

- MD32010 $MA_JOG_VELO_RAPID[n] (rapid traverse in JOG mode) or
- MD32040 $MA_JOG_REV_VELO_RAPID[n] (revolutional feedrate in JOG mode with rapid traverse override)

The entered value may not exceed the max. permissible axis velocity.

This machine data will not be used for the programmed rapid traverse G00.

JOG axis velocity

The value entered in this machine data is the velocity at which the machine axis traverses in JOG mode with an axial feedrate override of 100%:

- MD32020 $MA_JOG_VELO[n] (axis velocity in JOG mode) or
- MD32050 $MA_JOG_REV_VELO[n] (revolutional feedrate in JOG mode)

The velocity from MD32020 JOG_VELO[n] or MD32050 JOG_REV_VELO[n] is used only if:

- for linear axes: SD41110 $SN_JOG_SET_VELO = 0
- for rotary axes: SD41130 $SN_JOG_ROT_AX_SET_VELO = 0

or

- for reverse feed: SD41120 $SN_JOG_REV_SET_VELO = 0

If the above mentioned setting data are unequal to 0, the JOG velocity results as follows:
1. SD41100 $SN_JOG_REV_IS_ACTIVE (revolutional feedrate in JOG mode) = 0
   => Linear feedrate (G94)
   – Linear axes:
     JOG velocity = SD41110 $SN_JOG_SET_VELO (JOG velocity for G94)
   – Rotary axes:
     JOG velocity = SD41130 $SN_JOG_ROT_AX_SET_VELO (JOG velocity for rotary axes)
2. SD41100 $SN_JOG_REV_IS_ACTIVE (revolutional feedrate in JOG mode) = 1
   – JOG velocity = SD41120 $SN_JOG_REV_SET_VELO (JOG velocity for G95)

The entered value may not exceed the max. permissible axis velocity.

**NOTICE**

Depending on MD30300 $MA_IS_ROT_AX[n], the velocities have to be entered in mm/min, inch/min, or rpm.

If the velocities are changed, MD36200 $MA_AX_VELO_LIMIT[n] (threshold value for velocity monitoring) must be adapted accordingly.

---

**Machine data**

Table 10- 23 Velocities: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name / remarks</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>30300</td>
<td>IS_ROT_AX[n]</td>
<td>Rotary axis</td>
<td></td>
</tr>
<tr>
<td>32000</td>
<td>MAX_AX_VELO[n]</td>
<td>Maximum axis velocity</td>
<td>G2</td>
</tr>
<tr>
<td>32010</td>
<td>JOG_VELO_RAPID[n]</td>
<td>Rapid traverse in JOG mode</td>
<td></td>
</tr>
<tr>
<td>32020</td>
<td>JOG_VELO[n]</td>
<td>JOG axis velocity</td>
<td></td>
</tr>
<tr>
<td>32040</td>
<td>JOG_REV_VELO_RAPID[n]</td>
<td>Revolutions feedrate in JOG mode with rapid</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>traverse override</td>
<td></td>
</tr>
<tr>
<td>32050</td>
<td>JOG_REV_VELO[n]</td>
<td>Revolutional feedrate in JOG mode</td>
<td></td>
</tr>
<tr>
<td>32060</td>
<td>POS_AX_VELO[n]</td>
<td>Initial setting for positioning axis velocity</td>
<td>P2</td>
</tr>
<tr>
<td>32250</td>
<td>RATED_OUTVAL</td>
<td>Rated output voltage</td>
<td></td>
</tr>
<tr>
<td>32260</td>
<td>RATED_VELO[n]</td>
<td>Rated motor speed</td>
<td></td>
</tr>
</tbody>
</table>
NCK start-up

10.5 Parameterize axis data

Setting data

Table 10- 24 Velocities: Setting data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name / remarks</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>41100</td>
<td>JOG_REV_IS_ACTIVE</td>
<td>Revolutionary feedrate in JOG mode active</td>
<td></td>
</tr>
<tr>
<td>41110</td>
<td>JOG_SET_VELO</td>
<td>JOG velocity for linear axes (for G94)</td>
<td></td>
</tr>
<tr>
<td>41120</td>
<td>JOG_REV_SET_VELO</td>
<td>JOG velocity (for G95)</td>
<td></td>
</tr>
<tr>
<td>41130</td>
<td>JOG_ROT_AX_SET_VELO</td>
<td>JOG speed for rotary axes</td>
<td></td>
</tr>
<tr>
<td>41200</td>
<td>JOG_SPIND_SET_VELO</td>
<td>JOG velocity for the spindle</td>
<td></td>
</tr>
</tbody>
</table>

Literature

Function Manual Basic Functions;
Speeds, setpoint/actual value systems, control, Chapter “Speeds, traversing ranges, accuracy”

Function Manual, Expanded Functions; Manual and Hand Wheel Travel
10.5.11 Axis monitoring

Static monitoring functions

The static monitoring functions with reference to a machine axis are:

**Exact stop coarse**
Window around the setpoint position within which exact stop coarse is detected.
- MD36000 $MA_STOP_LIMIT_COARSE (exact stop coarse)
- IS: DB31,... DBX60.6 (position reached with exact stop coarse)

**Exact stop fine**
Window around the setpoint position within which exact stop fine is detected.
- MD36010 $MA_STOP_LIMIT_FINE (exact stop fine)
- IS: DB31,... DBX60.7 (position reached with exact stop coarse)

**Delay time exact stop fine**
Delay time after which the actual value must have reached the tolerance window "Exact stop fine" when the setpoint position is reached.
- MD36020 $MA_POSITIONING_TIME (delay time exact stop fine)
- Alarm: "25080 Positioning monitoring" and follow-up mode.

**Zero speed tolerance**
Position tolerance which a standing machine axis may not leave.
- MD36030 $MA_STANDSTILL_POS_TOL (standstill tolerance)
- Alarm: "25040 Zero speed control" and follow-up mode.

**Delay time zero speed monitoring**
Delay time after which the actual value must have reached the tolerance window "Zero speed tolerance" when the setpoint position is reached.
- MD36040 $MA_STANDSTILL_DELAY_TIME (Zero-speed monitoring delay time)
- Alarm: "25040 Zero speed control" and follow-up mode.

**Clamping tolerance**
Tolerance window for a standing machine axis while the signal "Clamping active" is present at the PLC interface.
10.5 Parameterize axis data

- MD36050 $MA_CLAMP_POS_TOL (clamping tolerance)
- IS: DB31,... DBX2.3 (clamping active)
- Alarm: "26000 Clamping monitoring"

![Diagram of static monitoring functions](image)

Working area limitation
The permissible working area of the machine axes can be adapted to the particular machining situation using the "dynamic" working area limitation.

- SD43400 $SA_WORKAREA_PLUS_ENABLE (Working area limitation active in the positive direction)
- SD43410 $SA_WORKAREA_MINUS_ENABLE (Working area limitation active in the negative direction)
- SD43420 $SA_WORKAREA_LIMIT_PLUS (Working area limitation plus)
- SD43430 $SA_WORKAREA_LIMIT_MINUS (Working area limitation minus)
- Alarm: "10630 Axis reaching operating range limit +/-"
- Alarm: "10631 Axis is at operating range limit +/- (JOG)"
- Alarm: "10730 Progr. end point is behind working area limitation +/-"
Software limit switches

Two software limit switch pairs are provided per machine axis. The active software limit switch pair is selected in the PLC.

- MD36100 $MA_POS_LIMIT_MINUS (1st software limit switch minus)
- MD36110 $MA_POS_LIMIT_PLUS (1st software limit switch plus)
- MD36120 $MA_POS_LIMIT_MINUS2 (2nd software limit switch minus)
- MD36130 $MA_POS_LIMIT_PLUS2 (2nd software limit switch plus)
- IS: DB31,... DBX12.2 (2nd software limit switch minus)
- IS: DB31,... DBX12.3 (2nd software limit switch plus)
- Alarm: "10620 Axis reaching software limit switch +/-"
- Alarm: "10621 Axis is at software limit switch +/- (JOG)"
- Alarm: "10720 Progr. end point is behind software limit switch +/-"

NOTICE

All position monitoring functions are only active with valid reference point of the corresponding reference point of the machine axis.

Hardware limit switches

If the PLC signals that a hardware limit switch has been reached, the machine axis is stopped with the parameterized brake response.

- IS: DB31, ... DBX12.1 (hardware limit switch plus)
- IS: DB31, ... DBX12.0 (hardware limit switch minus)
- MD36600 $MA_BRAKE_MODE_CHOICE (braking behavior on hardware limit switch)
  0 = Brake characteristic is complied with
  1 = Rapid deceleration with setpoint "0"
- Alarm: "21614 Hardware limit switch [+/−]"

![Diagram of end limitations](image-url)

Figure 10-15 Overview of end limitations
Dynamic monitoring functions

The dynamic monitoring functions with reference to a machine axis are:

**Speed setpoint monitoring**

The speed setpoint monitoring prevents that the max. admissible motor speed is exceeded. It must be set such that the max. velocity (rapid traverse) can be reached and, in addition, a certain control margin remains.

- MD36210 $MA\_CTRLOUT\_LIMIT\[n\]$ (maximum speed setpoint as %)

![Figure 10-16 Speed setpoint limitation](image)

The following machine data is used to define how long the speed setpoint may remain within the limits before the speed setpoint monitoring responds.

- MD36220 $MA\_CTRLOUT\_LIMIT\_TIME\[n\]$ (delay time for speed setpoint monitoring)

**Error response**

- Alarm: "25060 Speed setpoint limiting"
- and stopping the machine axis using a speed setpoint ramp whose characteristic is set in

- MD36610 $MA\_AX\_EMERGENCY\_STOP\_TIME$ (braking ramp time when errors occur)

**Cause of errors/error handling**

- A measuring circuit error or drive error is present.
- Setpoints are too high (accelerations, velocities, reducing factors).
- Obstacle in the machining space (e.g. tool hits working table) => remove obstacle.

The speed setpoint consists of the speed setpoint of the position controller and the feedforward control parameter (if feedforward control is active).
NOTICE
The limitation of the speed setpoint will turn the control loop into a nonlinear control loop. Generally, this will result in deviations from the contour and longer dwelling of the machine axis within the speed setpoint limitation.

Actual velocity monitoring
Monitoring due to the actual velocity of the machine axis determined based on the encoder values

- MD36020 $MA_AX_VELO_LIMIT (velocity-monitoring threshold)

Error response
- Alarm: "25030 Alarm limit of actual velocity"
and stopping the machine axis using a speed setpoint ramp whose characteristic is set in
- MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur)

Remedy
- Check actual values
- Check position control direction (control sense)
- Threshold value for velocity monitoring is possibly too low.

Contour monitoring
Monitoring of the difference between the following error measured and the following error calculated from the position setpoint.

- MD36400 CONTOUR_TOL (contour monitoring tolerance range)

Error response
- Alarm: "25050 Contour monitoring"
and stopping the machine axis using a speed setpoint ramp whose characteristic is set in
- MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur)
Remedy
Contour errors are caused by signal distortions in the position control loop.

Remedy:
- Increase the tolerance band
- Checking the \( K_v \) factor:
  The real \( K_v \) factor must correspond to the desired \( K_v \) factor, set via MD32200 $MA_POSCTRL_GAIN[n] (K_v factor).

  **HMI-Advanced**
  Operating area "DIAGNOSTICS" > "Service displays" > "Service axis"

- Check optimization of the speed controller
- Check smooth running of the axes
- Check machine data for traversing motions
  (Feedrate override, acceleration, max. velocities, ...)
- For operation with feedforward control:
  MD32810 $MA_EQUIV_SPEEDCTRL_TIME (equivalent time constant of speed control loop for feedforward control) or if the machine data is imprecisely set, the MD36400 $MA_CONTOUR_TOL must be enlarged.

Encoder limit frequency monitoring
Monitoring of the limit frequency of the encoder of a machine axis.
- MD36300 $MA_ENC_FREQ_LIMIT (encoder limit frequency)

Error response
- Alarm: "21610 Encoder frequency exceeded"
- IS: DB31, ... DBX60.2 "Encoder limit frequency exceeded 1"
- IS: DB31, ... DBX60.3 "Encoder limit frequency exceeded 2"

  and stopping the machine axis using a speed setpoint ramp whose characteristic is set in
- MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur)

Remedy
After the axes have come to a stop, the position control is resumed after the alarm (RESET at the machine control panel) is acknowledged.

**NOTICE**
The axis affected must be re-referenced.
Encoder zero mark monitoring

The zero mark monitoring of the encoder of a machine axis checks whether pulses were lost between two zero mark passes.

- MD36310 $MA_ENC_ZERO_MONITORING (zero-mark monitoring)

is used to enter the number of detected zero mark errors at which the monitoring is to respond.

Special situation:
A value of 100 will additionally disable hardware monitoring of the encoder.

Error response

- Alarm: "25020 Zero mark monitoring"

and stopping the machine axes using a speed setpoint ramp whose characteristic is set in

- MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur)

Error causes

- MD36300 $MA_ENC_FREQ_LIMIT [n] (encoder limit frequency) set too high.
- Encoder cable damaged.
- Encoder or encoder electronics defective.

Position tolerance when switching over the encoder

It is possible to switch between the two encoders or position measuring systems of a machine axis at any time. The permissible position difference between the two position measuring systems when switching over is monitored.

- MD36500 $MA_ENC_CHANGE_TOL (max. tolerance on position actual value switchover)

Error response

- Alarm: "25100 Measuring system cannot be switched over"

The requested switchover to another encoder is not carried out.

Error causes

- The specified permissible tolerance is too small.
- The position measuring system to which you want to switch over to is not referenced.
Transmission Monitoring the encoder position tolerance

The position difference between the two encoders or position measuring systems of a machine axis is monitored with

- MD36510 $MA_ENC_DIFF_TOL (measuring system synchronism tolerance)

Error response

- Alarm: “25105 Measuring systems are not synchronous”

and stopping the machine axes using a speed setpoint ramp whose characteristic is set in the following machine data:

- MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur)

![Diagram of monitoring system](image-url)


**NOTICE**

| MD36620 $MA_SERVO_DISABLE_DELAY_TIME (switch-off delay servo enable) |
| must always be selected greater than |
| MD36610 $MA_AX_EMERGENCY_STOP_TIME (braking ramp time when errors occur) |
| If this is not the case, the braking ramp cannot be kept. |

**Literature**

Function Manual Basic Functions; Axis monitoring: Protection zones
10.5.12 Axis homing

Referencing
When referencing a machine axis, the actual position value system of the machine axis is synchronized with the machine geometry. Depending on the encoder type used, the machine axis is referenced with or without traversing movements.

Reference point approach
For all machine axes which are not equipped with an encoder providing an absolute actual position value, referencing is carried out by traversing the machine axis to a reference point; this is called the reference point approach.

The reference point approach can be carried out either manually in JOG mode, submode REF, or using a parts program.

With the operating mode JOG and submode REF, reference point approach is started using traverse direction keys PLUS or MINUS (depending on the parameterized reference point approach direction).
10.5.12.1 Incremental measuring system

Incremental measuring systems

With incremental measuring systems, referencing is carried out using a reference point approach divided into three phases:

1. Traversing to the reference cam
2. Synchronizing to the encoder zero marker
3. Approach reference point

![Signal chart: Referencing with an incremental measuring system (principle)](image)

**Phase-independent data**

The following **machine data** and **interface signals** are relevant in each of the individual phases of the reference point approach:

- MD11300 $MN_JOG_INC_MODE_LEVELTRIGGRD (INC/REF in jog mode)
- MD34000 $MA_REFP_CAM_IS_ACTIVE (axis with reference cam)
- MD34110 $MA_REFP_CYCLE_NR (axis sequence for channel-specific reference point approach)
- MD34020 $MA_REFP_VELO_SEARCH_CAM (Reference point approach velocity)
- MD34070 $MA_REFP_VELO_POS (Reference point positioning velocity)
- MD34040 $MA_REFP_VELO_SEARCH_MARKER (Reference point creep velocity)

- IS: DB21, ... DBX1.0 ("Activate referencing")
- IS: DB21, ... DBX33.0 ("Referencing active")
10.5 Parameterize axis data

Phase 1: Traversing to the reference cam

The following machine data and interface signals are relevant:

- MD34010 $MA_REFP_CAM_DIR_IS_MINUS (approach reference cam in minus direction)
- MD34020 $MA_REFP_VELO_SEARCH_CAM (reference cam approach velocity)
- MD34030 $MA_REFP_MAX_CAM_DIST (maximum distance to the reference cam)
- MD34092 $MA_REFP_CAMSHIFT (electr. cam offset, incremental measuring systems with equidistant zero markers)
- IS: DB21, ... DBX36.2 ("All axes with obligatory reference point are referenced")
- IS: DB31, ... DBX4.7/DBX4.6 ("Traversing keys plus/minus")
- IS: DB31, ... DBX12.7 ("Reference point approach delay")
- IS: DB31, ... DBX60.4, DBX60.5 ("Referenced/synchronized 1, 2")

Properties of phase 1:

- The feedrate override (feedrate switch) is active.
- The feed stop (channel-specific and axis-specific) is active.
- The machine axis can be stopped and restarted with NC-stop/NC-start.
- The machine axis traverses a distance specified in the following machine data from the starting position in the direction of the reference cam, without reaching the reference cam.
  - MD34030 $MA_REFP_MAX_CAM_DIST (max. distance to reference cam)
- The following interface signal is set to "0". The axis stops, and alarm 20000 "Reference cam not reached" is output.
  - IS: DB31, ... DBX12.7 ("Reference point approach delay") = 0

⚠️ WARNING ⚠️

If the reference cam is not calibrated exactly, it is possible that a wrong zero mark is evaluated after the reference cam has been left. As a result, the control system will take a wrong machine zero.

Software limit switches, protection areas and work area limits will thus also be active for the wrong positions. The difference is equivalent to one encoder revolution in each case.

Danger for man and machine exists.
Phase 2: Synchronizing to the encoder zero mark

The following **machine data** and **interface signals** are relevant:

- MD34040 $MA_REFP_VELO_SEARCH_MARKER (creep velocity)
- MD34050 $MA_REFP_SEARCH_MARKER_REVERSE (direction reversal on reference cam)
- MD34060 $MA_REFP_MAX_MARKER_DIST (maximum distance from cam to reference mark)

**Properties of phase 2:**

- Feed override (the feed override switch) is not active.
  
  If a feed override of 0% is selected via the feed override switch, the traverse movement is stopped.

- Feed stop (channel-specific and axis-specific) is active.
  
  On a feed stop, the traverse movement is stopped and the alarm displayed:

  - Alarm 20005 "Reference point approach canceled"
  
  - NC-Stop/NC-Start is inactive.

  - With IS: DB31, ... DBX12.7 ("Reference point approach delay") = 0, the machine axis traverses a distance parameterized in the following machine data after leaving the reference cam.
    
    - MD34060 $MA_REFP_MAX_MARKER_DIST (max. distance to the reference mark)
      
      Without the zero mark being detected, the machine axis stops and the following alarm is displayed:

      - Alarm 20002 "Zero mark missing"

Phase 3: Approach reference point

The following **machine data** and **interface signals** are relevant:

- MD34070 $MA_REFP_VELO_POS (reference point positioning velocity)
- MD34080 $MA_REFP_MOVE_DIST (reference point distance to zero mark)
- MD34090 $MA_REFP_MOVE_DIST_CORR (reference point offset, additive)
- MD34100 $MA_REFP_SET_POS (reference point value)
- IS: DB31, ... DBX2.4, 2.5, 2.6, 2.7 ("Reference point value 1...4")
- IS: DB31, ... DBX60.4, DBX60.5 ("Referenced/synchronized 1, 2")

**Properties of phase 3:**

- Feed override (the feed override switch) is active.

- Feed stop (channel-specific and axis-specific) is active.

- NC-Stop/NC-Start is active.

**Literature**

Function Manual Basic Functions; Reference point approach: Referencing with incremental measurement systems
10.5 Parameterize axis data

10.5.12.2 Distance-coded reference marks

Distance-coded reference marks

When clearance-coded reference marks are used, referencing is divided into 2 phases:

1. Synchronize by overriding 2 reference marks
2. Traverse to target point

![Signal chart: Distance-coded reference marks (principle)](image)

**Phase-independent data**

The following **machine data** and **interface signals** are independent with respect to the individual phases of reference point approach:

- MD11300 $MN_JOG_INC_MODE_LEVELTRIGGRD (INC/REF in jog mode)
- MD34000 $MA_REFP_CAM_IS_ACTIVE (axis with reference cam)
- MD34110 $MA_REFP_CYCLE_NR (axis sequence for channel-specific reference point approach)
- MD30240 $MA_ENC_TYPE (encoder type)
- MD34200 $MA_ENC_REFP_MODE (referencing mode)
- MD34310 $MA_ENC_MARKER_INC (interval between two reference marks)
- MD34320 $MA_ENC_INVERS (inverse measuring system)
- IS: DB21, ... DBX1.0 ("Activate referencing")
- IS: DB21, ... DBX33.0 ("Referencing active")
Phase 1: Synchronize by overriding 2 reference marks

The following **machine data** and **interface signals** are relevant:

- MD34010 $MA REFP_CAM_DIR_IS_MINUS (approach reference cam in negative direction)
- MD34040 $MA REFP_VELO_SEARCH_MARKER (referencing velocity)
- MD34060 $MA REFP_MAX_MARKER_DIST (maximum distance between 2 reference marks)
- MD34300 $MA ENC_REFP_MARKER_DIST (reference mark distance)
- IS: DB21 .. 30, DBX36.2 ("All axes to be referenced are referenced")
- IS: DB31, ... DBX4.7/DBX4.6 ("Traversing keys plus/minus")
- IS: DB31, ... DBX12.7 ("Reference point approach delay")
- IS: DB31, ... DBX60.4, DBX60.5 ("Referenced/synchronized 1, 2")

**Properties of phase 1:**

- If the machine axis travels from the initial position a distance defined in
  MD34300 $MA REFP_MARKER_DIST (max. distance to the reference mark) without two
  reference marks being overridden, then the machine axis stops and
  the system issues alarm 20004 "Reference mark missing".

Phase 2: Traversing to the target point

The following **machine data** and **interface signals** are relevant:

- MD34070 $MA REFP_VELO_POS (target point positioning velocity)
- MD34090 $MA REFP_MOVE_DIST_CORR (absolute offset)
- MD34100 $MA REFP_SET_POS (target point)
- MD34330 $MA REFP_STOP_AT_ABS_MARKER (with/without target point)
- IS: DB31, ... DBX60.4, DBX60.5 ("Referenced/synchronized 1, 2")

**Properties of phase 2:**

- The feed rate override (feed rate switch) is active.
- The feed stop (channel-specific and axis-specific) is active.
- The machine axis can be stopped and restarted with NC stop/NC start.
Determining the absolute offset

To determine the absolute offset between the measuring system zero point and the machine zero, the following procedure is recommended:

1. Determining the actual position of the measuring system

   After two reference marks following one after the other (synchronized) have been overtaveled, the actual position of the length measuring system can be read on the user interface at "Actual position".

   The absolute offset must be zero at this time:

   - MD34090 $MA REFP_MOVE_DIST_CORR = 0

2. Determine the absolute machine actual position

   Determining the absolute machine actual position, e.g., can be performed by traversing the machine axis to a known position (fixed stop). Alternatively, it can be measured at any position (laser interferometer).

3. Calculating the absolute offset

   Linear measurement system non-inverse to machine system:
   Absolute offset = machine actual position + actual position of the measuring system

   Linear measuring system inverse to machine system:
   Absolute offset = machine actual position - actual position of the measuring system

   - MD34090 $MA REFP_MOVE_DIST_CORR (reference point/absolute offset)

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>After you have determined the absolute offset and made an entry in</td>
</tr>
<tr>
<td>- MD34090 $MA REFP_MOVE_DIST_CORR (absolute offset)</td>
</tr>
<tr>
<td>the position measuring system must be re-referenced.</td>
</tr>
</tbody>
</table>

Literature

Function Manual Basic Functions; Reference point approach: Referencing with length measuring systems with distance-coded reference marks
10.5.12.3 Absolute encoders

Absolute encoder

Initial referencing of the measuring system of a machine axis with absolute encoder is performed by calibrating the encoder.

Follow-up referencing

Follow-up referencing of a machine axis is performed automatically while the NC starts up without axis movement. The following conditions must be fulfilled:

- The measuring system of the machine axis active after the booting of the NC works with the absolute encoder
- The absolute encoder is calibrated:
  
  MD34210 $MA_ENC_REFP_STATE[n] = 2$ (absolute value encoder is calibrated)

Calibration

To calibrate the absolute encoder, the actual value of the encoder is matched with the machine zero once and then enabled.

The SINUMERIK 840D sl supports the following types of calibration:

- Operator-assisted calibration
- Automatic calibration using probe
- Calibration using BERO

The calibration using the probe and BERO is described in:

Literature

Function Manual Basic Functions; Reference point approach: Automatic adjustment with measuring probe, adjustment with BERO

Operator-assisted calibration

During operator-assisted calibration, the machine axis of the absolute encoder is moved to the known machine position (reference position). The position value of the reference position is taken over by the NC as the reference point value.
10.5 Parameterize axis data

Recommended procedure

1. Parameterization of referencing mode
   - MD34200 $MA ENC_REFP_MODE[n] = 0

2. Approaching referencing position
   Traversing the machine axis to the referencing position in JOG mode. Approach direction according to machine data:
   - MD34010 $MA_REFP_CAM_DIR_IS_MINUS (reference point approach in minus direction) (0 = positive, 1 = negative approach direction)

   **NOTICE**

   To avoid the actual position of the machine axis being falsified by backlash in the drive train, reference point approach must be performed at low velocity and always from the same direction.

3. Assumption of the reference position in the NC
   The reference position is entered in the machine data:
   - MD34100 $MA_REFP_SET_POS[n] (reference point value)

4. Enabling encoder calibration
   Encoder calibration is performed in the machine data:
   - MD34210 $MA ENC_REFP_STATE[n] = 1

5. Activate changed machine data by NCK reset.

6. Completing encoder calibration
   When the NC has started up, encoder calibration is completed in mode: JOG > REF for the machine axis by once more pressing the direction key as described in point 2:
   - Select JOG > REF mode
   - Select machine axis
   - Press traverse direction key

   **Note**

   Pressing the traverse direction key does not move the machine axis!
The NC then calculates the reference point offset and enters it in the machine data:

- **MD34090 $MA_REFP_MOVE_DIST_CORR[n]** (reference point offset)
  
  To indicate that calibration has been completed, the value in the machine data changes from 1 = enable encoder calibration to 2 = encoder calibrated:

- **MD34210 $MA_ENC_REFP_STATE[n] = 2**

  The value from the machine data is shown as the actual position of the machine axis for the current machine position on the user interface:

- **MD34100 $MA_REFP_SET_POS[n]** (reference point value)

**Calibrating several absolute encoders**

For time-optimized calibration of the absolute encoders of several machine axes, the following procedure is recommended:

1. Depending on the machine design, move all or several machine axes to their reference position. See above: Points 1 to 4.
2. Perform an NCK reset. See above: Point 5.

**Recalibration**

Recalibration of the absolute encoder is required after:

- Gear change between load and absolute encoder
- Removal/installation of the absolute encoder (encoder replacement)
- Removal/installation of the motor with the absolute encoder (motor replacement)
- SRAM data loss of the NC, battery power failure. In this case, it is necessary to load a series startup file.

- **PRESET**

**NOTICE**

The status of the absolute encoder is only automatically reset to 1 = "encoder not calibrated" by the NCK on gear change:

- **MD34210 $MA_ENC_REFP_STATE[n] = 1**

In all other cases, it is the sole responsibility of the NCK user to indicate the uncalibrated state of the absolute encoder by manually resetting the status to "encoder not calibrated" and to perform calibration again.

A recalibration of the absolute encoder is also required when machine data MD34210 $MA_ENC_REFP_STATE[n] is set to zero under the following conditions:

- Alarm 25020 "Zero mark monitoring of the active encoder" has been issued.
- The control has been switched off during the consistency check.
- The encoder number has changed.


**NCK start-up**

**10.5 Parameterize axis data**

**Literature**

Function Manual Basic Functions; Reference point approach: Referencing with absolute encoders

**10.5.12.4 Interface signals and machine data**

**Interface signals**

Table 10-25 Referencing: Interface signals

<table>
<thead>
<tr>
<th>DB number</th>
<th>Bit, byte</th>
<th>Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode-group-specific Signals from PLC to mode group</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11, ...</td>
<td>0.7</td>
<td>Mode group reset</td>
<td>K1</td>
</tr>
<tr>
<td>11, ...</td>
<td>1.2</td>
<td>Machine function REF</td>
<td>K1</td>
</tr>
<tr>
<td>Mode-group-specific Signals from mode group to PLC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11, ...</td>
<td>5.2</td>
<td>Active machine function REF</td>
<td>K1</td>
</tr>
<tr>
<td>Channel-specific Signals from PLC to channel</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21, ...</td>
<td>1.0</td>
<td>Activate referencing</td>
<td></td>
</tr>
<tr>
<td>Channel-specific Signals from channel to PLC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21, ...</td>
<td>28.7</td>
<td>(MMC -&gt; PLC) REF</td>
<td>K1</td>
</tr>
<tr>
<td>21, ...</td>
<td>33.0</td>
<td>Referencing active</td>
<td></td>
</tr>
<tr>
<td>21, ...</td>
<td>35.7</td>
<td>Reset</td>
<td>K1</td>
</tr>
<tr>
<td>21, ...</td>
<td>36.2</td>
<td>All axes that must have a reference point are referenced</td>
<td></td>
</tr>
<tr>
<td>Axis-specific Signals from PLC to axis/spindle</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>1.5/1.6</td>
<td>Position measuring system 1/position measuring system 2</td>
<td>A2</td>
</tr>
<tr>
<td>31, ...</td>
<td>2.4-2.7</td>
<td>Reference point value 1 to 4</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>4.6/4.7</td>
<td>Traversing keys minus/plus</td>
<td>H1</td>
</tr>
<tr>
<td>31, ...</td>
<td>12.7</td>
<td>Reference point approach delay</td>
<td></td>
</tr>
<tr>
<td>Axis-specific Signals from axis/spindle to PLC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>60.4/60.5</td>
<td>Referenced, synchronized 1/Referenced, synchronized 2</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>64.6/64.7</td>
<td>Traverse command minus/plus</td>
<td>H1</td>
</tr>
</tbody>
</table>

**Machine data**

Table 10-26 Referencing: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Name of Identifier</th>
<th>Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>General ($MN_{...}$)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11300</td>
<td>JOG_INC_MODE_LEVELTRIGGRD</td>
<td>INC/REF in jog/continuous mode</td>
<td>H1</td>
</tr>
<tr>
<td>Channel-specific ($MC_{...}$)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20700</td>
<td>REFP_NC_START_LOCK</td>
<td>NC start disable without reference point</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>Name of Identifier</td>
<td>Name</td>
<td>Reference</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>30200</td>
<td>NUM_ENCS</td>
<td>Number of encoders</td>
<td>G2</td>
</tr>
<tr>
<td>30240</td>
<td>ENC_TYP</td>
<td>Actual value encoder type</td>
<td></td>
</tr>
<tr>
<td>30242</td>
<td>ENC_IS_INDEPENDENT</td>
<td>Encoder is independent</td>
<td>G2</td>
</tr>
<tr>
<td>31122</td>
<td>BERO_DELAY_TIME_PLUS</td>
<td>BERO delay time in plus direction</td>
<td>S1</td>
</tr>
<tr>
<td>31123</td>
<td>BERO_DELAY_TIME_MINUS</td>
<td>BERO delay time in minus direction</td>
<td>S1</td>
</tr>
<tr>
<td>34000</td>
<td>REFP_CAM_IS_ACTIVE</td>
<td>Axis with reference cam</td>
<td></td>
</tr>
<tr>
<td>34010</td>
<td>REFP_CAM_DIR_IS_MINUS</td>
<td>Reference point approach in minus direction</td>
<td></td>
</tr>
<tr>
<td>34020</td>
<td>REFP_VELO_SEARCH_CAM</td>
<td>Reference point approach velocity</td>
<td></td>
</tr>
<tr>
<td>34030</td>
<td>REFP_MAX_CAM_DIST</td>
<td>Maximum distance to reference cam</td>
<td></td>
</tr>
<tr>
<td>34040</td>
<td>REFP_VELO_SEARCH_MARKER[n]</td>
<td>Reference point creep speed [encoder number]</td>
<td></td>
</tr>
<tr>
<td>34050</td>
<td>REFP_SEARCH_MARKER_REVERSE[n]</td>
<td>Change of direction on reference cam [encoder number]</td>
<td></td>
</tr>
<tr>
<td>34060</td>
<td>REFP_MAX_MARKER_DIST[n]</td>
<td>Maximum distance to reference mark; Maximum distance to 2 reference marks with distance-coded scales [encoder number]</td>
<td></td>
</tr>
<tr>
<td>34070</td>
<td>REFP_VELO_POS</td>
<td>Reference point positioning velocity</td>
<td></td>
</tr>
<tr>
<td>34080</td>
<td>REFP_MOVE_DIST[n]</td>
<td>Reference point distance/target point with distance-coded system [encoder number]</td>
<td></td>
</tr>
<tr>
<td>34090</td>
<td>REFP_MOVE_DIST_CORR[n]</td>
<td>Reference point/absolute offset, distance-coded [encoder number]</td>
<td></td>
</tr>
<tr>
<td>34092</td>
<td>REFP_CAM_SHIFT</td>
<td>Electronic reference cam shift for incremental measurement systems with equidistant zero marks.</td>
<td></td>
</tr>
<tr>
<td>34100</td>
<td>REFP_SET_POS[n]</td>
<td>Reference point value [reference point number]</td>
<td></td>
</tr>
<tr>
<td>34102</td>
<td>REFP_SYNC_ENCS</td>
<td>Actual value adjustment to the referencing measurement system</td>
<td></td>
</tr>
<tr>
<td>34110</td>
<td>REFP_CYCLE_NR</td>
<td>Axis sequence for channel-specific referencing</td>
<td></td>
</tr>
<tr>
<td>34120</td>
<td>REFP_BERO_LOW_ACTIVE</td>
<td>Polarity change of BERO</td>
<td></td>
</tr>
<tr>
<td>34200</td>
<td>ENC_REFP_MODE[n]</td>
<td>Referencing mode [encoder number]</td>
<td></td>
</tr>
<tr>
<td>34210</td>
<td>ENC_REFP_STATE[n]</td>
<td>Status of absolute value encoder [encoder number]</td>
<td></td>
</tr>
<tr>
<td>34220</td>
<td>ENC_ABS_TURNS_MODULO</td>
<td>Absolute value encoder range for rotary encoders</td>
<td>R2</td>
</tr>
<tr>
<td>34300</td>
<td>ENC_REFP_MARKER_DIST[n]</td>
<td>Reference marker distance with distance-coded scales [encoder number]</td>
<td></td>
</tr>
<tr>
<td>34310</td>
<td>ENC_MARKER_INC[n]</td>
<td>Interval between two reference marks with distance-coded scales [encoder no.]</td>
<td></td>
</tr>
<tr>
<td>34320</td>
<td>ENC_INVERS[encoder]</td>
<td>Linear measuring system inverse to machine system [encoder number]</td>
<td></td>
</tr>
<tr>
<td>34330</td>
<td>REFP_STOP_AT_ABS_MARKER[n]</td>
<td>Distance-coded linear measurement system without destination point [encoder number]</td>
<td></td>
</tr>
<tr>
<td>35150</td>
<td>SPIND_DES_VELO_TOL</td>
<td>Spindle speed tolerance</td>
<td>S1</td>
</tr>
</tbody>
</table>
10.6 Parameterization of spindle data

<table>
<thead>
<tr>
<th>Number</th>
<th>Name of Identifier</th>
<th>Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>36302</td>
<td>ENC_FREQ_LIMIT_LOW</td>
<td>Encoder limit frequency re-synchronization</td>
<td></td>
</tr>
<tr>
<td>36310</td>
<td>ENC_ZERO_MONITORING</td>
<td>Zero mark monitoring</td>
<td></td>
</tr>
<tr>
<td>30250</td>
<td>ACT_POS_ABS</td>
<td>Absolute encoder position at time of deactivation.</td>
<td></td>
</tr>
</tbody>
</table>

Literature

Function Manual Basic Functions; Reference point approach:

10.6 Parameterization of spindle data

Reference

See also

Spindle data (Page 482)
Spindle modes (Page 483)
Initial spindle state (Page 483)
General functionality (Page 484)
General functionality (Page 484)

10.6.1 Setpoint/actual value channels of spindle

Parameterization of the setpoint/actual value channels of a spindle is identical to parameterization of the setpoint and actual value channels of an axis. For this, see Section “Setpoint / actual value channels” (Page 479).
10.6 Parameterization of spindle data

10.6.2 Gear stages

Enabling

The gear stage change is generally carried out in the following machine data:

- MD35010 $MA_GEAR_STEP_CHANGE_ENABLE (gear stage change possible, spindle has several gear stages)

If this machine data is not set, the system assumes that the spindle has no gear stages.

Multiple gearbox steps

If more than one gearbox step exists, the number of gearbox steps is entered into MD35090 $MA_NUM_GEAR_STEPS.

Parameter sets

In **spindle mode** of a spindle, the NC will select the parameter set that suits the current gear stage best.

Gear stage x => parameter set (x+1) => index [x]

In **axis mode** of a spindle, the NC always selects the 1st parameter set (index [0], independent of the current gear stage.

The machine data listed in the following are gear stage-dependent machine data of a spindle:

- MD35110 $MA_GEAR_STEP_MAX_VELO[n] (n_{max} for gear stage change)
- MD35120 $MA_GEAR_STEP_MIN_VELO[n] (n_{min} for gear stage change)
- MD35130 $MA_GEAR_STEP_MAX_VELO_LIMIT[n] (n_{max} for gear stage)
- MD35135 $MA_GEAR_STEP_PC_MAX_VELO_LIMIT (n_{max} for gearbox step with position control)
- MD35140 $MA_GEAR_STEP_MIN_VELO_LIMIT[n] (n_{min} for gear stage)
- MD35200 $MA_GEAR_STEP_SPEEDCTRL_ACCEL[n] (acceleration in speed-control mode)
- MD35210 $MA_GEAR_STEP_POSCTRL_ACCEL[n] (acceleration in position control mode)

For further information on parameter sets, see Section "Axis/spindle parameter sets" (Page 143).

Literature

Function Manual Basic Functions; Spindles: Gear stage change
10.6 Parameterization of spindle data

10.6.3 Spindle measuring systems

Encoder matching

When parameterizing the measuring systems of spindles, the same conditions apply as for parameterization of the measuring systems of rotary axes. This multiple is 2048.

For incremental measuring systems see Section "Parameterization of incremental measuring systems" (Page 145).

For absolute measuring systems see Section "Parameterization of absolute measuring systems" (Page 149).

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the motor encoder is used for actual-value sensing, the encoder matching data must be entered in the machine data for each individual gear stage if several gear stages are present.</td>
</tr>
</tbody>
</table>

Pulse multiplication factor

The maximum multiplication of the appropriate drive is always used as the multiplication of the increments.

Examples of encoder adaptation

Example A: encoder on the spindle

Suppose the following conditions are provided:

- The incremental encoder is mounted on the spindle.
- Encoder pulses = 500 [pulses/rev.]
- Pulse multiplication = 128
- Internal precision = 1000 [increment/degree]
- Sensor ratio = 1:1
- Load ratio = 1:1

The machine data are set acc. to the values above:

- MD10210 $MN_INT_INC_PER_DEG (computational resolution) = 1,000 [incr./degree]
- MD31020 $MA_ENC_RESOL (encoder resolution) = 500 [pulses/revolution]
- MD31050 $MA_DRIVE_AX_RATION_DENOM (load rev. denominator) = 1
- MD31060 $MA_DRIVE_AX_RATION_NUMERA (load rev. numerator) = 1
10.6 Parameterization of spindle data

- MD31070 $MA\_DRIVE\_ENC\_RATION\_DENOM$ (sensor speed denominator) = 1
- MD31080 $MA\_DRIVE\_ENC\_RATION\_NUMERA$ (sensor speed numerator) = 1

\[
\text{Internal Resolution} = \frac{360 \text{ degree}}{\text{MD31070} \cdot \text{pulse rev.}} \cdot \frac{\text{MD31080}}{\text{MD31070}} \cdot \frac{\text{MD31050}}{\text{MD31060}} \cdot \frac{\text{MD10210}}{\text{MD31060}}
\]

\[
\text{Internal Resolution} = \frac{360}{500 \cdot 128} \cdot 1 \cdot 1 \cdot 1000 = 5,625 \quad \text{int. increments per encoder pulse}
\]

One encoder increment corresponds to 5.625 internal increments.

One encoder increment corresponds to 0.005625 degrees (highest possible positioning resolution).

**Example B: encoder at motor**

Suppose the following conditions are provided:

- The incremental encoder is mounted on the motor.
- Encoder pulses = 2048 [pulses/rev.]
- Pulse multiplication = 128
- Internal precision = 1000 [increment/degree]
- Sensor ratio = 1:1
- Load ratio 1= 2.5:1 [motor speed/spindle speed]
- Load ratio 2= 1:1 [motor speed/spindle speed]

**Gear stage 1**

\[
\text{Internal Resolution} = \frac{360 \text{ degree}}{\text{MD31070} \cdot \text{pulse rev.}} \cdot \frac{\text{MD31080}}{\text{MD31070}} \cdot \frac{\text{MD31050}}{\text{MD31060}} \cdot \frac{\text{MD10210}}{\text{MD31060}}
\]

\[
\text{Internal Resolution} = \frac{360}{2048 \cdot 128} \cdot 1 \cdot 1 \cdot 1000 = 0.54932 \quad \text{int. increments per encoder pulse}
\]

One encoder increment corresponds to 0.54932 internal increments.

One encoder increment corresponds to 0.00054932 degrees (highest possible positioning resolution).

**Gear stage 2**

\[
\text{Internal Resolution} = \frac{360 \text{ degree}}{\text{MD31070} \cdot \text{pulse rev.}} \cdot \frac{\text{MD31080}}{\text{MD31070}} \cdot \frac{\text{MD31050}}{\text{MD31060}} \cdot \frac{\text{MD10210}}{\text{MD31060}}
\]

\[
\text{Internal Resolution} = \frac{360}{2048 \cdot 128} \cdot 1 \cdot 1 \cdot 1000 = 1.3733 \quad \text{int. increments per encoder pulse}
\]

One encoder increment corresponds to 1.3733 internal increments.

One encoder increment corresponds to 0.0013733 degrees (highest possible positioning resolution).
10.6.4 Speeds and setpoint adjustment for spindle

Speeds, gear stages

In SINUMERIK solution line, data for five gear stages are implemented. These stages are defined by a minimum and maximum speed for the stage itself and by a minimum and maximum speed for the automatic gear stage changeover.

A new set gear stage is output only if the new programmed speed cannot be traversed in the current gear stage. For the sake of simplification, the oscillation times for gear stage changeovers can be specified directly in the NC; the oscillation function must otherwise be implemented in the PLC. The oscillation function is initiated via the PLC.

![Diagram showing speeds and setpoint adjustment for spindle](image)

Figure 10-21 Example for speed ranges for automatic gear stage selection (M40)

Speeds for conventional operation

The speeds of the spindle in conventional mode are entered in the machine data:

- MD32010 $MA_JOG_VELO_RAPID (rapid traverse in jog mode)
- MD32020 $MA_JOG_VELO (axis velocity in JOG mode)

The direction of rotation is specified via the appropriate directional keys for the spindle on the MCP.
Direction of rotation

The direction of rotation of a spindle corresponds to the traversing direction of an axis.

Setpoint matching

The speeds must be transferred with standardized values for the drive controller. The values are scaled in the NC using the selected load gear and the appropriate drive parameter.

Machine data

Table 10-27  Speeds and setpoint adjustment for spindle: Machine data

<table>
<thead>
<tr>
<th>Axis-specific ($MA_\ldots$)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31050 DRIVE_AX_RATIO_DENOM</td>
<td>Denominator load gearbox</td>
</tr>
<tr>
<td>31060 DRIVE_AX_RATIO_NUMERA</td>
<td>Numerator load gearbox</td>
</tr>
<tr>
<td>32010 JOG_VELO_RAPID</td>
<td>Rapid traverse in the JOG mode</td>
</tr>
<tr>
<td>32020 JOG_VELO</td>
<td>JOG axis velocity</td>
</tr>
<tr>
<td>35010 GEAR_STEP_CHANGE_ENABLE</td>
<td>Gear stage change possible</td>
</tr>
<tr>
<td>35020 SPIND_DEFAULT_MODE</td>
<td>Basic spindle setting</td>
</tr>
<tr>
<td>35030 SPIND_DEFAULT_ACT_MASK</td>
<td>Activate initial spindle setting</td>
</tr>
<tr>
<td>35040 SPIND_ACTIVE_AFTER_RESET</td>
<td>Spindle active after reset</td>
</tr>
<tr>
<td>35200 GEAR_STEP_SPEEDCTRL_ACCEL[n]</td>
<td>Acceleration in speed control mode</td>
</tr>
<tr>
<td>35220 ACCEL_REDUCTION_SPEED_POINT</td>
<td>Speed limit for reduced acceleration</td>
</tr>
<tr>
<td>35230 ACCEL_REDUCTION_FACTOR</td>
<td>Reduced acceleration</td>
</tr>
<tr>
<td>35400 SPIND_OSCILL_DES_VELO</td>
<td>Oscillation speed</td>
</tr>
<tr>
<td>35410 SPIND_OSCILL_ACCEL</td>
<td>Oscillation acceleration</td>
</tr>
<tr>
<td>35430 SPIND_OSCILL_START_DIR</td>
<td>Oscillation start direction</td>
</tr>
<tr>
<td>35440 SPIND_OSCILL_TIME_CW</td>
<td>Oscillation time for M3 direction</td>
</tr>
<tr>
<td>35450 SPIND_OSCILL_TIME_CCW</td>
<td>Oscillation time for M4 direction</td>
</tr>
</tbody>
</table>

Interface signals

Table 10-28  Speeds and setpoint adjustment for spindle: Interface signals

<table>
<thead>
<tr>
<th>DB number</th>
<th>Bit, byte</th>
<th>Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis-specific</td>
<td>Signals from PLC to axis/spindle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>4.6</td>
<td>Traversing keys minus</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>4.7</td>
<td>Traversing keys plus</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>16.2-16.0</td>
<td>Actual gear stage</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>16.3</td>
<td>Gear changed</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>16.6</td>
<td>No speed monitoring when changing the gear</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>18.4</td>
<td>Oscillation via PLC</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>18.5</td>
<td>Oscillation speed</td>
<td></td>
</tr>
</tbody>
</table>
### 10.6 Parameterization of spindle data

<table>
<thead>
<tr>
<th>DB number</th>
<th>Bit, byte</th>
<th>Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis-specific</td>
<td>82.2-82.0</td>
<td>Signals from axis/spindle to PLC</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>82.2-82.0</td>
<td>Set gear stage</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>82.3</td>
<td>Change gear</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>84.7</td>
<td>Active spindle control mode</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>84.6</td>
<td>Active spindle mode oscillation mode</td>
<td></td>
</tr>
</tbody>
</table>
10.6.5  Position spindle

The NC provides an oriented spindle stop function with which the spindle can be moved into a certain position and held there (e.g. for tool changing purposes). Several programming commands are available for this function which define the approach and program processing.

Literature

Function Manual Basic Functions; Spindles

Functionality

- To absolute position (0-360 degrees)
- Incremental position (+/- 999999.99 degrees)
- Positioning without influence of block change (SPOSA)
- Block change when block end position is reached (calculated by interpolation)

The control brakes the spindle down to position control speed at the acceleration rate for speed operation.

If position control speed has been reached, the control branches into position control mode and the acceleration rate for position control mode and the KV factor become active.

The interface signal "Exact stop fine" is output to indicate that the programmed position has been reached (block change when position reached).

Acceleration rate for position control mode must be set such that the current limit is not reached. Acceleration rate must be entered separately for each gear step.

If the spindle is positioned from zero speed, it is accelerated up to a maximum speed corresponding to position control speed; the direction is defined via machine data. If there is no reference, the direction of actuation is as in MD35350 SPIND_POSITIONING_DIR. When position control mode is switched on, contour monitoring is also activated.

Machine data

Table 10- 29  Spindle positioning: Machine data

<table>
<thead>
<tr>
<th>Axis-specific ($MA_{...}$)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>35300</td>
<td>SPIND_POSCTRL_VELO</td>
</tr>
<tr>
<td>35350</td>
<td>SPIND_POSITIONING_DIR</td>
</tr>
<tr>
<td>35210</td>
<td>GEAR_STEP_POSCTRL_ACCEL</td>
</tr>
<tr>
<td>36000</td>
<td>STOP_LIMIT_COARSE</td>
</tr>
<tr>
<td>36010</td>
<td>STOP_LIMIT_FINE</td>
</tr>
<tr>
<td>32200</td>
<td>POSCTRL_GAIN</td>
</tr>
<tr>
<td>36400</td>
<td>CONTOUR_TOL</td>
</tr>
</tbody>
</table>
## Interface signals

Table 10-30 Spindle positioning: Interface signals

<table>
<thead>
<tr>
<th>DB number</th>
<th>Bit, byte</th>
<th>Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis-specific</td>
<td>Signals from axis/spindle to PLC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>60.6</td>
<td>Position reached with exact stop &quot;fine&quot;</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>60.7</td>
<td>Position reached with exact stop &quot;coarse&quot;</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>84.5</td>
<td>Positioning mode</td>
<td></td>
</tr>
</tbody>
</table>
10.6.6 Synchronizing spindle

To allow the spindle to be positioned from the NCK, its position has to be adjusted using the measuring system. This operation is called "synchronization".

As a rule, synchronizing is done to the zero mark of the connected encoder or to a reference cam as zero mark substitute.

The following machine data defines the actual position of the spindle at the zero mark position:

- MD34100 $MA_REFP_SET_POS (reference point value)
- The zero mark offset is entered in the following machine data:
  - MD34090 $MA_REFP_MOVE_DIST_CORR (reference point offset)

The following machine data specifies which signal is used for synchronization:

- MD34200 $MA_ENC_REFP_MODE (homing mode)
  - 1 = Encoder zero mark
  - 2 = Bero

When is synchronization necessary?

The spindle will be synchronized:

- after the NC has powered up when the spindle is moved using a programming command
- after a request for resynchronization by the PLC
  
  NST DB31,... DBX16.4 (resynchronize spindle 1)
  
  NST DB31,... DBX16.5 (resynchronize spindle 2)
- after each gear stage change for an indirect measuring system
  
  MD31040 $MA_ENC_IS_DIRECT (direct measuring system) = 0
- when the encoder limit frequency falls below the programmed value after a speed has been programmed which is above the encoder limit frequency.

### NOTICE

If the spindle encoder is not mounted directly on the spindle and there are gear ratios between the encoder and spindle (e.g. encoder mounted on motor), then a BERO signal connected to the drive (SERVO) must be used for synchronization. The control system then automatically resynchronizes the spindle after each gear stage change. The user does not have to contribute anything here.

In general, backlash, gearbox elasticity and reference cam hysteresis reduce the accuracy achievable during synchronization.
10.6 Parameterization of spindle data

**Machine data**

Table 10-31  Synchronizing spindle: Machine data

<table>
<thead>
<tr>
<th>Axis-specific ($MA_...$)</th>
<th>Parameter</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>34100</td>
<td>REFP_SET_POS</td>
<td>Reference point value</td>
</tr>
<tr>
<td>34090</td>
<td>REFP_MOVE_DIST_CORR</td>
<td>Reference point offset</td>
</tr>
<tr>
<td>34200</td>
<td>REFP_MODE</td>
<td>Referencing mode</td>
</tr>
</tbody>
</table>

**Interface signals**

Table 10-32  Synchronizing spindle: Interface signals

<table>
<thead>
<tr>
<th>DB number</th>
<th>Bit, byte</th>
<th>Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis-specific</td>
<td></td>
<td>Signals from PLC to axis/spindle</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>16.4</td>
<td>Synchronize spindle 1</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>16.5</td>
<td>Synchronize spindle 2</td>
<td></td>
</tr>
<tr>
<td>Axis-specific</td>
<td></td>
<td>Signals from axis/spindle to PLC</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>60.4</td>
<td>Referenced/synchronized 1</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>60.5</td>
<td>Referenced/synchronized 2</td>
<td></td>
</tr>
</tbody>
</table>
10.6 Parameterization of spindle data

10.6.7 Spindle monitoring

Spindle stationary

The maximum permissible spindle speed up to which spindle standstill is detected, is set using machine data:

- MD36060 $MA_STANDSTILL_VELO_TOL (max. speed "Spindle stationary")

If the actual speed falls below this speed limit, the NC/PLC interface signal is set:

- DB31,... DBX61.4 = 1 (spindle stationary)

Enabling path feed

Precondition:

- The spindle is in the open-loop control mode
- MD35510 $MA_SPIND_STOPPED_AT_IPO_START == TRUE (feed enable for "Spindle stationary")

The path feed is enabled when both conditions are fulfilled:

- (actual speed of the spindle) < (MD36060 $MA_STANDSTILL_VELO_TOL)
- DB31,... DBX61.4 == 1 (spindle stationary)

Spindle in setpoint range

If the spindle reaches the tolerance range specified in the following machine data, then the interface signal IS DB31,... DBX83.5 (spindle in setpoint range) is set:

- MD35150 $MA_SPIND_DES_VELO_TOL (spindle speed tolerance)

The path feedrate is then released in the following set machine data:

- MD35510 $MA_SPIND_STOPPED_AT_IPO_START (feed enable for "Spindle stopped")

Maximum spindle speed

The maximum spindle speed can be set using the following system data:

- Machine-dependent maximum speed via machine data MD35100 $MA_SPIND_VELO_LIMIT (max. spindle speed)
- Process-dependent maximum speed via immediately effective setting data SD43235 $SA_SPIND_USER_VELO_LIMIT (max. spindle speed)

The NC limits the spindle speed to the lower of the two values.

Error reaction:

If the speed is nevertheless exceeded by the speed tolerance (drive error), the following signal is output:

- DB31,... DBX83.0 = 1 (speed limit exceeded)
- Alarm "22150 Maximum number of chucks exceeded"
10.6 Parameterization of spindle data

The following machine data also limits the speed of the spindle:

- MD36200 $MA_AX_VELO_LIMIT (velocity-monitoring threshold)

When the speed is exceeded, an alarm is generated.

In position-controlled mode (e.g. SPCON), the NC limits the specified maximum speed specified in machine or setting data to 90% of the maximum value (control reserve).

**Gear stage speed min./max.**

The default of a max./min. gear stage speed is entered in the following machine data:

- MD35130 $MA_GEAR_STEP_MAX_VELO_LIMIT (maximum speed for gear stage)
- MD35140 $MA_GEAR_STEP_MIN_VELO_LIMIT (minimum speed for gear stage)

The speed cannot leave this range when the appropriate gear stage is engaged.

**Programmed spindle speed limitations**

The following functions can be used to specify a spindle speed limitation in an indexing program:

- G25 S... (min. spindle speed)
- G26 S... (max. spindle speed)

The limitation is active in all operating modes.

The function LIMS=... can be used to specify a spindle speed limit for G96 (constant cutting rate):

- LIMS=... (speed limitation (G96))

This limitation is only effective when G96 is active.

**Encoder frequency limit**

If the sensor limit frequency in the following machine data is exceeded, synchronization of the spindle is lost and spindle functionality is reduced (thread, G95, G96):

- MD36300 $MA_ENC_FREQ_LIMIT (encoder limit frequency)

The spindle will be re-synchronized automatically once the sensor frequency falls below the value defined in the following machine data:

- MD36302 $MA_ENC_FREQ_LIMIT_LOW (encoder limit frequency at which the encoder is turned on again)

The encoder limit frequency value must be such that the mechanical encoder speed limit is not exceeded or else the synchronization from high speeds will be incorrect.
Overview of the speed limit values

- max. encoder limit frequency
  MD369300 $MA_ENC_FREQ_LIMIT

- machine-dependent max. spindle speed
  MD35100 $MA_SPIND_VELO_LIMIT

- process-dependent max. spindle speed
  SD43235 $SA_SPIND_USER_VELO_LIMIT

- Maximum spindle speed for actual gear stage n
  MD35130 $MA_GEAR_STEP_MAX_VELO_LIMIT[n]
  MD35135 $MA_GEAR_STEP_PC_MAX_VELO_LIMIT[n]

- programmable spindle speed limit G26
  SD43220 $SA_SPIND_MAX_VELO_G26

- programmable spindle speed limit LIMS G96
  SD43230 $SA_SPIND_MAX_VELO_LIMS

- programmable minimum spindle speed G25
  SD43210 $SA_SPIND_MIN_VELO_G25

- min.m spindle speed for actual gear stage n
  MD35140 $MA_GEAR_STEP_MIN_VELO_LIMIT[n]

- Max. velocity/speed "Axis/spindle stopped"
  MD36060 $MA_STANDSTILL_VELO_TOL

Reference

Function Manual Basic Functions; Spindles: Spindle monitoring
10.6 Parameterization of spindle data

10.6.8 Spindle data

Machine data

Table 10-33 Spindle: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Name of identifier</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>General ($MN_ ... )</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12060</td>
<td>OVR_SPIND_IS_GRAY_CODE</td>
<td>Spindle override with Gray coding</td>
</tr>
<tr>
<td>12070</td>
<td>OVR_FACTOR_SPIND_SPEED</td>
<td>Evaluation of spindle speed override switch</td>
</tr>
<tr>
<td>12080</td>
<td>OVR_REFERENCE_IS_PROG_FEED</td>
<td>Override reference velocity</td>
</tr>
<tr>
<td>Channel-specific ($MC_ ... )</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20090</td>
<td>SPIND_DEF_MASTER_SPIND</td>
<td>Initial setting for master spindle on channel</td>
</tr>
<tr>
<td>20092</td>
<td>SPIND_ASSIGN_TAB_ENABLE</td>
<td>Enabling/disabling of spindle converter</td>
</tr>
<tr>
<td>20118</td>
<td>GEOAX_CHANGE_RESET</td>
<td>Allow automatic geometry axis change</td>
</tr>
<tr>
<td>22400</td>
<td>S_VALUES_ACTIVE_AFTER_RESET</td>
<td>S function active after RESET</td>
</tr>
<tr>
<td>Axis-specific ($MA_ ... )</td>
<td></td>
<td></td>
</tr>
<tr>
<td>30300</td>
<td>IS_ROT_AX</td>
<td>Rotary axis</td>
</tr>
<tr>
<td>30310</td>
<td>ROT_IS_MODULO</td>
<td>Modulo conversion</td>
</tr>
<tr>
<td>30320</td>
<td>DISPLAY_IS_MODULO</td>
<td>Position display</td>
</tr>
<tr>
<td>31050</td>
<td>DRIVE_AX_RATIO_DENOM</td>
<td>Denominator load gearbox</td>
</tr>
<tr>
<td>31060</td>
<td>DRIVE_AX_RATIO_NUMERA</td>
<td>Numerator load gearbox</td>
</tr>
<tr>
<td>31122</td>
<td>BERO_DELAY_TIME_PLUS</td>
<td>BERO delay time in plus direction</td>
</tr>
<tr>
<td>31123</td>
<td>BERO_DELAY_TIME_MINUS</td>
<td>BERO delay time in minus direction</td>
</tr>
<tr>
<td>32200</td>
<td>POSCTRL_GAIN</td>
<td>$K_v$ factor</td>
</tr>
<tr>
<td>32810</td>
<td>EQUIV_SPEEDCTRL_TIME</td>
<td>Equivalent time constant speed control loop for feedforward control</td>
</tr>
<tr>
<td>32910</td>
<td>DYN_MATCH_TIME</td>
<td>Time constant for dynamic matching</td>
</tr>
<tr>
<td>34040</td>
<td>REFP VELO SEARCH MARKER</td>
<td>Reference point creep speed</td>
</tr>
<tr>
<td>34060</td>
<td>REFP MAX MARKER DIST</td>
<td>Monitoring of zero mark distance</td>
</tr>
<tr>
<td>34080</td>
<td>REFP Move DIST</td>
<td>Reference point distance/destination point for distance-coded system</td>
</tr>
<tr>
<td>34090</td>
<td>REFP Move DIST CORR</td>
<td>Reference point offset/absolute offset, distance-coded</td>
</tr>
<tr>
<td>34100</td>
<td>REFP SET POS</td>
<td>Reference point value</td>
</tr>
<tr>
<td>34200</td>
<td>ENC ReFP Mode</td>
<td>Homing mode</td>
</tr>
<tr>
<td>35000</td>
<td>SPIND ASSIGN TO MACHAX</td>
<td>Assignment of spindle to machine axis</td>
</tr>
<tr>
<td>35010</td>
<td>GEAR STEP CHANGE ENABLE</td>
<td>Gear stage change possible</td>
</tr>
<tr>
<td>35012</td>
<td>GEAR STEP CHANGE POSITION</td>
<td>Gear stage change position</td>
</tr>
<tr>
<td>35020</td>
<td>SPIND DEFAULT MODE</td>
<td>Basic spindle setting</td>
</tr>
<tr>
<td>35030</td>
<td>SPIND DEFAULT ACT MASK</td>
<td>Activate initial spindle setting</td>
</tr>
<tr>
<td>35040</td>
<td>SPIND ACTIVE AFTER RESET</td>
<td>Spindle active after reset</td>
</tr>
<tr>
<td>35100</td>
<td>SPIND VELO LIMIT</td>
<td>Maximum spindle speed</td>
</tr>
<tr>
<td>35110</td>
<td>GEAR STEP MAX VELO[n]</td>
<td>Maximum speed for gear change</td>
</tr>
</tbody>
</table>
### 10.6 Parameterization of spindle data

<table>
<thead>
<tr>
<th>Number</th>
<th>Name of Identifier</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>35120</td>
<td>GEAR_STEP_MIN_VELO[n]</td>
<td>Minimum speed for gear change</td>
</tr>
<tr>
<td>35130</td>
<td>GEAR_STEP_MAX_VELO_LIMIT[n]</td>
<td>Maximum speed of gear stage</td>
</tr>
<tr>
<td>35140</td>
<td>GEAR_STEP_MIN_VELO_LIMIT[n]</td>
<td>Minimum speed of gear stage</td>
</tr>
<tr>
<td>35150</td>
<td>SPIND_DES_VELO_TOL</td>
<td>Spindle speed tolerance</td>
</tr>
<tr>
<td>35160</td>
<td>SPIND_EXTERN_VELO_LIMIT</td>
<td>Spindle speed limitation via PLC</td>
</tr>
<tr>
<td>35200</td>
<td>GEAR_STEP_SPEEDCTRL_ACCEL[n]</td>
<td>Acceleration in speed control mode</td>
</tr>
<tr>
<td>35210</td>
<td>GEAR_STEP_POSCTRL_ACCEL[n]</td>
<td>Acceleration in position control mode</td>
</tr>
<tr>
<td>35220</td>
<td>ACCEL_REDUCTION_SPEED_POINT</td>
<td>Speed limit for reduced acceleration</td>
</tr>
<tr>
<td>35230</td>
<td>ACCEL_REDUCTION_FACTOR</td>
<td>Reduced acceleration</td>
</tr>
<tr>
<td>35300</td>
<td>SPIND_POSCTRL_VELO</td>
<td>Position control activation speed</td>
</tr>
<tr>
<td>35350</td>
<td>SPIND_POSITIONING_DIR</td>
<td>Positioning direction of rotation for a non-synchronized spindle</td>
</tr>
<tr>
<td>35400</td>
<td>SPIND_OSCILL_DES_VELO</td>
<td>Oscillation speed</td>
</tr>
<tr>
<td>35410</td>
<td>SPIND_OSCILL_ACCEL</td>
<td>Oscillation acceleration</td>
</tr>
<tr>
<td>35430</td>
<td>SPIND_OSCILL_START_DIR</td>
<td>Oscillation start direction</td>
</tr>
<tr>
<td>35440</td>
<td>SPIND_OSCILL_TIME_CW</td>
<td>Oscillation time for M3 direction</td>
</tr>
<tr>
<td>35450</td>
<td>SPIND_OSCILL_TIME_CCW</td>
<td>Oscillation time for M4 direction</td>
</tr>
<tr>
<td>35500</td>
<td>SPIND_ON_SPEED_AT_IPO_START</td>
<td>Feed enable with spindle in setpoint range</td>
</tr>
<tr>
<td>35510</td>
<td>SPIND_STOPPED_AT_IPO_START</td>
<td>Feed enable with stationary spindle</td>
</tr>
<tr>
<td>35590</td>
<td>PARAMSET_CHANGE_ENABLE</td>
<td>Parameter set definition possible from PLC</td>
</tr>
<tr>
<td>36060</td>
<td>STANDSTILL_VELO_TOL</td>
<td>Threshold velocity &quot;Axis/spindle stationary&quot;</td>
</tr>
<tr>
<td>36200</td>
<td>AX_VELO_LIMIT</td>
<td>Threshold value for velocity monitoring</td>
</tr>
</tbody>
</table>

### Setting data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spindle-specific ($SA_...$)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>42600</td>
<td>JOG_FEED_PER_REF_SOURCE</td>
<td>Revolutional feedrate control in JOG mode</td>
</tr>
<tr>
<td>42800</td>
<td>SPIND_ASSIGN_TAB</td>
<td>Spindle number converter</td>
</tr>
<tr>
<td>42900</td>
<td>MIRROR_TOOL_LENGTH</td>
<td>Mirror tool length offset</td>
</tr>
<tr>
<td>42910</td>
<td>MIRROR_TOOL_WEAR</td>
<td>Mirror wear values of tool length compensation</td>
</tr>
<tr>
<td>42920</td>
<td>WEAR_SIGN_CUTPOS</td>
<td>Mirror wear values of machining plane</td>
</tr>
<tr>
<td>42930</td>
<td>WEAR_SIGN</td>
<td>Invert sign of all wear values</td>
</tr>
<tr>
<td>42940</td>
<td>TOOL_LENGTH_CONST</td>
<td>Retain the assignment of tool length components when changing the machining plane (G17 to G19)</td>
</tr>
<tr>
<td>43210</td>
<td>SPIND_MIN_VELO_G25</td>
<td>Progr. Spindle speed limiting G25</td>
</tr>
<tr>
<td>43220</td>
<td>SPIND_MAX_VELO_G26</td>
<td>Progr. Spindle speed limiting G26</td>
</tr>
<tr>
<td>43230</td>
<td>SPIND_MAX_VELO_LIMS</td>
<td>Progr. spindle speed limitation with G96</td>
</tr>
<tr>
<td>43300</td>
<td>ASSIGN_FEED_PER_REF_SOURCE</td>
<td>Rotational feedrate for positioning axes/spindles</td>
</tr>
</tbody>
</table>
10.6 Parameterization of spindle data

## Interface signals

Table 10-35  Spindle: Interface signals

<table>
<thead>
<tr>
<th>DB number</th>
<th>Bit, byte</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Axis-specific</strong></td>
<td></td>
<td><strong>Signals from PLC to axis/spindle</strong></td>
</tr>
<tr>
<td>31, ...</td>
<td>0</td>
<td>Feed override</td>
</tr>
<tr>
<td>31, ...</td>
<td>1.7</td>
<td>Override active</td>
</tr>
<tr>
<td>31, ...</td>
<td>1.6</td>
<td>Position measuring system 2</td>
</tr>
<tr>
<td>31, ...</td>
<td>1.5</td>
<td>Position measuring system 1</td>
</tr>
<tr>
<td>31, ...</td>
<td>1.4</td>
<td>Follow-up mode</td>
</tr>
<tr>
<td>31, ...</td>
<td>1.3</td>
<td>Axis/spindle disable</td>
</tr>
<tr>
<td>31, ...</td>
<td>2.2</td>
<td>Spindle reset/delete distance-to-go</td>
</tr>
<tr>
<td>31, ...</td>
<td>2.1</td>
<td>Servo enable</td>
</tr>
<tr>
<td>31, ...</td>
<td>3.6</td>
<td>Velocity/spindle speed limitation</td>
</tr>
<tr>
<td>31, ...</td>
<td>16.7</td>
<td>Delete S value</td>
</tr>
<tr>
<td>31, ...</td>
<td>16.5</td>
<td>Resynchronize spindle 2</td>
</tr>
<tr>
<td>31, ...</td>
<td>16.4</td>
<td>Resynchronize spindle 1</td>
</tr>
<tr>
<td>31, ...</td>
<td>16.3</td>
<td>Gear changed</td>
</tr>
<tr>
<td>31, ...</td>
<td>16.2-16.0</td>
<td>Actual gear stage A to C</td>
</tr>
<tr>
<td>31, ...</td>
<td>17.6</td>
<td>Invert M3/M4</td>
</tr>
<tr>
<td>31, ...</td>
<td>17.5</td>
<td>Resynchronize spindle during positioning 2</td>
</tr>
<tr>
<td>31, ...</td>
<td>17.4</td>
<td>Resynchronize spindle during positioning 1</td>
</tr>
<tr>
<td>31, ...</td>
<td>18.7</td>
<td>Direction of rotation setpoint left</td>
</tr>
<tr>
<td>31, ...</td>
<td>18.6</td>
<td>Direction of rotation setpoint right</td>
</tr>
<tr>
<td>31, ...</td>
<td>18.5</td>
<td>Oscillation speed</td>
</tr>
<tr>
<td>31, ...</td>
<td>18.4</td>
<td>Oscillation via PLC</td>
</tr>
<tr>
<td>31, ...</td>
<td>19.7 - 19.0</td>
<td>Spindle offset H - A</td>
</tr>
<tr>
<td><strong>Axis-specific</strong></td>
<td></td>
<td><strong>Signals from axis/spindle to PLC</strong></td>
</tr>
<tr>
<td>31, ...</td>
<td>60.7</td>
<td>Position reached with exact stop fine</td>
</tr>
<tr>
<td>31, ...</td>
<td>60.6</td>
<td>Position reached with exact stop coarse</td>
</tr>
<tr>
<td>31, ...</td>
<td>60.5</td>
<td>Referenced/synchronized 2</td>
</tr>
<tr>
<td>31, ...</td>
<td>60.4</td>
<td>Referenced/synchronized 1</td>
</tr>
<tr>
<td>31, ...</td>
<td>60.3</td>
<td>Encoder limit frequency exceeded 2</td>
</tr>
<tr>
<td>31, ...</td>
<td>60.2</td>
<td>Encoder limit frequency exceeded 1</td>
</tr>
<tr>
<td>31, ...</td>
<td>60.0</td>
<td>Axis/no spindle</td>
</tr>
<tr>
<td>31, ...</td>
<td>61.7</td>
<td>Current controller active</td>
</tr>
<tr>
<td>31, ...</td>
<td>61.6</td>
<td>Speed control loop active</td>
</tr>
<tr>
<td>31, ...</td>
<td>61.5</td>
<td>Position controller active</td>
</tr>
<tr>
<td>31, ...</td>
<td>61.4</td>
<td>Axis/spindle stationary (n &lt; nmin)</td>
</tr>
<tr>
<td>31, ...</td>
<td>82.3</td>
<td>Change gear</td>
</tr>
<tr>
<td>31, ...</td>
<td>82.2-82.0</td>
<td>Set gear stage A-C</td>
</tr>
<tr>
<td>31, ...</td>
<td>83.7</td>
<td>Actual direction of rotation clockwise</td>
</tr>
<tr>
<td>31, ...</td>
<td>83.5</td>
<td>Spindle in setpoint range</td>
</tr>
</tbody>
</table>
### 10.6 Parameterization of spindle data

<table>
<thead>
<tr>
<th>DB number</th>
<th>Bit, byte</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>31, ...</td>
<td>83.2</td>
<td>Setpoint speed increased</td>
</tr>
<tr>
<td>31, ...</td>
<td>83.1</td>
<td>Setpoint speed limited</td>
</tr>
<tr>
<td>31, ...</td>
<td>83.0</td>
<td>Speed limit exceeded</td>
</tr>
<tr>
<td>31, ...</td>
<td>84.7</td>
<td>Active spindle control mode</td>
</tr>
<tr>
<td>31, ...</td>
<td>84.6</td>
<td>Active spindle mode oscillation mode</td>
</tr>
<tr>
<td>31, ...</td>
<td>84.5</td>
<td>Active spindle positioning mode</td>
</tr>
<tr>
<td>31, ...</td>
<td>84.3</td>
<td>Rigid tapping active</td>
</tr>
<tr>
<td>31, ...</td>
<td>86 and 87</td>
<td>M function for spindle</td>
</tr>
<tr>
<td>31, ...</td>
<td>88-91</td>
<td>S function for spindle</td>
</tr>
</tbody>
</table>
10.7 Application example

10.7.1 Advanced Surface (AS)

Advanced Surface (AS) is a function to machine milled surfaces in the area of tool and mold building.

Advanced Surface is an option (Order No. 6FC5800-0AS07-0YB0).

The machine and setting data, which are influenced by this functionality as well as their contents, are subsequently listed.

The values are recommended settings.

10.7.2 Preconditions, G code

Introduction

Dynamic G groups are used for the Advanced Surface option.

Preconditions

- The machine axes have been optimized.
- The dynamic G groups have been set-up and parameterized for the following machining sections:
  - Roughing (DYNROUGH)
  - Pre-finishing (DYNSEMIFIN)
  - Finishing (DYNFINISH)

Recommendations

- Dynamic G groups

  The following classification of dynamic G groups is recommended (G code group 59):

    DYNORM → 2.5D machining without AS
    DYNPOS → Positioning mode (e.g. tool change, thread cutting) without AS
    DYNROUGH → Milling with AS
    DYNSEMIFIN → Milling with AS
    DYNFINISH → Milling with AS
Note
DYNNORM is the initial setting of the G group (default).
For Advanced Surface, the precondition is that jerk limited velocity control is active. Jerk-limited velocity control is selected using the G code SOFT.

- COMPCAD
  Using COMPCAD, it is possible to combine part programs with short linear blocks, with the associated tolerance, using polynomials.
  This path compression technique has been developed so that the surface character, which the milling paths form, is retained.

- G645
  G645 (G code group 10) switches in the continuous path mode (Look Ahead).
  G645 has the ability to insert smoothing elements in existing contour elements so that acceleration steps (jumps) do not occur.

- FIFOCTRL
  FIFOCTRL (G code group 4) switches in the automatic pre-processing memory control.
  The feed is adapted so that the pre-processing memory does not become empty.

- FFWON
  FFWON (G code group 24) switches in the parameterized precontrol (speed or acceleration precontrol). FFWON can only be used if precontrol is parameterized. This must be ensured by the machine suppliers.

Commands for 5-axis machining
The following commands are important for 5-axis machining:

- TRAORI enables the defined transformation and must be programmed alone in the block.
- UPATH (G code group 45) switches in the path parameter, which was developed for 5-axis interpolation.
- ORIAxes (G code group 51) linearly interpolates the orientation axes in the block up to the end of block.
- ORIWKS (G code group 25) defines the workpiece coordinate system for orientation interpolation.

CYCLE832 (High Speed Settings)
Cycle CYCLE832 (High Speed Settings) optimally supports Advanced Surface.
This cycle has been developed for this purpose and sets the above mentioned commands and the tolerance.
10.7 Application example

**Commands CTOL (Chord TOLERance) and OTOL (Orientation TOLERance)**

Commands CTOL (Chord TOLERance for chord tolerance) and OTOL (Orientation TOLERance) can be used if the tolerance is programmed without support of CYCLE832.

**Activating the G code**

Activation can be realized either using "Programming in the part program" or when commissioning machines, by re-configuring the RESET response (see \$MC_GCODE_RESET_VALUES).

**Programmable program sequence without CYCLE832**

Therefore, the following program sequence for customers to be programmed is obtained, which cannot use CYCLE832 or if the G commands do not correspond to the machine initial setting:

- SOFT
- FFWON
- FIFOCTRL
- G645
- COMPCAD
- DYNROUGH or DYNSEMIFIN or DYNFINISH {depending on the machining phase}
- TRAORI(<Transformation number>) {for 5-axis programs and transformation}
- ORIAxes
- ORIMKS
### 10.7.3 Preconditions, machine data

#### User system variables for 3 and 5-axis machining

The subsequently listed machine data should be pre-assigned as follows:

<table>
<thead>
<tr>
<th>MD</th>
<th>Name</th>
<th>Description</th>
<th>Rec. value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>10200</td>
<td>$MN_INT_INCR_PER_MM</td>
<td>Internal calculation resolution, linear axis</td>
<td>100000</td>
<td>10000 for export version</td>
</tr>
<tr>
<td>10210</td>
<td>$MN_INT_INCR_PER_DEG</td>
<td>Internal calculation resolution, rotary axis</td>
<td>=MD10200</td>
<td>10000 for export version</td>
</tr>
<tr>
<td>18360</td>
<td>$MN_MM_EXT_PROG_BUFFER_SIZE</td>
<td>Maximum reload memory when executing from external</td>
<td>500</td>
<td>Against jamming</td>
</tr>
<tr>
<td>18362</td>
<td>$MN_MM_EXT_PROG_NUM</td>
<td>Number of ext. programs that can be simultaneously processed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>20150</td>
<td>$MC_GCODE_RESET_VALUES[3]</td>
<td>Initial setting of G group 4</td>
<td>3</td>
<td>FIFOCTRL</td>
</tr>
<tr>
<td>20150</td>
<td>$MC_GCODE_RESET_VALUES[19]</td>
<td>Initial setting of G group 20</td>
<td>2</td>
<td>SOFT</td>
</tr>
<tr>
<td>20150</td>
<td>$MC_GCODE_RESET_VALUES[44]</td>
<td>Initial setting of G group 45</td>
<td>2</td>
<td>UPATH (for 5-axis machining)</td>
</tr>
<tr>
<td>20150</td>
<td>$MC_GCODE_RESET_VALUES[50]</td>
<td>Initial setting of G group 50</td>
<td>2</td>
<td>ORIAxes (for 5-axis machining)</td>
</tr>
<tr>
<td>20170</td>
<td>$MC_COMPRESS_BLOCK_PATH_LIMIT</td>
<td>Maximum length of POLY generated by the compressor</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>20172</td>
<td>$MC_COMPRESS_VELO_TOL</td>
<td>Max. deviation of the path feed for COMCAD</td>
<td>1000</td>
<td>Default</td>
</tr>
<tr>
<td>20443</td>
<td>$MC_LOOKAH_FFORM[0-1]</td>
<td>Activates the extended LookAhead in the particular technology group (DYNNORM, DYNPOS)</td>
<td>0</td>
<td>Default</td>
</tr>
<tr>
<td>20443</td>
<td>$MC_LOOKAH_FFORM[2-4]</td>
<td>Activates the extended LookAhead in the particular technology group (DYNNROUGH,DYNSEMIFIN,DYNFINISH)</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>20482</td>
<td>$MC_COMPRESSOR_MODE</td>
<td>Behavior of the compressor tolerance</td>
<td>300</td>
<td></td>
</tr>
<tr>
<td>20490</td>
<td>$MC_IGNORE_OVL_FACTOR_FOR_ADIS</td>
<td>Control of G642</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>20560</td>
<td>$MC_G0_TOLERANCE_FACTOR</td>
<td>Factor for tolerance for COMPCAD, G645, OST, ORISON</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>20600</td>
<td>$MC_MAX_PATH_JERK [0-4]</td>
<td>Path jerk</td>
<td>10000</td>
<td>Should not be effective</td>
</tr>
<tr>
<td>20602</td>
<td>$MC_CURV_EFFECT_ON_PATH_ACCEL[0-1]</td>
<td>Ratio, translatory to centripetal acceleration</td>
<td>0</td>
<td>Should not be effective</td>
</tr>
</tbody>
</table>
### 10.7 Application example

<table>
<thead>
<tr>
<th>MD</th>
<th>Name</th>
<th>Description</th>
<th>Rec. value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>20602</td>
<td>$MC_CURV_EFFECT_ON_PATH_ACCEL[2]</td>
<td>Ratio, translatory to centripetal acceleration for DYNROUGH</td>
<td>0.65</td>
<td>Must be effective so that for active curvature smoothing, the jerk is not quite so significantly exceeded!</td>
</tr>
<tr>
<td>20602</td>
<td>$MC_CURV_EFFECT_ON_PATH_ACCEL[3]</td>
<td>Ratio, translatory to centripetal acceleration for DYNSEMIFIN</td>
<td>0.6</td>
<td>Must be effective so that for active curvature smoothing, the jerk is not quite so significantly exceeded!</td>
</tr>
<tr>
<td>20602</td>
<td>$MC_CURV_EFFECT_ON_PATH_ACCEL[4]</td>
<td>Ratio, translatory to centripetal acceleration for DYNFINISH</td>
<td>0.5 (determine using the circularity test)</td>
<td>Limit rotational acceleration especially for &quot;large&quot; machines!</td>
</tr>
<tr>
<td>20606</td>
<td>$MC_PREPDYN_SMOOTHING_ON[0-1]</td>
<td>Activates curvature smoothing</td>
<td>0</td>
<td>Default</td>
</tr>
<tr>
<td>20606</td>
<td>$MC_PREPDYN_SMOOTHING_ON[2-4]</td>
<td>Activates curvature smoothing</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>21104</td>
<td>$MC_ORI_IPO_WITH_G_CODE</td>
<td>G code for orientation interpolation</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>28060</td>
<td>$MC_MM_IPO_BUFFER_SIZE</td>
<td>Memory, interpolator for number of G1 blocks</td>
<td>150</td>
<td></td>
</tr>
<tr>
<td>28070</td>
<td>$MC_MM_NUM_BLOCKS_IN_PREP</td>
<td>Memory, preparation (pre-processing)</td>
<td>80</td>
<td></td>
</tr>
<tr>
<td>28520</td>
<td>$MC_MM_MAX_AXISPOLY_PER_BLOCK</td>
<td>Maximum number of axis polynomials per block</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>28530</td>
<td>$MC_MM_PATH_VELO_SEGMENTS</td>
<td>Number of memory elements for limiting the path velocity</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>28533</td>
<td>$MC_MM_LOOKAH_FFORM_UNITS</td>
<td>Memory for extended LookAhead</td>
<td>18</td>
<td></td>
</tr>
<tr>
<td>28540</td>
<td>$MC_MM_ARCLENGTH_SEGMENTS</td>
<td>Number of memory elements to display the arc length function</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>28610</td>
<td>$MC_MM_PREPDYN_BLOCKS</td>
<td>Memory, curvature smoothing</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>29000</td>
<td>$OC_LOOKAH_NUM_CHECKED_BLOCKS</td>
<td>Number of Look Ahead blocks (this must be the same as N28060)</td>
<td>150</td>
<td></td>
</tr>
<tr>
<td>42470</td>
<td>$SC_CRIT_SPLINE_ANGLE</td>
<td>COMP criteria for target point analysis (should be &gt;30°)</td>
<td>36</td>
<td>Default</td>
</tr>
<tr>
<td>42471</td>
<td>$SC_MIN_CURV_RADIUS</td>
<td>Factor for compressor tolerance (should be 0.3-3)</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
### IBN CNC: NCK, PLC, drive

Commissioning Manual, 02/2011, 6FC5397-2AP40-0BA0

#### 10.7 Application example

<table>
<thead>
<tr>
<th>MD</th>
<th>Name</th>
<th>Description</th>
<th>Rec. value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>42500</td>
<td>$SC_IS_MAX_PATH_ACCEL</td>
<td>Limits the path acceleration via SD</td>
<td>10000</td>
<td></td>
</tr>
<tr>
<td>42502</td>
<td>$SC_IS_SD_MAX_PATH_ACCEL</td>
<td>Activates path acceleration via SD</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>42510</td>
<td>$SC_SD_MAX_PATH_JERK</td>
<td>Limits path jerk via SD</td>
<td>10000</td>
<td></td>
</tr>
<tr>
<td>42512</td>
<td>$SC_IS_SD_MAX_PATH_JERK</td>
<td>Activates path jerk via SD</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>
NCK start-up

10.7 Application example
You can optimize the drives in the "Commissioning" > "Optimization/Test" operating area.

The following functions are available:

- Frequency response measurements for the following control loops:
  - Current controller
  - Speed controller
  - Position controller
- Automatic controller setting
- Function generator
- Circularity test
- Trace
  - Servo trace
  - Drive trace
**Measuring functions**

The measuring functions make it possible to assess the automatic controller action of the respective control loop (frequency response) by the integrated FFT analysis (Fast Fourier Transformation) without external measuring equipment.

The measurement results are represented graphically as a Bode diagram. HMI file functions can be used to archive the diagrams for documentation purposes and to simplify remote diagnostics.

**Circularity test**

The circularity test serves to set and assess the dynamic response for interpolating axes or to analyze the contour accuracy on the quadrant transitions (circular contours) achieved by means of friction compensation (conventional or neural quadrant error compensation).

**Reference**

Function Manual Extended Functions, K3 Compensation, Section "Circularity test"

**Servo trace**

Servo trace provides a graphically assisted analysis of the time response of position controller and drive data.

**Drive trace**

Drive trace provides a graphically assisted analysis of the time response of drive signals.
11.1 Measuring functions

Explanation

A range of measuring functions allows the time and/or frequency response of drives and closed-loop controls to be displayed in graphic form on the screen. For this purpose, test signals with an adjustable interval are connected to the drives.

Measurement/signal parameters

The test setpoints are adapted to the application in question by means of measurement or signal parameters, the units of which are determined by the relevant measuring function or operating mode. The measurement or signal parameter units are subject to the following conditions:

<table>
<thead>
<tr>
<th>Size</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity</td>
<td>Metric system:</td>
</tr>
<tr>
<td></td>
<td>Specification in mm/min or rev/min for translatory or rotary moves</td>
</tr>
<tr>
<td></td>
<td>Inch system:</td>
</tr>
<tr>
<td></td>
<td>Specification in inch/min or rev/min for translatory or rotary moves</td>
</tr>
<tr>
<td>Distance</td>
<td>Metric system:</td>
</tr>
<tr>
<td></td>
<td>Specification in mm or degrees for translatory or rotary movements</td>
</tr>
<tr>
<td></td>
<td>Inch system:</td>
</tr>
<tr>
<td></td>
<td>Specification in inch or degrees for translatory or rotary movements</td>
</tr>
<tr>
<td>Time</td>
<td>Specified in ms</td>
</tr>
<tr>
<td>Frequency</td>
<td>Specified in Hz</td>
</tr>
</tbody>
</table>

Note

The default setting for all parameters is 0.
Preconditions for starting measuring functions

To ensure that no erroneous traversing movements due to part programs can be carried out, the measuring functions have to be started in <JOG> mode.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>When traversing movements are carried out within the framework of measuring functions, no software limit switches and working area limitations are monitored, since these are carried out in follow-up mode. Prior to starting traversing movements, the user must therefore ensure that the axes are positioned such that the traversing limits specified within the framework of the measuring functions are sufficient to prevent collision with the machine.</td>
</tr>
</tbody>
</table>

Starting measuring functions

Measuring functions initiating a traversing movement are only selected using the specific softkey. The actual start of the measuring function and thus of the traversing movement is always carried out with <NC-START> on the machine control panel.

If the main screen of the measuring function is quitted without the traversing movement being initiated, the selection of the traversing function is canceled.

Once the traversing function has been started, the main screen can be exited without any affect on the traversing movement.

Note

<JOG> mode must be selected when measuring functions are started.

Further safety notices

The user must ensure that when the measuring functions are used:

- The <EMERGENCY STOP> button is always within reach.
- No obstacles are in the traversing range.

Canceling measuring functions

The following events will cancel active measuring functions:

- Hardware limit switch reached
- Traversing range limits exceeded
- Emergency stop
- Reset (mode group, channel)
- NC STOP
11.1 Measuring functions

- No controller enabling command
- Canceling drive enable
- Canceling traversing enable
- Selection of parking (in position-controlled operation).
- Feed override = 0%
- Spindle override = 50%
- Change in operating mode (JOG) or operating mode JOG not selected
- Actuation of traversing keys
- Actuation of handwheel
- Alarms leading to axis shutdown
11.2 Frequency response measurements

11.2.1 Current control loop measurement

Functionality

The current control loop only needs to be measured for diagnostic purposes if there is a fault or if there is no standard data for the motor / power unit combination (third-party motor).

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>The user must take special safety measures when measuring the current control loop (e.g. secure drive clamping) for hanging axes without external counterweight.</td>
</tr>
</tbody>
</table>

Operating path

Operating path for measuring the current control loop: Operating area switchover > "Commissioning" > "Optimization/Test" > "Current control loop"

Measuring functions

The following measuring functions are available for measuring the current control loop:

<table>
<thead>
<tr>
<th>Measuring type</th>
<th>Measured variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference frequency response (downstream of the current setpoint filter)</td>
<td>Torque-generating actual current value / torque-generating current setpoint</td>
</tr>
<tr>
<td>Setpoint step change (downstream of the current setpoint filter)</td>
<td>Measured variable 1: Torque-generating current setpoint Measured variable 2: Torque-generating actual current value</td>
</tr>
</tbody>
</table>
Measurement

The measurement sequence is divided into the following steps:

1. Setting the traverse range monitoring and the enable logic.
2. Selecting the measurement type
3. Setting the parameters, softkey "Measuring parameters"
4. Displaying the measurement results, softkey "Display"

Figure 11-2  Current controller

Measuring parameters

- **Amplitude**
  
  Magnitude of the test signal amplitude. Given in percent of the peak torque. Values from 1% to 5% are suitable.

- **Bandwidth**
  
  The frequency range analyzed with the measurement.
  
  The bandwidth depends on the current controller sampling time.
  
  Example:
  
  125 μs current controller sampling time, set bandwidth 4000 Hz
11.2 Frequency response measurements

11.2.2 Speed control loop measurement

Functionality

The response characteristics for the motor measuring system are analyzed when measuring the speed control loop. Various measurement parameter lists are available depending on the basic measurement setting which has been selected.

Operating path

Operating path for measuring the speed control loop: Operating area switchover > “Commissioning” > “Optimization/Test” > “Speed control loop”

Measuring functions

The following measurement functions are available for measuring the speed control loop:

<table>
<thead>
<tr>
<th>Measuring type</th>
<th>Measured variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference frequency response (downstream of the speed setpoint filter)</td>
<td>Actual speed value motor encoder/speed setpoint after filter</td>
</tr>
<tr>
<td>Reference frequency response (upstream of the speed setpoint filter)</td>
<td>Actual speed value motor encoder/speed setpoint after filter</td>
</tr>
<tr>
<td>Setpoint step change (downstream of the speed setpoint filter)</td>
<td>Measured variable 1:</td>
</tr>
<tr>
<td></td>
<td>• Speed setpoint downstream of the filter</td>
</tr>
<tr>
<td></td>
<td>• Actual torque value</td>
</tr>
<tr>
<td></td>
<td>Measured variable 2: Actual speed value motor encoder</td>
</tr>
<tr>
<td>Interference frequency response (fault downstream of the current setpoint filter)</td>
<td>Actual speed value motor encoder / torque setpoint fct. generator</td>
</tr>
<tr>
<td>Disturbance variable step change (fault downstream of the current setpoint filter)</td>
<td>Measured variable 1:</td>
</tr>
<tr>
<td></td>
<td>• Torque setpoint fct. generator</td>
</tr>
<tr>
<td></td>
<td>• Actual torque value</td>
</tr>
<tr>
<td></td>
<td>Measured variable 2: Actual speed value motor encoder</td>
</tr>
<tr>
<td>Speed-controlled system (excitation downstream of the current setpoint filter)</td>
<td>Actual speed value motor encoder/actual torque value</td>
</tr>
<tr>
<td>Frequency response of the mechanical parts 1)</td>
<td>Actual speed value measuring system 1/actual speed value measuring system 2</td>
</tr>
</tbody>
</table>

1) The machine axis in question must have both a direct and an indirect measuring system to determine the frequency response of the mechanical parts.
Measurement

The measurement sequence is divided into the following steps:

1. Setting the traverse range monitoring and the enable logic
2. Selecting the measuring type and measured variable
3. Setting the parameters, softkey "Measuring parameters"
4. Displaying the measurement results, softkey "Display"

In the example shown, the speed control loop has not yet been optimized. A suitable filter parameterization is used to optimize the dynamic response. This can be called with the "Filter" softkey.

The following figure shows the standard settings for a low-pass filter at 1999 Hz (encoder mounting frequency).

Figure 11-3  Speed controller

Figure 11-4  Standard settings of the speed control loop filter
11.2 Frequency response measurements

The use of a rejection band at 1190 Hz and adaptation of the proportional gain results in the following optimized setting for the speed control loop.

Figure 11-6  Optimized speed control loop
11.2 Frequency response measurements

11.2.3 Position control loop measurement

Functionality

This measuring function basically analyzes the response to the active position measuring system. If the function is activated for a spindle without a position measuring system, an alarm is displayed. Depending on the measured variable selected, various measurement parameter lists are displayed.

Operating path

Operating path for measuring the speed control loop: Operating area switchover > "Commissioning" > "Optimization/Test" > "Position control loop"

Measuring functions

The following measuring functions are available for measuring the position control loop:

<table>
<thead>
<tr>
<th>Measuring type</th>
<th>Measured variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference frequency response</td>
<td>Actual position/position setpoint</td>
</tr>
<tr>
<td>Setpoint step change</td>
<td>Measured variable 1: Position setpoint</td>
</tr>
<tr>
<td></td>
<td>Measured variable 2:</td>
</tr>
<tr>
<td></td>
<td>• Actual position value</td>
</tr>
<tr>
<td></td>
<td>• System deviation</td>
</tr>
<tr>
<td></td>
<td>• Following error</td>
</tr>
<tr>
<td></td>
<td>• Actual speed value</td>
</tr>
<tr>
<td>Setpoint ramp</td>
<td>Measured variable 1: Position setpoint</td>
</tr>
<tr>
<td></td>
<td>Measured variable 2:</td>
</tr>
<tr>
<td></td>
<td>• Actual position value</td>
</tr>
<tr>
<td></td>
<td>• System deviation</td>
</tr>
<tr>
<td></td>
<td>• Following error</td>
</tr>
<tr>
<td></td>
<td>• Actual speed value</td>
</tr>
</tbody>
</table>
Measurement

The measurement sequence is divided into the following steps:

1. Setting the traverse range monitoring and the enable logic
2. Selecting the measuring type and measured variable
3. Setting the parameters, softkey: "Measuring parameters"
4. Displaying the measurement results, softkey: "Display"

The following figure shows an optimized position control loop in which the $K_v$ factor has been adapted via the machine data MD32200 $\text{MA\_POSCTRL\_GAIN}$.

Figure 11-7 Optimized position control loop
Reference frequency response measurement

The reference frequency response measurement determines the transmission ratio of the position controller in the frequency range (active position measuring system).

The setpoint filters, control loop gain ($K_v$ factor) and feedforward control must be parameterized such that resonance is avoided wherever possible over the entire frequency range.

Measuring parameters

- **Amplitude**
  This parameter determines the magnitude of the test signal amplitude. It should be set to the smallest possible value (e.g. 0.01 mm).

- **Bandwidth**
  The bandwidth parameter is used to set the analyzed frequency range. The larger this value, the finer the frequency resolution and the longer the measurement time. The maximum value is specified by the position controller cycle ($T_{position\ controller}$):
  \[
  Bandwidth_{\text{max}} \ [\text{Hz}] = \frac{1}{2 \times T_{position\ controller} \ [\text{sec}]} 
  \]
  Example:
  Position controller cycle: 2 ms
  \[
  Bandwidth_{\text{max}} = \frac{1}{2 \times 2 \times 10^{-3}} = 250 \text{ Hz}
  \]

- **Averaging**
  The accuracy of the measurement and measurement duration increase with this value. A value of 20 is normally suitable.

- **Settling time**
  This value represents the delay between recording of the measured data and injection of the test setpoint and offset. A value of between 0.2 and 1 s is recommended. Do not set too low a value for the settling times or the frequency response and phase diagrams will be distorted.

- **Offset**
  The measurement requires a slight speed offset of a few motor revolutions per minute. The offset must be set such that no speed zero crossings occur at the set amplitude.
Optimize the drive

11.2 Frequency response measurements

Measurement: Setpoint step change and setpoint ramp

The transient or positioning response of the position control in the time range, and in particular the effect of setpoint filters, can be assessed with the step and ramp stimulation functions.

Possible measured variables:

- Actual position value (active position measuring system)
- Control deviation (following error)

Measuring parameters

- Amplitude
  Determines the magnitude of the specified setpoint step change or ramp.

- Measurement time
  This parameter determines the period of time to be recorded (maximum: 2048 position controller cycles).

- Settling time
  This value represents the delay between measured data recording / test setpoint output and the injection of the offset.
- Ramp time
  With default setting: The position reference value is specified with the "Setpoint ramp" according to the set ramp time. In this case, the acceleration limits which currently apply to the axis or spindle are effective.

- Offset
  The step is stimulated from standstill or starting from the constant traverse speed set in this parameter.
  If an offset value other than zero is input, the step change is stimulated during traversal. For the sake of clarity, the displayed actual position value does not include this speed offset.

![Figure 11-8 Signal chart for position setpoint/ramp measuring function](image)

At maximum axis velocity, there is a (virtual) step change in the velocity (continuous line). The curves represented by the dashed line correspond to a realistic, finite value. The offset component is excluded from the display graphic in order to emphasize the transient processes.
11.2 Frequency response measurements

Measurement: Setpoint step change

To avoid overloading the mechanical system of the machine, the step height is limited to the value specified in the machine data during the "Setpoint step change" measurement:

- MD32000 $MA_MAX_AX VELO (maximum axis velocity)

This may result in failure to achieve the desired step height.

Measurement: Setpoint ramp

With measurement "Setpoint ramp", the following machine data influence the measurement result:

- MD32000 $MA_MAX_AX VELO (maximum axis velocity)

  The maximum axis velocity limits the ramp gradient (velocity limitation). The drive does not reach the programmed end position (amplitude).

- MD32300 $MA_MAX_AX ACCEL (maximum axis acceleration)

  The maximum axis acceleration limits the velocity change (acceleration limitation). This leads to "rounding" on the transitions at the beginning and end of the ramp.

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
</table>

In normal cases the machine data corresponds exactly with the load capacity of the machine kinematics and should not be changed (increased) as part of the measurements:

- MD32000 $MA_MAX_AX VELO (maximum axis velocity)

- MD32300 $MA_MAX_AX ACCEL (maximum axis acceleration)
11.3  Circularity test measurement

Functionality

The circularity test serves to set and assess the dynamic response for interpolating axes or to analyze the contour accuracy on the quadrant transitions (circular contours) achieved by means of friction compensation (conventional or neural quadrant error compensation).

Operating path

Operating path to circularity test: Operating area switchover > "Commissioning" > "Optimization/Test" > "Circularity test"

Measuring parameters

The parameters are entered in the "Measurement" menu.

- Axis names and axis numbers
- Circle that is to be traversed and the actual position values recorded
  The parameter settings in the input fields "Radius" and "Feed" must correspond to the values from the part program that controls the circular motion of the axes, taking account of the feed override switch setting.
- The "Measuring time" display field shows the measuring time calculated from the "Radius" and "Feed" values for recording the actual position values during the circular movement.

If only parts of the circle can be represented (i.e. measuring time too short) the measuring time can be increased in the menu by reducing the feed value. This also applies if the circularity test is started from the stationary condition.
Display mode

The following parameter assignments for programming the mode of representation of measurement results can also be made:

- Display based on mean radius
- Display based on programmed radius
- Scaling of the diagram axes

If the measuring time calculated exceeds the time range that can be displayed from the trace buffers (maximum measuring time = position controller cycle frequency * 2048), a coarser sampling rate is used for recording (n * position controller cycle frequency), so that a complete circle can be displayed.

The two drives selected for measurement must describe a circular interpolation (G2/G3) with the parameters shown in the example via a part program:

Radius=100 mm, F=10000 mm/min
Measurement

The measurement sequence is divided into the following steps:

1. Setting the parameters, softkey "Measurement" (see above figure).
2. Start measurement with "Start" softkey.
   The selected axes run in the part program.
3. Displaying the measurement results, softkey "Display".
   A switchover is made to the graphic illustration of the recorded circular diagram (see following figure).

Note

If required, a QEC / backlash compensation can be performed via MD32200 $MA POSCTRL_GAIN for the Kv factor optimization.

Figure 11-10  Circularity test measurement
11.4 Trace

11.4.1 Trace overview

Introduction

A trace shows signals over a time interval (signal charts)

The following functions are available:

- Servo trace
  Servo trace offers functions for recording and graphically illustrating the temporal characteristics of values for servo signals, e.g. actual position value, following error etc.

- Drive trace
  Drive trace offers functions for recording and graphically illustrating the temporal characteristics of values for signals from the drive system, e.g. actual speed value, actual current value etc.

  It must be possible for the signals to be recorded to be interconnected via a BICO source.
11.4.2 Servo trace

Basic servo trace display

The basic display of the servo trace function is reached via the operating area "Commissioning" > "Optimization/Test" > "Trace" > "Servo trace".

Parameterization in the basic display

The following selection is made in the basic display for the servo trace measurement:
- Axis/spindle selection
- Measuring signal
- Measurement time
- Trigger time
- Trigger type
- Trigger threshold

Signal selection

"Axis/spindle name" input field

The cursor must be positioned on the "Axis/spindle name" list box of the trace concerned. You can select it with the softkeys "Axis+" and "Axis-" or by accepting a value from the drop-down list box.
11.4 Trace

"Signal selection" input field

The cursor must be positioned on the "Signal selection" list box of the trace concerned. The selection is made through acceptance from the drop-down list box. The available selection options depend on the existing configuration and activated functions.

Measuring parameters

"Measuring duration" input field

The measuring time is written directly into the "Measuring duration" input field.

"Trigger time" input field

Direct entry of pre-triggering or post-triggering. With negative input values (leading sign minus -) recording begins at the set time before the trigger event.

With positive input values (without sign) recording starts the time set after the triggering event.

Condition: Trigger time + measuring duration ≥ 0.

"Trigger" input field

The trigger type is displayed in the "Trigger" drop-down list box. The trigger always refers to Trace 1. When the trigger condition is satisfied, Traces 2 to 4 are started simultaneously.

Settable trigger conditions:

- "No trigger", i.e. measurement starts by pressing softkey "Start" (all traces are started time-synchronized)
- "Positive edge"
- "Negative edge"
- "Trigger event from the part program"

The trace can be started via an NC part program in conjunction with the system variable $AA_SCTRACE [axis identifier].

Reference

SINUMERIK 840D sl / 840Di sl System Variable Manual

"Threshold" input field

Direct input of the trigger threshold. The threshold is only effective with trigger types "Positive edge" and "Negative edge". The unit refers to the selected signal.
Softkeys "Axis+" and "Axis-"

Selection of the axis/spindle when the cursor is positioned on the appropriate "Axis/spindle name" list field.

You can also select the axis/spindle directly in the list box from the drop-down list using the cursor.

Softkeys "Start" and "Stop"

Trace function recording is started with the softkey "Start".

With the "Stop" softkey or RESET, you can cancel a running measurement.
11.4.3 Drive trace

Basic drive trace display

The basic display of the drive trace function is reached via the operating area "Commissioning" > "Optimization/Test" > "Trace" > "Drive trace".

![Drive trace display](image)

Figure 11-12 Basic "drive trace" display

When you are in the field for signal selection for a signal, you can press the <SELECT> button to move to a window in which you can determine the signal for interconnecting.

![Drive trace interconnections](image)

Figure 11-13 Drive trace interconnections
If you scroll through the basic display, the following parameters are displayed:

**Parameterization in the basic display**

The following selection is made in the basic display for the drive trace measurement:

- Drive unit selection
- Signal selection
- Record
- Trigger

**"Trigger time"/"Delay" entry field**

Direct entry of pre-triggering or post-triggering. With negative input values (leading sign -) recording begins at the set time before the trigger event.

With positive input values (without sign) recording starts at the time set after the triggering event.

**Secondary condition:** Trigger time + measuring time ≥ 0.

**"Trigger type" entry field**

The trigger type is displayed in the "Trigger" drop-down list.

Settable trigger conditions:

- "Record immediately"
  This means no trigger, i.e. measurement starts by pressing the "Start" softkey.
- "Positive edge"
- "Negative edge"
- "Entry in the hysteresis band"
Optimize the drive

11.4 Trace

- "Exiting the hysteresis band"
- "Trigger on bit mask"

Reference
SINAMICS S120 List Manual

Signal selection

Signals to be recorded, e.g. actual speed value, actual current value etc.
It must be possible for the signals to be recorded to be interconnected, i.e. a BICO source.

Trigger signal

The trigger (signal) can be used to specify the event with which the recording of values is to start, e.g. the actual speed value is not to be recorded straightaway when the drive trace starts but only when the actual current value is > 10 A (here the actual current value trigger is > 10 A).

"Drive unit+" and "Drive unit-" softkeys

Selection of drive unit in which recording is to take place.

Softkeys "Start" and "Stop"

Trace function recording is started with the softkey "Start".

Figure 11-15 Drive trace recording

You can cancel an active recording with the "Stop" softkey or RESET.
11.5 Further optimization options

Introduction

You can adapt the following parameters in the operating area "Commissioning" > "Machine data" > "Drive MD" for the drive optimization.

Speed adjustment

- Spindle drive:
  \[ p_{500} = 102, \text{ speed setpoint in } p_{322} \text{ corresponds to setpoint } 4000\,0000\text{hex} \]
- Feed drive:
  \[ p_{500} = 101, \text{ speed setpoint in } p_{311} \text{ corresponds to setpoint } 4000\,0000\text{hex} \]

The speed setpoint can be diagnosed in the corresponding drive in \( r_{2050}[1+2] \) or \( r_{2060}[1] \).

Brake behavior OFF3

Depending on the requirements, the brake behavior for each drive can be adjusted to the signal 2.OFF3. Default setting: \( p_{1135} = 0 \), brake with maximum current.

Parameters \( p_{1135}, p_{1136}, p_{1137} \) can be used to set a flatter braking ramp for drive-specific parameterization.

Maximum braking ramp setting: 600 secs
11.5 Further optimization options
12.1 Automatic servo optimization

Introduction

With the SINUMERIK Operate sl user interface under the "Commissioning" > "Automat. Servo Opt." menu, you have the following options for automatic axis optimization:

- Selection of individual axis for optimization
- Selection of one strategy from many options
- Reconfiguration of measurement conditions
- Chart display and activities protocol for optimization process
- Display of current measurement and at the same time the average of previous measurements
- Checking and processing of optimization results for speed and position controller
- Accept or reject results

Figure 12-1 Basic display for automatic optimization of SERVO axes
12.2 Overview of navigation

Overview

When optimizing an axis, you navigate via various dialog screens. The following figure shows the navigation options for optimizing an axis:

Note

The master slave axes for automatic optimization are not supported by SINUMERIK Operate Version 2.6 SP1.

Master slave axes can be optimized as individual axes if they are not coupled.
Drive optimization using SINUMERIK Operate

12.2 Overview of navigation

Figure 12-2 Navigation for automatic optimization of an individual axis

Note

The following section "General operating sequences for automatic servo optimization" uses the numbers shown in the above diagram (e.g. dialog screen "Strategy selection" ②).
12.3 Setting options

Introduction

The general behavior of the automatic servo optimization can be controlled in the main screen using the "Options" softkey.

![Options softkey screenshot]

Figure 12-3 Options

Options

- Perform all measurements of each measurement series with the first NC start:
  All repeats (e.g. motion in the positive and negative axis direction) within a measurement series are automatically started.
- Start measurements automatically:
  The start screen of each measurement series is skipped and the measurement process is directly started with the default measurement parameters.
- Automatic confirmation of the measurement:
  The final screen of each measurement series (is used to evaluate the measurement results -> if required, adapt measurement parameters and restart measurement series) is skipped. The algorithm changes directly to the next optimization step.
- Automatic acknowledgement of the controller data:
  The "controller data overview" display is skipped. The controller data determined by the algorithm are directly activated.
- Automatic data activation using the operator panel reset:
  The "Operator panel reset" signal is generated by the algorithm. If this option is deactivated, "Operator panel reset" is requested using a dialog screen.
• Automatically backup drive boot files (ACX format):
  After completing the optimization of a machine axis, the drive data are automatically saved on the CompactFlash Card in the ACX format. If this option is deactivated, the query is realized via a dialog screen.

• Permit strategy selection:
  The dialog screen to select the optimization strategies for the speed and position controller is displayed.

• Backup measurement data in temporary directory:
  The recorded measurement data are saved in a temporary directory.

• Perform preliminary measurement to determine the excitation:
  Activate a preceding (additional) measurement for each measurement series to more precisely determine the measurement parameters. This is especially recommended when measuring directly-driven machine axes for the first time.
12.4 General operating sequences for automatic servo optimization

General operating sequences

1. In the "Commissioning" operating area, press the "Automat. servo opt." softkey. "Axis selection" dialog screen appears ①.

![Figure 12-4 Axis selection](image)

2. Use the cursor keys to select an axis for optimization.

![Figure 12-5 Axis selection, gantry axis grouping](image)

Note

For "Gantry axis groups", only the leading axis is displayed with the "Gantry" note. Synchronous axes are hidden, but when selecting the leading axis, are measured and optimized.
3. In the "Axis selection" dialog screen ①, press the "Optimize" softkey.

4. In the "Strategy selection" dialog screen ②, select the strategy for optimization.

![Strategy selection screen](image)

For example in a typical strategy, the mechanical controlled system of the speed control is measured and gains and filters defined for optimized dynamic behavior.

**Note**

A user-specific strategy (Page 255) can be set using a vertical "Custom/manufacturer" softkey.

5. Press "OK".
6. In the "Axis park position" dialog screen (3), move the axes on the machine into a safe position for optimization.

![Figure 12-7 Axis park position](image)

**DANGER**

Automatic servo optimization based on analysis of measurements. The measurements require the axis to move. Ensure that all axes are in a safe position and no collisions will occur during the traversing motion that is required.
7. Press "OK".

Optimization is started ⑤.

![Optimization in progress](Image)

If measurement can only be continued after the necessary inputs have been made, then this is signaled using input prompts (screen forms).

This is required because you need to initiate certain machine processes (e.g. measurements which require an <NC START>).

You can abort the coordination process at any stage of automatic servo optimization.
Once optimization has been aborted, all original machine data, which was present in the control and in the drives before optimization was started, is restored.

**Note**

After the measurement has been completed, you can perform the measurements again. In this case, the quality of the measurement data can be influenced by changing the excitation parameters using the dialog screen "Measurement configuration".
Drive optimization using SINUMERIK Operate

12.4 General operating sequences for automatic servo optimization

8. If the optimization process has completed some optimizations for a control loop, a "Controller data overview" dialog screen ⑦ appears.

![Figure 12-10 Controller data overview](image)

![Figure 12-11 Controller data, overview gantry axis group](image)

You can modify and check the results and either accept or reject the proposed control parameters.

**Note**

Alternatively the optimized values can also be displayed graphically as a Bode diagram using the "Bode diagram" softkey function.

9. Select "Transfer" to transfer the values calculated.
10. If you accept the settings for closed-loop speed control by pressing "Transfer", the drive data is updated, and the strategy then runs the measurements for closed loop position control, "Measurement is running" dialog screen ⑥.

Figure 12-12 Measurement is running

Figure 12-13 Measurement running, gantry axis group

11. Once the optimum values for closed loop position control have been selected, the data is transferred to the CNC and drives, and the strategy runs the next stage which may be e.g. to measure for verification.
12.5 Setting the user-specific strategy

Introduction

You can go to the area "Design user-specific strategy" in screen ② "Strategy selection" using the vertical softkey "Custom/manufacturer".

Various settings can be selected or deselected in order to control the behavior of the automatic servo optimization.

For the user-specific strategy, settings of the general axis strategy are handled separately from the settings specifically for the speed or position controller.

![Figure 12-14 Setting the user-specific strategy]

Setting areas

- **Axis**
  Activating/deactivating individual measurements and optimization steps for the selected machine axis - including entering the measurement parameters.

- **n/v controller**
  Settings exclusively to optimize the speed or velocity controller of the selected machine axis.

- **Position controller**
  Settings exclusively to optimize the position controller of the selected machine axis.
12.6 Additional optimization stages - commissioning interpolation axes

Additional optimization stages

Additional optimization stages should be undertaken for axes which make up a collection of interpolations. These optimization steps should be undertaken manually by the commissioning engineer using the options provided in HMI Advanced or the start-up (commissioning) tool:

e.g.:

- Circularity test measurement (Page 231)
- Adaptation of servo gains (e.g. smallest servo gain in all interpolating axes without DSC see Position control loop measurement (Page 225))
- When using speed feed forward control, transfer equivalent time constants of the slowest axis (highest value) into all interpolating axes (see Speed control loop measurement (Page 222)).
Commissioning external drives

13.1 Introduction (PLC drive <-> NC drive)

Introduction

A distinction is made between integrated and external drives using the physical bus arrangement.

Integrated drive

The drives, which are connected to the internal, virtual PROFIBUS, can only be assigned to NC axes.

The assignment is realized using the axis machine data:

- MD30110 $MA_CTRLOUT_MODULE_NR (setpoint channel)
- MD30220 $MA_ENC_MODUL_NR (actual value channel)
- MD30130 $MA_CTRLOUT_TYPE (setpoint type of output)
- MD30240 $MA_ENC_TYPE (actual value sensing)

Further, the logical I/O addresses ≥ 4100 are defined in the general machine data:

- MD13050 $MN_DRIVE_LOGIC_ADDRESS (axis address)
External drive

Drives, which are connected to external buses, e.g. DP1 and/or DP2 - can be assigned to the following drives:

- PLC drives:
  - Data is directly exchanged with the PLC user program
  - Integrated in the part program operations using an H command

- NC drives with NC axes:

  The NC axes are assigned using the above mentioned NC machine data with changed logical I/O address ≤ 4095 in the general MD13050 $MN_DRIVE_LOGIC_ADDRESS.

**Note**

A drive that can be assigned to an NC axis must be a standard slave according to the PROFIdrive profile version 4.1.

**Note**

In certain version combinations, the integration functions are checked for compatibility. The following versions are supported:

- SINUMERIK from CNC software 2.6 SP1 up to CNC software 2.7 with:
  - CU320DP from SINAMICS firmware Version 2.6 SP2
  - CU310DP from SINAMICS firmware Version 2.6 SP2

- SINUMERIK from CNC software 4.4 with:
  - CU320-2DP from SINAMICS firmware Version 4.4
  - CU310-2DP from SINAMICS firmware Version 4.4

All other SINAMICS drives can be connected to the PLC as standard slaves in accordance with PROFIdrive profile and are not included in the quantity structure, according to the following table "Quantity structure".

Slight differences between the SINAMICS versions of the integrated and external drives should be taken from the upgrade instructions.

**Note**

With CNC software 4.4, no SINAMICS drives with PROFINET connection are separately supported.
Operator control options with HMI for an external drive

External drives, type SINAMICS S120 can be e.g. CU320 or CU310. These drives communicate on the external PROFIBUS DP1/DP2 (as PNO Ident 0x80E5).

These external drives are supported by SINUMERIK HMI with the following advanced operator options:

- Automatic device configuration (Page 73)
- Only for HMI Advanced
  - Guided commissioning (Page 70), with the known drive wizards for SERVO DOs.

**Note**

Other guided commissioning wizards (e.g. vector control) are not provided in SINUMERIK HMI. The appropriate version of STARTER can be used for this purpose.

- Manual commissioning (Page 98) performed by experienced commissioning engineers.

- All parameters of the drive DOs are shown in the operating area "Start-up" > "Machine data", e.g.
  - "Control Unit MD" for the DO1 drive unit
  - "Infeed MD" for DriveCLiQ Line Module, generally DO2
  - "Drive MD" for drive control DOs

Parameters of the integrated drives with SINUMERIK view as well as external drives with SINAMICS view are displayed.

- Series commissioning support, where the parameters of these external drives are also handled (backing-up/loading) also in the series commissioning drive archive.
- Topology views including a list of all of the drive units of this type which have been found.
- Diagnostics with alarms from these PLC drives whose time stamp is synchronized with the system.

In this case, it is necessary that the following general machine data are pre-assigned:

- MD13120[...] $MN_CONTROL_UNIT_LOGIC_ADDRESS
  I/O address on a DO1 telegram, type SINUMERIK telegram 390
- MD13150 $MN_SINAMICS_ALARM_MASK
  Set bit 2 -> faults of external drives are displayed
  Set bit 10 -> alarms of external drives are displayed
Commissioning external drives

13.1 Introduction (PLC drive <-> NC drive)

General Information

- The number of these drive objects (DOs) is limited on an NCU-for-NCU basis as an additional communication load is obtained as a result of the additional operator control options for these external drives.
  - Alarm 380077 "PROFIBUS/PROFINET: Too many DOs: actual %2, maximum %3 in DO group %1"
  - Quantity structure (see table below)

- Depending on the versions used, the texts displayed for the SINAMICS parameters and alarms can be incomplete.

- The extended operator control options are guaranteed in conjunction with the drive unit, infeed and the axis drive SERVO-DO. This is the reason that a device-granular view is considered. All SERVO-DOs of a drive unit can either be assigned to the NC or PLC.

- In an extreme situation, all NC axis assignments can be realized at axis drives at the external DP1 or DP2.

- If the drives are assigned to the NC and distributed across several buses, such as DP1, DP2 and DP3, it must be ensured that each equidistant bus has the same clock cycle settings.

Note

Observe the following for SINUMERIK 840D sl:

- A DO1 drive unit is required for the internal virtual PROFIBUS DP3 for access to the onboard I/O including probe.

- ADI4 can only be assigned to NC axes. The number of ADI4 does not reduce the maximum number of managed DO1 drive units

- The HMI does not support 611U connected to SINUMERIK solution line; it has not been checked as far as its reactions are concerned - and has therefore not been released.

Note

Please note the following for all drive units connected to an external DP1 or DP2:

- In the configuration, the user must take into account the supply as well as the switch-on and switch-off behavior in interaction with the other axes and their supply.

Note

When wiring terminals, observe the guidelines for the machine configuration Chapter 6. In the simplest case, the feedback of the Line Module is connected to the external PLC drives (see Terminal assignment of the digital inputs/outputs (Page 31) )
Commissioning external drives

13.1 Introduction (PLC drive <-> NC drive)

Quantity structure

Table 13-1  Quantity structure

<table>
<thead>
<tr>
<th>Quantity structure-scaling</th>
<th>840D si NCU type</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>NCU710</td>
</tr>
<tr>
<td>Drives (drive control DOs) in total (1):</td>
<td>15</td>
</tr>
<tr>
<td>Of which, assigned to the NC, maximum (2):</td>
<td>6/8(4)</td>
</tr>
<tr>
<td>Resulting from this, those not assigned to the NC, minimum:</td>
<td>9/7(5)</td>
</tr>
<tr>
<td>Not assigned to the NC, maximum:</td>
<td>15</td>
</tr>
<tr>
<td>Drives units (DO1) with drive control objects, in total (3):</td>
<td>9</td>
</tr>
<tr>
<td>Of which, at the virtual, integrated PROFIBUS, maximum (3):</td>
<td>4</td>
</tr>
<tr>
<td>Of which, at the virtual, integrated PROFIBUS, minimum:</td>
<td>1</td>
</tr>
<tr>
<td>Of which, at DP1/DP2 minimum:</td>
<td>5</td>
</tr>
<tr>
<td>Of which, at DP1/DP2, maximum:</td>
<td>8</td>
</tr>
</tbody>
</table>

1) Drive control DOs -> with software version 2.6 must be SERVO-DOs
2) DP1 -> 1st PROFIBUS interface of the integrated PLC
   DP2 -> 2nd PROFIBUS interface of the integrated PLC
3) Sum is monitored using Alarm 380077
4) "6" for SW 2.7; "8" for SW 4.4
5) "9" for SW 2.7; "7" for SW 4.4

Commissioning external drives

Commissioning PLC drives is described step-by-step in the following Chapters.
13.2 Commissioning PLC drives

13.2.1 Example configuration

Overview

The SINAMICS drive system for PLC drives communicates with the PLC via the external PROFIBUS DP.

The commissioning described in this chapter orientates itself to an example configuration of the SINAMICS drive line-up.

The following figure roughly shows the components.

- Was commissioned:
  - NCU 720 and NX15 with additional components.

- Will be commissioned in this chapter:
  - CU320 with:
    - An infeed (Active Line Module)
    - Three Single Motor Modules
  - CU310DP with:
    - A PM340 Power Module
Note

This example also applies to CU3x0-2 drives.

Figure 13-1 PROFIBUS DP configuration example
13.2 Commissioning PLC drives

13.2.2 Principle procedure when commissioning

Overview

The following commissioning steps are performed when commissioning PLC drives for the first time:
1. PLC commissioning
2. Generating a PLC user program
3. Commissioning external drives
4. Commissioning communication NCK<->Drive

13.2.3 PLC commissioning

Introduction

The PLC must be notified of the PROFIBUS communication interfaces of SINAMICS. You generate a SIMATIC S7 project using the SIMATIC Manager.

To do this, perform the following steps:
- Insert CU320 in HW Config
- Configure the properties of the PROFIBUS interface
- Insert CU310DP
- Configure the properties of the PROFIBUS interface
- Compile the configuration and then download to the PLC

Also see Chapter PLC commissioning (Page 49) for the integrated drive.

Note

The toolbox must have been installed.

The GSD file for SINAMICS S120 from the SINUMERIK toolbox is required for configuration.

The following preferred telegrams are supported:
- Standard telegram 2
- SIEMENS telegram 116
- SIEMENS telegram 390
Precondition

- You have connected the PG/PC to the PLC (see Connect PG/PC with the PLC (Page 47)).
- You have started the SIMATIC Manager and created a project (see Creating a project (Page 50)).
- You have inserted a SIMATIC Station-300 in the project (see Inserting a SIMATIC station 300 (Page 50)).
- You have started HW Config.
- You have inserted and configured an NCU 720 and NX 15 at the integrated PROFIBUS (see Insert NCU 7x0 in HW config (Page 52)).
Inserting CU320 operating sequence

1. Search in the catalog under "PROFIBUS DP" > "SINAMICS" > "SINAMICS S120" > "S120 CU320" (see following figure).

![HW Config S120 CU320](image)

2. Keeping the lefthand mouse key pressed, drag the "S120 CU320" in the station window to PROFIBUS (9): DP master system.
3. After releasing the mouse key, in the dialog box, configure the properties of the PROFIBUS interface SINAMICS.

![Figure 13-3 Properties, PROFIBUS interface SINAMICS](image)

4. Press "OK".

![Figure 13-4 Properties, SINAMICS CU320](image)

5. In the selection box "Version", select the firmware version of the Control Unit.

**Note**

The firmware version must match the version of the CompactFlash Card on the CU320. Refer to the upgrade instructions for the versions that have been released for external drives.

6. Press "OK".
7. In the "DP Slave Properties" dialog box, select the "Configuration" tab.

![Figure 13-5 DP slave properties, telegrams](image)

8. Select the telegrams required for the individual objects (axes and CU320) (see following figure).
   - 3x "Standard telegram 2, PZD-4/4" for e.g. speed axes.
   - "SIEMENS telegram 390, PZD-2/2" for CU320

**Note**

SIEMENS telegram 390 is required for the time stamp of the PLC alarms.

![Figure 13-6 DP slave properties, telegrams CU320 overview](image)
9. Click on the "Details" tab in the "Configuration" window.

![Figure 13-7 DP slave properties, configuration details](image)

**Note**

You can now view the generated input and output addresses on PROFIBUS for the individual objects.

The input and output addresses must be identical to support automatic device commissioning.

These addresses are required for the PLC user program in FB283 (see Generate PLC user program (Page 273)).

10. Press "OK".
Inserting CU310DP operating sequence

1. Search in the catalog under "PROFIBUS DP" > "SINAMICS" > "SINAMICS S120" > "S120 CU310DP" (see following figure).

Figure 13-8 CU320 inserted, CU310DP selected

2. Keeping the lefthand mouse key pressed, drag the "S120 CU310DP" in the station window to PROFIBUS (9): DP master system.

3. After releasing the mouse key, in the dialog box, configure the properties of the PROFIBUS interface SINAMICS.
4. In turn, you configure the properties (see following figures).

![Figure 13-9 SINAMICS CU310 properties](image)

Figure 13-9  SINAMICS CU310 properties

![Figure 13-10 DP slave properties, telegrams CU310DP overview](image)

Figure 13-10  DP slave properties, telegrams CU310DP overview

![Figure 13-11 DP slave properties, telegrams CU310DP details](image)

Figure 13-11  DP slave properties, telegrams CU310DP details
5. You have inserted and configured the hardware in HW Config.

Operating sequence, save/compile/load into the module

1. Select the menu "Station" > "Save and compile"

2. Click on the button "Load in module", to load the configuration to the PLC.

   See also End hardware configuration and load to the PLC (Page 61).

The next step is to create the PLC user program.
13.2.4 Generate PLC user program

Introduction
You generate the PLC user program using the SIMATIC Manager.

The SIMATIC STEP7 documentation describes how to modify and extend an application program.

The chapter explains how to program the function blocks for PLC drives using an example.

Precondition
You require the SINAMICS toolbox V1.x for this example.

The SINAMICS toolbox is in the SINUMERIK toolbox in directory BSP_PROG.

The path depends on the version, e.g. -> \8x0d\020606\BSP_PROG\Toolbox_S120_V13_HF1.zip.

You can also download the SINAMICS toolbox V1.x under the following link:

Operating sequence
1. You are on the main screen of the SIMATIC Manager.
2. You have created a project.
3. Select the "File" > "Open" menu and then click on the "User projects" tab.
4. Open the project example.
5. Copy blocks FB283, FC70, DB70 and DB283 into your existing project.
6. As the DB70 could be used by another program, rename DB70 as DB111!
7. Edits blocks OB1, FC70 and FC73.

Block OB1

... 
... 
CALL FC70 
CALL FC73 
... 
...
13.2 Commissioning PLC drives

FC70

CALL FB 283, DB283
NR_ACHS_DB := 111
LADDR := 300  //Logical I/O address
LADDR_DIAG := 8186  //Diagnostics address
WR_PZD := P#DB111 DBX172.0 Byte 8  //Source range for outputs
RD_PZD := P#DB111 DBX212.0 Byte 8  //Target range for inputs
CONSIST := TRUE
RESTART := FALSE
AXIS_NO := B#16#3  //Drive object number

FC73

L W#16#47E
T DB111.DBW 172  //Issue all enable signals to drive
        //with the exception of ON/OFF1
        //RESET
U E 3.7  //RESET MCP
        = DB111.DBX 173.7

Additional entries

Using the variable table, the missing ON/OFF1 enable signal can now be set:
DB111.DBX173.0

Further, the speed setpoint must be entered into DB111.DBW174.

In our example (standard telegram 2), 4000hex corresponds to the rated speed in drive
parameter p2000.
Significance of the signals "WR_PZD" and "RD_PZD"

Table 13-2 Signals "WR_PZD" and "RD_PZD"

<table>
<thead>
<tr>
<th>Signal</th>
<th>Type</th>
<th>Range of values</th>
</tr>
</thead>
<tbody>
<tr>
<td>WR_PZD</td>
<td>I</td>
<td>P#Mm.n byte x.. P#DBnr.dbxm.n byte x</td>
</tr>
<tr>
<td>RD_PZD</td>
<td>I</td>
<td>P#Mm.n byte x.. P#DBnr.dbxm.n byte x</td>
</tr>
</tbody>
</table>

- Target range for process data, master → slave (control words/setpoints)
- Here, generally the axis DB is used, i.e. in the pointer, the same DB-No. must be specified as formal parameter "NR_ACHS_DB"
- The length of the pointer depends on the telegram.
- Standard telegram 2: 8 bytes
- Siemens telegram 116: 22 bytes
- Target range for process data, master ← slave (status words/actual values)
- Here, generally the axis DB is used, i.e. in the pointer, the same DB-No. must be specified as formal parameter "NR_ACHS_DB"
- The length of the pointer depends on the telegram.
- Standard telegram 2: 8 bytes
- Siemens telegram 116: 38 bytes

Load project to PLC

You have completed the programming of the user memory
Now load the project to the PLC (Page 65).

Commissioning the PLC has been completed

NOTICE

A reset (warm restart) of the NCK and HMI is required for the HMI-PLC-NCK synchronization.
See Chapter Triggering a reset (warm restart) for NCK and drive system (Page 70)

The PLC and NCK are in the following state after a reset (warm restart):

- LED RUN illuminates GREEN continuously.
- Status display shows a "6" with a flashing point.
- ⇒ PLC and NCK are in cyclic operation.

You have completed the first commissioning of the PLC.
You commission the devices, infeed(s) and drives in the next step.
See also Guided commissioning of SINAMICS drives (Page 70).
13.2.5 Commissioning external drives

Introduction

The following description for commissioning briefly discusses the automatic configuration of the devices via the user interface of HMI-Advanced.

Commissioning drive components of an external PROFIBUS corresponds to the SINAMICS commissioning of an integrated drive (Page 70) with SERVO drives.

Preconditions

- You have loaded the PLC project into the PLC.
- To synchronize the PLC-NCK-HMI, you have initiated a reset (warm restart) for the NCK and the drive system.
- The PLC and NCK are in the following state after a reset (warm restart):
  - LED RUN illuminates GREEN continuously.
  - Status display shows a "6" with a flashing point.
  - PLC and NCK are in cyclic operation.
Operating sequence

1. At the HMI, select the "Commissioning" > "Drive system" menu. Alarm "120 402,....First commissioning of SINAMICS required!" is displayed in the area for alarms.

Figure 13-13 "Commissioning" > "Drive system" menu

2. Press the "Drive units" to start the automatic device configuration.

Figure 13-14 Menu "Commissioning" > "Drive system" > "Drive units" > Query

3. Press "OK"."
4. The individual steps for automatic device configuration are displayed one after the other in the following dialog box:

![Device configuration running](image)

Figure 13-15  Device configuration running

5. You are guided through the automatic device configuration up to commissioning of the individual drive objects that have still not been commissioned.

The commissioning corresponds to the SINAMICS commissioning via an integrated PROFIBUS.

For additional commissioning steps, please refer to Chapter Commissioning integrated drives (NCU) (Page 69) from Chapter Automatic device configuration (Page 73).

### 13.2.6 Commissioning communication NCK<->Drive

**Introduction**

The PLC alarms of the drives communicating at the external PROFIBUS, must have an identical time stamp with the NCK.

For the configuration in HW Config, this is the reason that you defined SIEMENS telegram 390 for the CU320 and CU310DP devices.

The corresponding logical input and output addresses of this communication interface must be entered in the general machine data MD13120[...] CONTROL_UNIT_LOGIC_ADDRESS.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can view these logical addresses in HW Config when configuring the DP Slave properties of SINAMICS components under &quot;Details&quot;.</td>
</tr>
</tbody>
</table>
Operating sequence

Please check the following logical addresses in the menu "Commissioning" > "Machine data" > "General machine data" in MD13120[...]:

- MD13120[6] logical address for CU320 -> "324"
- MD13120[7] logical address for CU310DP -> "338"

Press "Reset (po)....)

The changed machine data are updated.

This completes the commissioning of the external drive.
13.3 Configuring safety functions for external drives

Introduction

The Chapter "Configuration of Safety functions for external drives" only partially describes how an external drive can be integrated in a safety-related application.

In this case, the published supplement of the PROFIdrive profile that includes drive-based safety functions via the PROFIsafe supplement with telegram 30 is used.

Reference

For the implementation, reference is made to the following function manuals for safety functions, which are binding for the safety-related version:


Basic procedure

The following steps are necessary to integrate drive-based safety functions:

- Configuration with SIMATIC Manager under HW Config.
- Embedding in safe programmable logic (SPL).
- Configuration of test cases with SinuCom NC ATW that must go through an acceptance procedure.

13.3.1 Configuration with SIMATIC Manager under HW Config

Precondition

The chapter PLC commissioning (Page 264) describes in detail the operating sequence when you create a project with SIMATIC Manager. The chapter goes into detail on the configuration in HW Config.

A CU320 has been inserted and for the operating sequence 8, in the dialog box of the "DP Slave Properties" the telegrams selected.

Provided that the option package "S7 Configurations Pack" has been installed, the following steps are necessary here for telegram 30:
Operating sequence

1. Select a telegram.

![Selecting a telegram](image1)

2. For this telegram, in the selection field "Option", select the PROFIsafe telegram 30.

![Selecting PROFIsafe telegram 30](image2)

3. Under the "Details" tab, set the input/output addresses.

   The PROFIsafe option requires an additional 6 bytes.
4. To do this, press the "PROFIsafe ..." button.

![Figure 13-19 Setting the input and output addresses](image)

5. Set the "F_Dest_Add".
   - Under "Parameter name", you select "F_Dest_Add".
   - You can change the value using the "Change Value.." button.
   - Note down the value.

![Figure 13-20 "F_Dest_Add" setting](image)

The value of the parameter "F_Dest_Add" must be entered in p9610 and p9810 as a hexadecimal value of the corresponding drive (e.g. 200 decimal corresponds to C8 hexadecimal).

The value of the "F_Source_Add" must match the other PROFIsafe modules and must also be entered in MD 10385 $MN_PROFISAFE_MASTER_ADDRESS.

It must be ensured that the same source address is set for all PROFIsafe modules.
13.3.2 Embedding in safe programmable logic (SPL) based on the example of an SPL of SINUMERIK 840D sl

**Introduction**

The following machine data and files must be taken into account when embedding telegram 30 in a safe programmable logic:

- NC machine data
- Drive machine data
- "safe.SPF" file
- PLC program expansion

**NC machine data**

- Not bold: Values already used by PROFIsafe / F-Send/F-Rec.
- **Bold:** Values that have been added as a result of telegram 30.

The SPL PROFIsafe configuration for the basic safety functions STO without SSI are then shown as example:

<table>
<thead>
<tr>
<th>Archive excerpt</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHANDATA(1)</td>
<td></td>
</tr>
<tr>
<td>N10385 $MN_PROFISAFE_MASTER_ADDRESS='H50007d2'</td>
<td>;=&gt; entry from HW Config</td>
</tr>
<tr>
<td>N10386 $MN_PROFISAFE_IN_ADDRESS[0]='H50000c8'</td>
<td>;=&gt; entry from HW Config</td>
</tr>
<tr>
<td>N10387 $MN_PROFISAFE_OUT_ADDRESS[0]='H50000c8'</td>
<td>;=&gt; entry from HW Config</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>N10390 $MN_PROFISAFE_IN_ASSIGN[0]=9011</td>
<td>;=&gt; INSE[9] for S_STW1.0 No Safe Torque Off</td>
</tr>
<tr>
<td></td>
<td>;=&gt; INSE[10] for S_STW1.1 No Safe Stop 1</td>
</tr>
<tr>
<td></td>
<td>;=&gt; INSE[11] for S_STW1.7 INTERNAL_EVENT_ACK</td>
</tr>
<tr>
<td></td>
<td>; No extended functions</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>N10400 $MN_PROFISAFE_OUT_ASSIGN[0]=9011</td>
<td>;=&gt; OUTSE[9] for S_ZSW1.0 Power removed</td>
</tr>
<tr>
<td></td>
<td>;=&gt; OUTSE[10] for S_ZSW1.1 Safe Stop 1 not active</td>
</tr>
<tr>
<td></td>
<td>;=&gt; OUTSE[11] for S_ZSW1.7 INTERNAL_EVENT</td>
</tr>
<tr>
<td></td>
<td>; No extended functions</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>N13300 $MN_PROFISAFE_IN_FILTER[0]='H83'</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>N13320 $MN_PROFISAFE_OUT_FILTER[0]='H83'</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
</tbody>
</table>
13.3 Configuring safety functions for external drives

Drive machine data

- Values that have been added as a result of telegram 30:
  
  \[ p9601 = p9801 = 0x8 \]
  
  \[ p9610 = p9810 = 0xC8 \]

"safe.SPF" file

**Program example**

```plaintext
IDS = 40 DO $A_OUTSE[09] = $A_INSE[2] ; If the cover is locked then deselect STO
IDS = 41 DO $A_OUTSE[10] = $A_INSE[2] ; If the cover is locked then deselect SS1
```

PLC program expansion

**Program example**

```plaintext
U "SPL".SPL_DATA.INSEP[2]; // => cover switch locked?
= "SPL".SPL_DATA.OUTSEP[9]; // $A_OUTSE[9] = 1 => Deselect STO
= "SPL".SPL_DATA.OUTSEP[10]; // $A_OUTSE[10] = 1 => Deselect SS1
// Enable signal OFF1 set:
UN "SPL".SPL_DATA.INSEP[9]; // => No STO?
UN "SPL".SPL_DATA.INSEP[10]; // => No SS1?
U E 0.0; // of course, only if OFF1 is also requested by switch

= "CU320_A".Speed_Control.WR_PZD_DREHZÄHL.STW1.Aus1;
```

13.3.3 Configuration of test cases with SinuCom NC SI-ATW that must go through an acceptance procedure

**Note**

SinuCom NC SI-ATW, which can be used for the acceptance of safety-related SINUMERIK Safety Integrated functions, can also be used to accept certain drive-based safety functions.

The following example for STO (Safe Torque Off)/SH (safe standstill) of an external SINAMICS CU3xx device shows these functions.

**Note**

For safety-related acceptance, the function manuals, as specified in Chapter Configuring safety functions for external drives (Page 280), are binding.
Basic operator input options when ATW is running

The tests for the drives of the CU320 are integrated into the ATW using the "Function inter-relationships". For the parameters there are two options:

1. The contents of the parameter are entered into the result box.
2. The "setpoint/reference" values are located in the condition box and are only confirmed in the result box with "OK" if there is a match.

Test 1: Checking the version parameters

![Figure 13-21 Test 1: Checking the version parameters](image)
13.3 Configuring safety functions for external drives

Figure 13-22 Test 1: Checking the version parameters

Test 2: Checking the SI monitoring clock cycles

Figure 13-23 Test 2: Checking the SI monitoring clock cycles
Test 3: Testing the safety-related shutdown (STO). There is a test for each drive.

Figure 13-24  Testing the safety-related shutdown

Figure 13-25  Testing the safety-related shutdown
13.3 Configuring safety functions for external drives
Data backup and standard commissioning

Introduction

Once commissioning of the NCK, PLC and drive has been completed, you can manage the modified data using the functions below:

- Save/Archive user data
- Series commissioning
- Upgrading, as series commissioning

User data

The following user data can be managed:

Table 14-1  User data

<table>
<thead>
<tr>
<th>NCK/HMI</th>
<th>PLC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine data</td>
<td>OB (organization blocks)</td>
</tr>
<tr>
<td>Setting data</td>
<td>FB (function blocks)</td>
</tr>
<tr>
<td>Option data</td>
<td>SFB (system function blocks)</td>
</tr>
<tr>
<td>Global (GUD) and local (LUD) user data</td>
<td>FC (functions)</td>
</tr>
<tr>
<td>Tool and magazine data</td>
<td>SFC (system functions)</td>
</tr>
<tr>
<td>Protection zone data</td>
<td>DB (data blocks)</td>
</tr>
<tr>
<td>R parameters</td>
<td>SDB (system data blocks)</td>
</tr>
<tr>
<td>Work offsets</td>
<td></td>
</tr>
<tr>
<td>Compensation data</td>
<td></td>
</tr>
<tr>
<td>Display machine data</td>
<td></td>
</tr>
<tr>
<td>Workpieces, global part programs and subroutines</td>
<td></td>
</tr>
<tr>
<td>Standard and user cycles</td>
<td></td>
</tr>
<tr>
<td>Definitions and macros</td>
<td></td>
</tr>
</tbody>
</table>
14.1 Data backup

Introduction
Data is backed up by means of the HMI. SINUMERIK solution line components can either be backed up individually or jointly. You can select from:
- NCK (NC)
- PLC
- HMI
- Drives

Operating sequence
1. Selection of Data backup menu
   Operating range "Services > ETC key "">" > "Standard commissioning".
2. You can choose which data you want to back up:
   - HMI
   - NC with compensation data
   - PLC
   - PROFIBUS drives
3. Archive name: The suggested archive name depends on the selected area and can be changed if necessary.
4. Create the data backup file by selecting the component to which you wish the file to be output:
   - NC card (CompactFlash card)
   - Archive

Data backup DRIVE-CLiQ motors

Note
We would recommend backing up the DRIVE-CLiQ motor data onto a CompactFlash card (NC card).
The p4692 parameter must be set to "1" in the "Commissioning" > "Machine data" > "Control unit MD" operating range.
14.2 User data backup/Series commissioning

Introduction

Data can be saved and archived in the following ways:

- Reading out the data completely: Series commissioning
- Files are exported/imported area by area.

The following user data can be selected as individual files:

- Machine data
- Setting data
- Tool data
- R parameters
- Zero point offset
- Compensation data (LEC)
- Part programs
- Standard cycles
- User cycles
- PLC programs (binary file)

In the case of a data backup, e.g., following commissioning of the control system, the user data selected via the user interface are written to what is known as a series-commissioning file. Once a series-commissioning file has been imported, the control system returns to its original state, as it was at the time of the data backup.

Time of data backup

Experience has shown that the following times can be recommended for carrying out data backups:

- Following commissioning
- After changing machine-specific settings
14.3 Preassignments when saving PLC data

Introduction

When creating a series-commissioning file that contains PLC data, the PLC image that is saved during this process is dependent on the status of the PLC at the time of creation. Depending on the status of the PLC, the following PLC images result:

- Original image
- Instantaneous image
- Inconsistent image

Operating sequence for original image

The original image of the PLC is represented by the PLC-data state immediately after loading the S7 project into the PLC.

1. Set the PLC to the operating status STOP.
2. Load the appropriate S7 project into the PLC using SIMATIC Manager STEP 7.
3. Create a series-commissioning file with PLC data.
4. Set the PLC to the RUN operating status.

Operating sequence for instantaneous image

If you cannot create an original image, you can save an instantaneous image as an alternative.

1. Set the PLC to the operating status STOP.
2. Archive PLC data.
3. Set the PLC to the RUN operating status.
Operating sequence for inconsistent image

An inconsistent image results if a series-commissioning file with PLC data is created and the PLC is in the RUN state (cyclic operation). The data blocks of the PLC are saved at different times with contents that under certain circumstances may meanwhile have changed. This may result in a data inconsistency that, once the data backup has been copied back to the PLC, may under certain circumstances result in a PLC stop in the user program.

NOTICE

The creation of a series-commissioning file with PLC data while the PLC is in RUN status (cyclic operation) may result in an inconsistent PLC image in the series commissioning archive. After this series-commissioning file has been copied back, this data inconsistency in the PLC user program may under certain circumstances result in a PLC stop.

Changing the PLC operating status

The PLC operating status can be changed using:

- SIMATIC STEP7 Manager
- PLC mode selector on the NCU (position "2" -> STOP, position "0" -> RUN)
14.4 Series commissioning

Introduction

Series commissioning means bringing a series of control systems to the same initial state as regards their data.

You can archive/read in your choice of PLC, NC and HMI data for series commissioning. Compensation data can be saved at the same time if necessary. The drive data are saved as binary data which cannot be modified.

Requirement

The password, e.g., with access level 3 (user) is set.

Note

In order to prevent a topology error, Control Unit parameter p9906 (topology comparison stage of all components) should be set to "Medium" to load Control Unit series commissioning.
Operating sequence

1. Open the menu to create a series-commissioning file:

   Operating range "Services" > <ETC> key > "Series IBN".

   ![Figure 14-1 Series commissioning](image)

2. Create an archive for the series-commissioning file: You can select which data you wish to save as the archive contents:
   - HMI
   - NC with compensation data
   - PLC
   - PROFIBUS drives

3. Archive name: The suggested archive name depends on the selected area and can be changed if necessary.

4. Create the series-commissioning file by selecting the component to which you wish the file to be output:
   - NC-Card
   - Archive
Data backup and standard commissioning

14.4 Series commissioning
15.1 Introduction

Functionality

You have the following options when using the "File functions" function:

- SINAMICS parameters of the drive objects:
  - Backing up on SINUMERIK Operate
  - Loading to the drive unit
  - Editing on SINUMERIK Operate
- Back-up all of the machine data and SINAMICS parameters on an HMI drive and from there, move them to another HMI.

The functions are available under "Commissioning" > "Machine data" > <ETC> key > "File functions".

Depending on the machine data area from which the file functions were selected, the corresponding entry is selected from the selection box for selecting data.

The data and parameters available on the control appear in this selection box.

The first three vertical softkeys for "+/-" and "Direct selection" are adapted accordingly and are only visible where there is more than one component.
15.2 File functions for SINAMICS parameters

15.2.1 Overview

SINAMICS parameters

You can use a drop down list box in the "Data" window to back up/load the following SINAMICS parameters from the individual drive objects:

- SINAMICS control unit parameters
- SINAMICS infeed parameters
- SINAMICS drive parameters
- SINAMICS communications parameters

Drive objects

Select the respective drive objects using the vertical softkeys.

For example the "Drive +"/"Drive -" vertical softkeys for "SINAMICS drive parameters".

15.2.2 Data backup of SINAMICS parameters

Introduction

Select the "File functions" dialog under "Commissioning" > "Machine data" > <ETC> key.
Operating sequence

Proceed as follows to back up the drive object parameters:
1. In the "Data" window, select the data type you require.
2. Use the "+/-" or "Direct selection" vertical softkeys to select the component if there is more than one component.
3. In the "File" window enter a name or select an existing name from the selection box.
4. In the "Directory" window, select the directory under which you want to save the parameters.
5. Press "Save".

The following screen shots show examples of "SINAMICS drive parameters" and "SINAMICS control unit parameters".

Figure 15-3 Select "File functions" > "SINAMICS drive parameters"

Figure 15-4 Select "File functions" > "SINAMICS control unit parameters"
15.2 File functions for SINAMICS parameters

15.2.3 Loading/copying the SINAMICS parameter file

Introduction

Select the "File functions" dialog under "Commissioning" > "Machine data" > <ETC> key.

Operating sequence

Proceed as follows to load parameters to the individual drive objects:

1. In the "Data" window, select the data type you require.
2. Use the "+/−" or "Direct selection" vertical softkeys to select the component if there is more than one component.
3. Select an existing name from the selection box.

Figure 15-5 Loading/copying SINAMICS drive parameter file functions
4. Press "Load".

The following message will appear if the source and target numbers don't match:

![Image](image.png)

**Figure 15-6** Loading/copying SINAMICS drive parameter file functions, "Adapt" query

5. Select "Adapt".

You can now adapt the "Actual values" for the "File" using the "Setpoints".

![Image](image.png)

**Figure 15-7** Loading/copying SINAMICS drive parameter file functions, "Adapt"

6. Press "OK".
15.2 File functions for SINAMICS parameters

15.2.4 Editing the SINAMICS parameter file

Introduction

Select the "File functions" dialog under "Commissioning" > "Machine data" > <ETC> key.

Operating sequence

Proceed as follows to display the contents of a file:

1. In the "Data" window, select the data type you require.
2. Use the "+/-" or "Direct selection" vertical softkeys to select the component if there is more than one component.
3. Select an existing name from the selection box.

Figure 15-8 Select "File functions" > "File"
15.3 Copying data from one HMI to another

15.3.1 Overview

Functionality

All of the machine data and SINAMICS parameters can be saved at the HMI under a directory and are then written from this directory to a medium. The data can then be copied to another HMI from this medium (e.g. USB-FlashDrive).

You can copy the following data:

- General machine data
- Channel-specific machine data
- Axis-specific machine data
- General display, machine data
- Channel-specific display machine data
- SINAMICS Control Unit parameters
- SINAMICS infeed parameters
- SINAMICS drive parameters
15.3 Copying data from one HMI to another

- SINAMICS I/O parameters
- SINAMICS communication parameters

File names and directory names

Note
At the HMI, all file and directory names are mapped to unique 8.3 file/directory names.
This is the reason that the file and directory names should be a maximum of 8 characters long.
Example: "MYDIR"
This makes it easier to identify file and directory names with more than 8 characters in the file system.

15.3.2 Copying machine data

Introduction
Select the "File functions" dialog under "Commissioning" > "Machine data" > <ETC> key.

Operating sequence
Proceed as follows to copy machine data:
1. In the "Data" window, select the data type you require.
2. In the "File" window, assign a name to the file or select an existing name from the selection box.
3. In the "Directory" window, assign a name to the directory or select an existing name from the selection box.
4. Press "Save".
The files are saved in the HMI file system. Copy the files from there to a USB-FlashDrive and you can then copy them to another HMI.
Only the <file name>.TEA file has to be copied.
Default directory

If you have selected the "default directory", then the files are saved in the HMI file system under the following directory:

- General machine data  <HMI installation directory>\dh\dg\dir\MDNC.DIR\<file name.TEA>
- Channel-specific machine data  <HMI installation directory>\dh\dg\dir\MDCH.DIR\<file name.TEA>
- Axis-specific machine data  <HMI installation directory>\dh\dg\dir\MDAX.DIR\<file name.TEA>
- General and channel-specific display, machine data <HMI installation directory>\dh\dg\dir\ MDBT.DIR\<file name.TEA>

New directory, e.g. "MYDIR"

If, for example, you have entered a new directory name, e.g. "MYDIR", then the files are saved in the HMI file system under the following directory:

- General machine data  <HMI installation directory>\dh\dg\dir\MYDIR\MDNC.DIR\<file name.TEA>
- Channel-specific machine data  <HMI installation directory>\dh\dg\dir\MYDIR\MDCH.DIR\<file name.TEA>
- Axis-specific machine data  <HMI installation directory>\dh\dg\dir\MYDIR\MDAX.DIR\<file name.TEA>
- General and channel-specific display, machine data <HMI installation directory>\dh\dg\dir\MYDIR\MDBT.DIR\<file name.TEA>

15.3.3 Copying SINAMICS parameters

Introduction

Select the "File functions" dialog under "Commissioning" > "Machine data" > <ETC> key.

Operating sequence

Proceed as follows to copy SINAMICS parameters:

1. In the "Data" window, select the data type you require.
2. In the "File" window, assign a name to the file or select an existing name from the selection box.
15.3 Copying data from one HMI to another

3. In the "Directory" window, assign a name to the directory or select an existing name from the selection box.

4. Press "Save".

The files are saved in the HMI file system. Copy the files from there to a USB-FlashDrive and you can then copy them to another HMI.

Only the <file name>.TEA file has to be copied.

---

Note

For HMI-Advanced Version 7.6, the <file name>.TEA file and the <file name>.ACX file must be copied.

---

Default directory

If you have selected the "default directory", then the files are saved in the HMI file system under the following directory:

- SINAMICS Control Unit parameters <HMI installation directory>\dh\dg.dir\MDSINAMI.DIR\MD_CU.DIR\<file name>.TEA
- SINAMICS infeed parameters <HMI installation directory>\dh\dg.dir\MDSINAMI.DIR\MD_LM.DIR\<file name>.TEA
- SINAMICS drive parameters <HMI installation directory>\dh\dg.dir\MDSINAMI.DIR\MD_DC.DIR\<file name>.TEA
- SINAMICS I/O parameters <HMI installation directory>\dh\dg.dir\MDSINAMI.DIR\MD_IO.DIR\<file name>.TEA
- SINAMICS communication parameters <HMI installation directory>\dh\dg.dir\MDSINAMI.DIR\MD_COM.DIR\<file name>.TEA
New directory, e.g. "MYDIR"

If, for example, you have entered a new directory name, e.g. "MYDIR", then the files are saved in the HMI file system under the following directory:

- SINAMICS Control Unit parameters <HMI installation directory>\dh\dg.dir\MYDIR\MDSINAMI.DIR\MD_CU.DIR\<file name.TEA>
- SINAMICS infeed parameters <HMI installation directory>\dh\dg.dir\MYDIR\MDSINAMI.DIR\MD_LM.DIR\<file name.TEA>
- SINAMICS drive parameters <HMI installation directory>\dh\dg.dir\MYDIR\MDSINAMI.DIR\MD_DC.DIR\<file name.TEA>
- SINAMICS I/O parameters <HMI installation directory>\dh\dg.dir\MYDIR\MDSINAMI.DIR\MD_IO.DIR\<file name.TEA>
- SINAMICS communication parameters <HMI installation directory>\dh\dg.dir\MYDIR\MDSINAMI.DIR\MD_COM.DIR\<file name.TEA>
15.3 Copying data from one HMI to another
Introduction

This chapter describes instructions and tips on:

- Changing topology (modular machine)
- Drive states
- Diagnostics for pending alarms
- Drive (SERVO) parameter RESET, individual
- Version display of the drives (SERVOs)
- Checking/setting power supply data settings
- Identification/Optimization "ALM > Infeed/Configuration"
16.1 Changing topology (modular machine)

Introduction

The topology is changed using the following menus:

- "Commissioning" > "Drive system" > "Drive units" > "Topology".

- "Commissioning" > "Drive system" > "Drive units" > "Configuration".

Figure 16-1 "Drive units" > "Topology" menu

Figure 16-2 "Drive units" > "Configuration" menu
Functions for changing topology

The following functions are provided for changing the topology:

- "Topology" > "Add component..."
- "Topology" > "Change..."
  - Delete drive objects/components
  - Enable/disable drive objects
  - Change drive object name/number
  - Change component name/number
- "Configuration" > "Sort..."
- "Configuration" > "Change..."
  - Change drive object name
  - Change component name
  - Change comparison level

Note
First commissioning is not necessary after changes to the topology.

16.1.1 Adding components

Introduction
If you connect a component (e.g. SMC20) via DRIVE-CLiQ to the drive system for the NCU, SINAMICS detects the change in the actual topology and sends the actual/reference topology difference to the HMI.

The new component must be configured on the HMI and assigned to a drive object (SERVO-DO/Motor Module) via the drive wizard.

Note
Up to version 2.5
A new motor with DRIVE-CLiQ can only be assigned to an existing drive object (SERVO-DO) (see following operating sequence, including "Add component") that has never previously been assigned an encoder interface or another motor with DRIVE-CLiQ and that has not yet ever been commissioned.
Operating sequence

1. Select the "Commissioning" > "Drive system" > "Drive units" menu.

2. Press "Topology".

In the "Topology" menu, you start with the actual status (here an example). The component has not been connected yet.
3. Connect a new DRIVE-CLiQ component (e.g. SMC20) to a Motor Module.

**Note**

Only plug in (connect) components when the drive unit is switched off.
### 16.1 Changing topology (modular machine)

**SINAMICS detects the change in the actual topology and sends the actual/reference topology difference to the HMI.**

- **GRAYED OUT** -> Desired state, drive object/component not plugged in and/or deactivated in drive system
  
  Use the cursor keys to select the required line. The state is indicated in the bottom part of the window.

- **RED** -> actual state - present in the actual topology

New components which haven't yet been commissioned have a component number > "200", in this example, the number is "201".

The new component must now be configured in the drive system via the vertical softkey "Add component...".

---

![Component not commissioned yet (201)](image_url)

**Figure 16-7** Component not commissioned yet (201)
4. Press "Add component...".

![Figure 16-8 Menu “Add component”](image)

A new component has been found.
5. Press "OK" to configure and accept this component.

During the unit configuration there are a succession of messages containing information on the configuration.

Determining the device configuration may take several minutes.

Before the configuration is completed, the HMI displays the following query:

6. Press "OK" to perform an NCK power on restart (warm restart).
Figure 16-11 Component accepted

The unit configuration is finished. The component has been accepted.

You have the following options to assign this component (e.g. SMC20 with new encoder) to a drive:

- Press "Drives" to open the drive wizard. Select the drive and run through the drive wizard to the encoder configuration (Page 82).

- Press "OK" and assign this component later to a drive.

Figure 16-12 "Topology" menu after "OK"

The actual state is displayed in the topology.

If you select the component with the cursor keys, the HMI informs you in the bottom area of the topology table, which components have been connected to this component via DRIVE-CLiQ.
**Note**

A non-assigned component must be commissioned with the drive wizard.

You can start the drive wizard via the "Topology" menu with the following operating sequence:
1. Press the <RECALL> key.
2. Press "Drives".

**See also**

[Drive diagnostics](Page 335)
16.1.2 "Topology" > "Change..." menu

16.1.2.1 Changing entry into topology

Introduction

You have the following options in the "Topology" > "Change..." dialog:

- Delete drive objects/components
- Enable/disable drive objects
- Change drive object name/number
- Change component name/number

Operating sequence for "Topology" > "Change" dialog

You have saved the drive data (see "Data backup of SINAMICS parameters" (Page 298))

You are in the "Commissioning" > "Drive system" > "Drive units" > "Topology" menu.

Figure 16-13 Changing topology (modular machine) SK "Change"
1. Press "Change...".

2. Read the query through carefully.
   You have saved the data.
   Press "Ok".

3. You are in the basic display for changing the topology (modular machine).
   Activate the following functions from this basic display:
   - Delete drive objects/components
   - Enable/disable drive objects
   - Change drive object name/number
   - Change component name/number

   The sections below describe the operating sequences for these functions.
16.1.2.2 Deleting drive objects

Operating sequence

1. Use the cursor keys to select a drive object.

Once you have selected a drive object, the vertical "Delete drive object" softkey function is displayed.

2. Press "Delete drive object".

A note regarding the drive object appears and you are again asked whether the drive object is to really be deleted.

3. Press "OK".

The drive object is deleted from the reference topology.
### 16.1.2.3 Deleting components

#### Operating sequence

1. Use the cursor keys to select a component.

   Once you have selected a component, the vertical "Delete component" softkey function is displayed.

   ![Figure 16-18 Menu "Topology" > "Change" > Component SM_2 selected](image)

2. Press "Delete component".

   ![Figure 16-19 Menu "Topology" > "Change" > "Delete component" > Note relating to component](image)

3. A note regarding the component appears and you are again asked whether the component is to really be deleted.
4. Press "OK".

The component is deleted from the reference topology.

5. A warning appears above the topology window if the component is still present in the actual topology.

6. Press "OK".

7. You can see in the window with the "Topology comparison" view that the "SMx module" component in the actual topology is still wired (highlighted in red).

8. Remove the module.
16.1.2.4 Enabling/disabling drive object

Introduction

In the "Topology" > "Change..." menu you can disable/enable drive objects directly in the drive system.

Operating sequence

1. Use the cursor keys to select a drive object.

   Once you have selected a drive object, the vertical "Enable/disable dr. obj." softkey function is displayed.

   Figure 16-22 "Topology" > "Change" menu

2. Press "Enable/disable dr. obj.".

   Follow the instructions given by the messages.

   Figure 16-23 Menu "Topology" > "Change" > SERVO_3_3:2 disabled drive object
3. Once successfully disabled, the drive object and the associated components are grayed out.

4. If you want to reactivate this drive object, press "Enable/disable dr. obj.".
   Follow the instructions given by the messages.
16.1.2.5 Changing drive object/component names/numbers

Introduction

You have the following options under the menu:

- "Topology" > "Change..."
  - Change drive object name/number
  - Change component name/number

- "Configuration" > "Change..."
  - Change drive object name
  - Change component name
  - Change comparison level

Figure 16-24 Menu "Topology" > "Change..." > "Drive object no. 2" set to 20

Figure 16-25 Menu "Configuration" > "Change..." > Name/comparison level
Tip for commissioning SINAMICS drives

16.1 Changing topology (modular machine)

Note
Changing the names and numbers affects data in the reference and actual topology for the drive software.
Changing the comparison level affects the topology comparison in the drive software.

Operating sequence
1. Position the cursor in the "Change..." menu on the corresponding field. Specify a new "Name/number/comparison level".
2. Press <Input>.

16.1.3 Replacing SINAMICS S120 components

Introduction
The operating sequences describe two procedures for replacing a component:
- Replacing a motor module with a more powerful one.
- Replacing SMI/SMx motor component.
Operating sequence for replacing a motor module with a more powerful one.

The following prerequisites are satisfied:

- The motor modules are of the same type.
- The serial number is different.
- MLFB number differs e.g. instead of 5 A -> 9 A.

---

**Note**

**DRIVE-CLiQ components simply have different serial numbers**

In this case no further configuration is needed.

---

**Note**

**A permanent change in the drive system should not be undertaken**

Before you replace the DRIVE-CLiQ component, change the comparison level.

1. Select the "Commissioning" > "Machine data" > "Control unit MD" dialog.
2. Change parameters p9907 (component number) and p9908 (comparison level of a component).
3. Save (Page 298) the changed drive data before switching off (power OFF).
4. Switch the drive system off (power OFF).
5. Replace the component.
6. Switch the drive system on (power ON).
7. No further configuration is required.

You have replaced the motor module with the drive system switched off.

The motor module should be permanently replaced.

1. Select the "Commissioning" > "Machine data" > "Control unit MD" dialog.
2. Set the "Device configuration" parameter to control unit: p0009 = 1
3. Transfer the new component: Control Unit: p9905 = 2
4. Wait until p9905 = 0 is automatically set.
5. Set the "Device configuration" parameter to control unit: p0009 = 0
7. It is imperative you wait until p977 is automatically written back to "0" this takes about 40 seconds.

The replacement of a single SINAMICS component is automatically acknowledged by the system.
Operating sequence for replacing SMI/SMx motor component

1. You have removed the previous SMI or SMx motor component.
   This motor component is missing from the actual topology.
   SINAMICS indicates this in the form of a topology error alarm.
   The "Commissioning" > "Drive system" > "Drive units" > "Topology" dialog shows the
   previous motor component awaiting replacement GRAYED OUT (present in reference
   topology only).

   **Note**
   The new SMI/SMx motor component must not yet be inserted!

2. In the "Commissioning" > "Drive system" > "Drive units" > "Topology" > "Change..."
   dialog, remove the SMI/SMx motor component awaiting replacement from the reference
   topology using the "Delete component" dialog (Page 322).

   **Note**
   Save (Page 298) the changed drive data before switching off (power OFF).

3. Switch the drive system off and on (power OFF/ON).
4. In the "Commissioning" > "Drive system" > "Drive units" > "Topology" dialog box, check
   whether the SMI/SMx motor component has been removed from the reference topology -
   and check the following:
   - Topology error alarm no longer active.
   - "Commissioning" > "Drive system" > "Drive units" > "Topology" dialog no longer shows
     any differences.
5. Switch off the drive system.
6. Plug in the new SMI/SMx motor component.
7. Switch on the drive system.
8. Add the new SMI/SMx motor component using the "Commissioning" > "Drive system" >
   "Drive units" > "Topology" > "Add component" (Page 311) dialog for the reference
   topology.
9. Assign the added SMI/SMx motor component via the "Commissioning" > "Drive system" >
   "Drives" (Page 82) drive wizard.
16.1.4 Display options

Introduction

The “Display options” function allows you to do things like set which drive object and component properties are to be displayed in the "Configuration" and "Topology" windows.

Operating sequences for "Configuration" window

You are in the "Commissioning" > "Drive system" > "Drive units" menu.

1. Select "Configuration" > "Display options".

![Configuration > Display options menu](image)

Figure 16-26 "Configuration" > "Display options" menu.

Define the following properties for the "Configuration" window:

- Topology display
- Columns to be displayed
- Filter for drive objects and components to be displayed
Operating sequences for "Topology" window

You are in the "Commissioning" > "Drive system" > "Drive units" menu.

1. Select "Topology" > "Display options".

Define the following properties for the "Topology" window:

- Topology display
- Filter for drive objects and components to be displayed

When you click on filter "off", even components which are not in the DRIVE CLiQ are displayed.

The colors used in the topology window have the following meanings for the drive objects and components:

Figure 16-27 "Topology" > "Display options" menu.

Figure 16-28 "Topology" menu - Filter "off" has been selected for the "Display options".

The colors used in the topology window have the following meanings for the drive objects and components:
16.1 Changing topology (modular machine)

- **GRAYED OUT** -> Desired state, drive object/component not plugged in and/or deactivated in drive system

  Use the cursor keys to select the required line. The state is indicated in the bottom part of the window.

- **RED** -> actual state - present in the actual topology

### 16.1.5 Sorting the topology display

**Operating sequence**

In the "Drive system" > "Drive units" > "Configuration" menu you can call up a sorting function for the topology display.

Figure 16-29 "Drive system" > "Drive units" > "Configuration" menu
16.1 Changing topology (modular machine)

1. Press "Sort...".

![Figure 16-30 "Configuration" > "Sort..." menu]

2. In the "Sort" dialog select from the following sorting options for displays in the topology window:
   - Drive object
     The display is sorted by drive object number.
   - Wiring
     The display is sorted by the wiring of the drive components in the drive system.
   - Component number
     The display is sorted by component number.
   - Axis
     The display is sorted by axis number.

3. Press "OK".
16.1.6 Check topology

Introduction

After you have parameterized the drive components, you can view the topology on the HMI.

Topology of individual drive components

1. Under "Commissioning", press the "Drive system" > "Drive units" > "Topology" softkeys one after the other.
2. On the HMI, the topology of individual drive components is displayed, including the component number (see figure below).

You can now check whether the topology displayed conforms with the topology of your system.

You will need the component numbers in order to configure direct measuring systems manually.

See also

Drive diagnostics (Page 335)
16.2 Drive diagnostics

Introduction

You can view the alarms and faults of the drive in the "Diagnostics" > "Drive system" operating area on the HMI.

Operating sequence

1. Select the relevant drive component with the cursor in the overview of the drive states.
2. Press "Details".

Figure 16-32  Overview of drive states, “Diagnostics” > “Drive system” menu

Figure 16-33  "Diagnostics” > “Drive system” > "Details" menu
3. Press "Alarms".

4. Press "Faults".

See also

Adding components (Page 311)
Check topology (Page 334)
16.3 Diagnostics for pending alarms

Introduction

Alarms - these are warnings and faults - can be viewed in SINAMICS S120 via parameters.

Warnings

Pending warnings are indicated by parameter r2122 of the relevant drive components in question.

Deleting the warning buffer may be carried out manually:

- Write r2111 of the drive component with "0".

  This results in the deletion of all existing warnings of this component and updates the current warnings still pending.

Faults

Fault messages are indicated by parameter r945.

Display on HMI

If you set the MD13150 $MN_SINAMICS_ALARM_MASK to the hexadecimal value "D0D" on the HMI, then the HMI automatically displays the pending warnings/faults from SINAMICS S120.
16.4 Drive (SERVO) parameter RESET, individual

Introduction

The factory setting (parameter RESET) may be set for each drive (SERVO) individually.

Note

Not just the motor and encoder data are reset. All the configured Binector-Connector logic operations (releases, probe signals) and message frame type are also deleted.

Operating sequence

1. Set the factory settings on the selected drive: p0010 = 30
2. Activate the factory settings on this drive: p0970 = 1
3. Device automatically carries out RESET of all parameters on this drive.
4. Save drive-specific: set p971 = 1
   or
   save "All": set p977 = 1
5. It is imperative you wait until p977/p971 is automatically written back to "0"; this takes about 40 seconds.
Firmware version display of drive components

Introduction

The firmware version of the drive components can be viewed under "Commissioning" > "Drive system" > "Drive units" > Configuration in the "FW comp" column.

Example: 2603000, -> Firmware version is 02.60.30.00

Using certain parameters from individual drive components, it is also possible to view the relevant firmware version for:

- System software SINAMICS S120
- Firmware from:
  - Drive components
  - SMC or SMI modules

System software SINAMICS S120

The version of the SINAMICS S120-SW available in the system is readable in parameter r18 on the TCU/PCU.

Example:

r18 = 2300700, -> firmware version is 02.30.07.00
**Firmware version drive components**

The firmware version of all individual components is read out individually in parameters r975[2] and r975[10] for each drive component (NCU, ALM, power unit).

Example:

r975[2] = 230, r975[10] = 700 -> "230" & "700" -> firmware version is 02.30.07.00

**Firmware version of all SMC or SMI modules**

The firmware version of all SMC or SMI modules is read out in parameter r148[0…2] on the relevant motor module.

Example:

r148[0] = 2300700, -> firmware version of the connected encoder module 1 is 02.30.07.00
16.6 Checking/setting power supply data settings

Introduction

The power supply data settings must be checked/set in the SINAMICS during commissioning.

Checking/setting network data when commissioning the infeed

You can use the "Commissioning" > "Drive units" > "Infeed" > "Configuration" > "Network data" menu to view and modify the network data.

![Network data settings](image)

Figure 16-37 Network data

See also

Identification/Optimization "ALM > Infeed/Configuration" (Page 342)
16.7 Identification/Optimization "ALM > Infeed/Configuration"

Introduction

On identification of the ALM, control optimization in the ALM is also carried out. Here, the inductance and capacity of the DC link are determined and the optimum control data determined for the set-up converter.

Identification can only be performed after the controller and the drive have been put into operation.

Procedure for automatic identification of the ALM

Identification of the ALM is performed automatically by the system in the current SINAMICS versions as soon as the first drive has been commissioned and enable terminal X122.1 activated. An internal optimization sequence is started automatically; it takes approx. 20 seconds to complete.

During this optimization sequence, enable terminal X122.1 should not be deactivated; otherwise the optimization would be aborted. If optimization is aborted, identification may be carried out manually at a later stage by the user.

Procedure for manual identification of the ALM

Identification of the ALM is carried out as follows:

1. Disconnect release (AUS1) ALM (X122.1) by commissioner.
2. Select machine data for the infeed (ALM) in the "Commissioning" > "Machine data" > "Infeed MD" menu.
4. Connect release ALM (release has to remain pending during the execution of the first step of the identification).
5. ALM controller data are reset automatically and power supply identification starts.
6. After identification has occurred, p3410 is automatically written to 0 and the values are saved automatically for the controller data of the ALM. Check: p3402 = 9 (release has to remain during the execution of this step of the identification!).
7. Disconnect release ALM (X122.1) by commissioner.
8. The optimized ALM data are saved automatically. The data does not need to be saved manually (p977 = 1).
16.8 Configuring motor data sets

Introduction

You can configure the following drive data sets:

- Motor data set -> MDSx (max. 4)
- Drive data set -> DDSx (max. 8 pro MDS)
- Encoder data sets -> MDSx (max. 3)

Data sets are configured under the menu "Commissioning" > Drive system" > "Drives" > "Data sets".

Note

The particular drives must have been already commissioned.
Operating sequence

1. Press "Change".

2. The following options are now available:
   - "Insert MDS"
   - "Delete MDS", if an additional data set was created.
   - "Change EDS"
   - "Change DDS"
3. Press "Insert MDS".

The system automatically creates a new motor data set. In the example, "MDS1"
The existing MDS0 is copied to MDS1 here.

Alternatively, the "empty" MDS1 can also be generated, which must then be subsequently commissioned.

Note
Up to three motor data sets can be created with "Insert MDS".
- MDS0 -> DDS0 to DDS7 (is always created as standard)
- MDS1 -> DDS8 to DDS15
- MDS2 -> DDS16 to DDS24
- MDS3 -> DDS25 to DDS32
4. Press "Next >".

![Figure 16-42 DDS -> Drive Data Sets](image)

The drive data sets from MDS0 are assigned to MDS1 as copy.

In the example, DDS8 to DDS15.
5. Press "Next".

![Summary dialog box](image1)

In the summary, you can again check what the system inserts.

With "Complete", the system creates the new MDS1 as copy of MDS0. The drive data sets DDS0 to DDS7 (MDS0) are also copied into MDS1 (DDS8 to DDS15).

**Note**

You exit the "Insert MDS" dialog box with "Complete".

If you click on the field "Start drive assistant" then you go directly to the menu "Commissioning" > "Drive units" > "Drive".

6. Press "Complete".

![Store in non-volatile manner dialog box](image2)
7. Respond to the prompt that is displayed with "yes".

<table>
<thead>
<tr>
<th>Setup</th>
<th>CHANN</th>
<th>JOG Ref</th>
<th>MP3</th>
<th>Ctrl interrupt</th>
<th>Program aborted</th>
<th>Drive settings</th>
<th>Routine</th>
<th>Drive data set</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 16-45** New motor data set with drive data set and encoder data set

The new motor data set is created.

8. Press <RECALL>.

**Figure 16-46** "Drives" > "Configuration" menu

You are in the "Drives" > "Configuration" menu.
9. Press "Select MDS...".

Now, in the direct selection, you can select the motor data set in the selection box.

10. The new motor data set for the drive is selected with "Accept".

The drive can now be commissioned.

11. Press "Change...".

The drive wizard now guides you as you commission the drive.
Tips for commissioning SINAMICS drives

16.8 Configuring motor data sets
17.1 Import licensing terms

The terms below are important for understanding the license management of SINUMERIK software products.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software product</td>
<td>&quot;Software product&quot; is generally used to describe a product that is installed on a piece of hardware to process data. Within the license management of SINUMERIK software products, a corresponding license is required to use each software product.</td>
</tr>
<tr>
<td>Hardware</td>
<td>In the context of license management of SINUMERIK software products, &quot;hardware&quot; refers to the component of a SINUMERIK control system to which licenses are assigned on the basis of its unique identifier. License information is also saved to remanent memory on this component. Example:</td>
</tr>
<tr>
<td></td>
<td>- SINUMERIK 840D sl: CF card</td>
</tr>
<tr>
<td></td>
<td>- SINUMERIK 840Di sl: MCI board</td>
</tr>
<tr>
<td>License</td>
<td>A license gives the user a legal right to use the software product. Evidence of this right is provided by the following:</td>
</tr>
<tr>
<td></td>
<td>- CoL (Certificate of License)</td>
</tr>
<tr>
<td></td>
<td>- License key</td>
</tr>
<tr>
<td>CoL (Certificate of License)</td>
<td>The CoL is the proof of the license. The product may only be used by the holder of the license or authorized persons. The CoL includes the following data relevant for the license management:</td>
</tr>
<tr>
<td></td>
<td>- Product name</td>
</tr>
<tr>
<td></td>
<td>- License number</td>
</tr>
<tr>
<td></td>
<td>- Delivery note number</td>
</tr>
<tr>
<td></td>
<td>- Hardware serial number</td>
</tr>
<tr>
<td>Note</td>
<td>The hardware serial number is located only on a CoL of the system software or if the license was ordered bundled, in other words the system software came together with options.</td>
</tr>
<tr>
<td>License number</td>
<td>The license number is the feature of a license that is used for its unique identification.</td>
</tr>
<tr>
<td>CF Card (Compact Flash Card)</td>
<td>The CF Card represents, as the carrier of all the remanent data of a SINUMERIK solution line control system, the identity of this control system. The CF Card includes the following data relevant for the license management:</td>
</tr>
<tr>
<td></td>
<td>- Hardware serial number</td>
</tr>
<tr>
<td></td>
<td>- License information including the License Key</td>
</tr>
</tbody>
</table>
17.2 Overview

The use of the installed system software and the options activated on a SINUMERIK control system require that the licenses purchased for this purpose are assigned to the hardware. In the course of this assignment, a License Key is generated from the license numbers of the system software, the options, as well as the hardware serial number. Here, access occurs to a license database administered by Siemens A&D via the Internet. Finally, the license information including the License Key is transferred to the hardware.

There are two ways to access the license database:

- Web License Manager
- Automation License Manager

Note
Using SINUMERIK software products for testing purposes

SINUMERIK software products may be temporarily activated and used for testing purposes on a SINUMERIK control system, even without the corresponding License Key.

On the SINUMERIK user interface, the license key is displayed as "not sufficient" in the dialog box: "Overview" of the license information. Also the control system will repeatedly display a corresponding message.
17.3 **Web License Manager**

By using the Web License Manager, you can assign licenses to hardware in a standard Web browser. To conclude the assignment, the License Key must be entered manually at the control system via the HMI user interface.

**Internet address**

The Internet address of the Web License Managers is:

http://www.siemens.com/automation/license

17.4 **Automation License Manager**

The Automation License Manager can be used to assign all the licenses required for a piece of hardware (license-requirement comparison). The license information, including the License Key, is transferred electronically via an Ethernet link (TCP/IP).

**Preconditions:**

- The Automation License Manager must be installed on the computer (PC/PG) that is used to assign the licenses to the hardware.
- The computer (PC/PG) must be able to connect to the license database and the SINUMERIK control system via Ethernet link (TCP/IP):
  - License database: Internet connection
  - SINUMERIK control system: Intranet or PTP connection (Ethernet, Peer-To-Peer)

The individual steps for assigning licenses to hardware (license database) and the transfer of license information from/to the SINUMERIK control system can be performed such that only one connection must be available at any one time.

17.5 **License database**

The license database contains all the customer-specific license information relevant for the license management of SINUMERIK software products. The central management of the license information in the license database ensures that the existing license information regarding a piece of hardware is always up to date.
License database access

License database access occurs via:

- Direct access
  The direct access occurs with:
  - Delivery note number
  - License number
  The direct access enables the direct assignment of licenses for which the license numbers are available, e.g., in the form of a CoL.

- Customer login
  The customer login occurs with:
  - User name
  - Password
  The customer login enables the assignment of all the licenses available to the user that are delivered at the time of the login and have not yet been assigned to any hardware. Here, the license numbers of licenses that can still be assigned need not be directly at hand, instead these are displayed from within the license database.

Note
Customer login

You can obtain a customer login from Siemens A&D Mall under menu item: "Registration". The Internet address is: [http://mall.automation.siemens.com/](http://mall.automation.siemens.com/)
Currently, access is not yet possible for all countries.

Various license information

As indicated above, only the license information in the license database represents the current status regarding a piece of hardware. Differences may arise between the license information available for a piece of hardware and that of the license database due to:

- loading older archive data into the NCK (data restoration from a series-commissioning file after a service job)
- assigning licenses to hardware without transferring the modified license information for the hardware control system (online)

As a result, a more limited license requirement (possibly no license requirement) may be displayed than indicated on the HMI user interface of the control system for a license requirement alignment by Automation License Manager.

To align the license information, a transfer should be carried out for the current license information of the license database for the hardware control system (online).
17.6 CF Card and hardware serial numbers

The CF card (Compact Flash card) contains, in addition to the system and user software and the retentive system and user data, that data relevant for the license management of SINUMERIK software products of a control system:

- Hardware serial number
- License information including the License Key

The CF card thus represents the identity of a SINUMERIK control system. For this reason, assigning licenses to a control system always occurs using the hardware serial number.

This has the advantage that the CF card can be slotted into a replacement NCU in the event of failure and all data is retained.

Automation License Manager

Thus, the hardware serial number is always decisive during the transfer of license information to a control system in Automation License Manager and not the set IP address of the control system with which Automation License Manager is currently communicating.

Determining the hardware serial number

The hardware serial number is a permanent part of the CF card. It is used to identify a control system uniquely. The hardware serial number can be determined by:

- CoL (Certificate of License) (see note)
- SINUMERIK user interface, e.g. HMI Advanced
- Printing on the CF card
- Display in the Automation License Manager as supplementary information for the elements below:
  - Control system file
  - Control system (online)
  - Control image (offline)

Note

Hardware serial number and CoL

The hardware serial number is located only on a CoL of the system software or if the license was ordered bundled, in other words the system software came together with options.
17.7 SINUMERIK License Key

Basic information on License Keys

If a license is required for a product, then with the purchase of the license the purchaser receives a CoL as proof for the rights to use this product and a corresponding License Key as to the "technical representative" of this license. In conjunction with software products, the License Key usually must be available on the hardware on which the software product executed.

SINUMERIK License Keys

Depending on the software product, there are License Keys with different technical properties. The essential properties of a SINUMERIK License Key are:

- **Hardware reference**
  The hardware serial number included in the SINUMERIK License Key provides a direct link between the License Key and the hardware on which it can be used. In other words, a License Key created for the hardware serial number of a specific CF card is only valid for this CF card and will be rejected on other CF cards as invalid.

- **Total number of assigned licenses**
  A SINUMERIK License Key not only refers to one single license, instead it is the "technical representative" of all licenses that are assigned to the hardware at the time of its generation.

Copying SINUMERIK License Keys

By the fixed reference to certain hardware, a SINUMERIK License Key may, for example, be copied to various computers (PC/PG) and/or memory media for security or archiving purposes.

17.8 Assigning via Web License Manager

17.8.1 You can execute an assignment via direct access as follows

Background

For the direct access, log on to a computer connected to the Internet (PC/PG) with the delivery note and license number in the Web License Manager. All licenses of the delivery note numbers entered at the login may then be assigned to a piece of hardware. After completing the assignment process, the new License Key is displayed. This must then be entered in the license dialog box of the HMI components used.
Preconditions

The following prerequisites must be met in order to assign a license to a piece of hardware via direct access and HMI user interface:

- The HMI component is connected with the control system (NCU) on which the license should be assigned. Both components have booted.
- A computer (PC/PG) with Internet connection and browser is available.
- The login data for the direct access (e.g., per CoL) are available:
  - License number
  - Delivery note number

Assigning a license to a piece of hardware

1. Determine the HW serial number and the designation of the product (HMI-Advanced / HMI-Embedded: "Type of hardware") using the HMI license dialog box.
   HMI-Advanced / HMI-Embedded:
   Operating-area switchover: Commissioning > Key: etc. (">") > Licenses > Overview

Note

Ensure that the hardware serial number displayed is also really the one you want to make the assignment for. The assignment of a license to a piece of hardware cannot be reversed via the Web License Manager.

2. Go to the Internet page of the Web License Manager:
   http://www.siemens.com/automation/license

3. Login via "Direct access":
   - License number
   - Delivery note number

4. Follow the additional instructions in the Web License Manager.

Note

License Key via e-mail

If you have an e-mail address, you have the option (checkbox) of receiving the License Key by e-mail. Advantage: It is simpler to enter the License Key at the control.

5. After completing the assignment process, enter the License Key displayed on the Web License Manager into the license dialog box of the HMI user interface.
   HMI-Advanced / HMI-Embedded:
   Operating-area switchover: Commissioning > Key: etc. (">") > Licenses > Overview

6. Confirm the entry of the new License Key by pressing the softkey: "Accept".
17.8 Assigning via Web License Manager

17.8.2 You can execute an assignment via customer login as follows

Background

For the customer login, log on to a computer (PC/PG) connected to the Internet with the user name and password in the Web License Manager. All licenses released for this user name in the framework of the license management may then be assigned to a piece of hardware. After completing the assignment process, the new License Key is displayed. This must then be entered in the license dialog box of the HMI components used.

Preconditions

The following prerequisites must be met in order to assign a license to a piece of hardware via customer login and HMI user interface:

- The HMI component is connected with the control system (NCU) on which the license should be assigned. Both components have booted.
- A computer (PC/PG) with Internet connection and browser is available.
- The login data for the customer login is available:
  - User name
  - Password

Assigning a license to a piece of hardware

1. Determine the HW serial number and the designation of the product (HMI-Advanced / HMI-Embedded: "Type of hardware") using the HMI license dialog box.
   
   HMI-Advanced / HMI-Embedded:
   
   Operating-area switchover: Commissioning > Key: etc. ("->") > Licenses > Overview

   Note

   Ensure that the hardware serial number displayed is also really the one you want to make the assignment for. The assignment of a license to a piece of hardware cannot be reversed via the Web License Manager.

2. Go to the Internet page of the Web License Manager:
   
   http://www.siemens.com/automation/license

3. Login via "Customer login":
   
   - User name
   - Password
4. Follow the additional instructions in the Web License Manager.

**Note**

**License Key via e-mail**

If you have an e-mail address, you have the option (checkbox) of receiving the License Key by e-mail. Advantage: It is simpler to enter the License Key at the control.

5. After completing the assignment process, enter the License Key displayed on the Web License Manager into the license dialog box of the HMI user interface.

   **Operating-area switchover:** Commissioning > Key: etc. (">") > Licenses > Overview

6. Confirm the entry of the new License Key by pressing the softkey: "Accept".
17.9 Assigning via Automation License Manager

17.9.1 Function Overview

The following figure provides an overview of the functions available and the sequence in which they should be applied.
17.9.2 Installing the Automation License Manager

Background

The following components need to be installed for the license management of SINUMERIK solution line License Keys:

- **Automation License Manager**
  The Automation License Manager is loaded by the installation routine only if no manager or a manager version with a lower version number is installed on the computer (PC/PG).

- **SINUMERIK plug-in**
  The SINUMERIK plug-in is loaded by the installation routine only if it finds a version of the Automation License Manager installed on the computer (PC/PG).

- **HMI basic software**
  The HMI basic software is loaded by the installation routine only if no HMI software or a version with a lower number is installed on the computer (PC/PG).

---

**Note**

The Automation License Manager is used for all Siemens A&D products, e.g. SIMATIC STEP7. As versions of the Automation License Manager are upwards compatible, we always recommend using the version with the highest version number, irrespective of the source of supply (e.g. SINUMERIK or SIMATIC product CD, download via A&D Mall, etc.).

---

System requirements

**Hardware**

- **Computer**: Industrial PC, programming device, etc.
- **Work memory**: >= 128 MB
- **Free hard-disk storage**:
  - 5 MB (SINUMERIK plug-in)
  - + 32 MB (Automation License Manager)
  - + 300 MB (HMI basic software)
- **Operating system**: Windows XP

**Execution**

1. Launch the installation program for the Automation License Manager from "SETUP.EXE" and follow the instructions for the installation.
2. Launch the installation program for the SINUMERIK plug-in from "SETUP.EXE" and follow the instructions for the installation.
   The HMI basic software can be installed as part of this process.
17.9 Assigning via Automation License Manager

17.9.3 Enabling/disabling SINUMERIK plug-ins

Background

All of the plug-ins enabled for the Automation License Manager scan the relevant communication interfaces when booting and after specific operator inputs. If there is a large number of enabled plug-ins, this can result in a significantly longer boot and refresh time for the user interface. To prevent this delay, you can disable the plug-in installed for handling the SINUMERIK License Keys in dialog: "Connect to target system".

Procedure

Perform the following actions to enable/disable the SINUMERIK plug-ins:

1. Start the Automation License Manager
2. Open the "Connect to target system" dialog via menu command: Edit > Connect to target system > SINUMERIK . . .
3. In the dialog, open tab: Settings
4. Enable/disable the plug-in by selecting/deselecting the appropriate checkbox.
5. Close the dialog by pressing the button: OK

Result

The Automation License Manager shows the SINUMERIK-specific license information in accordance with the current status of the SINUMERIK plug-in. See Section:

Note

How to refresh the view manually

If the view is not automatically refreshed, you can refresh the view manually. See Section: "How to refresh the view: Manage"
17.9 Assigning via Automation License Manager

17.9.4 Assigning parameters to the TCP/IP communication with a control system

Background
To be able to read or transfer license information from or to the CF card of a control system, the Automation License Manager must communicate with the control system via TCP/IP.

Requirements:
- The HMI basic software is installed
- The SINUMERIK plug-in is enabled

Note
HMI Advanced
If the SINUMERIK user interface "HMI Advanced" is installed on the same computer (PC/PG) as the Automation License Manager you can set the IP address using the user interface. The IP address for the control system with which both HMI Advanced as well as the Automation License Manager communicate is set via the following dialog:
Operating area switchover > Start-up > HMI > NCU link
This requires at least the password of protection level 2 (manufacturer) to be set.

General communication parameters
The default general communication parameters for the HMI basic software are stored in the following initialization file:
<installation drive>:\Siemens\Sinumerik\HMI-Advanced\mmc2\MMC.INI

User-specific communication parameters
The user-specific communication parameters for the HMI basic software are stored in the following initialization file:
<installation drive>:\Siemens\Sinumerik\HMI-Advanced\user\MMC.INI

During evaluation of the initialization data when booting the HMI basic software, user-specific communication parameters have priority over general communication parameters.

Sections of the initialization file: MMC.INI
The parameters relevant to TCP/IP communication with SINUMERIK control systems are stored in the following sections:

- [ GLOBAL ]
  Section: [ GLOBAL ] specifies the section (e.g. AddressParameter) that contains the communication parameters for the current SINUMERIK control system.

- [ AddressParameter ]
  The name of this section can be any unique ASCII string within the file. The specified IP address is crucial for communication with the current SINUMERIK control system: IP address.
Table 17-1  User-specific file: MMC.INI

<table>
<thead>
<tr>
<th>Statements</th>
</tr>
</thead>
<tbody>
<tr>
<td>[GLOBAL]</td>
</tr>
<tr>
<td>NcddeMachineName = AddressParameter</td>
</tr>
<tr>
<td>NcddeDefaultMachineName = AddressParameter</td>
</tr>
<tr>
<td>NcddeMachineNames = AddressParameter</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>[ AddressParameter ]</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDRESS0 = IP address, LINE=10, NAME=/NC, SAP=030d, PROFILE=CLT1__CP_L4_INT</td>
</tr>
<tr>
<td>ADDRESS1 = IP address, LINE=10, NAME=/PLC, SAP=0201, PROFILE=CLT1__CP_L4_INT</td>
</tr>
<tr>
<td>ADDRESS2 = IP address, LINE=10, NAME=/DRIVE0, SAP=0900, PROFILE=CLT1__CP_L4_INT</td>
</tr>
<tr>
<td>ADDRESS3 = IP address, LINE=10, NAME=/DRIVE1, SAP=0a00, PROFILE=CLT1__CP_L4_INT</td>
</tr>
<tr>
<td>ADDRESS4 = IP address, LINE=10, NAME=/DRIVE2, SAP=0b00, PROFILE=CLT1__CP_L4_INT</td>
</tr>
<tr>
<td>ADDRESS5 = IP address, LINE=10, NAME=/DRIVE3, SAP=0c00, PROFILE=CLT1__CP_L4_INT</td>
</tr>
<tr>
<td>ADDRESS6 = IP address, LINE=10, NAME=/DRIVE4, SAP=0d00, PROFILE=CLT1__CP_L4_INT</td>
</tr>
<tr>
<td>ADDRESS7 = IP address, LINE=10, NAME=/DRIVE5, SAP=0e00, PROFILE=CLT1__CP_L4_INT</td>
</tr>
</tbody>
</table>

Multiple SINUMERIK control systems

If you require communication with multiple SINUMERIK control systems you must create a section

[ AddressParameter ] with a unique name e.g. [ 840D_001 ], [ 840D_002 ], etc. for each control system with the relevant IP address.

In the [ GLOBAL ] section, you must specify the section name for the SINUMERIK control system, e.g. [ 840D_001 ], with which communication should occur once the Automation License Manager has booted.

NOTICE

Editing the IP address

The IP address specified in the user-specific initialization file MMC.INI influences not only the Automation License Manager but also all other applications installed on the same computer (PC/PG) that use HMI basic software (e.g. HMI Advanced).

To apply the change to the active IP address, you must close all active applications using HMI basic software (e.g. HMI Advanced). Once you have closed all applications, restart the computer to activate the new IP address.

Requirements

The following conditions must be fulfilled:

- The HMI basic software is installed on the computer (PC/PG) on which the Automation License Manager is running.
- The IP addresses of the SINUMERIK control systems with which the Automation License Manager must communicate are known.
**Procedure: Creating parameters for the first time**

Perform the following actions when creating user-specific communication parameters for the first time:

1. Create the text file:
   <installation drive>\Siemens\Sinumerik\HMI-Advanced\user\MMC.INI if it does not already exist.
2. Open the file MMC.INI with a text editor.
3. Copy the [ GLOBAL ] section from the table given above: "User-specific file: MMC.INI" to the open file MMC.INI.
4. Copy the [ AddressParameter ] section from the table given above: "User-specific file: MMC.INI" to the open file MMC.INI according to the number of available SINUMERIK control systems.
5. For all [ AddressParameter ] sections replace the string: "AddressParameter" with a unique name.
6. In all [ AddressParameter ] sections replace the string: "IP-Address" with the relevant IP address for the corresponding SINUMERIK control system.
7. In the [ GLOBAL ] section replace the string: "AddressParameter" with the section name for the SINUMERIK control system with which the Automation License Manager must communicate after booting. (See note "Changing the IP address" above.)

**Procedure: Changing the active control system (online)**

Perform the following actions to change the active control system (online), i.e. the SINUMERIK control system with which the Automation License Manager communicates:

1. Close the Automation License Manager.
   (See note "Changing the IP address" above.)
2. Open the file: <installation drive>\Siemens\Sinumerik\HMI-Advanced\user\MMC.INI with a text editor.
3. In the [ GLOBAL ] section, replace the current address string with the section name for the SINUMERIK control system with which the Automation License Manager should communicate after booting.
4. Start the Automation License Manager.

**Result**

After booting the Automation License Manager communicates with the SINUMERIK control system defined in the user-specific communication parameters.

The control system to which you have switched is represented by an "online" control system file in the navigation area of the Automation License Manager.

The control system to which the Automation License Manager was connected before switching is represented by an "offline" control system file, if a control image (offline) exists.
17.9 Assigning via Automation License Manager

17.9.5 How to refresh the navigation view: "Manage"

Background

After actions which add or remove elements in the navigation area of the navigation view: "Manage" of the Automation License Manager (e.g. deletion of a control image (offline), enabling/disabling of plug-ins), the view is normally refreshed automatically. If the view does not refresh automatically after an operation, you can refresh the view manually.

Execution

Perform the following actions to refresh the navigation view: "Manage" manually:

1. Select the following nodes in the navigation area of the Automation License Manager:
   - My Computer
2. Refresh the view using one of the following options:
   - Menu command: View > Refresh
   - Key F5
   - Toolbar: 

Result

The navigation view of the Automation License Manager is refreshed. All sub-nodes under the node: My Computer are closed.

The object view of the Automation License Manager shows the current nodes and drives of the navigation area.

Note

All directories are closed when the view is refreshed. When you select key: '*' on the numeric keypad, you can open all directories with a single key.
17.9.6 Displaying the license information of a piece of hardware

Background

To perform one of the following tasks with the Automation License Manager:

- Check the license information for the hardware
- Ascertaining the license requirement for the hardware and align if necessary
- Assign new licenses to hardware and transfer updated license information including License Keys to the hardware

you must display the license information for a hardware item.

Requirements

The license information can only be displayed if the Automation License Manager is communicating with the relevant SINUMERIK control system.

Procedure with current control system (online)

Perform the following actions to display the license information for the control system currently connected to the Automation License Manager:

1. In the navigation area of the Automation License Manager, open: Technology folder: "SINUMERIK online" > Control folder and choose the control system (online) by clicking with the left mouse button.
2. Enable the default object view: "SINUMERIK".

Procedure with control system change over (online)

Perform the following actions to display the license information for a control system not connected to the Automation License Manager:

1. Exit the Automation License Manager and all other applications using HMI basic software (e.g. HMI Advanced).
2. Switch the active communication parameters to the required control system. See Section:
3. Start the Automation License Manager
4. In the navigation area of the Automation License Manager, open: Technology folder: "SINUMERIK online" > Control folder and choose the control system (online) by clicking with the left mouse button.

Result

The license information for the control system (online) is displayed in the object area of the Automation License Manager.
17.9 Assigning via Automation License Manager

17.9.7 Creating a control image (offline)

Background

It is essential to create a control image (offline) in the following situations:

- The license information must later be transferred to the control system (online).
- The computer (PC/PG) on which the Automation License Manager is installed is not simultaneously connected to the Internet and the control system. This means the license information must be transferred to the control system (online) in three separate steps.
  - Intranet or PTP link to control system: Creating a control image (offline) in the Automation License Manager
  - Internet connection: Transferring license information to the control image (offline) by license requirement alignment
  - Intranet or PTP link to control system: Transferring license information from the control image (offline) to the control system (online) in the Automation License Manager
- The license information for a control system should be saved as an archive file for the purpose of archiving or customer support.

Requirements

A control image (offline) can only be created if the Automation License Manager is communicating with the control system.

Note

A PTP link (Peer-To-Peer) via Ethernet and TCP/IP requires a crossed Ethernet cable (twisted pair crossed 10baseT/100baseTX Ethernet cable).

Procedure using drag-and-drop

Perform the following steps to create a control image (offline) of the control system (online) by drag-and-drop:

1. In the navigation area of the Automation License Manager, open:
   Technology folder: SINUMERIK online > Control folder and choose the control system (online) by clicking with the left mouse button.
2. Select any line from the license information displayed in the object area by clicking with the left mouse button.
3. Drag the selected line to the desired target and release the mouse button.
The following objects can be selected as the target:

- Computer
- Drive
- Storage folder
- Control folder "offline"
- Control image (offline)

**Result**

A control image (offline) has been created from the license information of the control system (online) in the selected target:

- <computer> → drive C:\<default storage folder>
- <drive>:\SINUMERIK\<storage folder>\<control folder "offline">
- <storage folder>\<control folder "offline">
- <control folder "offline">
- Control image (offline): The control image (offline) was overwritten with the license information of the control system (online)

**Procedure using menu command: "Upload from target system"**

Perform the following actions to create a control image (offline) of the control system (online) using menu command: "Upload from target system”:

1. In the navigation area of the Automation License Manager, open: Technology folder: SINUMERIK online > Control folder by clicking with the left mouse button.

2. Create the control image (offline) using menu command: License Key > Upload from target system

**Result**

A control image (offline) has been created from the license information of the control system (online) in the default storage folder:
17.9 Assigning via Automation License Manager

17.9.8 Performing a license requirement alignment for a piece of hardware

Background

If one or more options are active on a SINUMERIK control system, you must assign each license to the hardware. Next, the updated license information including the new license key is transferred to the hardware.

Via the function: "Align requirement" you can perform the alignment automatically for all required licenses based on the control system (online) or a control image (offline). The following actions are performed:

- Determining the hardware serial number for the control system
- Determining the license requirement for the control system
- Taking the required licenses from the customer-specific licenses and assigning these to the hardware
- Transferring the updated license information including License Key to the control system (online) or the control image (offline)

Requirements

The following requirements must be met for the license requirement alignment:

- The address data for the customer login (personalized login) is available:
  - User name
  - Password
- Control (online) or control image (offline)
  An "online" control system file or an "offline" control system file with the relevant control image (offline) is available.

Procedure

Perform the following actions for license requirement alignment with a control system (online) or a control image (offline):

1. In the navigation area of the Automation License Manager, open:
   - For control system (online)
     Technology folder: SINUMERIK online > Control folder "online"
   - For control image (offline)
     Technology folder: SINUMERIK offline > storage folder > control folder "offline"

and choose the control system (online) or the control image (offline) by clicking with the left mouse button.

2. Select the menu command: License Key > Align requirement
3. Login via your customer login.

4. Start the Automation License Manager and perform the following actions: "Align requirement", "Confirm requirement list" and "Transfer licenses". Follow the instructions displayed on the screen.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Suggested license assignment</strong></td>
</tr>
<tr>
<td>Carefully check the suggested license assignment. An adjustment may be required if:</td>
</tr>
<tr>
<td>• you wish to use a license number that differs from the number suggested</td>
</tr>
<tr>
<td>• you wish to use a license package rather than single licenses</td>
</tr>
<tr>
<td>• you wish to assign greater or fewer licenses than suggested for any reason</td>
</tr>
<tr>
<td>You can no longer undo the assignment independently.</td>
</tr>
</tbody>
</table>

The procedure for transferring the updated license information from a control image (offline) to a control system (online) is described in Subsection:

**Result**

A new License Key has been generated and loaded to the control (online) or the control image (offline).
17.9 Assigning via Automation License Manager

17.9.9 Transferring license information for a control image (offline) to a control system (online)

Background

It is essential to transfer the license information for a control image (offline) to a control system (online), i.e. the hardware for a SINUMERIK control, in the following situations:

- The computer (PC/PG) on which the Automation License Manager is installed is not simultaneously connected to the Internet and the control system. License information is initially only updated based on a control image (offline). The computer on which the Automation License Manager is running is then disconnected from the Internet and connected to the relevant SINUMERIK control system to transfer the license information.
- After a service call, the license information should be transferred from an archive file to a SINUMERIK control system.

Requirements

The following conditions must met for transmission of a control image (offline) to the control system (online):

- The Automation License Manager must be communicating with the control system.
- The hardware serial number of the control image (offline) and the control system (online) must be identical.

Procedure using drag and drop

Perform the following steps to transfer a control image (offline) to the control system (online) by drag-and-drop:

1. In the navigation area of the Automation License Manager, open:
   Technology folder: "SINUMERIK online" > Control folder and left-click on the control (online) to select it.

2. In the navigation area of the Automation License Manager, open:
   Technology folder: "SINUMERIK offline" > storage folder: > control folder . Choose the control image (offline) by clicking with the left mouse button.

3. Select any line from the license information displayed in the object area by clicking with the left mouse button.

4. Drag the selected line to the control system (online) release the mouse button.
Procedure using menu commands

Perform the following actions to transfer a control image (offline) to the control system (online) using menu command: "Download to target system":

1. In the navigation area of the Automation License Manager, open:
   Technology folder SINUMERIK offline > storage folder: > control folder: and choose the control image (offline) by clicking with the left mouse button:

2. Select the menu command: License Key > Download to target system

Result

The license information of the control system (online) is now identical to the information for the control image (offline), including the license key.

17.10 Internet links

Overview of Internet links used:

<table>
<thead>
<tr>
<th>No.</th>
<th>Topic</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Web License Manager</td>
<td><a href="http://www.siemens.com/automation/license">http://www.siemens.com/automation/license</a></td>
</tr>
</tbody>
</table>
| 2   | Siemens A&D Mall: Customer login | http://mall.automation.siemens.com/ |}
| 3   | Download server               | http://software-download.automation.siemens.com |
Licensing

17.10 Internet links
Cycle protection

18.1 Overview, cycle protection

Functionality

With cycle protection, cycles can be encrypted and then stored, protected in the control. For cycles with cycle protection, execution in the NC is possible without any restrictions. In order to protect the manufacturer's know-how, any type of view is inhibited for cycles with cycle protection. For encryption, a symmetrical algorithm is used - which does not require embargo authorization - with a key length of 56 bits and a non-symmetrical algorithm with a factorization of integer numbers of 2512.

NOTICE
This type of encryption is in compliance with export restrictions and embargo regulations.

Copying encrypted cycles
The encrypted cycle can be copied and can therefore be used at other machines.

Using encrypted cycles at only one machine
If the cycle must not be used at another machine, then the cycle can be permanently linked to a particular machine. Machine data MD18030 $MN_HW_SERIAL_NUMBER can be used for this purpose. When 840D sl boots, the unique hardware serial number of the CompactFlash Card is saved in this machine data.

If a cycle is to be permanently linked to a machine, then the specific serial number of the control must be queried in the call header of the cycle (MD18030 $MN_HW_SERIAL_NUMBER).

If the cycle identifies a serial number that does not match, then an alarm can be output in the cycle - therefore preventing further processing. As the code of the cycle is encrypted, there is always a fixed link to a defined hardware.
Using encrypted cycles for several machine data

If a cycle is to be permanently linked to several, defined machines, the cycle must be entered into each hardware serial number.

The cycle must be re-encrypted with these hardware serial numbers.

Preconditions to encrypt cycles

The encrypted cycles can only be decrypted at the machine in the NC with Power On.

For service calls, it is not possible for Siemens service technicians to decrypt an encrypted cycle file locally.

For a service call, the machine manufacturer must provide the unencrypted cycle.

It is also not possible for the Siemens development department to decrypt an encrypted cycle. Also here, the equipment manufacturer must supply the unencrypted cycle for debug purposes.

18.2 Sequence

18.2.1 Overview, cycle protection sequence

The cycle to be protected is encrypted using an external PC and the SINUCOM Protector program.

The encrypted cycle has the extension _CPF (Coded Program File).

The _CPF files are either loaded to /_N_CST_DIR, /_N_CMA_DIR or /_N_CUS_DIR.

These files can be seen there and can be executed just like the previous part programs (_MPF, _SPF).

To execute a _CPF file, a Power On is required after loading the cycles.

If a Power On is not executed, and a _CPF file is run, then this results in a new NC alarm 15176 "Program %3 can only be executed after Power On".

18.2.2 Preprocessing

Encrypted files can be pre-processed just the same as all _SPF files.

To activate pre-processing, machine data MD10700 $MN_PREPROCESSING_ LEVEL must be set.
Pre-processing is always recommended for runtime reasons.

For pre-processing, an NC program (_MPF) or cycle (_SPF) must be converted from the ASCII format into the binary format (compiled). The following NC alarm is issued if, at the time of execution, the compilation is older than the encrypted cycle file:

15176 "Program%3 can only be executed after Power On".

18.2.3 File extensions for encrypted cycles

Introduction

When considering file extensions, in this conjunction, the following, already existing extensions are relevant:

- _ .MPF "Main Program File" for unencrypted main programs; ASCII
- _ .SPF "Sub Program File" for unencrypted subprograms; ASCII
- _ .CYC "Cycle" for pre-compiled file; binary files

Extensions for encrypted cycles

The following file extensions are available for encrypted cycles:

- _ .CPF "Coded Program File" for encrypted binary files

18.2.4 Handling encrypted cycles in the control

A _CPF file can be deleted or unloaded just like an _SPF or _MPF file. If an archive is generated, all of the encrypted _CPF files are also backed-up.

Note

An encrypted cycle cannot ...

- be directly selected for execution. It can only be called from a program - or directly in MDI.
- Executed with the "Execute from external" function
18.2.5 Subprogram calls without extension

A directory can include an encrypted file file _CPF and also an unencrypted file _SPF with the same name, e.g. CYCLE1. If the unencrypted _SPF file is pre-processed, then the following are located in directory:

- CYCLE1.SPF ; unencrypted cycle
- CYCLE1.CYC ; compilation unencrypted cycle
- CYCLE1.CPF ; encrypted cycle

For a call in the part program without extension, N5 CYCLE1(1.2) the call is made with the following priority:

- CYCLE1.CYC
- CYCLE1.SPF
- CYCLE1.CPF

If only the encrypted file (*.CPF ) is in a directory, for a call without extension, nothing has to be changed. The encrypted file or its compilation is called.

In the case of service, an unencrypted file (*.SPF ) is loaded. As this file has a higher priority, for the same call without extension, this file is called.

Note

An unencrypted file and its compilation have a higher priority than an encrypted file.

18.2.6 Subprogram calls with extensions

Subprogram calls with extension are:

- Direct call N5 CYCLE1_SPF
- Indirect subprogram call ( CALL ) N5 CALL "CYCLE1_SPF"
- Subprogram call with path data ( PCALL ) N5 PCALL /_N_CMA_DIR /_N_CYCLE1_SPF

The following extensions are possible

- N3_MPF ; calls the unencrypted file.
- N5 _SPF ; calls the unencrypted cycle
- N10 _CYC ; calls the compilation of the unencrypted cycle.
- N15 _CPF ; calls the encrypted or its compilation.

If a previous unencrypted cycle CYCLE1 is called with _SPF and this is now only loaded encrypted as _CPF, then all of the calls must be adapted.
18.2.7 **NC language commands with absolute path data**

Using the following commands, files can be accessed in the passive file system from the part program. In this case, absolute path data with extensions are used.

- **WRITE**: Data cannot be attached to a _CPF file, return 4 "incorrect file type".
- **READ**: Lines cannot be read from a _CPF file, return 4 "incorrect file type".
- **DELETE**: _CPF files can be deleted.
- **ISFILE**: A check can be made as to whether a _CPF file is available.
- **FILEDATE**
- **FILETIME**
- **FILESIZE**
- **FILESTAT**
- **FILEINFO**

All commands can also be called for _CPF files. The commands then supply the corresponding information.

18.2.8 **Actual block display**

If an encrypted cycle is executed, then DISPLOF is always active, independent of the programmed PROC attributes. DISPLOF and DISPLON in the block have no effect. If an NC alarm occurs in the cycle, when programming ACTBLOCNO, the block number is not output in the alarm line, but always just the line number.

18.2.9 **Basic block display**

If a _CPF cycle is executed, for an active basis block display, the absolute end of block is still displayed. In the single block, this information corresponds to the display of the axis actual values and can also be entered there.

18.2.10 **Version display**

If a version is entered in the header of an encrypted _CPF cycle, then this version is displayed in the contents screen of a cycle directory, just the same as for unencrypted cycles.

18.2.11 **Simulation**

When executing a _CPF file, the absolute end values are still displayed.
18.3 General conditions

A machine manufacturer cycle can be called from a main program using the cycle name and an extension, for example _SPF. This is possible in the CALL, PCALL command or also directly with the name. If this machine manufacturer cycle is loaded encrypted as _CPF, all sub-program calls with extension must be changed to _CPF.
18.4 Notes

---

Note
End user
When using encrypted cycles of a machine manufacturer, when problems occur, then only the service department of the machine manufacturer should be contacted.

---

Note
Machine manufacturer
When using encrypted cycles, the machine manufacturer must ensure that original, unencrypted cycles are archived with the appropriate version management.
New installation/upgrading

19.1 Classic

19.1.1 Introduction

Introduction

The CNC software on the CompactFlash Card can be newly installed or upgraded.

A new installation is required if there is no CNC software on the CompactFlash Card (see Chapter New installation (Page 385)).

An upgrade is required if an older CNC software is available on the CompactFlash Card (see Chapter Upgrading (Page 392)).

Media for new installation/upgrade

Using the following media, you have the option of initiating a new installation/upgrade:

- USB-FlashDrive
- WinSCP on PC/PG
- VNC viewer on PC/PG

Note

A new installation/upgrade always requires a bootable USB-FlashDrive for the control.

In order that this USB-FlashDrive is capable of being booted, an "NCU Service System" must be installed on it.

The procedure to generate a "boot-capable" USB FlashDrive is described in Chapter Installing "NCU Service System" on a USB-FlashDrive (Page 384).

See also

Initial commissioning procedure (Page 19)
19.1.2 Installing "NCU Service System" on a USB-FlashDrive

Introduction

A new installation/upgrade always requires a USB-FlashDrive with "NCU Service System".

19.1.2.1 Installing "NCU Service System" on the USB-FlashDrive via DOS-Shell

Flow diagram

Figure 19-1 Installing "NCU Service System" on a USB-FlashDrive via "Dos shell"
19.1.2.2 Installing "NCU Service System" on a USB-FlashDrive via RCS-Commander

Flow diagram

19.1.3 New installation

Introduction

No CNC software was installed on the CompactFlash Card. The CompactFlash Card is empty.

You have the following options of initiating a new installation of the CNC software:

- Automatic installation using USB-FlashDrive
- Installation using USB-FlashDrive
- Installation using WinSCP on PG/PC
- Installation using VNC Viewer on PG/PC
19.1.3.1 Automatic installation of the CNC software using USB-FlashDrive

Flow diagram

Figure 19-3  Automatic installation using USB-FlashDrive
19.1.3.2 Installation of the CNC software using USB-FlashDrive

Flow diagram

![Flow diagram](image-url)

Figure 19-4 Installing the control software using USB-FlashDrive
Flow diagram - installation of the system TCU (1) continued

Figure 19-5 Installing the control software using USB-FlashDrive - continued (TCU system)
Flow diagram - installation of the system PCU (2) continued

Figure 19-6 Installing the control software using USB-FlashDrive - continued (PCU system)
19.1.3.3 Installation of the CNC software using WinSCP on PC/PG

Flow diagram

Figure 19-7  Installation using WinSCP on PG/PC
19.1.3.4 Installation of the CNC software using VNC Viewer on PC/PG

Flow diagram

Figure 19-8 Installation using VNC Viewer on PG/PC
19.1.4 Upgrading

Introduction

Note
Upgrade

An upgrade is possible from CNC software 2.xx and higher. It is not permissible to upgrade from other software releases. In the case, a new installation is required.

- When the software is upgraded, all user data are kept on the CompactFlash Card in the directories /user, /addon, /oem. The license key is kept as well.
- Backup data before each upgrade:
  - NC/PLC/drive archive
  - Load the PLC project into the PC/PG (STEP7)
  - License key
- Prior to overwriting a licensed CompactFlash Card, a backup of the license key is absolutely necessary. The key is included in the "keys.txt" file and is located in the path /card/keys/sinumerik. The key can be backed-up e.g. using WinSCP from the PG/PC.
- The licenses are permanently assigned to the CompactFlash Card (card ID) and can only be used on this card.

Note
The license key can be read back via Web License Manager (Page 353) using the card number.

Upgrade options

You have the following options of upgrading the CNC software:

- Automatic upgrade using USB-FlashDrive
- Upgrade using USB-FlashDrive
- Upgrade using WinSCP on PG/PC
- Upgrade using VNC Viewer on PG/PC

Note
Before the upgrade, you can backup the complete CompactFlash Card. Using Restore, you can write back this backup to the CompactFlash Card.
19.1 Classic

IBN CNC: NCK, PLC, drive
Commissioning Manual, 02/2011, 6FC5397-2AP40-0BA0

Note
For an automatic upgrade with autoexec.sh from the USB-FlashDrive, the CompactFlash Card is first backed up.
The backup file "card_img.tgz" is saved under the following directory:
/machines/[machine name+serial number of the CompactflashCard]
An existing data backup is not overwritten. In this case, the operation is exited with an error.
The upgrade is made once the backup has been successfully completed.

19.1.4.1 Backup/Restore

Introduction
Before the upgrade, you can backup the complete CompactFlash Card. Using Restore, you can write back this backup to the CompactFlash Card.
Automatic backup of the complete CompactFlash Card

**Flow diagram**

1. **Automatic backup of the complete CompactFlash Card**
2. **Installation of the NCU service system on USB-FlashDrive**
   - USB-FlashDrive with NCU Service System >= 2.50.21.00 available?
     - no
     - Open Windows Explorer
     - Insert USB-FlashDrive in the PC/PG
     - Copy "autexec.sh" to USB-FlashDrive (root directory)
     - Remove USB-FlashDrive
     - Power OFF NCU
   - yes
     - Path on the DVD supplied: \Vol_hmi-all\standard (export!) emergency_bootsys_ncu sw_update/autexec.sh

3. **SIM/NCK -> 7 PLC -> 0**
   - Insert USB-FlashDrive at NCU (X125)
   - Power ON NCU
   - –> RDY LED flashes green (approx. 5sec)
   - RDY LED red?
     - no
     - RDY LED OFF?
       - yes
         - Backup file "card_img.tgz" generated on USB-FlashDrive
         - Power OFF NCU
         - Remove USB-FlashDrive
         - SIM/NCK -> 0 PLC -> 0
       - no
         - See error cause in the autoexec.log file (e.g. CompactFlash Card too small)

4. **END**

Figure 19-9  Automatic backup of the complete CompactFlash Card
Automatic restoration of the complete CompactFlash Card

Flow diagram

Figure 19-10 Automatic restoration of the complete CompactFlash Card
19.1.4.2 Automatic upgrade of the CNC software using USB-FlashDrive

Flow diagram

Path to the DVD supplied: \Vol_hmi-slstandards\emergency_bootsys_nceu_sw_update\autoexec.sh

Figure 19-11 Automatic upgrade of the CNC software using USB-FlashDrive
19.1.4.3 Upgrading the CNC software using USB-FlashDrive

Flow diagram

Figure 19-12 Upgrading the CNC software using USB-FlashDrive
New installation/upgrading

19.1 Classic

Flow diagram - continued system TCU (1)

Figure 19-13 Upgrading the CNC software using USB-FlashDrive - continued (TCU system)
Flow diagram - continued PCU system (2)

Figure 19-14 Upgrading the CNC software using USB-FlashDrive - continued (PCU system)
19.1.4.4 Upgrading the CNC software using WinSCP on PC/PG

Flow diagram

Figure 19-15 Upgrading the CNC software using WinSCP on PC/PG
19.1.4.5 Upgrading the CNC software using VNC Viewer on PC/P8

Flow diagram

Figure 19-16 Upgrading the CNC software using VNC Viewer on PC/P8
19.2 With SinuCom Installer (SCI)

19.2.1 Software prerequisites and fundamentals on the content of this chapter "New installation/upgrade with SinuCom Installer"

Software prerequisites

The prerequisite for the configuration of an Installer package for automatic new installation/upgrade is that the engineering software "SinuCom Installer" higher than or equal to Version 2.6 is installed on your PG/PC.

Basic information on the content of the chapter

Note

The descriptions for new installation/upgrading with SinuCom Installer include basic steps for configuring and subsequent automatic new installation/upgrading of an NCU.

Detailed online help is provided in the engineering software "SinuCom Installer Expert".
19.2.2 Automatic new installation with SinuCom Installer (SCI)

Introduction

You configure an Installer package for new installation of the CNC software using the "SinuCom Installer Expert" engineering software.

Precondition

You have installed the "SinuCom Installer" software Version 2.6 on the PG/PC.

The following preconditions must be met for the CompactFlash Card of the NCU:

- The CompactFlash Card of the NCU is empty or contains executable NCU software.
  - If any CNC software and possibly irrelevant user data are on the CompactFlash Card, then these are lost when the software is newly installed.
- You have a <name>.tgz file (cnc-sw.tgz) with the actual software.
- You want to initiate a new installation of the NCU via a USB FlashDrive.

Note

If the CompactFlash Card is empty or contains CNC software that cannot be executed, then you need a USB-FlashDrive with installed "NCU Service System (Page 384)".

Operating sequence

1. Start the engineering software "SinuCom Installer Expert".
   - With this software you configure an Installer package, which initiates a new installation from the USB-Flashdrive to the CompactFlash Card of the NCU.

2. Create a new project under "File" > "New" > "New Project".
3. Activate the "NCU" area under the "Package" tab.

Figure 19-17 SinuCom Installer Expert
4. Activate the "NCU system software" window under the "Dialogs" tab.

![Figure 19-18 "Dialog" tab]
5. In the context menu, select > right mouse button > "edit mode for all dialog boxes" > "Automatic".

![Figure 19-19 Automatic edit mode](image)

6. In the "NCU system software" window under "Installation", select the "New installation" mode.

7. For the file "<name>.tgz" you have the following options:
   - The file is embedded in the Installer package.
     For the automatic new installation insert the "<name>.tgz" file in the project under "TGZ files". To do this, enter the name of the TGZ file in the "Preselection" area.
   - Copy the file on the USB FlashDrive into the root directory in which the Installer package is located.
     You only enter the name with the prefix "./" in the "Preselection" field under "TGZ files": ./<name>.tgz
     The file is automatically selected while the Installer package is running.
8. Create an Installer package "<name>.usz" via the menu "File" > "Transfer" > "Linuxpaket (NCU).

The SinuCom Installer Expert saves the project and performs a check routine.

The Installer package is placed in the root directory on the USB-FlashDrive - and depending on the configuration - also the file "<name>.tgz".

**Note**

The USB-FlashDrive must only be bootable if the CompactFlash Card of the NCU does not contain executable CNC system software.

9. Insert the USB FlashDrive into a USB socket (X125 or X135) of the NCU.
10. Switch the control system off and on again.

Provided that when configuring you configured the "Edit mode of all dialogs" > "Automatic", then the package is automatically executed when the control system powers-up (boots).

The dialogs are displayed, but require no operator actions.

The CNC software has been installed once the Installer package has been completed.

A logbook about the activities that have been performed can be saved. The logbook documents all activities performed during the new installation.
11. Switch-off the control.
12. Remove the USB-FlashDrive.
13. Commissioning work can continue after the control system has been switched on.

**Optional additional functions for CNC software installations**

In the same package - after the CNC software installation - the following actions can be optionally configured, which can either run completely automatically or conditionally at the machine:

- Loading an SDB Archive
- SINAMICS device configuration
- Renaming DOs, SINAMICS components and DO numbers
- Assignment of the drives to NC axes
- Manipulation of (standard) data in the NC and drive area
- Manipulation of display machine data
- Loading of PLC user programs
- Installation of user software
- Copying, deleting and manipulating files on the CompactFlash Card.
- Conditional execution of actions, executing, deleting, copying and manipulating
- Messages and interactions to the operator
19.2.3 Automatic upgrade with SinuCom Installer (SCI)

Introduction

Note
An upgrade is possible from CNC software 1.4, 1.5, 2.4, 2.5, 2.6 and higher (precise Version, see "siemens.txt" on the product CD of the SinuCom installer).

When the software is upgraded, all user data is kept on the CompactFlash Card and in the control areas NCK, PLC and drives.

The NCK and drive data are automatically migrated into the new CNC software version. Archives neither have to be created nor imported again.

The "NCK commissioning switch" and "PLC mode selector switch" remain during the update in position "0".

In conjunction with an upgrade, using the same Installer package, the automatic generation of a backup can be configured, which is then stored on the USB FlashDrive. It is not necessary to first generate an archive.

You configure an Installer package for upgrade of the CNC software using the "SinuCom Installer Expert" engineering software.

Note
After the CNC software has been upgraded, adaptations may be required. Using the SinuCom Installer Expert, these adaptations can also be configured and therefore automatically executed.

For information about the necessary adaptations, please refer to the upgrade instructions of the respective CNC software versions.
Operating sequence

1. You have started the engineering software "SinuCom Installer Expert". Using this software, you configure an Installer package which initiates that the CNC software on the CompactFlash Card of the NCU is updated.

2. You have created a new project under "File" > "New" > "New Project".

3. Activate the "NCU" area under the "Package" tab.

Figure 19-20  SinuCom Installer Expert
4. Activate the "NCU system software" window under the "Dialogs" tab.

4.1. Figure 19-21 "Dialog" tab

5. In the context menu, select > right mouse button > "edit mode for all dialog boxes" > "Automatic".

6. In the "NCU system software" window under "Installation", select the "Update" mode.

7. For the <name>.tgz files you have the following options:
   - The file is embedded in the Installer package.
     - For the automatic new installation insert the "<name>.tgz" file in the project under "TGZ files". To do this, enter the name of the TGZ file in the "Preselection" area.
   - Copy the file on the USB FlashDrive into the root directory in which the Installer package is located.
     - You only enter the name with the prefix "/" in the "Preselection" field under "TGZ files": ./<name>.tgz
     - The file is automatically selected while the Installer package is running.
8. Create an Installer package "<name>.usz" via the menu "File" > "Transfer" > "Linuxpaket (NCU)."

   The SinuCom Installer Expert saves the project and performs a check routine.

   The Installer package is placed in the root directory on the USB-FlashDrive - and depending on the configuration - also the file "<name>.tgz".

9. Insert the USB FlashDrive into a USB socket (X125 or X135) of the NCU.

10. Switch the control system off and on again.

    Provided that when configuring you configured the "Edit mode of all dialogs" > "Automatic", then the package is automatically executed when the control system powers-up (boots).

    The CNC software has been updated and all data is available again after the Installer package has been completed on the NCU.

11. Switch-off the control.

12. Remove the USB-FlashDrive.

13. The machine is ready for operation again after switch-on.

   A logbook about the activities that have been performed can be saved. The logbook documents all activities performed during the update.

---

**Optional additional functions for CNC software installations**

In the same package - after the CNC software has been updated - the following actions can be optionally configured, which can either run completely automatically or conditionally at the machine:

- SINAMICS device configuration
- Renaming DOs, SINAMICS components and DO numbers
- Assignment of the drives to NC axes
- Manipulation of the NC and drive data
- Manipulation of display machine data
- Loading, deleting and replacing PLC blocks (replacing the basic program)
- Installation of application software on the NCU.
- Copying, deleting and manipulating files on the CompactFlash Card.
- Conditional execution of actions, executing, deleting, copying and manipulating
- Messages and interactions to the operator
New installation/upgrading

19.2 With SinuCom Installer (SCI)
20 General tips

20.1 Configuration of the properties of the network interface for PROFIBUS

Introduction

In the STEP7 project, you configure the network interfaces PROFIBUS DP, via which you want to reach the machine control panel:

PROFIBUS DP operating sequence

1. You used the left mouse button to select NCU 720.1 and while holding down the mouse button you dragged it to the “Station design” station window.

2. After you release the mouse button, configure the properties of PROFIBUS DP interface for socket X126 (machine control panel) in the dialog box (see figure below).

![Properties of PROFIBUS DP](image)

Figure 20-1 Properties of PROFIBUS DP

3. Click on the following one after the other:
   
   - the "New..." button,
   
   - the "Network settings" tab in the "Properties new subnet PROFIBUS Subnet" dialog box.
4. Select the transmission rate "12 Mbps" for the "DP" profile (see figure below).

![Properties of the PROFIBUS interface](image1.png)

Figure 20-2  Properties of the PROFIBUS interface

5. Click on "Options" and then on the "Equidistance" tab (see figure below).

![Equidistance](image2.png)

Figure 20-3  Equidistance
6. To enable reproducible access to peripherals (for hand wheel mode), the PROFIBUS DP must have constant bus cycle time. The following entries are necessary under Equidistance:
   - Click on the "Activate equidistance bus cycle" field
   - Enter the cycle, e.g., "2 ms" for the "Equidistance DP cycle" (for integrated PROFIBUS) (see MD10050 $MN_SYSOCK_CYCLE_TIME).
   - Click on the "Times Ti and To equal for all slaves" field
   - The fields "Time Ti" and "Time To" must contain a value "< 2ms".
7. Click on "OK" three times.
8. Module NCU 720.1 with SINAMICS S120 is inserted into the HW config (see figure below).

Note
With the <F4> key and confirmation of the question regarding "Reorganize", you can reorganize the display in the station window.

As the next step configure a machine control panel with hand wheel.
20.2 Separate NCK and PLC general reset

20.2.1 NCK general reset

Carry out the following actions to perform an NCK general reset:

1. Turn the NCK commissioning switch (labeled "SIM/NCK") at the front of the NCU to position "1".
2. Initiate a power on reset by switching-off the control and switching-on again - or by pressing the Reset button on the front of the NCU (labeled "RESET"). The NCU is terminated and with the request for a general NCK reset is restarted.
3. After the NCU has booted, turn the NCK commissioning switch back to the "0" position.
   Effect:
   - The number "6" and a flashing point are output on the status display (7-segment display) on the front of the NCU.
   - "RUN" LED is lit
The NCU is in the following state after an error-free power-up (boot):
- The static memory of the NCU is deleted.
- The machine data are preassigned standard values.
- The NCK is in cyclic operation.

20.2.2 PLC general reset

A PLC general reset can be performed with or without power on reset. Depending on this - and depending on the PLC - different states are obtained for the basic PLC and user program:

PLC general reset without power on reset

Perform the following operator actions for a PLC general reset without power-on reset:

1. Turn the PLC mode selector switch (labeled "SIM/NCK") on the front of the NCU to position "2" (STOP).
   Effect:
   - The PLC goes into the "STOP" state
   - LED "STOP" is lit
2. Turn the PLC mode selector switch to position "3" (MRES)
   Effect:
   - LED "STOP" goes dark and after approximately 3 seconds is lit again
3. Within approx. 3 seconds, turn the PLC mode selector to the positions "2" → "3" → "2"

Effect:
- LED "STOP" flashes with about 2 Hz and then changes to a steady light.

4. After the LED "STOP" again has a steady light condition, turn the PLC mode selector again back to position "0".

Effect:
- LED "STOP" goes dark
- "RUN" LED is lit

A general reset has now been performed for the PLC and is now in cyclic operation with the following properties:

- The user data have been deleted (data and program blocks).
- PLC319-3PN/DP: see the following note
- The system data blocks (SDB) have been deleted.
- The buffered data have been written back to the RAM area.
- The time of day and the operating hours counter have not been reset.
- The diagnostics buffer and the MPI parameters are not reset.

Note
PLC319-3PN/DP

For a PLC319-3PN/DP, in the case of a PLC general reset without power on reset, the user data is first backed up on the CF Card and is then loaded into the PLC. Therefore, after a PLC general reset, user data are not deleted.

PLC general reset with power on reset

Perform the following operator actions for a PLC general reset with power on reset:

1. Turn the PLC mode selector on the front of the NCU to position "3" (MRES).

2. Initiate a power on reset by switching-off the control and switching-on again - or by pressing the Reset button on the front of the NCU (labeled "RESET"). The NCU is shut down and with the request for a general PLC reset is restarted.

Effect:
- LED "STOP" flashes
- LED "SF" is lit
20.2 Separate NCK and PLC general reset

3. Turn the PLC mode selector switch to position "2" and back again to position "3".
   Effect:
   – The "STOP" LED flashes approx. 20 seconds with approx. 2 Hz, then:
   – LED "STOP" is lit
   – "RUN" LED is lit

4. After the LED "STOP" again has a steady light condition, turn the PLC mode selector back to position "0".
   Effect:
   – LED "STOP" goes dark

A general reset has now been performed for the PLC and is now in cyclic operation with the following properties:

- The user data have been deleted (data and program blocks).
- The system data blocks (SDB) have been deleted.
- The buffered data have been written back to the RAM area.
- The time of day and the operating hours counter have not been reset.
- The diagnostics buffer and the MPI parameters are reset.
20.3 Configuring the communication between the PLC and the drive

Telegram lengths and I/O addresses

Note

In the HW Config, a telegram length and the associated I/O addresses is preassigned per default.

The pre-assignment for SINAMICS Integrated corresponds to telegram 116 for the axes and 391 for the NCU and 370 for the ALM with the max. possible telegram length.

This default can be used to supply all known telegrams; no modification is necessary.

Operating sequence

1. To view this configuration, click in the HW Config on the module "SINAMICS Integrated" and select "Object properties", using the <right mouse button>.
2. Select the "Configuration" tab and the select the "Overview" tab.

As shown in the figure below, you can view the lengths of the preassigned telegrams.

The figure shows user-defined telegrams for 6 axes.

![Image of HW Config showing telegram lengths and I/O addresses](image)

Figure 20-5 Message length
3. Click "OK" to close the dialog.

4. You can view the address areas in the station window in the detail view by clicking on "SINAMICS Integrated". Here, for example, address 4100 corresponds to the address entered in MD13050 $MN_DRIVE-LOGIC_ADDRESS[0]. The addresses have a gap of 40 bytes. The following figure shows how the default values MD13050 $MN_DRIVE-LOGIC_ADDRESS[0…5] correspond to the input/output addresses for standard configuration of the PLC.

Figure 20-6 SINAMICS Integrated addresses
20.4 Integrating PG/PC into the network (NetPro)

Introduction
To carry out routing functions, it is necessary to integrate a PG/PC in the SIMATIC Manager under NetPro and to configure the interfaces.

Requirements
The following preconditions for integrating a PG/PC in the hardware configuration network must be satisfied:

- inserted NCU 720.1 into the HW config,
- configured the properties of the network interfaces,
- configured the PLC to drive communication,
- inserted the machine control panel (MCP),
- saved and compiled the configuration,
- created a PLC program.

See also
- Insert NCU 7x0 in HW config (Page 52)
- Configuring the properties of the network interfaces (Page 54)
- Adding a machine control panel and handwheel in HW Config (Page 439)
- End hardware configuration and load to the PLC (Page 61)
- Creating a PLC program (Page 62)
20.4 Integrating PG/PC into the network (NetPro)

20.4.1 Integrating PG/PC into NetPro

Introduction

To enable the communication between PG/PC <-> HMI via Ethernet, the PG/PC should be included in the network configuration of the system.

To integrate the PG/PC, proceed from the following starting situation in the SIMATIC Manager.

You are in the HW config in the created project "PLC-Erst-IBN 840D sl" (see figure below).

Figure 20-7  HW config project "PLC-Erst-IBN 840D sl"
Operating sequence for integrating PG/PC into NetPro

1. Click on the "NetPro" button (see previous figure).
2. From the catalog under "Stations", insert the PG/PC via Drag&Drop into the network configuration (see figure below).

The newly inserted symbol PG/PC does not yet contain any interfaces. Next, configure the interfaces.
20.4.2 PG/PC interface configuration

Introduction

Under NetPro, configure the interfaces required for commissioning at the PG/PC. These may include the following interfaces:

- Ethernet for the communication for NCU socket X127
- PROFIBUS

Operating sequence for configuring interfaces

1. Highlight the symbol "PG/PC" under NetPro.
2. Select "Object properties" <right mouse button >.
3. In the "Properties - PG/PC" dialog box displayed, select the "Interfaces" tab in the dialog (see figure below).

Under this tab, define/configure all the required interfaces.

![Properties - PG/PC](image-url)
Operating sequence for configuring interfaces at PG/PC

1. Click on "New..." to configure the Ethernet interface first.

2. In the type selection field, select "Industrial Ethernet" (see figure below).

3. Click "OK".

4. In the subsequent dialog box, select the subnet "Ethernet(1)" and enter the IP address and the subnet screen mask of your PG/PC (see figure below). E.g.:
   - IP address, such as, 192.168.0.3
   - Subnet screen form = 255.255.255.0

5. Click "OK".
6. You can configure additional interfaces via "New".

7. When you have configured the interfaces, all the configured interfaces are visible under the "Interface" tab (see figure below).

![Configured interfaces](image)

Figure 20-12 Configured interfaces

The configured interfaces must be assigned in a device-specific manner to the available hardware interfaces on the PG/PC.

The sequence steps are laid out in the following section.
20.4 Integrating PG/PC into the network (NetPro)

20.4.3 Assigning interfaces

Introduction

The interfaces configured in the previous chapter must now be assigned in a device-specific manner to the available hardware interfaces on the PG/PC.

Operating sequence for assigning an Ethernet interface

1. Select the "Assign" tab.
2. Select "Ethernet interface(1)" in the selection field "Configured interfaces".
3. Select the installed network card "TCP/IP -> Realtek RTL8139/810xF..." in the selection field "Interface parameterizations in PG/PC" (see figure below).

Figure 20-13 Selecting
4. Click on "Assign" and confirm the subsequent message on processing object properties with "OK".

The assigned interfaces are deleted from the field "Configured interfaces" and these assigned interfaces are displayed in the field "Assigned" (see figure below).

![Figure 20-14 Assigning Ethernet interface](image)

5. Now assign the remaining configured interfaces (PROFIBUS).

   From those interfaces assigned, one must be marked as "active".

6. Select "Ethernet interface" in the field "Assigned" and mark the field next to it as "active".
7. Click on "OK" to end the dialog "Properties - PG/PC".

In NetPro, the PG/PC interface declared as "active" is highlighted in YELLOW (see figure below).

![Figure 20-15 Configured PG/PC in the network configuration](image)

8. Select "Save and compile > Save and check all" and confirm the process with "OK".

The next operating sequence described explains how to load this hardware configuration to the NCU.
20.4.4 Loading the HW config to NCU

Introduction

The newly created network configuration PG/PC must be introduced to NCU. You have established a connection to the Ethernet interface (X120 or X127) and you load this configuration from the PG/PC to the NCU.

Operating sequence for loading HW config to NCU

1. Change from "NetPRO" to "HW Config".
2. Press the "Download to module" button.
   - The target module interactive screenform automatically displays both configured communication peers.
3. Confirm the load into the module with "OK".
4. Confirm the dialog boxes displayed subsequently with "OK" or "No" for the query "…Should the module be started now (restart)?".

Note

Loading the HW config to NCU is only possible via Ethernet interface.
20.5 Overview - Assignment of SINAMICS and NCK machine data for communication via PROFIBUS

Assignment of SINAMICS and NCK machine data for communication

The table below uses a sample to SINAMICS S120 component configuration to illustrate the assignment of the communication parameters. The SINAMICS S120 drive group comprises the following:

- an NCU (CU),
- an ALM,
- three Motor Modules (MM)

**Note**

In the Control Unit Parameter 978, deactivate the process data exchange with the value "0". Cyclic and acyclic data are separated. Components that do not communicate on PROFIBUS are to be preassigned "255".
### General Tips

#### 20.5 Overview - Assignment of SINAMICS and NCK machine data for communication via PROFIBUS

**IBN CNC: NCK, PLC, drive**

**Commissioning Manual, 02/2011, 6FC5397-2AP40-0BA0**

---

#### SINAMICS S120

<table>
<thead>
<tr>
<th>HW Module</th>
<th>Control Unit Parameter p978[0-9]</th>
<th>Message frame type</th>
<th>Drive parameter p922</th>
<th>Message frame type</th>
<th>I/O address 1</th>
<th>MD13120[0]</th>
<th>MD1305[0-5]</th>
<th>MD1306[0-5]</th>
<th>MD30110/3022</th>
<th>MD30130</th>
</tr>
</thead>
<tbody>
<tr>
<td>MM1</td>
<td>3</td>
<td>116</td>
<td>116</td>
<td>PZD-11/19</td>
<td>4100</td>
<td>4100</td>
<td>116</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>MM2</td>
<td>4</td>
<td>116</td>
<td>116</td>
<td>PZD-11/19</td>
<td>4140</td>
<td>4140</td>
<td>116</td>
<td>2</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>MM3</td>
<td>5</td>
<td>116</td>
<td>116</td>
<td>PZD-11/19</td>
<td>4180</td>
<td>4180</td>
<td>116</td>
<td>3</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>x</td>
<td>255</td>
<td>x</td>
<td>116</td>
<td>PZD-11/19</td>
<td>4220</td>
<td>4220</td>
<td>116</td>
<td>4</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>x</td>
<td>255</td>
<td>x</td>
<td>116</td>
<td>PZD-11/19</td>
<td>4260</td>
<td>4260</td>
<td>116</td>
<td>5</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>x</td>
<td>255</td>
<td>x</td>
<td>116</td>
<td>PZD-11/19</td>
<td>4300</td>
<td>4300</td>
<td>116</td>
<td>6</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CU</td>
<td>1</td>
<td>391</td>
<td>391</td>
<td>PZD-3/7</td>
<td>6500</td>
<td>6500</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ALM</td>
<td>255</td>
<td></td>
<td>370</td>
<td>PZD-1/1</td>
<td>6514</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

**Figure 20-16 Assignment**

- **Control Unit Parameter p978[0-9]**
- **Message frame type**
- **Drive parameter p922**
- **Message frame type**
- **I/O address 1**
- **MD13120[0]**
- **MD1305[0-5]**
- **MD1306[0-5]**
- **MD30110/3022**
- **MD30130**

1 Standard value, do not change

---

**Legend**

- **Process data (PZD) exchange configured**
- **Does not exist**
- **Not active**
20.6 Drive-object assignment for PROFIBUS connection

Introduction

PROFIBUS message frames (internal PROFIBUS, HW Config) are used to specify the process data to be exchanged between the NCK and the drives. The sequence of the drive objects (configurable/configured using HW Config) involved in PROFIBUS process-data exchange is defined via a drive-object list.

List of drive objects

You usually configure eight drive objects (DOs). The drive objects have drive-object (DO) numbers and are input in p978[0…9] as a list of drive objects.

You configure the following from parameter p978 in the index:

- 0…5 -> Motor Module (e.g., DO no. 3…8)
- 6 -> Control Unit (e.g., DO no. 1)
- 7 -> Active Line Module (e.g., DO no. 2),

PROFIBUS message frame 370 is not currently available for the Active Line Module (infeed). However, according to the SINAMICS rule, all DOs from parameter p0101 have to be assigned in parameter p0978. The resulting infeed DO number then has to be entered in index 9 (see table below).

Note

The list of DOs involved in process-data exchange is completed by entering a value of "0". Components that are available, but do not communicate on PROFIBUS, must be preset to "255".

The list of drive objects is already pre-assigned in the following order by the system upon initializing the drive (acceptance of topology):

- ALM, first Motor Module …n., CU; e.g., 2-3-4-5-1.
- The assignment allocated by the drive when the DRIVE-CLiQ topology is accepted must be reviewed and adapted.

Drive-object numbers

The drive-object numbers (DO numbers) can be viewed under "Commissioning > Machine data > Control Unit MD/Infeed MD/Drive MD" in the component name line. For example, the name for a Control Unit could be: "DP3Slave3:CU_003 (1)". The DO number appears inside the brackets "(…)".
Drive-object assignment

The table below uses the example of a SINAMICS S120 component configuration to illustrate the drive-object assignment to be made for the drive parameters.

For example, the drive group could be configured as follows:

- One Control Unit (CU)
- One Active Line Module (ALM)
- Three Motor Modules

Table 20-1  Assignment of p978[0…9] for infeed with DRIVE-CLiQ connection

<table>
<thead>
<tr>
<th>Component</th>
<th>Index p978</th>
<th>List of drive objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st motor module</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>2nd motor module</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>3rd motor module</td>
<td>2</td>
<td>5</td>
</tr>
<tr>
<td>not found</td>
<td>3</td>
<td>255(^1)</td>
</tr>
<tr>
<td>not found</td>
<td>4</td>
<td>255(^1)</td>
</tr>
<tr>
<td>not found</td>
<td>5</td>
<td>255(^1)</td>
</tr>
<tr>
<td>CU</td>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td>ALM, only if protocol 370 is available</td>
<td>7</td>
<td>255(^1)</td>
</tr>
<tr>
<td>not found</td>
<td>8</td>
<td>0(^2)</td>
</tr>
<tr>
<td>ALM (Standard for SINUMERIK)</td>
<td>9</td>
<td>2</td>
</tr>
</tbody>
</table>

1) Not active
2) End of exchange of PZD

Note

The following table describes the assignment of the drive objects in the p978[0…9] for an infeed without DRIVE-CLiQ connection. This assignment is also done for a drive group with NX module.
20.6 Drive-object assignment for PROFIBUS connection

Table 20-2  Assignment p978[0…9] for infeed without DRIVE-CLiQ connection

<table>
<thead>
<tr>
<th>Component</th>
<th>Index p978</th>
<th>List of drive objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st motor module</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>2nd motor module</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>3rd motor module</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>not found</td>
<td>3</td>
<td>255₁</td>
</tr>
<tr>
<td>not found</td>
<td>4</td>
<td>255₁</td>
</tr>
<tr>
<td>not found</td>
<td>5</td>
<td>255₁</td>
</tr>
<tr>
<td>CU</td>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td>ALM, only if protocol 370 is</td>
<td>7</td>
<td>255₁</td>
</tr>
<tr>
<td>available</td>
<td></td>
<td></td>
</tr>
<tr>
<td>not found</td>
<td>8</td>
<td>0₂</td>
</tr>
<tr>
<td>not found</td>
<td>9</td>
<td>0</td>
</tr>
</tbody>
</table>

1) Not active
2) End of exchange of PZD

Procedure for assigning the drive objects in parameter p978

You are now in the "Commissioning > Machine data > Control Unit MD" menu.
p978 can be written using the following sequence:

1. Set p9 = 1
2. Set p978 [0...9] to the values outlined in the table below (column …List of drive objects…), e.g., 3-4-5-255-255-1-255-0-2.
   - Motor Module drive objects, ascending order (connected as per DRIVE-CLiQ)
   - Control unit
   - ALM
3. Set p9 = 0
4. Save "All": set p977 = 1

It is imperative you wait until p977 is automatically written back to "0".

See also

Overview - Assignment of SINAMICS and NCK machine data for communication via PROFIBUS (Page 431)
20.7 PROFIBUS machine control panel on the HMI

Configuration of the PROFIBUS machine control panel

The following is required in the HW Config for a PROFIBUS machine control panel on the HMI:

- Configuration of the properties of the network interface for PROFIBUS
- Supplementation of the machine control panel and hand wheel in HW Config
- Modification of the machine control panel in OP100

20.7.1 Configuration of the properties of the network interface for PROFIBUS

Introduction

In the STEP7 project, you configure the network interfaces PROFIBUS DP, via which you want to reach the machine control panel:

PROFIBUS DP operating sequence

1. You used the left mouse button to select NCU 720.1 and while holding down the mouse button you dragged it to the "Station design" station window.

2. After you release the mouse button, configure the properties of PROFIBUS DP interface for socket X126 (machine control panel) in the dialog box (see figure below).

![Figure 20-17 Properties of PROFIBUS DP](image)

3. Click on the following one after the other:
   - the "New..." button,
   - the "Network settings" tab in the "Properties new subnet PROFIBUS Subnet" dialog box.
4. Select the transmission rate "12 Mbps" for the "DP" profile (see figure below).

![Properties of the PROFIBUS interface](image)

Figure 20-18 Properties of the PROFIBUS interface

5. Click on "Options" and then on the "Equidistance" tab (see figure below).

![Equidistance](image)

Figure 20-19 Equidistance
6. To enable reproducible access to peripherals (for hand wheel mode), the PROFIBUS DP must have constant bus cycle time. The following entries are necessary under Equidistance:
   - Click on the "Activate equidistance bus cycle" field
   - Enter the cycle, e.g., "2 ms" for the "Equidistance DP cycle" (for integrated PROFIBUS) (see MD10050 $MN_SYSOCK_CYCLE_TIME).
   - Click on the "Times Ti and To equal for all slaves" field
   - The fields "Time Ti" and "Time To" must contain a value "< 2ms".
7. Click on "OK" three times.
8. Module NCU 720.1 with SINAMICS S120 is inserted into the HW config (see figure below).

Note

With the <F4> key and confirmation of the question regarding "Reorganize", you can reorganize the display in the station window.

Figure 20-20 HW config with NCU 7x0

As the next step configure a machine control panel with hand wheel.
20.7 PROFIBUS machine control panel on the HMI

20.7.2 Load GSD file (contains machine control panel)

Introduction
To expand the machine control panel, you need the device data (GSD file) with the SINUMERIK MCP. This file contains information that a DP master system requires to link the MCP as DP slave in its PROFIBUS configuration.

This file is a component of the STEP7 package for NCU7x0 (tool box).

Operating sequences
1. Search in the HW config under "Extras" > "Install GSD file..." in the installation directory of the tool box under, for example: C:\temp\tb_sl_1.1.0.0\8x0d\GSD\MCP_310_483 to find the corresponding GSD directory.
2. Choose the corresponding language you want to install.
3. Click "Install".
4. Click "Close".

20.7.3 Adding a machine control panel and handwheel in HW Config

Introduction
The machine control panel (MCP) can be connected via PROFIBUS to the PLC. In later configurations, this will also be possible over the network.

Operating sequence for adding an MCP in HW Config
You have created a NCU and a NX in the HW Config and installed the GSD file for the MCP.
1. Search under "PROFIBUS DP" > "Further field devices" > "NC/RC" > "MOTION CONTROL" for the "SINUMERIK MCP" module.
2. Click with the left mouse button to select the "SINUMERIK MCP" module and drag it to the chain for the "PROFIBUS DP master system" in the "Station design" station window.
3. After releasing the mouse button, the machine control panel is added (see figure below).
4. Select "MCP" and enter the PROFIBUS address 6 under "Object properties" > button "PROFIBUS..." > tab "Parameter" > input field "Address".
5. Click on "OK" twice.

Now you can assign the slots of the machine control panel, e.g., "Standard + Hand wheel".

6. In the hardware catalog under "SINUMERIK MCP" click with the left mouse button to select the "Standard+Hand wheel" option and drag it to Slot 1 (see figure below).

---

Figure 20-21  Machine control panel in HW Config

Figure 20-22  Standard+Handwheel for slot
You have configured a machine control panel with handwheel in HW Config.

**Note**
If a handwheel has been configured, equidistance is required. You set this when you configured the PROFIBUS DP. PROFIBUS address for the machine control panel is "6".

Save, compile and load the configuration to the PLC as the next operating sequence.
20.7.4 Modifying PROFIBUS machine control panel in OB100

Introduction

The PLC basic program automatically transfers the machine control panel signals (MCP signals) and the addresses of the MCP in the HW config if the configuration is set up as laid out below.

Operating sequence

- Under "Blocks", double-click on "OB100" to open it.
- In OB100, the parameters below have to be preset:

  MCPNum := 1
  MCP1IN := P#E 0.0
  MCP1OUT := P#E 0.0
  MCP1StatSend := P#E 8.0
  MCP1StatRec := P#E 12.0
  MCPBusAdresse := 6
  MCPBusType = B#16#33
21.1 Basic information on SINAMICS S120

Introduction

When wiring components with DRIVE CLiQ, the following rules apply: The rules are subdivided into **obligatory rules**, which must be observed, and **optional rules**, which enable automatic topology detection if they are adhered to.

**Obligatory rules:**
- A maximum of 198 DRIVE-CLiQ node components can be connected for each NCU.
- Up to 16 nodes can be connected to a DRIVE-CLiQ socket.
- A maximum of 7 nodes can be connected in one row. A row is always considered from the perspective of the closed-loop control module.
- Ring wiring is not permitted.
- Components must not be double-wired.
Optional rules:

If you follow the optional rules for wiring DRIVE-CLiQ, the components associated with the encoder are automatically assigned to the drives (see figure below) if commissioning is performed via macro 150xxx.

- For one motor module, the related motor encoder must also be connected.
- Due to the improved performance utilization, use as many of the DRIVE-CLiQ points on the NCU as possible.
- It is essential you comply with the optional rules when using the macro. This is the only way to achieve a proper assignment of the drive components.
21.1.2 Drive Objects (DO's) and Drive components

Introduction

The components that belong to the drive group are reflected in the parameterization in a drive object.

Each drive object has its own parameter list.

General procedure

The figure below uses the example of a SINAMICS S120 drive group to illustrate the meaning of the drive components and drive objects.

Example

Drive object 3 is made up of the components Single Motor Module (No. 3), Motor (No. 10), Encoder (No. 9) and SMC (No. 8).

The component number is assigned by the drive after DRIVE-CLiQ topology recognition.

The component number in each case can be viewed in the parameter list for the relevant drive object. E.g.: under operating area "Commissioning > Machine data > Drive MD > Axis +".

Table 21-1 Component numbers in the DO 3

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name of the parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>p121</td>
<td>Component number of power module</td>
</tr>
<tr>
<td>p131</td>
<td>Component number of motor</td>
</tr>
<tr>
<td>p141</td>
<td>Component number of encoder interface</td>
</tr>
<tr>
<td>P142</td>
<td>Component number of encoder</td>
</tr>
</tbody>
</table>
21.1 Basic information on SINAMICS S120

Figure 21-2 Drive group
21.1.3 BICO interconnection

Introduction

Each drive unit contains a large number of interconnectable input and output variables as well as internal control variables.

BICO technology (binector connector technology) allows the drive to be adapted to a wide variety of conditions.

Digital and analog signals, which can be connected freely by means of BICO parameters, are identified by the prefix BI, BO, CI, or CO in their parameter name.

These parameters are identified accordingly in the parameter list or in the function diagrams.

There are:

- Binectors (digital), with
  BI: binector input, BO: binector output
- Connectors (analog), with
  CI: connector input, CO: connector output

Interconnecting signals using BICO technology

To interconnect two signals, a BICO input parameter (signal sink) must be assigned to the required BICO output parameter (signal source).

Literature

Commissioning Manual or List Manual for SINAMICS S120 Documentation
Visualization of BICO connections on the HMI

Accessing the following menu allows you to perform a BICO connection of the SINAMICS drive group associated components.

- "Commissioning" > "Drive system" > "Drives/Drive units" > "Connections" menu

Figure 21-3  "Connections" menu

21.2 Transfer telegrams

Introduction

The transfer telegrams from NCK to the drive are transferred via an internal PROFIBUS on the NCU. They are:

- Send telegrams (drive->NCK)
- Receive telegrams (drive->NCK)

Telegrams

The telegrams are standard telegrams with pre-defined assignment of the process data. These telegrams are interconnected in the drive object using BICO technology.

The drive objects that can exchange process data include the following:

1. Active line module (A_INF)
2. Basic line module (B_INF)
3. Motor module (SERVO)
4. Control unit (CU)

The order of the drive objects in the telegram is displayed on the drive page via the parameter list in the "Commissioning" > "Machine data" > "Control Unit MD" operating area in p978[0...15] and may also be changed through it.
21.2 Transfer telegrams

Receive words/send words
By selecting a telegram via p922 of the related drive object (operating area "Commissioning" > "Machine data" > "Drive MD"), the process data is determined which is transferred between the master and slave.

From the perspective of the slave, the received process data comprises the receive words and the process data to be sent the send words.

The receive and send words are comprised of the following elements:

- Receive words: Control words or setpoints
- Send words: Status words or actual values

Message frame types
The message frame length for communication with the drive must be defined in the hardware configuration. The message frame length to be chosen depends on the axis functions required, e.g., the number of encoders or DSC, or the functions in the drive used.

Note
If you change the message frame length of a drive component in HW config, you also must adjust the selection of the message frame type in the configuration of the interface in the NCK.
21.2 Transfer telegrams

What types of message frames are available?

- Standard telegrams
  The standard telegrams are structured in accordance with the PROFIdrive Profile V3.1. The internal process data links are set up automatically in accordance with the message frame number setting.

- Manufacturer-specific telegrams
  The manufacturer-specific telegrams are structured in accordance with internal company specifications. The internal process data links are set up automatically in accordance with the message frame number setting.

The following vendor-specific telegrams can be set via p0922:
  - For axes (SERVO)
    116 DSC with torque reduction, 2 position encoders, supplementary data (also parameterization)
  - For axes (SERVO)
    118 DSC with torque reduction, 2 independent position encoders per axis, supplementary data (also parameterization)
  - For Control Unit
    390 telegram without probe (for NX)
    391 message frame for up to 2 probes (for NCU)
21.2 Transfer telegrams

21.2.1 Structure of the telegram with the process data for SINUMERIK 840D sl

Introduction

SINUMERIK 840D sl uses the following preferred message frame types:

- For axes
  116 DSC with torque reduction, 2 position encoders, supplementary data (also parameterization)
- For NX
  390 message frame without probe (NX)
- For NCU
  391 message frame for up to 2 probes (only valid for NCU)

Note

The telegram types 116, 390 and 391 are preset by default via HW Config. It is recommended not to change these.

Telegrams for receiving

The following table contains the structure of the telegrams with the process data for receiving the control words and setpoints (NCK->drive).

<table>
<thead>
<tr>
<th>PZD receive word</th>
<th>Message frame 116</th>
<th>Message frame 118</th>
<th>Message frame 390</th>
<th>Message frame 391</th>
</tr>
</thead>
<tbody>
<tr>
<td>PZD 1</td>
<td>STW1</td>
<td>STW1</td>
<td>STW1</td>
<td>STW1</td>
</tr>
<tr>
<td>PZD2</td>
<td>NSET_B</td>
<td>NSET_B</td>
<td>Digital outputs</td>
<td>Digital outputs</td>
</tr>
<tr>
<td>PZD 3</td>
<td></td>
<td></td>
<td></td>
<td>STW_PROBES</td>
</tr>
<tr>
<td>PZD 4</td>
<td>STW2</td>
<td>STW2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PZD 5</td>
<td>M_RED</td>
<td>M_RED</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PZD 6</td>
<td>G1_STW</td>
<td>G2_STW</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PZD 7</td>
<td>G2_STW</td>
<td>G3_STW</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PZD 8</td>
<td>XERR</td>
<td>XERR</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PZD 9</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PZD 10</td>
<td>KPC</td>
<td>KPC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PZD 11</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
21.2 Transfer telegrams

Telegram for sending

The following table contains the structure of the telegrams with the process data for sending the status words and actual values (drive->NCK).

Table 21- 3 Telegrams with the process data for sending (drive->NCK)

<table>
<thead>
<tr>
<th>PZD sending word</th>
<th>Message frame 116</th>
<th>Message frame 118</th>
<th>Message frame 390</th>
<th>Message frame 391</th>
</tr>
</thead>
<tbody>
<tr>
<td>PZD 1</td>
<td>ZSW1</td>
<td>ZSW1</td>
<td>ZSW1</td>
<td>ZSW1</td>
</tr>
<tr>
<td>PZD 2</td>
<td>NACT_B</td>
<td>NACT_B</td>
<td>Digital inputs</td>
<td>Digital inputs</td>
</tr>
<tr>
<td>PZD 3</td>
<td></td>
<td></td>
<td>ZSW_PROBES</td>
<td></td>
</tr>
<tr>
<td>PZD 4</td>
<td>ZSW2</td>
<td>ZSW2</td>
<td>TIMESTAMP_PROBE</td>
<td>_1N</td>
</tr>
<tr>
<td>PZD 5</td>
<td>MELDW</td>
<td>MELDW</td>
<td>TIMESTAMP_PROBE</td>
<td>_1P</td>
</tr>
<tr>
<td>PZD 6</td>
<td>G1_ZSW</td>
<td>G2_ZSW</td>
<td>TIMESTAMP_PROBE</td>
<td>_2N</td>
</tr>
<tr>
<td>PZD 7</td>
<td>G1_XIST1</td>
<td>G2_XIST1</td>
<td>TIMESTAMP_PROBE</td>
<td>_2P</td>
</tr>
<tr>
<td>PZD 8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PZD 9</td>
<td>G1_XACT2</td>
<td>G2_XACT2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PZD 10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PZD 11</td>
<td>G2_ZSW</td>
<td>G3_ZSW</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PZD 12</td>
<td>G2_XACT1</td>
<td>G3_XACT1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PZD 13</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PZD 14</td>
<td>G2_XACT2</td>
<td>G3_XACT2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PZD 15</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PZD 16</td>
<td>LOAD</td>
<td>LOAD</td>
<td>LOAD</td>
<td></td>
</tr>
<tr>
<td>PZD 17</td>
<td>TORQUE</td>
<td>TORQUE</td>
<td>TORQUE</td>
<td></td>
</tr>
<tr>
<td>PZD 18</td>
<td>POWER</td>
<td>POWER</td>
<td>POWER</td>
<td></td>
</tr>
<tr>
<td>PZD 19</td>
<td>CURR</td>
<td>CURR</td>
<td>CURR</td>
<td></td>
</tr>
</tbody>
</table>

21.2.2 Process data for receiving and sending

Process data for receiving

The process data for the control words and setpoints are interconnected in the receive buffer.

Overview of control words and setpoints

The table below provides an overview of the process data that are interconnected as target at the receive buffer.
Literature

SINAMICS S120 Commissioning Manual

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>STW1</td>
<td>Control word 1</td>
</tr>
<tr>
<td>STW2</td>
<td>Control word 2</td>
</tr>
<tr>
<td>NSET_A</td>
<td>Speed setpoint A (16-bit)</td>
</tr>
<tr>
<td>NSET_B</td>
<td>Speed setpoint B (32-bit)</td>
</tr>
<tr>
<td>G1_STW</td>
<td>Encoder 1 control word</td>
</tr>
<tr>
<td>G2_STW</td>
<td>Encoder 2 control word</td>
</tr>
<tr>
<td>G3_STW</td>
<td>Encoder 3 control word</td>
</tr>
<tr>
<td>XERR</td>
<td>Positional deviation</td>
</tr>
<tr>
<td>KPC</td>
<td>Position controller gain factor</td>
</tr>
<tr>
<td>M_RED</td>
<td>Torque reduction</td>
</tr>
<tr>
<td>A_CSW1</td>
<td>Control word for A_INF/B_INF (infeed)</td>
</tr>
<tr>
<td>STW_PROBES</td>
<td>Control word probes</td>
</tr>
</tbody>
</table>

Note

The drive signals are interconnected to the PZD automatically when a telegram type is allocated (parameter p922).

Process data for sending

The process data for the control words and setpoints are interconnected in the send buffer.

Overview of status words and actual values

The table below provides an overview of the process data that are interconnected as source at the transmit buffer.

Literature

SINAMICS S120 Commissioning Manual

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZSW1</td>
<td>Status word 1</td>
</tr>
<tr>
<td>ZSW2</td>
<td>Status word 2</td>
</tr>
<tr>
<td>NACT_A</td>
<td>Speed setpoint A (16 bit)</td>
</tr>
<tr>
<td>NACT_B</td>
<td>Speed setpoint B (32 bit)</td>
</tr>
<tr>
<td>G1_ZSW</td>
<td>Encoder 1 status word</td>
</tr>
<tr>
<td>G1_XIST1</td>
<td>Encoder 1 actual position value 1</td>
</tr>
</tbody>
</table>
### 21.3 Control- and status-word bits for NCK<->drive communication

#### 21.3.1 NCK to drive

**Introduction**

The NCK transfers data to the drive using message frames via a PROFIBUS interface (internal PROFIBUS). Setpoints exist for speed control and torque and are preceded by a control word in the message frame.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>G1_XIST2</td>
<td>Encoder 1 actual position value 2</td>
</tr>
<tr>
<td>G2_ZSW</td>
<td>Encoder 2 status word</td>
</tr>
<tr>
<td>G2_XIST1</td>
<td>Encoder 2 actual position value 1</td>
</tr>
<tr>
<td>G2_XIST2</td>
<td>Encoder 2 actual position value 2</td>
</tr>
<tr>
<td>G3_ZSW</td>
<td>Encoder 3 status word</td>
</tr>
<tr>
<td>G3_XIST1</td>
<td>Encoder 3 actual position value 1</td>
</tr>
<tr>
<td>G3_XIST2</td>
<td>Encoder 3 actual position value 2</td>
</tr>
<tr>
<td>MELDW</td>
<td>Message word</td>
</tr>
<tr>
<td>A_ZSW1</td>
<td>Status word for A_INFEED</td>
</tr>
<tr>
<td>LOAD</td>
<td>Drive load</td>
</tr>
<tr>
<td>TORQUE</td>
<td>Drive torque setpoint</td>
</tr>
<tr>
<td>POWER</td>
<td>Drive efficiency</td>
</tr>
<tr>
<td>CURR</td>
<td>Drive actual current</td>
</tr>
<tr>
<td>ZWS_PROBES</td>
<td>Status word probe</td>
</tr>
<tr>
<td>TIMESTAMP_PROBE_1N</td>
<td>Time stamp probe 1 falling edge</td>
</tr>
<tr>
<td>TIMESTAMP_PROBE_1P</td>
<td>Time stamp probe 1 rising edge</td>
</tr>
<tr>
<td>TIMESTAMP_PROBE_2N</td>
<td>Time stamp probe 2 falling edge</td>
</tr>
<tr>
<td>TIMESTAMP_PROBE_2P</td>
<td>Time stamp probe 2 rising edge</td>
</tr>
</tbody>
</table>
### PLC interface for STW1

<table>
<thead>
<tr>
<th>Signal provided by NCK</th>
<th>VDI interface (PLC)</th>
<th>Remarks</th>
<th>Bit in STW1</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| Axis controllable from NCK:  
  - Servo enable  
  - Measuring system selected and OK  
  - Pulse enable  
  - … | DB(AX).DBX2.1  
DB(AX).DBX1.5/6  
DB(AX).DBX21.7 | No signal | 0 | OFF1 |
| Always "1", "TRUE" | No signal | | 1 | OFF2 |
| Always "1", "TRUE" | No signal | | 2 | OFF3 |
| VDI signal pulse enable | DB(AX).DBX21.7 | | 3 | Enable inverter |
| RFGIS | DB(AX).DBX20.1 | | 4 | Ramp-function generator enable |
| RFGIS | DB(AX).DBX20.1 | | 5 | Ramp-function generator Start |
| (DriveReset) is generated by:  
  - "RESET signal" or CANCEL KEY, if a simultaneous drive fault is present (ZSW1.bit3 or ZSW1.bit6) | No signal | Signal "OFF1" is automatically set to FALSE internally, simultaneously to "DriveReset" (user must NOT manipulate the servo enable separately!) | 7 | Reset fault memory |
| Selection of NC function generator (via PI service from HMI) | No signal | The user cannot influence the function generator selection via the VDI interface. | 8 | Activate function generator |
| Always "0", "FALSE" | No signal | Signal not used | 9 | Reserved |
| Is "1", "TRUE", if the NC can control the associated drive AND the drive itself requests that control (ZSW1.bit9) | No signal | | 10 | Control from the PLC |
| Always "0", "FALSE" | No signal | Signal not used | 11 | Reserved |
| "Release holding brake" | DB(AX).DBX20.5 | | 12 | Open holding brake |
| Always "1", "TRUE" | No signal | Signal is used as the identifier to shut down the drive's ramp-function generator (isochronous Profibus drive) | 13 | Ramp-up time zero for controller enable |
| Always "1", "FALSE" | No signal | Signal not used | 14 | Open-loop torque-controlled mode |
| Customer-specific signal | No signal for SINAMICS | | 15 | Signal not used in conjunction with SINUMERIK, no PROFIDRIVE standard signal |
### PLC interface for STW2

<table>
<thead>
<tr>
<th>Signal provided by NCK</th>
<th>VDI interface (PLC)</th>
<th>Remarks</th>
<th>Bit in STW2</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive-parameter-set switchover</td>
<td>DB(AX).DBX21.0</td>
<td>Bit A</td>
<td>0</td>
<td>Parameter-set switchover, bit0</td>
</tr>
<tr>
<td></td>
<td>DB(AX).DBX21.1</td>
<td>Bit B</td>
<td>1</td>
<td>Parameter-set switchover, bit1</td>
</tr>
<tr>
<td></td>
<td>DB(AX).DBX21.2</td>
<td>Bit C</td>
<td>2</td>
<td>Parameter-set switchover, bit2</td>
</tr>
<tr>
<td>1st speed setpoint filter</td>
<td>DB(AX).DBX20.3</td>
<td>Not used for SINUMERIK or SINAMICS (ineffective)</td>
<td>3</td>
<td>1st speed setpoint filter</td>
</tr>
<tr>
<td>Ramp-function generator disable</td>
<td>DB(AX).DBX20.4</td>
<td>Not used for SINUMERIK or SINAMICS (ineffective)</td>
<td>4</td>
<td>Ramp-function gen. inactive</td>
</tr>
<tr>
<td>Always &quot;FALSE&quot;</td>
<td>not used</td>
<td>5</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>Integrator inhibit, speed controller</td>
<td>DB(AX).DBX21.6</td>
<td>6</td>
<td>Integrator inhibit, speed controller</td>
<td></td>
</tr>
<tr>
<td>Selection of &quot;parking axis&quot; by shutting down the encoder bit on the VDI interface</td>
<td>DB(AX).DBX1.5 = FALSE &amp; DB(AX).DBX1.6 = FALSE</td>
<td>7</td>
<td>Selection of &quot;parking axis&quot;</td>
<td></td>
</tr>
<tr>
<td>Traversing to fixed endstop</td>
<td>No signal</td>
<td>Drive fault &quot;speed controller at limit&quot; deactivated</td>
<td>8</td>
<td>Suppress fault 608, &quot;speed controller at limit&quot;</td>
</tr>
<tr>
<td>Motor changeover/selection</td>
<td>DB(AX).DBX21.3</td>
<td>Bit A</td>
<td>9</td>
<td>Motor changeover, bit0</td>
</tr>
<tr>
<td></td>
<td>DB(AX).DBX21.4</td>
<td>Bit B</td>
<td>10</td>
<td>Motor changeover, bit1</td>
</tr>
<tr>
<td>Motor selection in progress</td>
<td>DB(AX).DBX21.5</td>
<td>11</td>
<td>Motor selection in progress</td>
<td></td>
</tr>
<tr>
<td>Master sign-of-life</td>
<td>No signal</td>
<td>12</td>
<td>Master sign-of-life</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>13</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>14</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>15</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
21.3 Control- and status-word bits for NCK<->drive communication

21.3.2 Drive to NCK

Introduction

The drive transfers the data to the NCK using message frames via a PROFIBUS interface (internal PROFIBUS). Actual values exist for the speed control and torque and are preceded by a status word in the message frame.

PLC interface for ZSW1

<table>
<thead>
<tr>
<th>Meaning</th>
<th>Bit in ZSW1</th>
<th>Remarks</th>
<th>VDI interface (PLC)</th>
<th>Signal processing in the NCK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready to start</td>
<td>0</td>
<td>No signal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ready-to-operate/no fault</td>
<td>1</td>
<td>No signal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status, controller enable</td>
<td>2</td>
<td>For a combination Bit2 from ZSW1 = 0 and simultaneously Bit11 from the MedW = 1, the drive is in autonomous drive status.</td>
<td>DB(AX).DBX92.4</td>
<td></td>
</tr>
<tr>
<td>Fault active</td>
<td>3</td>
<td>No signal</td>
<td>Alarm 25201/25202, is used to activate error deletion on the NCK.</td>
<td></td>
</tr>
<tr>
<td>No OFF2 pending.</td>
<td>4</td>
<td>No signal</td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>No OFF3 is active</td>
<td>5</td>
<td>No signal</td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>Power-on inhibit</td>
<td>6</td>
<td>No signal</td>
<td>Used on the NCK to generate the &quot;Acknowledge fault memory&quot; signal.</td>
<td></td>
</tr>
<tr>
<td>Warning present</td>
<td>7</td>
<td>No signal</td>
<td>No evaluation</td>
<td></td>
</tr>
<tr>
<td>nset = nact</td>
<td>8</td>
<td>No signal</td>
<td>No evaluation</td>
<td></td>
</tr>
<tr>
<td>Control from the PLC</td>
<td>9</td>
<td>Signal is primarily set by the drive.</td>
<td>No signal</td>
<td>The NCK itself then sets the associated STW1.bit9, if the drive in the NC is known to be &quot;operational&quot; and &quot;ready&quot; (e.g., bus booted, etc.).</td>
</tr>
<tr>
<td>Comparison value reached</td>
<td>10</td>
<td>No signal</td>
<td>No evaluation</td>
<td></td>
</tr>
<tr>
<td>Reserved</td>
<td>11</td>
<td>No signal</td>
<td>No evaluation</td>
<td></td>
</tr>
<tr>
<td>Reserved</td>
<td>12</td>
<td>No signal</td>
<td>No evaluation</td>
<td></td>
</tr>
<tr>
<td>Function generator active</td>
<td>13</td>
<td>DB(AX).DBX61.0</td>
<td>Drive test &quot;travel request&quot;</td>
<td></td>
</tr>
<tr>
<td>Only used in &quot;positioning mode&quot;: Open-loop torque-controlled mode</td>
<td>14</td>
<td>Irrelevant for SINUMERIK</td>
<td>No signal</td>
<td>No evaluation</td>
</tr>
<tr>
<td>Only used in &quot;positioning mode&quot;: Spindle positioning ON</td>
<td>15</td>
<td>Irrelevant for SINUMERIK</td>
<td>No signal</td>
<td>No evaluation</td>
</tr>
</tbody>
</table>
## PLC interface for ZSW2

<table>
<thead>
<tr>
<th>Meaning</th>
<th>Bit in ZSW2</th>
<th>Remarks</th>
<th>VDI interface (PLC)</th>
<th>Signal processing in the NCK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter set</td>
<td>0</td>
<td>Bit A</td>
<td>DB(AX).DBX93.0</td>
<td>active drive parameter set</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>Bit B</td>
<td>DB(AX).DBX93.1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Bit C</td>
<td>DB(AX).DBX93.2</td>
<td></td>
</tr>
<tr>
<td>1st speed-setpoint filter inactive</td>
<td>3</td>
<td>Signal from SINAMICS not operated</td>
<td>DB(AX).DBX92.3</td>
<td>As signal from SINAMICS not operated: Signal always &quot;0&quot;, &quot;FALSE&quot;</td>
</tr>
<tr>
<td>Ramp-function gen. inactive</td>
<td>4</td>
<td></td>
<td>DB(AX).DBX92.1</td>
<td>Ramp-function-generator disable active</td>
</tr>
<tr>
<td>Holding brake open</td>
<td>5</td>
<td></td>
<td>DB(AX).DBX92.5</td>
<td>Holding brake open</td>
</tr>
<tr>
<td>Integrator inhibit, speed controller</td>
<td>6</td>
<td></td>
<td>DB(AX).DBX93.6</td>
<td>Speed controller integrator disabled</td>
</tr>
<tr>
<td>Status: Parking axis</td>
<td>7</td>
<td>Axis parked via SINAMICS</td>
<td>No signal</td>
<td>NCK cannot respond to the &quot;axis parked&quot; state =&gt; alarm 25000, An alarm is output if the drive parks even though parking was not requested.</td>
</tr>
<tr>
<td>Suppress &quot;speed controller at limit&quot; fault</td>
<td>8</td>
<td></td>
<td>No signal</td>
<td></td>
</tr>
<tr>
<td>Motor data set</td>
<td>9</td>
<td>Bit A</td>
<td>DB(AX).DBX93.3</td>
<td>Active motor</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>Bit B</td>
<td>DB(AX).DBX93.4</td>
<td></td>
</tr>
<tr>
<td>Motor being changed over</td>
<td>11</td>
<td></td>
<td>No signal</td>
<td></td>
</tr>
<tr>
<td>Slave sign-of-life</td>
<td>12</td>
<td></td>
<td>No signal</td>
<td>Drive sign-of-life</td>
</tr>
<tr>
<td></td>
<td>13</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>14</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### PLC interface for MeldW

<table>
<thead>
<tr>
<th>Meaning</th>
<th>Bit in MeldW</th>
<th>Remarks</th>
<th>VDI interface (PLC)</th>
<th>Signal processing in the NCK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ramp-up function completed</td>
<td>0</td>
<td>DB(AX).DBX94.2</td>
<td>Ramp-up function completed</td>
<td></td>
</tr>
<tr>
<td>M&lt;Nx</td>
<td>1</td>
<td>DB(AX).DBX94.3</td>
<td>M&lt;Nx</td>
<td></td>
</tr>
<tr>
<td>Nact&lt;Nmin</td>
<td>2</td>
<td>DB(AX).DBX94.4</td>
<td>Nact&lt;Nmin</td>
<td></td>
</tr>
<tr>
<td>Nact&lt;Nx</td>
<td>3</td>
<td>DB(AX).DBX94.5</td>
<td>Nact&lt;Nx</td>
<td></td>
</tr>
<tr>
<td>DC link overvoltage</td>
<td>4</td>
<td>DB(AX).DBX95.0</td>
<td>Signal not available for SINAMICS 120!</td>
<td></td>
</tr>
<tr>
<td>Variable signaling function</td>
<td>5</td>
<td>DB(AX).DBX94.7</td>
<td>Signal not available for SINAMICS 120!</td>
<td></td>
</tr>
<tr>
<td>Motor temperature pre-warning</td>
<td>6</td>
<td>DB(AX).DBX94.0</td>
<td>Motor temperature pre-warning</td>
<td></td>
</tr>
<tr>
<td>Heatsink-temperature prewarning</td>
<td>7</td>
<td>DB(AX).DBX94.1</td>
<td>Heatsink-temperature prewarning</td>
<td></td>
</tr>
<tr>
<td>Nsetp=Nact</td>
<td>8</td>
<td>DB(AX).DBX94.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reserved</td>
<td>9</td>
<td>No signal</td>
<td>No evaluation</td>
<td></td>
</tr>
<tr>
<td>Power module current not limited</td>
<td>10</td>
<td>DB(AX).DBX95.7</td>
<td>Signal not available for SINAMICS 120!</td>
<td></td>
</tr>
<tr>
<td>Reserved</td>
<td>11</td>
<td>Speed controller active</td>
<td>DB(AX).DBX61.6&amp;DB(AX).DBX61.7</td>
<td></td>
</tr>
<tr>
<td>Reserved</td>
<td>12</td>
<td>Drive Ready</td>
<td>DB(AX).DBX93.5</td>
<td></td>
</tr>
<tr>
<td>Pulses enabled</td>
<td>13</td>
<td>Only for SINAMICS S120 with message-frame types 101ff direct on VDI interface</td>
<td>DB(AX).DBX93.7</td>
<td></td>
</tr>
<tr>
<td>Reserved</td>
<td>14</td>
<td>Only in conjunction with positioning mode, irrelevant for SINUMERIK</td>
<td>No signal</td>
<td></td>
</tr>
<tr>
<td>Reserved</td>
<td>15</td>
<td>Only in conjunction with positioning mode, irrelevant for SINUMERIK</td>
<td>No signal</td>
<td></td>
</tr>
</tbody>
</table>
21.4 PLC program

Introduction

The PLC program is constructed modularly. It comprises the two parts:

- PLC basic program
  The PLC basic program organizes the exchange of signals and data between the PLC user program and the NCK, HMI, and machine control panel components. The PLC basic program is a part of the tool box delivered with the SINUMERIK 840D sl.

- PLC user program
  The PLC user program is the user-specific part of the PLC program by which the basic PLC program has been added to or extended.

PLC basic program

For a complete description of the basic PLC program, its structure and all modules including their call parameters, please refer to:

Literature

Function Manual Basic Functions; Basic PLC Program

PLC user program

The organization blocks of the basic machine contain the entry points for the appropriate parts of the PLC user program.

- OB100 (cold restart)
- OB1 (cyclic processing)
- OB40 (process alarm)
The following diagram shows the structure of the PLC program:

![PLC Program Structure Diagram]

**PLC status**

The PLC always starts up in RESTART mode, i.e. the PLC operating system runs OB100 after initialization and starts cyclic operation at the beginning of OB1. There is no re-entry at the point of interruption (e.g. on power failure).
Start-up behavior of the PLC

There are both remanent and non-remanent areas for the markers, times and counter. The areas are continuous and are divided by a parameterizable limit, where the area with the higher-value address range is defined as the non-remanent area. Data blocks are always remanent.

Start-up mode COLD RESTART (OB 100)

If the remanent area has no battery backup (backup battery is empty) start-up is prevented. The following operations are performed during a cold restart:

- UStack, BStack and non-retentive flags, timers and counters are deleted
- The process output image (POI) is deleted
- Process and diagnostics alarms are cancelled
- The system status list is updated
- Parameterization objects of modules (from SD100 onwards) are evaluated or default parameters are output to all modules in single-processor mode
- Execute cold restart (OB100)
- Read in process input image (PII)
- Cancel command output inhibit (BASP)

Basic program, start-up part (FB1)

FB 1 (start-up block of the PLC program) must be assigned variables.

Parameter FB 1

A precise description of the variables and options for modifying their parameterization is given in:

Literature

Function Manual Basic Functions; Basic PLC Program

Cyclical mode (OB 1)

From a chronological viewpoint, the basic program runs ahead of the PLC user program. The complete processing of the NCK-PLC interface is carried out in cyclic mode.

A cyclic monitoring function is activated between PLC and NCK once power-up and the first OB1 cycle have been completed. A PLC failure produces alarm “2000 Sign-of-life monitoring PLC”.

See also

Creating a PLC program (Page 62)
21.4 PLC program

21.4.1 Fundamentals of creating a PLC user program

Introduction

The following points must be observed when generating a PLC user program:

- Software and hardware requirements
- Installing the toolbox (PLC basic program, slave OEM, GSD files)
- Editing the blocks in the PLC basic program

Software and hardware requirements

- SIMATIC STEP 7 as from Version 5.3, Service Pack 3
- SIMATIC STEP 7 is installed on the PG/PC

Installing the PLC basic program library

To be able to use the blocks of the basic PLC program (OBs, FBs, DBs, etc.) in a SIMATIC S7 project, the library must first be installed in the SIMATIC manager.

Editing the blocks in the PLC basic program

The individual blocks in the basic PLC program can be processed as follows in the SIMATIC manager:

- Select the appropriate block, e.g. OB 100 in the folder Blocks of the corresponding Module
- Use the "Edit" > "Open object" menu command to open the block or double-click the block with the left mouse button
- Edit the block using the LAD/STL/CSF editor. Switch over to the block display using the "View" > "LAD" or STL or CSF menu command

See also

Creating a PLC program (Page 62)
21.5 Machine and setting data

Introduction

Adaption of the control at the machine is carried out using the machine and setting data.

Parameter assignment

- Machine data
  - The machine data (MD) are divided into the following areas:
    - General machine data
    - Channel-specific machine data
    - Axis-specific machine data
    - Machine data for control unit
    - Machine data for infeed
    - Machine data for drives
- Setting data
  - The setting data (SD) are divided into the following areas:
    - General setting data
    - Channel-specific setting data
    - Axis-specific setting data
- Option data
  - For enabling options. The option data are included in the scope of delivery.

Overview of machine and setting data

The table below lists the areas for machine and setting data. The List Manual contains a detailed description.

<table>
<thead>
<tr>
<th>Range</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>from 1000 to 1799</td>
<td>Machine data for drives ($MD_{...}$)</td>
</tr>
<tr>
<td>from 9000 to 9999</td>
<td>Machine data for operator panel front ($MM_{...}$)</td>
</tr>
<tr>
<td>from 10000 to 18999</td>
<td>General machine data ($MN_{...}$)</td>
</tr>
<tr>
<td>from 19000 to 19999</td>
<td>Reserved</td>
</tr>
<tr>
<td>from 20000 to 28999</td>
<td>Channel-specific machine data ($MC_{...}$)</td>
</tr>
<tr>
<td>from 29000 to 29999</td>
<td>Reserved</td>
</tr>
<tr>
<td>from 30000 to 38999</td>
<td>Axis-specific machine data ($MA_{...}$)</td>
</tr>
<tr>
<td>from 39000 to 39999</td>
<td>Reserved</td>
</tr>
</tbody>
</table>
### 21.5 Machine and setting data

<table>
<thead>
<tr>
<th>Range</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>from 41000 to 41999</td>
<td>General setting data ($SN_... )</td>
</tr>
<tr>
<td>from 42000 to 42999</td>
<td>Channel-specific setting data ($SC_... )</td>
</tr>
<tr>
<td>from 43000 to 43999</td>
<td>Axis-specific setting data ($SA_... )</td>
</tr>
<tr>
<td>from 51000 to 61999</td>
<td>General machine data for compile cycles</td>
</tr>
<tr>
<td>from 62000 to 62999</td>
<td>Channel-specific machine data for compile cycles</td>
</tr>
<tr>
<td>from 63000 to 63999</td>
<td>Axis-specific machine data for compile cycles</td>
</tr>
</tbody>
</table>

#### See also

Overview Commissioning NCK (Page 121)

#### 21.5.1 Machine data fundamentals

**Introduction**

Machine and setting data are parameterized via:
- Number and identifier
- Activation
- Protection levels
- Unit
- Default value
- Value range (minimum and maximum)

**Number and identifier**

Machine data and setting data are identified using the number or the name (identifier). The number and name are displayed at the HMI.

The identifier of a machine data is subject to the scheme:
- **$ M k _IdentifierString**

  where the following applies:
  - **$** System variable
  - **M** Machine data
  - **k** Component

  *k* identifies the components of the NC parameterizing the appropriate machine data:
  - **N** NC
  - **C** Channel
  - **A** Axis
The identifier of a setting data is subject to the scheme:

- \$ S k _\text{IdentifierString}

  where the following applies:
  - \$ System variable
  - S Setting data
  - k Component

  k identifies the components of the NC parameterizing the appropriate machine data:
  - N NC
  - C Channel
  - A Axis

**Activation**

Activation when referring to a machine data indicates the NC status in which a change to a machine data becomes active.

The levels of effectiveness have been listed below in order of priority. Modification of the machine data takes effect after:

- POWER ON (po) NCK RESET
- NEWCONF (cf)
  - "Set MD to active" softkey on MMC
  - \(<\text{RESET}>\) key on the MSTT
  - It is possible to modify block limits during program operation
- RESET (re)
  - at end of program M2/M30 or
  - \(<\text{RESET}>\) key on the MSTT
- IMMEDIATE (so)
  - After entry of value

**Note**

Unlike machine data, changes to setting data always become effective immediately.

**Protection levels**

Access level 4 (keyswitch position 3) or more is required to display machine data.

To start up the system, the appropriate protection level must generally be enabled by entering the password "EVENING".
Unit

The unit refers to the standard setting of the machine data:
- MD10220 $MN_SCALING_FACTOR_USER_DEF_MASK
- MD10230 $MN_SCALING_FACTOR_USER_DEF
- MD10240 $MN_SCALING_SYSTEM_IS_METRIC = 1.

If the machine data is not based on an engineering unit, then the field is marked with "-".

Default value

The machine data/setting data is preset to this value.

Note

Inputs via HMI are limited to ten digits plus comma and sign.

Value range (minimum and maximum)

Specifies the input limits. If no range of values is specified, the data type determines the input limits and the field is marked with "***".

21.5.2 Handling the machine data

Introduction

To display and input machine data, appropriate screen forms are provided.

Example

Selection of displays:

When you press the <Area switchover> key on the HMI, the menu bar appears with the following areas: "Machine", "Parameter", "Program", "Services", "Diagnostics" and "Commissioning". Press "Commissioning" > "Machine data".

Note

For the input of machine data, the protection level 2 password "EVENING" has to be set at the least.
Screen editor for HEX machine data

A bit editor has been implemented to simplify the matter of setting certain machine data bits. If the input cursor is on a machine data in HEX format in the MD list, you can call up the bit editor by pressing the <Toggle> key (in the middle of the cursor keys).

You can set or reset single bits by clicking on them with the mouse or by selecting them with the cursor keys and then pressing the <Toggle> key.

- With the "Ok" softkey, you can terminate the bit editor and accept the value set.
- With the "Abort" softkey, you can reject the bit editor and accept the value set. The previous setting is then valid again.

21.6 Protection levels

Introduction

Access to programs, data and functions is user-oriented and controlled via eight hierarchical protection levels. These are divided into

- 4 password levels for Siemens, machine manufacturer, start-up personnel, and end user
- 4 key switch positions for end user

Protection levels

There are protection levels 0 to 7 (see table below), where

- 0 is the highest and
- 7 is the lowest level.

Table 21-5 Protection level concept

<table>
<thead>
<tr>
<th>Protection level</th>
<th>Locked by</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Password</td>
<td>Siemens</td>
</tr>
<tr>
<td>1</td>
<td>Password: SUNRISE</td>
<td>Machine manufacturer</td>
</tr>
<tr>
<td>2</td>
<td>Password: EVENING</td>
<td>Installation engineer, service</td>
</tr>
<tr>
<td>3</td>
<td>Password: CUSTOMER</td>
<td>End user</td>
</tr>
<tr>
<td>4</td>
<td>Key switch position 3</td>
<td>Programmer, machine setter</td>
</tr>
<tr>
<td>5</td>
<td>Key switch position 2</td>
<td>Qualified operator</td>
</tr>
<tr>
<td>6</td>
<td>Key switch position 1</td>
<td>Trained operator</td>
</tr>
<tr>
<td>7</td>
<td>Key switch position 0</td>
<td>Semi-skilled operator</td>
</tr>
</tbody>
</table>
Interlock

Protection levels

- 0 to 3 are locked by means of a password and
- 4 to 7 by means of keyswitch positions (see table below).

Table 21- 6 Keyswitch settings

<table>
<thead>
<tr>
<th>Keyswitch setting</th>
<th>Retraction pos.</th>
<th>NC password level</th>
<th>User group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red key</td>
<td>0 or 1 or 2 or 3</td>
<td>4</td>
<td>Programmer, machine setter</td>
</tr>
<tr>
<td>Green key</td>
<td>0 or 1 or 2</td>
<td>5</td>
<td>Qualified operator</td>
</tr>
<tr>
<td>Black key</td>
<td>0 or 1</td>
<td>6</td>
<td>Trained operator</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>7</td>
<td>Semi-skilled operator</td>
</tr>
</tbody>
</table>

Protection levels for machine data

The machine data is assigned different protection levels by default.
Access level 4 (keyswitch position 3) or more is required to display machine data.

Note
To start up the system the appropriate access level must generally be enabled by entering the password "EVENING".

You can find additional change options of protection levels at:

Literature

Function Manual Basic Functions; Diverse Interface Signals
21.6 Protection levels

21.6.1 Protection level fundamentals

Introduction
You can influence the protection levels used with passwords via softkeys.
Press the "HMI" -> "Password" softkey in the “Startup” operating area. The following softkeys are available:
- Setting the password
- Change password
- Delete password

Set password
1. Press the softkey "Set password." The "Please enter password:" input window appears.
2. Enter one of the possible default passwords (see table "Protection levels concept") and confirm the entry with the softkey "OK." A permissible password is set and the valid access level is displayed. Invalid passwords will be rejected.

Change password
For secure access protection, you should change the default passwords
1. Press the "Change password" softkey. The current access level is displayed in the window that opens.
2. Mark the area for which you would like to assign the new password. You can select the following areas here:
   - System
   - Vendor
   - Service
   - User
3. Enter the new password in the input fields "New password" and "Repeat password."
4. Confirm the entry with the softkey "OK." Both entered passwords must match for the modified password to become valid.

Delete password
1. Press the softkey "Delete password" in order to reset the access authorization.
Access authorization is not automatically deleted at POWER ON!

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>For a system boot in which standard machine data is loaded, the passwords are set to the default values.</td>
</tr>
</tbody>
</table>
21.7 Axis data

Introduction

The term "axis" is often used either as a single term in conjunction with SINUMERIK 840D sl or in compounded form, e.g. machine axis, channel axis, etc. To provide an overview of the philosophy used as the basis, here is a brief explanation of this term.

Definition

Generally, 4 types of axes are distinguished:
1. Machine axes
2. Channel axes
3. Geometry axes
4. Special axes

Machine axes

Machine axes are the motion units existing on a machine, which can also be designated as linear or rotary axes, depending on their usable movement.

Channel axes

The total of all machine, geometry and special axes assigned to a channel is designated as channel axes.

In this context, the geometry and special axes constitute the program-technological part of the machining process, i.e. they are used for programming in the parts program.

The machine axes constitute the physical part of the machining process, i.e. they carry out the programmed traversing movements on the machine.
Geometry axes

The geometry axes constitute the rectangular Cartesian basic coordinate system of a channel.

Generally, (Cartesian arrangement of the machine axes) direct imaging of the geometry axes to the machine axes is possible. If the arrangement of the machine axes, however, is not Cartesian at right angles, the imaging is performed using a kinematic transformation.

Special axes

Additional axes are all other channel axes that are not geometry axes. Unlike for geometry axes (Cartesian coordinate system), no geometric context is defined for additional axes, neither between additional axes or with respect to geometry axes.

Literature

Function Manual Basic Functions; Axes, Coordinate Systems, Frames, Workpiece numbers
IWS: Axes
21.7 Axis data

21.7.1 Axis configuration

Introduction

The figure below shows the assignment between the geometry axes, special axes, channel axes and machine axes as well as the names of the individual axis types. MD are used for assignment.

Figure 21-5 Axis configuration
**Note**
Leading zeroes in user-defined axis identifiers are ignored.

Example:

MD10000 $MN_AXCONF_MACHAX_NAME_TAB[0] = X01 corresponds to X1

The geometry axes must be assigned to the channel axes in ascending order leaving no gaps.

**Special features**

- Three geometry axes are assigned to the channel axes in the MD.
- All channel axes that are not assigned to the three geometry axes are special axes.
- The channel axes are assigned to machine axes.
- The spindles are also assigned to machine axes.

**Channel axis gaps**

Channel axes need not be defined contiguously in ascending order, in other words, not each channel axis needs to have a machine axis assigned to it (local or link axis). The assignment occurs as follows:

- MD20080 $MC_AXCONF_CHANAX_NAME_TAB
  via:
  - MD20070 $MC_AXCONF_MACHAX_USED

**Application:**
Consistent, semi-defined channel axes for various machine versions of a manufacturer's machine series.

**Advantages:**
- Uniform basic configuration of various machines
- Simple reconfiguration on removal of a machine
- Portability of programs

**Reliability of channel axis gaps**

Channel axis gaps must be disconnected via the machine data:

- MD11640 $MN_ENABLE_CHAN_AX_GAP = 1 (channel axis gap allowed).

If this is not carried out, an entry of 0 in the machine data MD20070 $MC_AXCONF_MACHAX_USED prevents other machine axes being assigned to channel axes.
Literature

Function Manual, Expanded Functions; Several Control Panels on Multiple NCUs, Decentralized Systems

Example

![Diagram of axis configuration with channel axis gap]

**Figure 21-6  Axis configuration with channel axis gap**

**Note**

The gaps count as axes with reference to the number of channel axes and their indices.

If an attempt is made to define a channel axis gap on the geo axis via the machine data MD20050 $MC_AXCONF_GEOAX_ASSIGN_TAB, the attempt is rejected without an alarm.

Using channel axes in MD24120ff. $MC_TRAFO_GEOAX_ASSIGN_TAB1...8 and MD24110ff. $MC_TRAFO_AXES_IN1...8, to which no machine axes are defined using MD20070 $MC_AXCONF_MACHAX_USED (gap), triggers alarms 4346 or 4347.
21.7.2 Axis assignment

Introduction

The assignment of machine, channel and geometry axes is carried out using the relevant machine data.

Axis assignment

The following diagram illustrates the assignment of the relevant machine data:

- Machine axes of the NC
- Channel axes of the channel
- Geometry axes of the channel

Figure 21-7 Axis assignment
21.7 Axis data

(1) The I/O addresses of the drives defined in the S7 project using "HW Config" are contained in the following machine data.
MD13050 $MN\_DRIVE\_LOGIC\_ADDRESS[n]$ (I/O address of the drive)
The machine data index (n+1) is the logical drive number for the NC.

(2) The following machine data are used to assign each individual machine axis to a drive.
MD30110 $MA\_CTRLOUT\_MODULE\_NR[0]$ (setpoint assignment)
MD30220 $MA\_ENC\_MODULE\_NR[0]$ (actual value assignment)
The logical drive number m to be entered in the two machine data refers to the entry with the index n=(m-1) in the list described under Point 1 MD13050 $MN\_DRIVE\_LOGIC\_ADDRESS[n]$.

(3) Which channel axis uses which machine axis (explicitly) and how many channel axes are present in the channel (implicitly) is determined through the following machine data:
MD20070 $MC\_AXCONF\_MACHAX\_USED[n]$ (machine axis number valid in channel)
The machine axis number m to be entered in the machine data (with m=1,2,3...) is referred to the appropriate machine axis m.

(4) Which channel axis uses which machine axis (explicitly) and how many channel axes can be implicitly available in a channel is defined by the following machine data:
MD20050 $MC\_AXCONF\_GEOAX\_ASSIGN\_TAB[n]$ (assignment geometry axis - channel axis) (n = 0...2)
The channel axis number k to be entered in the machine data (k=1,2,3...) refers to the entry with the index n (n=(k-1)=0,1,2...) in the list of the channel axes MD20070 $MC\_AXCONF\_MACHAX\_USED[n]$ (see Point 3)

Machine data

The following machine data are relevant for the axis configuration:

<table>
<thead>
<tr>
<th>Number</th>
<th>Name of identifier</th>
<th>Name / remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>13050</td>
<td>DRIVE_LOGIC_ADDRESS</td>
<td>I/O address of drive</td>
</tr>
<tr>
<td>20050</td>
<td>AXCONF_GEOAX_ASSIGN_TAB</td>
<td>Assignment of geometry axis to channel axis</td>
</tr>
<tr>
<td>20070</td>
<td>AXCONF_MACHAX_USED</td>
<td>Machine axis number valid in channel</td>
</tr>
<tr>
<td>30110</td>
<td>CTRLOUT_MODULE_NR</td>
<td>Setpoint assignment</td>
</tr>
<tr>
<td>30220</td>
<td>ENC_MODULE_NR</td>
<td>Actual-value assignment</td>
</tr>
</tbody>
</table>
21.7.3 Axis names

Introduction

Each machine, channel and geometry axis can/must be assigned an individual name unambiguously identifying it in its name range.

Machine axes

The name of the machine axes are defined via the following machine date:
MD10000 $MN_AXCONF_MACHAX_NAME_TAB[n] (machine axis name)

Machine axis names must be unambiguous for the entire NC.

The names and the corresponding index defined in the machine date above is used for:
- Accessing axis-specific machine data (loading, saving, displaying)
- Reference point approach from the parts program G74
- Measuring
- Test point traversing from the parts program G75
- Traversing the machine axis from PLC
- Display of axis-specific alarms
- Display in the actual-value system (machine-related)
- DRF handwheel function

Channel axes

The name of the channel axes are defined via the following machine date:
MD20080 $MC_AXCONF_CHANAX_NAME_TAB[n] (name of the channel axis in the channel)

Channel axis names must be unambiguous for the entire channel.

Geometry axes

The name of the geometry axes are defined via the following machine data:
MD20060 $MC_AXCONF_GEOAX_NAME_TAB[n] (geometry axis in the channel)

Geometry axis names must be unambiguous for the entire channel.

The axis names for channel and geometry axes are used in the parts program for programming general traversing movements or to describe the workpiece contour. The axis names are used for:
- Path axes
- Synchronized axes
- Positioning axes
• Command axes
• Spindles
• Gantry axes
• Coupled axes
• Guide value coupling axes

Machine data

The following machine data are relevant for the axis names:

Table 21-8  Axis names: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Identifier</th>
<th>Name/remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>$MN_...$</td>
<td></td>
</tr>
<tr>
<td>10000</td>
<td>AXCONF_MACHAX_NAME_TAB</td>
<td>Machine axis name</td>
</tr>
<tr>
<td>Channel-specific</td>
<td>$MC_...$</td>
<td></td>
</tr>
<tr>
<td>20060</td>
<td>AXCONF_GEOAX_NAME_TAB</td>
<td>Geometry axis name in channel</td>
</tr>
<tr>
<td>20080</td>
<td>AXCONF_CHANAX_NAME_TAB</td>
<td>Channel axis name/special axis name in channel</td>
</tr>
</tbody>
</table>

21.7.4  Setpoint/actual value channels

Introduction

The following points must be observed for setpoint/actual value channels:

Note

In order to guarantee that the control runs up reliably, all machine axes are declared as simulation axes (without hardware).

- MD30130 $MA_CTRLOUT_TYPE (output type of setpoint value) = 0
- MD30240 $MA_ENC_TYPE (actual value acquisition mode) = 0

Traversing of the axes in servo mode is simulated without speed setpoint output, and no hardware-specific alarms are output.

Machine data

- MD30350 $MA_SIMU_AX_VDI_OUTPUT (output of axis signals with simulation axes) can be used to select whether the interface signals of a simulation axis are output at the PLC interface (e.g. during program test, if there is no drive hardware, used in FC18 in PLC).
Assignment of the setpoint/actual value channels

For each machine axis to which a drive is assigned, the following must be parameterized:

- a setpoint channel and
- at least one actual-value channel

A second actual-value channel can be set up as an option.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The motor measuring system is always used for the speed control function. Motor and motor measuring system must therefore always be connected to the same drive (SERVO).</td>
</tr>
</tbody>
</table>

Index m to the MD13050 $MN_DRIVE_LOGC_ADDRESS of the drive which represents the machine axis must be entered in the two axis-specific machine data:

- MD30110 $MA_CTRLOUT_MODULE_NR[0] (setpoint assignment: logical drive number)
- MD30220 $MA_ENC_MODULE_NR[n] (actual value assignment: logical drive number)

The entered value m refers to the drive whose I/O address is defined under the index n = (m-1) in MD13050 $MN_DRIVE_LOGIC_ADDRESS[n] (see "Drive configuration" section).

NCK Reset

Once the drive configuration and setpoint/actual value assignment have been parameterized, an NCK reset must be executed to initiate a warm restart of the NC. After the NC has powered up, the set configuration is effective.

Measuring system switchover

The following interface signals can be used to switch between the two position measuring systems of a machine axis from the PLC.

- DB31, ... DBX1.5 (position measuring system 1 selected)
- DB31, ... DBX1.6 (position measuring system 2 selected)

References

Function Manual Basic Functions; Diverse Interface Signals
Machine data

Table 21-9  Setpoint/actual value channels: Machine data

<table>
<thead>
<tr>
<th>Number</th>
<th>Name of identifier</th>
<th>Name/remarks</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis-specific ($MA_ ... )</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30110</td>
<td>CTRLOUT_MODULE_NR</td>
<td>Setpoint assignment: Logical drive number</td>
<td></td>
</tr>
<tr>
<td>30130</td>
<td>CTRLOUT_TYPE</td>
<td>Output of setpoint value</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 = Simulation</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = Output of speed setpoint</td>
<td></td>
</tr>
<tr>
<td>30200</td>
<td>NUM_ENCS</td>
<td>Number of measuring channels</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = One position measuring system present</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = Two position measuring systems present</td>
<td></td>
</tr>
<tr>
<td>30220</td>
<td>ENC_MODULE_NR[0]</td>
<td>Actual value assignment: Logical drive number for</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>position measuring system 1</td>
<td></td>
</tr>
<tr>
<td>30220</td>
<td>ENC_MODULE_NR[1]</td>
<td>Actual value assignment: Logical drive number for</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>position measuring system 2</td>
<td></td>
</tr>
<tr>
<td>30230</td>
<td>ENC_INPUT_NR[0]</td>
<td>Actual value assignment: Position measuring</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>system 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = G1_XIST encoder 1 actual position value 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = G2_XIST encoder 1 actual position value 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>system 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = G1_XIST encoder 2 actual position value 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 = G2_XIST encoder 2 actual position value 2</td>
<td></td>
</tr>
<tr>
<td>30240</td>
<td>ENC_TYPE[0]</td>
<td>Type of actual value recording</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 = Simulation</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 = Incremental encoder</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 = Absolute encoder with EnDat interface</td>
<td></td>
</tr>
</tbody>
</table>

Interface signals

Table 21-10  Switchover of position measuring system: Interface signals

<table>
<thead>
<tr>
<th>DB number</th>
<th>Bit, byte</th>
<th>Name</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis/spindle-specific</td>
<td>Signals from PLC to axis/spindle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>1.5</td>
<td>Position measuring system 1</td>
<td></td>
</tr>
<tr>
<td>31, ...</td>
<td>1.6</td>
<td>Position measuring system 2</td>
<td></td>
</tr>
</tbody>
</table>

References

Function Manual Basic Functions; Speeds, Setpoint/actual-value systems, Control: Setpoint/actual-value system

Function Manual Basic Functions; Diverse Interface Signals: Interface signals to axis/spindle
21.8 Spindle data

Introduction
The spindle mode of a machine axis is a subset of the general axis functionality. For this reason, the machine data required to start up an axis have also to be set for a spindle. The machine data to parameterize a spindle are therefore to be found under the axis-specific machine data (from MD 35000 onwards).

Note
After the default machine data have been loaded, no spindle is defined.

Spindle definition
With the following machine data, a machine axis is declared to be an endlessly rotating rotary axis whose programming and display is carried out modulo 360 degrees.

- MD30300 $MA_IS_ROT_AX (rotary axis/spindle)
- MD30310 $MA_ROT_IS_MODULO (modulo conversion for rotary axis/spindle)
- MD30320 $MA_DISPLAY_IS_MODULO (modulo 360 degrees display for rotary axis/spindle)

The machine axis is converted to a spindle by defining the spindle number x (with x = 1, 2, ...max. number of channel axes) in machine data

- MD35000 $MA_SPIND_ASSIGN_TO_MACHAX (spindle number)

The spindle number must be unique within the channel axes of the channel to which the spindle is assigned.
21.8.1 Spindle modes

Spindle modes

The spindle can have the following modes:

- Control mode
- Oscillation mode
- Positioning mode
- Synchronous mode, synchronous spindle

References:
Function Manual, Extension Functions, Synchronous Spindle (S3)

- Rigid tapping

References:
Programming Manual, Fundamentals; Chapter: Motion commands

Axis mode

The spindle can be switched from spindle mode to axis mode (rotary axis) if the same motor is used for spindle and axis operation.

21.8.2 Initial spindle state

Spindle basic setting

The following machine data is used to specify a spindle mode as basic setting:

MD35020 $MA_SPIND_DEFAULT_MODE

<table>
<thead>
<tr>
<th>Value</th>
<th>Spindle basic setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Speed control mode, position control deselected</td>
</tr>
<tr>
<td>1</td>
<td>Speed control mode, position control activated</td>
</tr>
<tr>
<td>2</td>
<td>Positioning mode</td>
</tr>
<tr>
<td>3</td>
<td>Axis mode</td>
</tr>
</tbody>
</table>

Time when the spindle basic setting takes effect

The time when the spindle basic setting takes effect is set in the machine data:

MD35030 $MA_SPIND_DEFAULT_ACT_MASK
### 21.8 Spindle data

#### Value Effective time

<table>
<thead>
<tr>
<th>Value</th>
<th>Effective time</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>POWER ON</td>
</tr>
<tr>
<td>1</td>
<td>POWER ON and program start</td>
</tr>
<tr>
<td>2</td>
<td>POWER ON and RESET (M2 / M30)</td>
</tr>
</tbody>
</table>

#### 21.8.3 General functionality

**Why axis mode?**

For certain machining tasks (e.g. on lathes with end-face machining), the spindle not only has to be rotated with M3, M4 and M5 and positioned with SPOS, M19 and SPOSA, but also addressed as an axis with its axis identifier (e.g. "C").

**Prerequisites**

- The same spindle motor is used for spindle mode and axis mode.
- The same position measurement system or separate position measurement systems can be used for spindle mode and axis mode.
- A position actual-value encoder is a mandatory requirement for axis mode.
- If the axis is not synchronized, e.g. M70 is programmed after POWER ON, the axis must first be referenced with G74. Only then does the mechanical position match the programmed one.

  **Example:**

  ```
  M70
  G74 C1=0 Z100
  G0 C180 X50
  ```

**Configurable M function**

The M function used to switch the spindle to axis mode can be configured in the machine data:

```
MD20094 $MC_SPIND_RIGID_TAPPING_M_NR
```
The value on delivery is 70.

**Note**
From software version 2.6, the control system detects the transition to axis mode automatically from the program sequence. Therefore, there is no need at all for the explicit programming in the part program of the configured M function for switching the spindle to axis mode (default: M70). However, the M function can continue to be programmed, e.g. to increase the readability of the part program.

**Functionality**
If the axis mode is active and the rotary axis homed, all axis functions can be used.
The most important functions are:
- Programming with axis name
- Use of zero offsets (G54, G55, TRANS, etc.)
- G90, G91, IC, AC, DC, ACP, ACN
- Use of kinematic transformations (e.g. TRANSMIT)
- Interpolation with other axes (path interpolation)
- Programming as a positioning axis

**References:**
Function Manual, Extension Functions; Rotary Axes (R2)

**Special points to be noted**
- The feed override switch is active.
- NC/PLC IS:
  - DB21, ... DBX7.7 (Reset) does not terminate axis mode as standard.
- The NC/PLC interface signals:
  - DB31, ... DBB16 to DBB19 and DBB82 to DBB91 are not important if:
    - DB31, ... DBX60.0 (axis / no spindle) = 0
- Axis mode can be activated in all gear steps.
  - If the position actual value encoder is installed on the motor (indirect measuring system), the positioning and contouring accuracy can vary for the different gear steps.
- The gear step cannot be changed when the axis mode is active.
  - The spindle must be switched to control mode.
    - This is done with M41 ... M45 or M5, SPCOF.
- In axis mode, the machine data from the servo parameter set with index zero are effective in order to carry out adaptations in this mode.
Servo parameter set

The relevant machine data from the servo parameter set are:

<table>
<thead>
<tr>
<th>Machine data</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD31050 $MA_DRIVE_AX_RATIO_DENOM</td>
<td>Measuring gear denominator</td>
</tr>
<tr>
<td>MD31060 $MA_DRIVE_AX_RATIO_NUMERA</td>
<td>Numerator load gearbox</td>
</tr>
<tr>
<td>MD32200 $MA_POSCTRL_GAIN</td>
<td>$K_v$ factor</td>
</tr>
<tr>
<td>MD32452 $MA_BACKLASH_FACTOR</td>
<td>Weighting factor for backlash</td>
</tr>
<tr>
<td>MD32610 $MA_VELO_FFW_WEIGHT</td>
<td>Weighting factor for feedforward control</td>
</tr>
<tr>
<td>MD32800 $MA_EQUIV_CURRCTRL_TIME</td>
<td>Equivalent time constant current control loop for feedforward control</td>
</tr>
<tr>
<td>MD32810 $MA_EQUIV_SPEEDCTRL_TIME</td>
<td>Equivalent time constant speed control loop for feedforward control</td>
</tr>
<tr>
<td>MD32910 $MA_DYN_MATCH_TIME</td>
<td>Time constant for dynamic matching</td>
</tr>
<tr>
<td>MD36012 $MA_STOP_LIMIT_FACTOR</td>
<td>Factor for exact stop coarse/fine and zero speed control</td>
</tr>
<tr>
<td>MD36200 $MA_AX_VELO_LIMIT</td>
<td>Velocity monitoring threshold value</td>
</tr>
</tbody>
</table>

Other notes on the servo parameter set:

References:
Function Manual, Basic Functions; Velocities, Setpoint/Actual-Value System, Closed-Loop Control (G2)

Dynamic response

The dynamic limits of the axis stored in the machine data are applicable in axis operation.
The axis switches to the current feedforward control mode as designated by the MD and the commands $FFWON$ and $FFWOF$.

Use of resolution changes

When using resolution changes in (analog) drive actuators, the following NC program steps are required:

1. Changeover to axis mode

<table>
<thead>
<tr>
<th>Programming</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPOS=...</td>
<td></td>
</tr>
<tr>
<td>M5</td>
<td>; Controller enable off (by PLC)</td>
</tr>
<tr>
<td></td>
<td>→ is output on PLC</td>
</tr>
<tr>
<td>M70</td>
<td>; Switch actuator (by PLC on account of M70)</td>
</tr>
<tr>
<td></td>
<td>Controller enable on (by PLC)</td>
</tr>
<tr>
<td>C=...</td>
<td>; NC traverses with axis parameter set</td>
</tr>
</tbody>
</table>
2. Switch back to spindle mode

<table>
<thead>
<tr>
<th>Programming</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>C=...</td>
<td>; → Output to PLC</td>
</tr>
<tr>
<td>M71</td>
<td>Closed-loop controller enable off (by PLC)</td>
</tr>
<tr>
<td></td>
<td>Switch actuator (by PLC)</td>
</tr>
<tr>
<td></td>
<td>Switched to spindle parameter set (1-5) internally in the NC, controller enable on (by PLC)</td>
</tr>
<tr>
<td>M3/4/5 or SPOS=...</td>
<td>NC traverses with spindle parameter set</td>
</tr>
</tbody>
</table>

### Change to spindle mode

The interpolation parameter (set 1 ... 5) is selected according to the currently valid gear step. The feedforward control function is always activated, except for tapping with compensating chuck.

Machine data:
MD32620 $MA_FFW_MODE (feedforward control type) must always be not equal to 0.

Feedforward control should always be operated with the value 100% to avoid alarms being output during positioning.

![Parameter Set Table](image)

Figure 21-8  Validity of parameter sets for axis and spindle modes
**Fundamentals**

**21.8 Spindle data**

**Master spindle**

In order to use diverse spindle functions in one channel, like for instance

- Revolutinal feed (G95)
- Tapping with compensation chuck (G63)
- Thread cutting (G33)
- Dwell time in spindle revolutions (G4 S...)

it is necessary to define a master spindle in each channel:

- MD20090 $MC_SPIND_DEF_MASTER_SPIND (master spindle initial setting in channel)

The spindle number of the channel spindle which is to be the master spindle defined in machine data MD35000 $MC_SPIND_ASSIGN_TO_MACHAX (spindle number) is entered in this machine data.

**Spindle reset**

The following machine data defines whether the spindle is to remain active after reset (IS: DB21,... DBX7.7) or end of program (M02/M30).

- MD 35040 $MC_SPIND_ACTIVE_AFTER_RESET (spindle active after reset)

To cancel spindle movements, an independent spindle reset is required:

- IS: DB31,... DBX2.2 (spindle reset)

**Literature**

Function Manual Basic Functions; Spindles
### Appendix

#### A.1 Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACX</td>
<td>Compressed format from XML</td>
</tr>
<tr>
<td>ALM</td>
<td>Active Line Module</td>
</tr>
<tr>
<td>AS</td>
<td>Automation System</td>
</tr>
<tr>
<td>BASP</td>
<td>Command output disable</td>
</tr>
<tr>
<td>BERO</td>
<td>Proximity limit switch</td>
</tr>
<tr>
<td>BI</td>
<td>Binector input</td>
</tr>
<tr>
<td>BICO</td>
<td>Binector connector</td>
</tr>
<tr>
<td>BO</td>
<td>Binector output</td>
</tr>
<tr>
<td>CF</td>
<td>CompactFlash</td>
</tr>
<tr>
<td>CI</td>
<td>Connector input</td>
</tr>
<tr>
<td>CNC</td>
<td>Computerized Numerical Control</td>
</tr>
<tr>
<td>CO</td>
<td>Connector output</td>
</tr>
<tr>
<td>CoL</td>
<td>Certificate of License</td>
</tr>
<tr>
<td>CP</td>
<td>Communications Processor</td>
</tr>
<tr>
<td>CPU</td>
<td>Central Processing Unit</td>
</tr>
<tr>
<td>CU</td>
<td>Control unit</td>
</tr>
<tr>
<td>DHCP</td>
<td>Dynamic Host Configuration Protocol: Protocol for automatic assignment of IP addresses from a DHCP server to a client computer</td>
</tr>
<tr>
<td>DIP</td>
<td>Dual In–Line Package: dual in-line arrangement</td>
</tr>
<tr>
<td>DO</td>
<td>Drive objects</td>
</tr>
<tr>
<td>DP</td>
<td>Distributed I/O</td>
</tr>
<tr>
<td>DRAM</td>
<td>Dynamic Random Access Memory</td>
</tr>
<tr>
<td>DRF</td>
<td>Differential resolver function: differential-synchro transmitter function</td>
</tr>
<tr>
<td>DRIVE-CLIQ</td>
<td>Drive Component Link with IQ</td>
</tr>
<tr>
<td>DSC</td>
<td>Dynamic servo control</td>
</tr>
<tr>
<td>DWORD</td>
<td>Doubleword</td>
</tr>
<tr>
<td>EMC</td>
<td>Electro-Magnetic Compatibility</td>
</tr>
<tr>
<td>EN</td>
<td>European standard</td>
</tr>
<tr>
<td>EQN</td>
<td>Designation for an absolute encoder with 2048 sine signals per revolution</td>
</tr>
<tr>
<td>ESD</td>
<td>Electrostatic Sensitive Device</td>
</tr>
<tr>
<td>GC</td>
<td>Global Control</td>
</tr>
<tr>
<td>GSD</td>
<td>Device master file</td>
</tr>
<tr>
<td>GUD</td>
<td>Global User Data</td>
</tr>
<tr>
<td>GWPS</td>
<td>Grinding wheel peripheral speed</td>
</tr>
<tr>
<td>HMI</td>
<td>Human Machine Interface: SINUMERIK operator interface for operating, programming, and simulation</td>
</tr>
<tr>
<td>IBN</td>
<td>Start up</td>
</tr>
</tbody>
</table>
### Appendix

#### A.1 Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPO</td>
<td>Interpolator cycle</td>
</tr>
<tr>
<td>IS</td>
<td>Interface signal</td>
</tr>
<tr>
<td>JOG</td>
<td>JOG mode: manual mode for setting up the machine</td>
</tr>
<tr>
<td>LAN</td>
<td>Local Area Network</td>
</tr>
<tr>
<td>LED</td>
<td>Light Emitting Diode</td>
</tr>
<tr>
<td>LR</td>
<td>Position controller</td>
</tr>
<tr>
<td>LUD</td>
<td>Local User Data</td>
</tr>
<tr>
<td>MAC</td>
<td>Media Access Control</td>
</tr>
<tr>
<td>MCIS</td>
<td>Motion Control Information System</td>
</tr>
<tr>
<td>MCP</td>
<td>Machine Control Panel</td>
</tr>
<tr>
<td>MD</td>
<td>Machine data</td>
</tr>
<tr>
<td>MELDW</td>
<td>Message word</td>
</tr>
<tr>
<td>MLFB</td>
<td>Machine-readable product designation</td>
</tr>
<tr>
<td>MM</td>
<td>Motor module</td>
</tr>
<tr>
<td>NC</td>
<td>NCK</td>
</tr>
<tr>
<td>NCK</td>
<td>Numerical Control Kernel: NC kernel with block preparation, travel range, etc.</td>
</tr>
<tr>
<td>NCU</td>
<td>Numerical Control Unit: NCK hardware unit</td>
</tr>
<tr>
<td>NX</td>
<td>Numerical Extension (axis extension module)</td>
</tr>
<tr>
<td>OB</td>
<td>Organization block</td>
</tr>
<tr>
<td>OLP</td>
<td>Optical Link Plug</td>
</tr>
<tr>
<td>PCU</td>
<td>PC Unit: computer unit</td>
</tr>
<tr>
<td>PD</td>
<td>Process date</td>
</tr>
<tr>
<td>PELV</td>
<td>Protective Extra-Low Voltage</td>
</tr>
<tr>
<td>PG</td>
<td>Programming device</td>
</tr>
<tr>
<td>PII</td>
<td>Process input image</td>
</tr>
<tr>
<td>PIO</td>
<td>Process output image</td>
</tr>
<tr>
<td>PLC</td>
<td>Programmable Logic Control (component of the CNC controller)</td>
</tr>
<tr>
<td>PM</td>
<td>Power Module</td>
</tr>
<tr>
<td>PNO</td>
<td>PROFIBUS User Organization (e.v.)</td>
</tr>
<tr>
<td>PUD</td>
<td>Global Program User Data</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory (can be read and written)</td>
</tr>
<tr>
<td>RDY</td>
<td>Ready</td>
</tr>
<tr>
<td>REF</td>
<td>Reference point</td>
</tr>
<tr>
<td>RES</td>
<td>Reset</td>
</tr>
<tr>
<td>RTCP</td>
<td>Real Time Control Protocol</td>
</tr>
<tr>
<td>SBC</td>
<td>Safe brake activation</td>
</tr>
<tr>
<td>SD</td>
<td>Setting Data</td>
</tr>
<tr>
<td>SH</td>
<td>Safe standstill</td>
</tr>
<tr>
<td>SIM</td>
<td>Single Inline Module</td>
</tr>
<tr>
<td>SLM</td>
<td>Smart Line Module</td>
</tr>
<tr>
<td>SMC</td>
<td>Sensor Module Cabinet-Mounted</td>
</tr>
<tr>
<td>SME</td>
<td>Sensor Module Externally Mounted</td>
</tr>
<tr>
<td>SMI</td>
<td>Sensor Module Integrated</td>
</tr>
</tbody>
</table>
### Appendix

#### A.1 Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SRAM</td>
<td>Static RAM (battery-backed)</td>
</tr>
<tr>
<td>STW</td>
<td>Control word</td>
</tr>
<tr>
<td>TCU</td>
<td>Thin Client Unit (communication with operator panels)</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>VDE</td>
<td>Association of Electrical Engineering, Electronics and Information Technology</td>
</tr>
<tr>
<td>VO</td>
<td>Voltage output</td>
</tr>
<tr>
<td>ZSW</td>
<td>Status word</td>
</tr>
</tbody>
</table>
## A.2 Overview

### SINUMERIK 840D sl Documentation Overview

#### General Documentation

- **SINUMERIK 840D sl**
  - Sales Brochure
- **SINUMERIK 840D sl 840Di sl 802D sl**
  - Catalog NC 61
- **SINAMICS S120**
  - PM 21 Catalog SIMOTION, SINAMICS S120 and Motors for Production Machines

#### User Documentation

- **SINUMERIK 840D sl**
  - Operating Instructions
    - Universal
    - Turning
    - Milling
    - HMI Advanced
- **SINUMERIK 840D sl 828D**
  - Operating Manual
    - Turning
    - Milling
- **SINUMERIK 840D sl 826D**
  - Programming Manual
    - Fundamentals
    - Job planning
    - Measuring cycles
- **SINUMERIK 840D sl 840Di sl 828D 802D sl**
  - Programming Manual
    - ISO Turning
    - ISO Milling
- **SINUMERIK 840D sl S120**
  - Diagnostics Manual

#### Manufacturer/service documentation

- **SINUMERIK 840D sl**
  - Manual
    - NCU
    - Operator components and networking
  - System Manual
    - Guidelines for machine configuration
- **SINUMERIK 840D sl 828D**
  - System Manual
    - Ctrl Energy
  - Commissioning Manual
    - DNC: NCK, PLC, Drive
    - Basic Software and Operating Software
    - Basic Software and HMI Advanced
- **SINUMERIK 840D sl S120**
  - Parameter Manual
    - Part 1
    - Part 2
    - Detailed Machine Data
    - Description
    - System variables

#### Information / Training

- **SINUMERIK 840D sl 828D**
  - Function Manual
    - Basic Functions
    - Extension Functions
    - Special functions
    - Synchronized actions
    - Tool management
- **SINUMERIK 840D sl 840Di sl 802D sl 828D**
  - Function Manual
    - Drive functions
  - Function Manual
    - Safety Integrated
- **SINAMICS S120**
  - Configuration Manual
    - EMC Design Guidelines
- **SINUMERIK 840D sl**
  - Manuals
    - Tool and mold making
- **SINUMERIK**
  - Beginner’s Manual
    - Milling and Turning
  - Training documents
    - Milling made easier with ShopMill
    - Turning made easier with ShopTurn
  - Manuals
    - DOCentCD
    - DOCentWEB

#### Electronic documentation

- **My Documentation Manager**
  - IBN CNC: NCK, PLC, drive
  - Commissioning Manual, 02/2011, 6FC5397-2AP40-0BA0
Glossary

Active Line Module
Controlled, self-commutating feed/feedback unit (with "IGBT"s in feed/feedback direction), which supplies the DC link voltage for the "Motor module".

CompactFlash card
Memory card for non-volatile storage of the drive software and corresponding "Parameters". The memory card can be plugged into the "Control Unit" from outside.

Control unit
Central control module in which the closed-loop and open-loop control functions for one or more "SINAMICS" "Line Module(s) and/or "Motor Module(s) are implemented.
There are three types of Control Unit:
- SINAMICS Control Units, e.g. "CU320"
- SIMOTION Control Units, e.g. "D425" and "D435"
- SINUMERIK solution line Control Units, e.g. NCU710, NCU720 and NCU730

Control Word
Bit-coded "Process data" word, transmitted by "PROFIdrive" at cyclic intervals to control the drive states.

Double Motor Module
Two motors can be connected to and operated with a Double Motor Module.
See "Motor Module" "Single Motor Module"
Former term: "Double-axis module"

Drive
The drive includes the motor (electric or hydraulic), the actuator (converter, valve), the control unit, measuring system, and supply components (line infeed module, pressure reservoir).
For electric drives, a distinction is made between a converter system and an inverter system.
With a converter system (e.g. "MICROMASTER 4"), from the point of view of the user the line infeed, actuator, and control component form a single device; with an inverter system (e.g. "SINAMICS S"), the supply is ensured by means of "Line Module", thereby realizing a DC line to which the "Invertors" ("Motor Module")s are connected.
The ("Control unit") is implemented as a separate device and connected to the other components by means of "DRIVE-CLiQ".
Glossary

Drive component

Hardware component connected to a "Control Unit" via "DRIVE-CLiQ", for example. Drive unit are for instance: "Motor Module"s, "Line Module"s, "Motor"s, "Sensor Module"s and "Terminal Module"s.

The overall layout of a Control Unit together with the connected drive components is called "Drive unit".

Drive group

A drive group comprises a "Control Unit" and the and the "Motor Module"s and "Line Module"s connected via "DRIVE-CLiQ".

Drive object

A drive object is an autonomous, individual software function with its own "Parameters" and may also have its own "Fault"s and "Alarm"s. Drive objects may exist by default (e.g. On Board I/O) can be created individually (e.g. "Terminal Board" 30, TB30) or also as multiples (e.g. "Servo Control"). As a rule, each drive object has its own window for parameterization and diagnostic purposes.

Drive parameters

Parameters of a drive axis that include, for example, the parameters of the corresponding controllers, as well as the motor and encoder data. The parameters of the higher-level technology functions (positioning, ramp-function generator), however, are called "Application Parameters". See "Basic Unit System".

Drive system

The drive system includes all the components in a product family (e.g. SINAMICS). A drive system comprises, for example, - The drive system includes all the components in a product family (e.g. SINAMICS). A drive system comprises, for example, SINAMICS. A drive system comprises "Line Module"s, "Motor Module"s, "Sensors", "Motors", "Terminal Module"s and "Sensor Module"s as well as additional components (reactors, filters, cables, etc.). See "Drive unit".

Drive unit

The drive unit includes all the components connected via "DRIVE-CLiQ" that are required for carrying out a drive task: "Motor Module" "Motor Module" "Control Unit" "Line Module" and the required "Firmware" and "Motor"s, but not additional components, such as filters or reactors.

Several "Drive"s can be implemented in a drive unit.

See "Drive System".
Glossary

DRIVE-CLiQ
Abbreviation of "Drive Component Link with IQ". Communication system for connecting the different components of a SINAMICS drive system (e.g. -> "Control Unit", -> "Line Module"s, -> "Motor Module"s, -> "Motor"s, and speed/position sensors. The DRIVE-CLiQ hardware is based on the Industrial Ethernet standard with twisted-pair lines. The DRIVE-CLiQ line provides the transmit and receive signals, as well as the +24 V power supply.

DRIVE-CLiQ Hub Module Cabinet
The DRIVE-CLiQ Hub Module Cabinet (DMC) is a star coupler for multiplying -> "DRIVE-CLiQ sockets. The DMC can be clipped onto a rail. The DMC20 is available, for example:
See -> "Hub"

Encoders
An encoder is a measuring system that captures actual values for the speed and/or angular/position values and makes them available for electronic processing. Depending on the mechanical construction, encoders can be integrated in the -> "Motor" (→ "Motor Sensor") or mounted on the external mechanics (→ "External Sensor"). Depending on the type of movement, a distinction is made between rotary sensors ("rotary transducers") and translatory sensors (e.g. - Linear Sensors). In terms of measured value provision, a distinction is made between -> "Absolute Sensor"s (code sensors) and -> "Incremental Sensors"s.
See -> "Incremental Sensor TTL/HTL" -> "Incremental Sensor sin/cos 1 Vpp" -> "Resolver".

External Encoder
Position encoder that is not built in or mounted on the -> "Motor", but fitted instead via a mechanical transmission element or mechanical intermediate element.
The external encoder (see -> "Externally-Mounted Sensor") is used for -> "Direct Position Detection".

Hub
Central connection device in a network with star-shaped topology. A hub distributes incoming data packages to all connected end devices.
See -> "DRIVE-CLiQ Hub Module Cabinet" (DMCxx)
**Line Module**

A Line Module is a power component that generates the DC link voltage for one or more Motor Modules from a 3-phase mains voltage.

In SINAMICS, the following three types of Line Module are available:
-> "Basic Line Module", --> "Smart Line Module", -- "Active Line Module".

The overall function of an infeed, including the required additional components like Line Reactor, proportional computing power in a Control Unit, switching devices, etc., is called Basic Infeed, Smart Infeed, and Active Infeed.

**Motor**

For the electric motors that can be driven by SINAMICS, a basic distinction is made between rotary and linear motors with regard to their direction of motion, and between synchronous and induction motors with regard to their electromagnetic operating principle.

In SINAMICS, the motors are connected to a Motor Module.


**Motor Encoder**

A Sensor (e.g. Resolver, Incremental Sensor TTL/HTL, or Incremental Sensor sin/cos 1 Vpp) that is integrated in or attached to the motor.

The sensor detects the motor speed. In the case of synchronous motors, it can also detect the rotor position angle (of the commutation angle for the motor currents).

For drives without an additional Direct Position Measuring System, it is also used as a Position Sensor for position control.

In addition to the motor encoders, External Sensors for Direct Position Sensing are available.

**Motor Module**

A Motor Module is a power component (DC-AC inventor) that supplies the power for the connected motor(s).

Power is supplied through the DC Link of the Drive Unit.

A Motor Module must be connected to a Control Unit via DRIVE-CLiQ. The open-loop and closed-loop control functions for the Motor Module are stored in the Control Unit.

-> "Single Motor Module"s and --> "Double Motor Module"s are available.

**Option Slot**

Slot for an optional module (e.g. in the Control Unit).

**Parameters**

Variable quantity within the drive system that the user can read and, in some cases, write.

For SINAMICS, all specifications defined in the PROFIdrive profile are defined by a parameter.

See Visualization Parameters and Adjustable Parameters.
PROFIBUS
Field bus to IEC 61158, Sections 2 to 6. The abbreviation "DP" is no longer included because PROFIBUS FMS is not standardized and PROFIBUS PA (for Process Automation) is now part of the "general" -> "PROFIBUS".

Sensor Module
Hardware module for evaluating speed/position encoder signals and providing detected actual values as numerical values at a -> DRIVE CLiQ Socket". Three mechanical Sensor Module variants are available:
- SMCxx = Sensor Module Cabinet-Mounted
- SME = Sensor Module Externally Mounted (with a high degree of protection)

Servo Control
For -> "Motor"s equipped with a -> "Motor Encoder", this control type allows operation with a high level of -> "Accuracy" and -> "Dynamic Response". In addition to speed control, position control can also be implemented.

Servo Drive
An electric servo drive comprises a motor, a -> "Motor Module", a -> "Servo Control" and, in most cases, a speed and position -> "Sensor". Electric servo drives are normally extremely precise and have a high dynamic response. They are designed for cycle times to less than 100 ms, and often have a short-time overload capacity, which enables quick acceleration. Servo drives are available as rotary and linear drives and are used for machine tools, handling robots, and packaging machines.

SITOP Power
Components for -> "Electronics Power Supply". Example: 24 V DC

Smart Line Module
Unregulated line infeed/feedback unit with a diode bridge for the infeed and stall-protected, line-commutated feedback via -> "IGBT"s. The Smart Line Module supplies the DC link voltage for the -> "Motor Module"s.

Status Word
Bit-coded -> "Process data" word, transmitted by -> "PROFIdrive" at cyclic intervals to control the drive states.
Supply

Input component of a converter system for generating a DC link voltage to supply one or more "Motor module"s, including all the required components (e.g. "Line module"s, fuses, reactors, line filters, and firmware, as well as proportional computing power (if required) in a "Control unit".

Vector Control

Vector control (field-oriented control) is a high-performance control type for induction machines. It is based on an exact model calculation of the motor and two current components that simulate and accurately control the flux and torque by means of software algorithms, thereby enabling predefined speeds and torques to be observed and limited accurately and with a good dynamic response.

Two vector control types exist:
Frequency control ("Sensorless Vector Control") and speed-torque control with speed feedback ("Sensor").
Index

8

840Di sl, 351

A

Absolute encoders, 185
   Calibration of multiple axes, 187
   Operator-assisted calibration, 185
   Recalibration, 187
Absolute measuring systems
   Parameterization, 149
Acceleration, 161
   Checking, 161
Actual value inversion, 152
Advanced Surface (AS), 208
Assign axis, 116
Assigning actual-value channels, 480
Assigning setpoint channels, 480
Assignment
   General and axis-specific machine data, 114
Automatic servo optimization, 244
   Axis selection, 244
   Controller data overview, 244
   Measurement, 244
   Options, 244
   Park position, 244
   Reconfigure measurement, 244
   Strategy selection, 244
Automation License Manager, 353, 361
Axis
   Monitoring functions, 169
   Parameter sets, 143
   Reference point approach, 178
   Velocity matching, 166
Axis configuration, 473
Axis selection, 244

B

BICO connections on the HMI, 448
Brake behavior OFF3, 241

C

Catalog motor, 83
CF card, 351, 355
Changing the password, 470
Changing topology, 309
Channel axes, 471
Circularity test, 216
Clamping tolerance, 169
CoL, 351, 355
Cold restart, 480
Communication parameters, 363
CompactFlash card, 355
Computational resolution, 122
Contour monitoring, 173
Control direction, 158
Control image (offline), 372
Control mode, 88
Control system (online), 361, 367, 372
   Switchover, 365, 367
Controller data overview, 244
Copy drive object, 301
Current control loop
   Measurement, 220
   Customer login, 354
   Cycle times, 133

D

Data backup DRIVE-CLiQ motors, 290
DB 31, ...
   DBB16-19, 485
   DBB82-91, 485
   DBX60.0, 485
DB21, ...
   DBX7.7, 485
DDS, 343
Deleting the password, 470
Detailed view, 52
Device configuration, 74
Diagnostics
   System, 41
Direct access, 354
Display resolution, 121, 122
Distance-coded reference marks, 182
Download to target system, 373
Drift compensation, 165
Drive components, 445
Drive object, 445
Drive states, 335
Drive wizard, 82
DSC, 151
Dynamic monitoring functions, 172
  Velocity monitoring, 173
Dynamic servo control, 151
EDS, 343
Encoder Monitoring
  Cut-off frequency, 174
  Cyclic monitoring of position tolerance, 176
  Position tolerance when switching over the encoder, 175
  Zero mark monitoring, 175
Encoder types
  Absolute measuring system, 149
  Endlessly rotating rotary axis, 153
  EQN 1325, 149
  Ethernet connection, 353
  Exact stop
    Coarse, 169
    Fine, 169
  External drive, 258
  External HMI, 15
Factory settings, 101
Firmware update, 103
Firmware version drive components, 340
Firmware version measuring systems, 340
Function Overview, 360
GEAR_STEP_PC_MAX_VELO_LIMIT, 191
Geometry axes, 472
HMI Advanced, 17, 355, 363
HMI basic software, 361, 363
HMI Embedded, 16
HW Config, 52
Identification of the ALM, 342
Incremental measuring systems
  Parameterization, 145
  Indexing axes, 156
  Indexing position tables, 156
Infeeds, 76
Input limits, 123
Input resolution, 121
Inputs/outputs (HMI function), 35
Integrated drive, 257
Interface signals, 49
Interlock, 469
Internal HMI, 15
Intranet, 368
Intranet connection, 353
IP address, 364
JOG axis velocity, 166
Key
  *, 366
  F5, 366
KV factor
  Definition, 159
LED
  Fault and status display, 41
  License, 353, 361
  License database, 353, 354
  License information, 355, 367
  License key, 352, 356
    copying, 356
    SINUMERIK, 356
Hardware, 351
Hardware limit switches, 171
Hardware reference, 356
Hardware serial number, 352, 355
Hirth axes, 156
Index

License number, 351
License requirement, 367
Linear axis
  With linear scale, 147
  With rotary encoder on motor, 145
  With rotary encoder on the machine, 146
Linear measuring system, 147
Load drive object, 301

M
M70, 484
Machine axes, 471
Machine data
  Changing scaling, 128
  Loading of default data, 129
  Normalization of physical quantities, 124
Manufacturer-specific telegrams, 450
Max. axis velocity, 166
MCI board, 351
MD10000, 474
MD10002, 474
MD10050 $MN_SYSCLK_CYCLE_TIME, 137
MD1061 $MD_POSCTRL_CYCLE_TIME, 137
MD1070 $MD_IPO_SYSCLK_TIME_RATIO, 137
MD1071 $MD_IPO_CYCLE_TIME, 137
MD11640, 474
MD20050, 475
MD20070, 474, 475
MD20080, 474
MD20094, 484
MD24110, 475
MD24120, 475
MD31050, 486
MD31060, 486
MD32200, 486
MD32452, 486
MD32610, 486
MD32620, 487
MD32800, 486
MD32810, 486
MD32910, 486
MD35020, 483
MD35030, 483
MD36012, 486
MD36200, 486
MDS, 343
Measurement of autom. servo optimization, 244
Measurement of speed control loop, 222
Measuring functions, 216, 217
  Cancel, 218
  Start, 218
Measuring system switchover
  Interface signals, 480
Menu command
  Connect to target system, 362
  Download to target system, 373
  Edit, 362
  PlugIn SINUMERIK, 362
  Refresh, 366
  Upload from target system, 369
  View, 366
MMC.INI, 363
Modular machine, 309
Modulo axis, 153
Modulo display, 153
My Computer, 366

N
NC utilization, 137
NCK commissioning switch, 39, 42
NCU 7x0.2
  Interfaces, 29
  LED fault and status display, 41
  Terminal assignment, 31
NCU 7x0.3
  Interfaces, 30
  LED fault and status display, 41
  Terminal assignment, 31
New installation
  Classic, 383
  SinuCom Installer, 403
NX 1x.1
  Terminal assignment, 34
NX 1x.3
  Terminal assignment, 34

O
Option, 244
Options for autom. servo optimization, 244
Overview of functions, 360

P
Parameter sets of the position controller, 143
Park position, 244
Peer-to-Peer, 353
PLC mode selector switch, 39, 42
Position control loop
  Measurement, 225
  Overshoots, 160
Reference frequency response, 227
Setpoint step change, 228
Step height, 230
Position controller cycle, 133
Positioning accuracy of the control system, 132
Positioning axes, 155
Power on reset, 75
Process data
  Actual values: G1_XACT1, 453
  Actual values: G1_XACT2, 454
  Actual values: G2_XACT1, 454
  Actual values: G2_XACT2, 454
  Actual values: G3_XACT1, 454
  Actual values: G3_XACT2, 454
  Actual values: NACT_A, 453
  Actual values: NACT_B, 453
  Control words: A_STW1, 453
  Control words: STW1, 453
  Control words: STW2, 453
  Control words: G1_STW, 453
  Control words: G2_STW, 453
  Control words: G3_STW, 453
  Setpoints: NSET_A, 453
  Setpoints: NSET_B, 453
  Setpoints: TRQRED, 453
  Setpoints: KPC, 453
  Setpoints: XERR, 453
  Status words: A_ZSW1, 454
  Status words: G1_ZSW, 453
  Status words: G2_ZSW, 454
  Status words: G3_ZSW, 454
  Status words: MELDW, 454
  Status words: ZSW1, 453
  Status words: ZSW2, 453
  Process data for receiving, 452
  Process data for sending, 453
  Product, 352
  PROFIBUS connection, 109, 115
  PROFIBUS telegram type, 88
  Protection levels, 468
    for machine data, 469
    Influence via softkeys, 470
  PTP link, 353, 368
  Pulse multiplication factor, 192

Q
  Quantity structure, 261

R
  Ramp-up time, 362
  Rapid traverse in the JOG mode, 166
  Reference point approach, 178
  Reset (warm restart), 72
  Resolutions, 121
  Rotary axes
    Drive Optimization, 153
  Rotary axis
    With rotary encoder on motor, 146
    With rotary encoder on the machine, 147
  Rotary measuring system, 145

S
  Safe operation, 21
  Safety Integrated, 13
  Section, 363
  Servo gain, 159
    Checking, 160
  Setting data
    Normalization of physical quantities, 124
  Setting the axis-specific setpoint parameters, 479
  Setting the axis-specific setpoint/actual value parameters, 479
  Setting the password, 71, 470
  Signal distortion, 174
  SIMATIC, 361
  SIMATIC Manager, 47
  SIMATIC S7 project, 49
  SinuCom Installer, 403
  SinuCom Update Agent, 290
  SINUMERIK 840Di sl, 351
  SINUMERIK plug-in, 361, 363
    enable/disable, 362
  Software limit switches, 171
  Software product, 351
  Speed adjustment, 241
  Speed setpoint matching, 163
  Speed setpoint monitoring, 172
  Spindle
    Encoder matching, 192
    Gear stages, 191, 194
    Measuring systems, 192
    Modes, 483
    Monitoring functions, 201
    Parameter sets, 143, 191
    Positioning, 197
    Setpoint matching, 195
    Setpoint/actual value channels, 190
Index

Synchronization, 199
Velocities, 194
Spindle data, 204
Standard telegrams, 450
Static monitoring functions, 169
Strategy selection, 244
Switching over the measuring system, 130
System basic cycle, 133
System data, 121
System requirements, 361
System resources, 137
System software SINAMICS S120, 339

T
TCP/IP, 353
Telegram assignment, 435
Telegrams
   Manufacturer-specific, 450
   Standard, 450
Telegrams for receiving, 451
Telegrams for sending, 452
Terminal assignment
   HMI function, inputs/outputs, 35
   HMI support, 35
   NCU 7x0.2, 31
   NCU 7x0.3, 31
   NX 1x.1, 34
   NX 1x.3, 34
Third-party motor, 90
Thread
   Tapping/thread cutting, 143
Toolbox, 28
Topology of individual drive components, 334
Transfer license information
   Drag-and-drop, 372
   using menu commands, 373
Traversing direction, 158
Traversing ranges, 132

U
Upgrade
   Classic, 383
   SinuCom Installer, 408

V
Velocities, 194
   Max. axis velocity, 139
   Max. tool path velocity, 139
   Maximum spindle speed, 139
   Upper limit, 139
   Voltage limit, 140
Velocity monitoring
   Actual, 173

W
Working area limitation, 170

Z
Zero speed tolerance, 169